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Overview

Log data can comprise up to 25 percent of all enterprise data. Log data also contains
critical information that can improve security, compliance and availability. Until now most
companies have relied on ineffective and inefficient homegrown solutions and manual
processes to manage this data.

TIBCO LoglLogic® provides the industry's first enterprise class, end-to-end log management
solution. Using LoglLogic® log management solutions, IT organizations can analyze and
archive network log data for the purpose of compliance and legal protection, decision
support for network security remediation, increased network performance, and improved
availability.

LogLogic log management appliances help you to simplify, automate, and reduce the cost
of log data aggregation and retention, eliminating the need for servers, tape libraries, and
archival administrators. If the network grows, you can simply rack and stack additional
appliances as needed.

o Note: Loglogic LMI has been used to represent LoglLogic LMI, LoglLogic EVA, and
LogLogic EVA - Container Edition. All processes and procedures applicable to
LoglLogic LMI are also applicable to LogLogic EVA and LoglLogic EVA -

Container Edition, unless explicitly stated otherwise.

Appliance Functions

There are two primary user types on a TIBCO LoglLogic® appliance:

e Administrator - Configures and maintains the appliance itself, including managing log
sources, user accounts, appliance configurations, running backups, and more.

» User - Monitors appliance operations, runs searches, manages alerts, and creates and
runs reports based on collected data.

The appliance GUI provides access to administrator and user functions.

» Administrators can perform all functions on the appliance. TIBCO LogLogic® Log

TIBCO Loglogic® Log Management Intelligence User Guide
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Management Intelligence Administration describes administrator tasks and functions.
The default admin user can perform certain tasks and functions exclusively. Such
tasks are exclusively indicated in the relevant sections.

» Users can perform functions that have been assigned to them by the system
administrator, and these might include a subset of the administrator task and
functions. The TIBCO LogLogic® Log Management Intelligence User Guide describes
user tasks and functions.

Reports, search, and alert functions can be opened by clicking their respective icons on the
Home page or by clicking their buttons on the top menu on the Home page. Dashboard,
management, and administration functions for the appliance can be accessed from the top
menu on the Home page. For more information, see the TIBCO LogLogic® Log Management
Intelligence Administration.

Online Help can be opened by clicking the Help icon on the top right corner. Brief video
tutorials provide tips and guidance by example for many new LoglLogic features. The
tutorials are accessible from the Home page and from certain application pages.

LogLogic Appliance Home Page

TIBC® LoglLogic Dashboards ~  Reports ~  Search ~  Alerts - Management ~  Administration ~

Home Enterprise Virtual Appliance

Welcome to the LogLogic

Log Management Platform I\ Reports Search Alerts
LogLogic helps you gain understanding of |-|_I Report Categories~ Search Tools~ AA Manage~
your enterprise-wide systems and user

activities to meet the security, operational
and compliance needs of your enterprise.

Reports, Search, and Alert functions are
available by clicking on the respective
buttons to the right or from the Reports,
Search, and Alert menus.

Log Source Settings, Message Labeling,
and Appliance Accounts are accessible
from the Management menu.
Administration provides access to
Appliance Settings.

Online Help is available by clicking on the
"Help" button.

The LogLogic Tutorials provide tips and
detailed guidance for many new LogLogic
features. (Registration is required.)

TIBCO Loglogic® Log Management Intelligence User Guide
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o Note:

e The functions in the navigation menu vary depending on the appliance
product family. For example, a TIBCO LogLogic® ST Appliance displays
fewer options than a TIBCO LoglLogic® LX Appliance because certain
features are not available on LoglLogic® ST Appliances. In addition, reports
might show different entries, depending on the TIBCO Loglogic® Log
Source Packages installed.

e For all text fields throughout the GUI, null is not a valid entry.

TIBCO LogLogic® Product Families

TIBCO LoglLogic® appliances bring visibility of compliance activity metrics to CIOs and
CSOs, and control over activities to the compliance team, permitting them to review the
compliance timeliness and compliance posture mandated by Sarbanes-Oxley (SOX) and
Payment Card Industry Data Security Standard (PCIDSS).

TIBCO LogLogic® appliances provide the highest log collection and analysis performance
amongst all log management vendors. Log events are received and indexed in real-time.
The TIBCO Loglogic® appliances have clearly stated metrics that cannot be matched.

Hardware Product Families

TIBCO LogLogic® offers the following hardware product families to provide better, faster,
and smarter log management, database security, and regulatory compliance solutions to
corporations:

e TIBCO LoglLogic® LX Appliances are purpose-built appliances for real-time log data
collection and analysis. These appliances slash response times to network security
and utilization incidents, boost IT productivity, and reduce the corporate cost of
security and performance event remediation.

» TIBCO LoglLogic® MX Appliances perform real-time log data collection and analysis
ideal for mid-size and large companies. These appliances slash response times to
network security and utilization incidents, boost IT productivity, and are optimized to
provide for log data needs in a non-enterprise environment.

e TIBCO LoglLogic® ST Appliances automate the entire log data archival process,

TIBCO Loglogic® Log Management Intelligence User Guide
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minimizing administration costs while providing more secure log data capture and
retention.

To view photographs of the appliance layout, see TIBCO LogLogic® Log Management
Intelligence Hardware Installation Guide.

Virtual Editions

TIBCO LoglLogic® Enterprise Virtual Appliance provides an all-in-one software solution for
log management.

TIBCO LogLogic® Enterprise Virtual Appliance and TIBCO LoglLogic® Enterprise Virtual
Appliance - Container Edition are virtual versions of the TIBCO LoglLogic® Log Management
Intelligence hardware appliance, and are distributed on the TIBCO eDelivery website.

For a comparison between the platforms and deployment instructions, see TIBCO LogLogic®
Enterprise Virtual Appliance Quick Start.

LogLogic® LX Appliance Product Family

Featuring a parallel processing architecture, the LoglLogic LX Appliances centralize log data
collection and retention by simultaneously processing raw log data and metalog data at
high volume.

Distributed real-time reporting and targeted queries let administrators take immediate
action on network issues from a centralized management console.

These appliances help enterprises harness the power of log data for a safer, more reliable
network, while reducing corporate IT costs and providing a rapid return on investment.

Benefits

Appliances in the LogLogic LX Appliance product family offer the following benefits:

» Real-time reports, ad-hoc queries, and fast drill-downs to speed up identification,
isolation, and repair of security and network incidents.

» Non-disruptive installation and plug-and-play operation: no changes to network
configurations; no dependencies on other systems; no training required; available in

TIBCO Loglogic® Log Management Intelligence User Guide
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minutes.

» Self-maintaining, embedded database technology eliminates the need for database
administration.

To view photographs of the appliance layout, see TIBCO LogLogic® Log Management
Intelligence Hardware Installation Guide.

LogLogic® MX Appliance Product Family

The LoglLogic MX Appliances centralize log data collection and retention by simultaneously
processing raw log data and metalog data at any volume.

Designed specifically for mid-size and large companies, LoglLogic MX Appliances provide the
disk space and processing power required for most non-enterprise environments.

LogLogic MX Appliance features are focused on those needed to harness the power of log
data for a safer, more reliable network, while reducing corporate IT costs and providing a
rapid return on investment. LoglLogic MX Appliances are designed for installations where
data must be retained longer than LoglLogic LX Appliances provide, but where managing
other log appliances is not required.

Benefits

LoglLogic MX Appliances offer the following benefits:

» Real-time reports, ad-hoc queries and fast drill-downs to speed up identification,
isolation and repair of security and network incidents.

» Features and specifications targeted specifically to mid-size and large companies.

» Self-maintaining, embedded database technology eliminates the need for database
administration.

To view photographs of the appliance layout, see TIBCO LoglLogic® Log Management
Intelligence Hardware Installation Guide.

TIBCO Loglogic® Log Management Intelligence User Guide
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LogLogic® ST Appliance Product Family

The LoglLogic ST Appliances archive up to 10 years of log data while eliminating the need
for servers, tape libraries, and archive administrators.

They are available in compact, rack-mountable systems with up to 8 terabytes of storage
and interfaces to NAS devices. The LoglLogic ST SAN (Storage Area Network) appliances
offer virtually unlimited archive storage.

When used with LoglLogic LX Appliances, LoglLogic ST Appliances guarantee the complete
and accurate transmission of network equipment logs from anywhere on the enterprise
WAN or LAN. LogLogic ST Appliances feature an n-Tier architecture controlled by a
management console that centralizes long-term log data archival while allowing for
distributed log analysis and broader data accessibility.

Benefits

LoglLogic ST Appliances offer the following benéefits:
» High volume log data aggregation from centralized and remote log data sources.

e Long-term retention of unaltered, complete, raw log messages at a secure, central
location to make archives unimpeachable.

 Distributed architecture of remote collection and central storage make log data
collection and retention infinitely scalable.

» Self-maintaining, embedded database technology eliminates the need for database
administration.

To view photographs of the appliance layout, see TIBCO LogLogic® Log Management
Intelligence Hardware Installation Guide.

LogLogic® EVA and LoglLogic® EVA -
Container Edition

LoglLogic EVA is optimized for virtual and cloud platforms such as VMware server, Kernel-
based Virtual Machine (KVM), Amazon Web Services (AWS), and Microsoft Azure; and
provides an all-in-one software solution for log management.

LoglLogic EVA - Container Edition is meant for container platforms such as Docker.

TIBCO Loglogic® Log Management Intelligence User Guide
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It helps you derive actionable information by capturing, indexing, and compressing log files
and flow data.

Benefits

LoglLogic EVA and LoglLogic® EVA - Container Edition offer the following benefits:

» Provides all the alerting, searching, and reporting you need for both near-term
activity and archived data.

e Real-time monitoring lets you alert as needed and monitor system behavior such as
VPN session tracking, application distribution, port monitoring, hardware health, and
security stance.

 Better IT operations, which leads to reduced time-to-resolution, simplified and
improved security, improved IT efficiency, and best-practice implementations.

* Provides easy scalability.

For a comparison between the platforms and deployment instructions, see TIBCO LogLogic®
Enterprise Virtual Appliance Quick Start.

Scalable Infrastructure

The scalable LoglLogic network infrastructure significantly accelerates response time to
data center security and availability events, while providing complete log data archives for
compliance and legal protection.

LoglLogic appliances make log data in enterprise networks truly useful for the first time,
improving corporate security, compliance, and network availability, while reducing IT costs
and costly network downtime and improving corporations' return on IT investment.

TIBCO Loglogic® Log Management Intelligence User Guide
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Viewing Dashboards

LoglLogic appliances let you monitor a large variety of data to observe the system’s status
and the widgets saved on your Dashboard.

e Viewing Multiple Systems Status (Management Station)

* Viewing Log Source Status

Viewing Multiple Systems Status (Management
Station)

The Management Station System Status is the fastest way to view the condition and status
of your appliances as traffic flows through your system.

You can use this information to provide for rapid reporting to the operations staff and
acquire information about syslog messages at any particular time.

The appliance list can be sorted by ID, Model, or IP Address when the page opens.
Administrators can set the default sort order.

The System Status information uses a proprietary technology for optimizing and then
collecting security data for immediate use. Administrators can monitor the CPU usage
when necessary to check on its congestion.

Procedure
1. Choose Dashboards > Management Station from the navigation menu.

2. View the following sections on the Management Station tab for information about
an appliance’s status. For detailed descriptions of each section, see the following
table.

e Message Statistics
e Message Rate

e New Alerts
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e Message Counters

3. Click the Refresh button to view updated status information for the appliance.

Management Station Screen Elements

Element Description

General information

Software Version Management Station appliance’s software version.
Management Station sections

Appliances Lists the appliances in your Management Station cluster. To view
the System Status for an Appliance, click its name.

» A green square indicates the appliance is online.
» Ared square indicates the appliance is offline.
e A blank square indicates the appliance entry is being
updated.
Message Statistics Displays the following message statistics:

e Total, Processed, Dropped, Unapproved, and Skipped:
Message processing information about each managed
appliance.

Click a number in these columns to change the displayed
value to the nearest thousand, million, or billion value.

Click the ID, Model, or IP columns to sort the appliances as
required.

* Message Rate/Sec: Message rate, per second, by time
segments of 1, 5, and 15 minutes.

Click on the message rate values to set the Message Rate
graph to time scales of 4, 12, and 24 hours, respectively.

e Time Skew: Time delta, in seconds, between the
Management Station appliance and each remote
appliance.
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Element

Message Rate Graph

New Alerts

Message Counters

Description

Monitors the rate at which messages are collected.

The Message Rate graph displays the current message rate by
time segments of 1, 5, and 15 minutes. For example, 1 min - 100
msgs/sec. On LoglLogic ST Appliances, to the right of the minutes
is the number of messages per second (xxx msgs/sec) for the
appliance. xxx does not reflect the number of messages that
come in via the LoglLogic TCP protocol.

e The pink line represents the average number of messages
per time segment.

e The blue line represents the real-time incoming message
rate for your appliance.

e The red line appears when inbound traffic exceeds the
preset threshold

The number of activated alerts, by hour and by priority (High,
Medium, Low, All).

Click an alert value to show the Aggregated Alert Log for
LogLogic LX Appliance or LogLogic MX Appliance.

Statistics on each message category, stored in the syslog
database. The count corresponds to a percentage related to the
total number of messages received. This is useful in calculating
data retention settings and maximum syslog message rates.

The following is a list of message counters:

e Total Received: Total number of incoming messages for all
categories.

e Processed: Total number of messages received and parsed
into the database.

e Skipped: Total number of messages ignored by the
appliance when the log source entry in LogLogic~ LMI

TIBCO Loglogic® Log Management Intelligence User Guide
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Element

's]

Description

exists but is disabled.

e Unapproved: Messages received from a log source that is
not in the Manage Devices table. These messages are
discarded. The most recent 100 messages are accessible
from the Data Sources screen. If auto-identify is on, all
messages are auto-identified and no messages are
unapproved.

» Dropped: Total number of messages recognized but not
processed due to network congestion.

Updates the system status information for your appliance.

Viewing Log Source Status

The Log Source Status tab lets you view statistics for each source device.

Note: If during auto-discover a device has the same name as an existing device,
a random number is appended to the device name.

Procedure

1. Choose Dashboards > Log Source Status from the navigation Menu.

2. View the following log status information for each source device:

Name

IP Address

Type

Last Received Time
Collector Domain
Total Message Count

Byte Rate/Sec
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e Description

For detailed descriptions of each item, see the Log Source Status Tab Elements
table.

3. Click the Refresh button to update the view of your devices.

4. Optionally, click =1 to print all the items in the list.

Log Source Status Descriptions
The following table lists and describes the elements in the Log Source Status tab.

Log Source Status Tab Elements

Element Description
E Saves the report in a CSV format. You can view the file in Excel as a
spreadsheet.

Note: The CSV file saves and displays a maximum of 10,000 lines. A
generated report can contain more than this number.

Displays the report in HTML format in a new window. You can save the HTML
file to your local machine.

Note: The HTML file saves and displays a maximum of 5,000 lines. A
generated report can contain more than this number.

Saves the report as a PDF file. You can save the PDF file to your local
machine. Viewing the generated report as a PDF only works for Adobe
Acrobat Reader version 6.0 and higher.

Note: The PDF file saves and displays a maximum of 5,000 lines even
though the generated report might contain more than this number.

Click to print all the items in the list.
Displays the first page or last page of detail for the device list.

TIBCO Loglogic® Log Management Intelligence User Guide
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Element

Description

 Displays the previous page of detail for the device list.

 Displays the next page of detail for the device list.

e To display details for a specific page, type a page number and click GO.
Note: For certain pages that display this option, you can only view a

set number of rows. To set the number of rows to view, use the
Personal Preferences tab.

Log Source Status section (all of the following columns are sortable)

Name

IP Address

Type

Last Received
Time

Collector
Domain

Total Message
Count

Name of your source device. The format for this field is <collector domain
id>_<ip address>_ <device type>, for example, 1_10.10.10.10._windows.

IP address for your source device.
Type of source device.
e For File-based devices, the time displayed shows the last event
processed time
» For Syslog-based devices, the time displayed shows when the last

event was received

This is the name used to identify each message sent from a specific device.
This can either be the Collector Domain name added in the TIBCO LogLogic®
Universal Collector or the name specified in the LoglLogic LMI when the
device was added.

The following types of messages counts:

e Total—Total number of messages processed for the specified device.

e 1 Min—Total number of incoming messages during the previous one-
minute period.

e 5 Min—Total number of incoming messages during the previous five-
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Element

1 Min (Byte
Rate/Sec)

Description

']

Advanced
Options

Description

minute period.
e 15 Min—Total number of incoming messages during the previous 15

minute period.

Byte rate per second for each device during the previous one-minute period.

The description you defined for the Source Device in the Management >
Devices > Devices tab and the Management > Check Point Configuration >
Interfaces tab.

If you selected the Auto-identify Log Sources option in the Administration
> System Settings > General tab, the system displays that the source device
is an auto-identified log source.

Updates the view of your devices. If auto-identify is enabled and the
appliance detects new devices, refresh displays them in this view.
By default, all these options are displayed:

¢ Name

e |P Address - supports /prefix length <0-32> for IPv4 and / prefix length
<0-128> for IPv6. The field supports the Classless Inter-Domain Routing
(CIDR) notation for IPv4 and IPv6. Available options include:

° equals - only returns the pattern entered
° not equals - returns everything but the entered pattern

° in - several patterns can be entered separated by a comma; all
matches are returned

° notin
o like - like behaves the same way as "in"

° not like

Note: The use of asterisks (*) is no longer supported.
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Element Description

e Type

e Last Received Time

e Collector Domain

e Total

e 1Min

e 5Min

e 15 Min

e 1 Min (Byte Rate/Sec)
e Description

Use the list to view options in ascending or descending order.

Deletes all text in the Advanced Options text boxes.

m Executes with the defined Advanced Options parameters.

Viewing Unapproved Messages

Use the Unapproved Messages tab to view information on up to 100 of the most recent
real-time messages received from a recognized but unapproved source.
Unapproved messages are discarded.

Note: Messages from all file-based data are not listed here because they are not
treated as real-time messages.

Procedure
1. Choose Dashboards > Log Source Status from the navigation menu.

2. Click the Unapproved Messages tab.
This tab contains the following elements:
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Element Description
No Number assigned to the message
Time Time the message was received

IP Address  IP address of the appliance through which the message was received

Message Text of the message

3. Click the Refresh button D to update the information.

4. (Optional) Click =] to print all the messages in the list.

Viewing Recent Messages

Use the Recent Messages tab to view information on up to 100 of the most recently-
received real-time messages.

Note: Messages from all file-based data are not listed here because they are not
treated as real-time messages.

Procedure
1. Choose Dashboards > Log Source Status from the navigation menu.

2. Click the Recent Messages tab.
This tab contains the following elements:

Element Description
No Number assigned to the message
Time Time the message was received
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Element Description
IP Address  IP address of the appliance through which the message was received

Message Text of the message

3. Click the Refresh button D to update the information.

4. (Optional) Click =] to print all the messages in the list.
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Search for Collected Log Messages

As the appliance collects log data from your log sources, you can search on those collected
log messages.

In addition to running various simple and complex searches, you can define search filters
and run reports.

By defining search filters in advance, you can include specific search criteria in an Index
Search, a Regular Expression Search, and All Saved Searches without having to reenter the
filtering criteria each time.

Note: To reload and open older, compressed log data for viewing on an
appliance, download and view the files on your workstation.

Search Overview

LoglLogic provides search and reporting tools for finding specific information in the
collected log message content.

The tool you use varies depending on the task you want to perform.

Index Search

Search on indexed log source messages using a Boolean expression and see the results
quickly. Use Index Search when a simple, fast search can provide the information you
need to analyze failures or other anomalies.

Regular Expression (RegEx) Search

Search using a single regular expression or pre-defined search filter, either immediately
or at a scheduled time.

Index Report

Generate a report based on indexed data using pre-defined Boolean search filters.
Essentially, an Index Report is a compilation of multiple Index Searches run at once. You
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can specify one or more pre-defined filters to use, and add additional criteria to those

filters.

Search and Reporting Feature Comparison

Feature Index Report

Multiple filters  Yes
in search

Boolean Yes
Expressions

Regular No
Expressions

Graphical Yes
Results
Available

Graphically No
view trends

over time or

log sources

Schedulable Yes
Search

Save Yes
customized

search criteria

for future use

View No
finished/past
search results

Index Search

No

Yes

No

Yes

Yes

Yes

Yes

No

RegEx Search

No

No

Yes

No

No

Yes

Yes

Yes

Note: For a simple search to match a specific string, use Index Search. To search
for strings that match more complex patterns, use RegEx Search.
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Index Search

Use index search to perform targeted searches on log messages using keywords, Boolean
expressions, and wildcards on the appliance or log sources.

Index Search lets you pinpoint problem areas on all log sources captured on the appliance
and then view the search results quickly.

Due to the dynamic nature of LoglLogic reporting, when paging between the last page of
search results and other pages, additional messages matching the search criteria might
have been received since the initiation of the original search. As such, you might see
additional messages included on subsequent visits to the last search results page.

Index Search works on indexed logs making it faster than a search using regular
expressions (RegEx search). The default criteria for the index search page is to search
against all logs collected by the appliance (except the appliance’s own logs) and for the
last hour.

Search Expression Rules

Various rules apply when you enter a search expression.

» Use Boolean operators, such as AND, OR, or NOT for your search expression (but do
not begin the expression with leading NOT)

» Use wildcard characters, such as an asterisk (*) or question mark (?) to match strings
(but do not begin the expression with the wildcard)

e Do not use < or > as these are not valid characters

e Use parentheses to force an order of operations when the index search evaluates the
search expression

e Enter up to 4096 characters for your search expression

e When using Index Search and Tag-Based search, the system does not support the use
of search patterns shorter than 3 characters

Index Searches are case insensitive, so you do not have to use all uppercase letters when
using Boolean operators, although it helps readability.

Some simple Index Search examples are listed in the following table.
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Index Search Examples

Index Search Rule

Example

tep Use search expressions containing at least three
characters.

authenticate AND Use Boolean operators, such as AND, OR, or NOT.

failed

Tcp NOT Udp

adminx* Use wildcard characters such as an asterisk (*) or

10. % a question mark (?) as shortcuts to match strings.

Note: Wildcard character Index Search on IPv6
addresses work only if the asterisk or question
mark is at the end of the address. The
following examples demonstrate that the
wildcards do not work if they are used
anywhere else in the address:

2001:db8::ff00:42:837?
2001:db8::ff00:*:8329
2001:db8::ff07:42:8329
2001:db8::ff0*:42:8329
2001:db8::7777:42:8329

(tcp and udp) and Use a delimiter such as parentheses to specify

service what gets evaluated first. In this example, tcp
and udp are evaluated before the service
keyword.

Running an Index Search

Index Search is available on all appliances.

The default criteria for the index search page is to search against all logs collected by the
appliance (except the appliance’s own logs) and for the last hour. You can search using
these defaults or change them.
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Procedure
1. Access the Index Search page from Search > Index Search.

2. Enter your search expression in the search text box and click the Run button.

Note: Do not use < or > in your search expression, as these are not valid
characters.

If you want, you can adjust the search scope and rerun the search by selecting
specific log sources and/or a different timeframe.

Selection of Specific Log Sources

Narrow the scope of the search to a group of log sources.

To perform a more targeted search, you can narrow the search scope to a group of log
sources, such as all firewall interfaces, all routers, all General Syslog, Microsoft sources,
other UNIX, or LoglLogic appliances.

The default rule is set as A1l Sources except Loglogic. This includes all logs except
LogLogic appliance logs. You can add any individual and/or group of non-LoglLogic sources
to this rule. However, if you specify any other log source, other than LogLogic source, the
default rule is removed from the filter list (from the left pane) and the new log source is
added. This enhancement applies to only system-defined groups and not the user-defined
groups. For example, if you select a user-defined group that only includes LogLogic source,
then the default rule is removed.

On the Management Station, you can select from one managed appliance or all appliances,
or particular groups of appliances (for example, all LogLogic LX Appliances or all LoglLogic
ST Appliances) on which to run the search. The Choose Device page automatically
populates the log sources included on all defined groups.

Note: When appliance selection is All, All LX/MX, or All ST, only system-defined
groups (for example, All Cisco PIX) and user-defined global groups that reside on
the management station are displayed.
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Running a Targeted Index Search

Procedure

1. Click the All Sources except LogLogic button to open the Select Source(s) window.

2. Select log sources from the Add Log Sources pane. You can select sources by
appliance, and filter by Name, Collector Domain, IP Address, Group or Type.

If you picked “Name”, enter a Source Name, a specific Device Name or a Name
Mask. Wild cards are accepted in this field.

If you picked "Collector Domain", enter the name of the Collector Domain. This
is the name used to identify each message sent from a specific device.

If you picked “IP Address”, enter a Source IP Address, a specific IP Address or
an IP Address Mask. Wild cards are accepted in this field.

If you picked “Group”, enter a Group Name, or click the down arrow to the
right of the text field and select “All” or one of the other Group names
displayed in the drop-down box.

If you picked “Type”, enter a Source Type (a specific device type), or click the
down arrow to the right of the text field and select “All” or one of the other
Device Types displayed in the drop-down box

o Note: When adding a large number of devices, create a dynamic rule that

contains all listed devices. To create a rule, first filter by Name or Type to
retrieve the list of devices. Then click << Add filters as a rule. This creates
a dynamic rule containing all listed devices, on the right pane.

3. Enter a name for the dynamic rule in the pop-up window and click OK.

4. Click to select the sources you want in your report and then click << Add selected
log sources to add the selected devices and filters to the left-hand pane.

5. Click Set.

The new Index Report search selection appears in the Sources row. The Index Search
Sources field displays the newly added log sources.

Note: If the number of devices selected is more than 60,000, the devices
might not be loaded and the message Loading might be displayed.
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Selecting Time Frame for an Index Search

Procedure
1. Click the calendar icon (to the right of Last Hour) to launch the Date and Time
Range Picker.

2. Select a preset time interval by clicking the down arrow to the right of Last Hour, or
pick a timeframe from the pop-up calendar. Click Set.

3. Click Run.

4. At the Search pop-up, select whether you want to retrieve all messages. Click Yes.

Result
After a few moments, the Index Search results are displayed.

The Search Results Tab

Index Search results are displayed on the Search Results tab.

The keywords you entered are highlighted in different colors. For example, when entering
login AND user as your Boolean expression, the first keyword “login” are displayed in
yellow and the second keyword “user” in turquoise.

Home > Search > Index Search Enterprise Virtual Appliance LSP32 - Jan 12, 2017 19:58:47 UTC
{21 All Sources except LogLogic Today (] Options View Settings  ~ 0
Q login and user m
Search Results Search History Search Filters Clipboard
= @ Clip selected message(s) = 01/12/17 17:00:00 - 01/12/17 19:58:00 B - <L < Ppage oft > @
Time Device IP Device Source Facility Severity
01/12/17 17:15:30 192.168.1.252 ::ffff:192.168.1.252_General 1 6
Message:
<14>Jan 12 17:15:30 localhost login: module:login; action:command; info:user logout; status:success
01/12/17 19:40:56 192.168.1.252 «ffff:192.168.1.252_logu 1 6
Message:
<14>Jan 12 19:40:56 localhost llweb application="logu" [22559]:eventTime="2017-01-12T19:40:56.3862" systemId=" " nodeId="web: D Id=" " Id=
" type="INFO" tenant=" " domain=" " sourceIP=" " targetIP=" " actor=" " logger="Controllers.Login" " UNKNOWN" " " id=" " msg="Logging out user"

Different colors are used to highlight search keywords on the GUI after which it repeats the
same color scheme.
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The 11shred utility destroys log event data. After running the utility, the log data is not

deleted from the appliance. If the utility is run with dryRun=true, the log data is only
processed. However, with dryRun=false, the log data is prefixed with the string

LLSHREDDER and all characters are replaced with X. Running an index search after running

the utility displays the shredded data in the search results.

8 Last Hou )
Q 153020779
1530307704
SearchResults | SearchHistory  SearchFiters  Clipboard
29 Clip selected mes: : 06/20/18 13:4400 -06/29/18 14:44:00 [ B e 1 oeamm
Time Device P Device Source Facity Severty
06129118 13:44:00 101148143 101148143 2 5
Message
ity o0 o0 000 o0 000 o0 000 09
OO0 0000000000000 0000000000000 0000000000 0000000000 00000 0000000000 0000000000000 00000
SE000000GT000000LT000000G000 o0 0000000000000 C0000G000000000000GT00000GID0 Oa000000 0000000 I000000000000G 000000
000000000000000000000000000000000000000000000000000000000000000000000500000 DE00H0000000000000000B00BE000E0000D00000 oB0000000500000000000000000000000:

06/29/18 13:44.00 101148175 101148175 2 5

Message:
LLSHREDDEROX 0000000000000000000000000D I I T T ——
Axuxxxxx)xvxAxxxmxxxxxxxxx%xxxxxxxxxxxxuxxxxxxxxxxxxx(uxxxwmxAxxxmxxxxxxxxx%xxxxxxxxmxuxxxxxxxxxxxxx(MxxxxxmxAxx(uxxxyxxxxxxxxxxxxxx><xxxx%xxxxxxxxxxxxx(MxxxxxmxAxmuxxxwxxxxxxxxxxxxxxxxxx%xxxxxxxxxxxxx%MxxxxxxxxAxmuxxxwxxmxxxxxxxxxxxxxnxxxxxxxx

30000000¢ GE000000E00000E00000000 00000000000000000000 060000000000000000000000000000000000C 00000000
R R T T Y
06729718 134400 101148163 101148143 2 s

SR D ERO000000000 IO KIHIKIKIIKIKHIIKIKKINK
0000000000000 00BN ¥ 000000000 O00000I000000C00NKIOVIXOOCIOIIOOTKI) 00000
00000000 a000000a 00000000000 a0a0a000000d O O0O0000000a0a 000000000 O000000a 000000000000 O000C00000a0DO0g0d0EO000000aO000a000000000E0D00000C00000000000ID0T00000000000000000000000I00000000000K

0612918 134401 101148175 101148175 2 s
Message:
B bero0a000000000000000000000000005000000000000000BE000E000B0000E000E000CEOTE000B0000OEO0OE0TEI0IC0A0TOE00L0OBE0TE0OB0EBBIBCLTONBLLLVNC
00O CE0000D0000a00 0000000000 00H0000E00aE0oE00 0 00D00000 OO0 aE00E00000000S0aEOO0a0000 0D 0OE0a00OE OO0 EOOL0O000E00 gL 00D00a0000a0a00E00a000E0000ALO0C00000000000000000K
00000000000 00aEo0DD00a00OOH0000OE 00 BE0gE0gOa0OD00D00 DO gEDO0a0gEOO 00000000 aEOOE 0000000 aOOEODD00OEOgEDO 000000000000 EOaER00D000000E00a0000000E000BE000E000D0OIE00OE000B0000E000000HE00K
R R R R B R S R R R SR SRR SR

0612918 134401 To114s18 To114s1a 2 s

Message:
LLSHRED X0000T0000N00) 0000 0000000000000 0000 0000000000000 0000 0000000000000
0000000000000
OO0 0000000000000V
Oa0000000000000000000000000000000000000000¢ 0000000000000 00000000000000000000000 XOUKI00000TI00TIO0TOTIOOTI000
06/29/18 13:44.01 101148143 101148143 2 5

B Em0000000000000000000500000000000000E0EU000EOBUVEIEUTUBIGNILTTVTNVNIND 00000000000000000000000000000000U00I00000BI00IA0TI0BVTIOTITOCIOTIVOTIOTNOTITN
000000000 0a00E000000R00T0a0T00 0000000000000 0TO0P00O0D0A00D0aO0000E0000000a0000A0T00000000000000E0I0000E000000000H000H0000000000A00000000000000
0000000000000 0000000000000 0000000000000

For more information about the utility, contact your administrator.

On the results tab, the Collector Domain is displayed in one of the following ways:

e For Collector Domains specified in a UC the following format; <collectorDomainiD>_
<devicelP>_<deviceType> is displayed in the Name field. For example, a Windows
machine with an IP address of 10.10.10.10 and collector domain windows is displayed

as 1 .10.10.10.10._windows.

» For Collector Domains specified in LogLogic LMI (Management > Devices > Add

New) the Collector Domain name is displayed in the Collector Domain field.

iewing search results

You can view search results by using different view options.
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From the top right of the Index Search page, select a suitable option from the View list:

Index Report Search-View options

Element Description
Reset to Default Reverts to default settings
Show Timeline Select this check box to show timeline graph.

Hide Meta Header  Select this check box to hide the metadata header information.

View By Select the option to view by Time or Device type.

Chart Type Select the type. The options are Bar chart or Line chart.

Configuring Search Results Settings

Procedure

1.

From the top right of the Index Search page, click the Options button. The Columns
and Grouping window is displayed.

Optionally, enter a filter keyword in the Keyword field to narrow the displayed
columns in your report.

Select the appropriate Column Name by selecting the check box to include or
exclude that column from your report. You can change the column name by clicking
the name. The column name field becomes an editable field allowing you to make
the changes.

Note: If you enter the same column name for two columns, the Index
Search Results page displays the results for those two columns merged
into one column.

Click or to move the selected column.

Choose the Display options.
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Display Options

Element Description

Raw Select this option to display Index Search Results -
both data in the columns, as well as the original raw
message - in ascending order by time.

Grouped Select this option to display Index Search Results -
only the data in the columns without the original raw
message - grouped by the selected column.

Group By Choose the appropriate column to display group
search results from the list. The default options are:

e Time

e Device IP

e Device Source
* Facility

e Severity

You can add more columns by creating custom tags
using Log Labels.

Time Interval This option is enabled when you select to Group By
Time. The results are grouped based on the specified
time interval. Select the Time Interval from the
following options:

e Every 5 Minutes
e Every 30 Minutes
e Every Hour

e Every 3 Hours

e Every 6 Hours

e Every 12 Hours
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Element

Sum By

Aggregation
Size

Description

e Every Day

» Every Week

This optional setting allows you to add the numerical
value of the selected column so that Search Results
Summary displays the sum value of the grouped
column instead of the count of message instances.

Select the option from the list. The results are sorted
based on the selected option. The options are:

e Topl
e Top5
e Top 50
e All

If the search result fetches multiple rows that
have identical log counts, the Aggregation Size
element considers those rows as a single result
group. Due to this, the Search Results tab might
display more rows than the 'Top’ option that
was selected.

For example, if there are seven result rows with
log count as 4, 7, 4, 0, 91, 235, and 1029, then
the 'Top 5’ option returns six rows (4, 7, 4, 91,
235, and 1029), because two result rows that
have identical log count (4) are considered as a
single result group.

6. Click Apply to apply the new settings. The Index Search Results page displays the
refined search results.

Search Results Options

The Search Results tab provides a toolbar with several options for managing Search

results.

TIBCO Loglogic® Log Management Intelligence User Guide



40 | Search for Collected Log Messages

Element

A -

B

Clip
Selected
message(s)

A -

<< <Pagel
of 22 > >>

Description

Collapses and condenses the results display view.

Allows you to view the selected message in relation to all others in your Index
Search results. For details, see Viewing Index Search Results In Context

Create a new log message pattern with the selected message. Highlight a
message in the Search Results and click the Create Message Pattern button.
The Message Pattern Editor is displayed, which can be used to select a
particular message from a particular device and then create a pattern based on
the parameters of that message for use in further searches.

From the list use the default clipboard, a saved clipboard, or create a new
clipboard to save results.

Saves the search definition. You can choose to Save or Save as from the list to
save your results. You can update your saved results using the Save option, see
Search Results: Download Options.

Used for page navigation and for indicating the total number of pages of search
results.

This is particularly useful for large volumes of log messages as it lets you go
through matched messages one page at a time. To page through the results,
click the next arrow; to return to the previous page click the previous page
arrow. You can also return to the first page or go to the last page by clicking on
the first and last page arrows accordingly. The total number of results is
automatically updated when you select the Show Timeline graphical view.

If the time filter of the search query is a very large period of time, for example,
10 years, the number of results is huge, and displaying the results takes a long
time. Furthermore, displaying the last page of results might take such a long
time that the following error is displayed:

HTTP Error - 0. Please contact your admin!!!!

To avoid this, you can either reduce the time range of the classic Index Search,
or add additional search terms to reduce the size of the result set, or do both.
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Viewing Index Search Results In Context

When analyzing log events, you can select a particular message and see the log messages
that immediately preceded or followed the message from your search results.

o Note: The In Context tab appears only after the first time you click the @ icon
in the search results toolbar.

Procedure

1. On the Search Results tab, select the message that you want to view and then select
the [ icon.

The In Context tab appears (next to the Clipboard tab) and the message you
selected is immediately displayed in the Search Results tab.

2. By scrolling down on the page, the affected log message is highlighted in blue to
show its relationship to the log messages that preceded this condition as well as
those that occurred after this message.

3. Click the appropriate button to save the results. You can choose to save results in
CSV, PDF, or HTML format.

Search Results: Download Options
You can download Index Search results in CSV, PDF, or HTML formats.

These buttons are located on the left side of the Save button. After the download is
complete, the report in your chosen format is displayed.

Note: Viewing the query on the web page is faster than downloading and saving
to a file. If the search results are large, downloading and saving as CSV format
might take longer than as PDF or HTML.
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Save Search Results

Output

CSv

PDF

HTML

Description

Use Microsoft Excel or another spreadsheet program to display Index Search
results in a spreadsheet. By default, search results are written to
SearchExpressionHits.csv and saved on the desktop.

Use Adobe Acrobat Reader to display the Index Search results. By default, search
results are written to report.pdf and saved on the desktop. The first page
includes a table of contents with links to the query used for the Index Search and
the results table.

Opens a new tab in your Web browser and immediately displays HTML Index
Search results as a Loglogic report. The HTML results include a table of contents
with links to the query used for the Index Search and the results table. By
default, the downloaded results are saved as LoglLogicReport.zip in a temp
folder on the local drive. You can use your own company logo on the report, see
the General tab under System Settings.

Saving Search Results Report

You can save the results of the index or Regex search as a report.

Procedure

1. Click Save As option from the B - icon list to save the report. You can update the

saved report by using the Save option. The Save As Report window appears.

2. Enter the name and description of the report in the Name and Description fields
respectively. The Name field is a mandatory field.

Note: Do not use any special characters in the Description field when
saving the Index report.

3. Select the Suite option from the list.

4. Select the Share? check box if you want to share the report.

5. Select the desired print option. For Grouped Search, the options are:
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e Print Summary Report

e Print Detailed Report

e Order by group-by value: The printed report is ordered by the column
selected as the group-by option.

» Collapse Messages: The printed report is briefer, and does not include raw
log data.

6. Click Save.

Trends

After running Index Searches, you can use the View menu to view search results graphically
using the timeline option.

The trend output you see is based on your chosen time range and chosen devices
referenced by the Index Search, and always includes only the messages and devices for
that distribution.

The trend feature can be a powerful tool during your analysis of certain events and lets you
see trends for certain activities by Time and Device.

Each option lets you view timeline data in either bar chart or line chart format. These
charts show:

e the time or device on the x-axis
* the total number of messages on the y-axis

The procedure for viewing trends over time and by device is the same.

Viewing trends over time

Procedure
1. Click the View list and then select the Show Timeline check box.

A timeline chart is displayed below the search text box. You can immediately see the
distribution of messages over time and begin to get a sense of trends in the timeline
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chart.

By hovering the mouse over an affected bar, you can get the total number of
messages matching your search expression at that particular point in time.

View Menu - Viewing Trends by the Timeline Bar Chart

{2 All Sources except LogLogic 01/13/17 16:00- 01/13/17 17:00 ® Options View Settings Q

Q Enter your search expression... m

20

15
IES SN SSSSNENEEEEEEN ARl I NNRRNNNRNNRNRNRNNNORNURNRRRE] EEENE

16:00 16:15 16184 16:30 16:45

For example, in the following figure, you can see 13 log message instances at 04:24 in
the evening. The scale on the x-axis shows the total number of messages while the y-
axis shows the time distribution of those instances.

2 All Sources except LogLogic 01/13/17 16:00- 01/13/17 17:00 ® Options View Settings o

Q Enter your search expression... m

20

15

S0 ISR | W (U [SNSNNU ||

16:00 16:15 1684 16:30 16:45

2. To zoom in on a particular area of interest, press and hold the left mouse button and
drag over the area of interest.

This refreshes the timeline view to show the zoom area in more detail.

B Al sources except Loglogic 0112417 1628 - 012417 1643 =) options | | viewsettngs < @

Q Enteryour searchexresson.. (&

3. To return to the original view, click Zoom Out.

4. To view the same search in the line format, select Chart Type > Line Chart from the
View menu.

This displays the results in a line chart format. From this view, you can see spikes in
the number of messages that match a keyword.

Viewing Trends by the Timeline Line Chart
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@ Al Sources except LogLogic 01/13/17 16:00- 01/13/17 17:00 (] Options View Settings  ~ (-]

Q Enter your search expression... Reset to Default .
¥| Show Timeline
2wt \ Hide Meta Header
\, y \ \, \

View By [

Bar Chart Chart Type »

@ Line Chart
Search Results Search History Search Filters Clipboard N

Result
Similarly, to view the same Index Search by log source, select View By > Device from the
View menu.

The Search History Tab

Each time you run an Index Search, your search criteria are automatically saved on the
Search History tab.

The Search History tab includes:
e Only those Index Searches with valid search criteria.
o User-specific Index Searches, which can be shared when saved as a search filter.
* Most recent searches on the top of the list

You can configure the search entries displayed (rows/page) on the Search History tab
through the Your LogApp Account tab (see Viewing Your LogApp Account).

Saving an Index Search as a Filter

While search histories are user-specific, you can save an Index Search as a search filter.

You can use these saved search filters yourself or you can share these saved search filters
with other users of the appliance.

Procedure

1. Click Search History to see the history of Index Searches.

2. Select the saved Index Search message and then click the button. The Save As
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Filter dialog box is displayed.

3. Enter a name, description, and expression for the filter.

Note: Do not use < or > in your search expression as these are not valid
characters.

4. The filter name and description help you and other users to quickly understand the
type of information that generates when running this Index Search.

5. If you want to share this filter with other users, click the Shared with other users
check box.

6. Click Add.
The Index Search is saved as a filter. You can use the filter in two places:
» Search > Index Search > Search Filters tab

e Search > All Search Filters tab

Running a Previously Saved Search Expression

Since your Index Searches are automatically saved for you on the Search History tab, you
can browse through these previously saved sets of search criteria and run them again.

From the Search History tab, select the saved Index Search that you want to run and then

click @

The Search Filters Tab

The Search Filters tab lists all saved search filters created on the Search History tab.

The Search Filters tab includes the button in the toolbar making it convenient to run a
previously saved search filter.

The Search Filters tab organizes search filters by their name and displays the search
expression used for the search filter in the Expression column.

Note: All of your saved search filters show up on the Search Filters tab and on
the Index Report tab.
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Viewing or Using a Previously Saved Index Search Filter

Procedure
1. Select the filter from the table and then click .

This copies the search expression and enters it in the search expression text box.

2. Press Enter to run the search filter.

This loads all the results of the search on the Search Results tab.

The Clipboard Tab

The Index Search Clipboard is an important tool for investigating and troubleshooting log
events.

For example, during your analysis of a certain event, you might find an item of interest in
one or more log messages. Once identified, you can create a Clipboard and copy and paste
the affected log message(s) onto the Clipboard.

You can create several clipboards until you have found everything you need to help you
with your analysis as you drill down on the details. After saving clipped messages to the
clipboard, you can view them on the Clipboard tab and on the Search Results tab.

The Clipboard tab provides a toolbar with several options for using clipped messages.
These options include:

|:| Adds a new clipboard
Deletes one or more clipped messages
[ Allows you to view or edit the clipped message

Adding a New Clipboard

You can add a clipboard from the Search Results page or the Clipboard tab.
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o Note: You can add up to 1,000 messages to a Clipboard. Each user is able to
create up to 100 Clipboards.

The procedures are essentially the same for adding a new Clipboard. The next procedure
shows how to add a Clipboard from the Search Results tab.

Procedure
1. On the Search Results tab, select messages to add to the clipboard from the search
results.

2. To select more than one message to add to the Clipboard, hold the Shift key as you
click on each message.

3. From the Clip selected message(s) list, select New Clipboard.

The Add Clipboard dialog box opens.
4. Enter a name for the clipboard in the Name field.

5. If you enter an existing clipboard name, the messages are added to that existing
clipboard.

6. Add a description for the clipped message in the Annotate field and click Add.

Result

The clipboard is added to the Clipboard tab and it is also available from the Search
Results tab. You can go back and view or edit the clipped message(s) later on to allow for
more analysis.

Viewing or Editing Clipped Messages

After saving clipped messages and annotating them, you can view or edit clipboards on the
Clipboard tab.

Procedure
1. On the Clipboard tab, select the clipboard that you want to view or edit and click the
edit icon (4.

The Edit Clipboard dialog box appears. You can change the following:
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e The Name of the clipped message
* The Annotation for the clipped message
* Remove one or more clipped log messages

2. Modify the Name, Annotation, or remove log messages and click Update.

Deleting Clipped Messages

You can manage the clipboard table by deleting unwanted clipped messages.

Procedure
1. On the Clipboard tab, select the Clipboard you want to delete and click the Delete
button.

2. To delete more than one clipped message, hold down the shift key and select the
messages you want to delete and then click the Delete button.

The selected messages are deleted from the Clipboard tab.

Using the Tag Picker Interface

Using the Tag Picker Interface you can perform a tag-based search and access saved search
terms, to quickly run an updated Index Report.

Procedure

1. Access the Index Search page by going to Search Index Search. Click the arrow ]
next to the text box labeled Enter your search expression... .

The Tag Picker Interface opens.

2. Select an Event Type and left-click. The selected Event Type appears in the Enter
your search expression... text box.

3. Add a Boolean operator (AND) to the search expression, and left-click a saved Field
Tag. The selected Field Tag appears after the Boolean operator in the Search
Expression text box.

4. Add a wild card (*) to recall all saved Field Tags with that name. Click Run.
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Note: You can specify special characters such as spaces, forward-slashes
(/), so on, inside the quotes for Field Tags. For example: Identity: “John
Smith”; Domain: “domain name / JOHN SMITH”.

5. Select View and display the Bar Chart for the search expression.

6. Compare with the previously saved Index Search results for this expression.

Regular Expression Search

Use the RegEx Search Filter tab to find specific types of data based on search expressions
and time intervals you define.

RegEx Search provides more powerful search filter options than Index Search, though
RegEx Search can take longer to process and is less interactive.

o Note: Working knowledge of regular expressions is a prerequisite.

Specifying Parameters for a New Search

Procedure
1. Select Search > Regular Expression Search from the navigation menu.

2. (Management Station only) Select the appliance (or All Appliances) on which to run
the search.

3. Select the Device Type.

4. Select the Source Device, or all devices, connected to the appliance.

To view Global groups created on this Management Station, you must select
Appliance > All Appliances.

Devices with Collector Domain are displayed in one of two ways:

» For Collector Domains specified in a UC the following format: <collector
domainid>_<device IP>_<devicetype> is displayed in the Name field. For

TIBCO Loglogic® Log Management Intelligence User Guide



51 | Search for Collected Log Messages

example, a Windows machine with an IP address of 16.10.10.10 and collector
domain is displayed as 1_10.10.10.10_windows.

For Collector Domains specified in LoglLogic LMI (Management > Devices > Add
New) the Collector Domain name is displayed in the Collector Domain field.

5. Specify the Time Interval which to search for data passing through your appliance.

6. Define your Search Filter. Select one of the following options and specify the
respective parameters.

Retrieve All—Use to retrieve all log files collected during a specified time interval
regardless of the defined search expression parameters.

Pre-Defined—Select a pre-defined search expression (defined in/by search
filters). All search filters you create appear in the list as a pre-defined search
expression. If the selected filter includes multiple parameter fields, a text field
for each parameter appears. The maximum length for each field is 25
characters.

Use Words—Use a specific word(s) as a search parameter.
Use Exact Phrase—Use an exact phrase as a search parameter.
Regular Expression—Use a regular expression as a search parameter.

For more information about modifying or creating search expressions, see
Search Filters.

7. Specify the Time Interval to search for data passing through your appliance.

8. Set a time for the search; do one of the following:

10.

11.

Select the Schedule Search to Run Immediately check box to start your search
of archived data immediately.

Define a time to start the search of archived data. If the selected time is in the
past, the search runs immediately. This search is useful if you know exactly
which data source you want to search and do not need to search a time
interval.

Enter a Search Name for the search.

Select the Notify me when this search completes check box to receive a

notification that the search has completed.

To generate the report, click the Run button ﬂ
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o Note: Concurrent Regular Expression Searches apply only to the appliance
models later than the 1000 series. You can select the number of concurrent
searches to perform. The default is one, but you can choose to perform up
to four searches concurrently. To specify more than four, you must edit the
capability.xml file.

Generating a previously saved report

Procedure
1. Select Search > Regular Expression Search from the navigation menu.

2.

In the RegEx Search Filter tab, select the report from the Saved Custom Report list.

e To generate the report, click the Run button.

e To export the report data to a file in CSV format, click the Save as CSV button.

Saving a Custom Report

After specifying the parameters for your report, you must save the report.

Procedure

1.
2.
3.

Click to expand the Save Custom Report section.
Type a name for your report and provide a brief description.

If you do not plan to share the report with other users logging in to the appliance,
clear the Share with Other Users check box. By default, this check box is selected.

If packages are present on the appliance, the Add Report to Package list is visible
letting you select a package in which to include this report.

Click the Save Report button to save your changes.
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Using Distributed Regular Expression Search

Use Distributed RegEx Search to select all configured appliances to run a RegEx search and
retrieve the merged results from the Remote Appliances and the Management Station.

Before you begin

e Add remote appliances — See the Creating a Management Station Cluster section in
TIBCO LoglLogic® Log Management Intelligence Administration.

* Your administrator must provide access to each of the remote appliances for you to
have access to the data on the remote appliances. Access to appliances is provided
via the Appliances tab of the User Edit page. For more information about user
privileges, see the Managing Users section in TIBCO LogLogic® Log Management
Intelligence Administration.

o Note: Loglogic LMI v5.4.2 or later must be installed on the Management
Station and all Remote Appliances.

Procedure
1. Select Search > Regular Expression Search from the navigation menu.

2. For a Distributed RegEx Search you must select All Appliances.

Note: The Distributed RegEx Search does not support Custom Reports on
the Management Station.

3. Select the Device Type from the list of device types configured on the Management
Station.

If you select All, the Source Device field is disabled.

4. Select the Source Device.

If All is selected, logs from both the Management Station and Remote Appliances are
returned.

Search results are based on the device name and are mostly returned from the
Management Station. However, if the Management Station and Remote Appliances
happen to have the same device name then the logs from both the Management
Station and the Remote Appliance are returned.
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5. Define your Search Filter. Select one of the following options and specify the
respective parameters.

Option

Retrieve All

Pre-Defined

Use Words

Use Exact
Phrase

Regular
Expression

Description

Use to retrieve all log files collected during a specified time interval
regardless of the defined search expression parameters.

Select a pre-defined search expression (defined in/by search filters). All
search filters you create appear in the list as a pre-defined search
expression. If the selected filter includes multiple parameter fields, a
text field for each parameter appears. The maximum length for each
field is 25 characters.

Use a specific word(s) as a search parameter.

Use an exact phrase as a search parameter.

Use a regular expression as a search parameter.

For more information about modifying or creating search expressions,
see Index Search.

6. Specify the Time Interval to search for data passing through your appliance.

7. Set a time for the search; do one of the following:

» Select the Schedule Search to Run Immediately check box to start your search
of archived data immediately.

» Define a time to start the search of archived data. If the selected time is in the
past, the search runs immediately. This search is useful if you know exactly
which data source you want to search and do not need to search a time

interval.

8. Select the Notify me when this search completes check box to receive a
notification that the search has completed.

9. Enter a Search Name for the search. If a name is not entered in this field the results
are displayed as distributed search <date<timestamp.
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10. To generate the report, click the Run button.

Note: Only the Management Station appliance can see the merged results
from both the Management Station and Remote Appliances. A Remote
Appliance can only see its own local results.

Distributed RegEx Search Results

To view a list of all the searches that are currently running, see the Currently Running
Searches table in the Pending Searches tab.

For each running search, this table lists the search schedule, timespan, name, owner,
Regular Expression, the approximate number of files processed, the total number to
search, and the percentage completed.

For Distributed RegEx Searches two results are displayed on the Management Station

search page. This is because two searches were run on the Management Station; one for
the Management Station and one for the combined results from the Management Station
and the selected Remote Appliances. The Remote Appliances see only their local results.

Finished Distributed RegEx Searches

Home > Search > Regular Expression Search Enterprise Virtual Appliance (Management Station) LSP32 - Jan 12, 2017 20:45:09

—_— - o
RegEx Search  Finished Searches  Pending Searches b=
Report Time Timespan of Report Search Name Owner Regular Expression Matches (Click To View) Download Size
01/12/17 20:42:05 Q1A 2/17:00:00:00 - distributed search Thu Jan 12 20:41:56 2017 admin Retrieve All () 67129/67129 100% 916.43 KB (csv, pdf, html)
01/12/17 20:41:55
01/12/17 20:42:01 20000 008 requested by 127.0.0.1 at Thu Jan 12 20:42:01 2017  admin Retrieve All () 67129/67129 100% 836.04 KB (csv, pdf, html)

01/12/17 20:41:55

The Pending Searches Tab

From the Pending Searches tab, you can view running and pending searches.

The Pending Searches tab regularly refreshes to list all the pending, currently running, and
finished RegEx and Distributed RegEx searches on the appliance.

To force a refresh, click the tab name.
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List of Running Searches

To view a list of all the searches that are currently running, see the Currently Running
Searches table on the Pending Searches tab.

For each running search, this table lists the following information:
e Search schedule
e Start time and timespan

e Search name followed by details of matches: <number of matches>/<number of
processed message>/<estimated number of messages>

e Owner

» Regular Expression

» Approximate number of messages processed
e Total number to search

e Percentage completed

To suspend a running search, select its check box and click the Stop button. A suspended
search stops processing; its partial results until that point appear in the Finished Searches
tab.

Running and Pending RegEx Searches

Home > Search > Regular Expression Search Enterprise Virtual Appliance (Management Station) LSP32 - Jan 12, 2017 20:56:02
-
RegExSearch  Finished Searches  pending Searches = 0
Currently Running Searches
Scheduled Time Start Time Timespan of Report Search Name Owner Regular Expression Approx. Processed Messages %
. . 01/02/17 00:00:00 - o e . .
01/12/17 20:55:40 01/12/17 20:55:40 01/12/17 20:53:38 distributed search Thu Jan 12 20:55:40 2017  admin Retrieve All () 0/00%
Currently Pending Searches
Priority | Scheduled Time Timespan of Report Search Name Owner Regular Exp i i to Process
01/12/17 20:55:40  01/02/17 00:00:00 - 01/12/17 20:53:38  distributed search Thu Jan 12 20:55:40 2017, pending on :ffff:127.0.0.1  admin Retrieve All () 0
Add New
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List of Pending Searches

To view a list of all the searches that are scheduled to run, see the Currently Pending
Searches table in the Pending Searches tab.

For each pending search, this table lists:
« the priority for the search
e its schedule
e timespan
* name
e owner
» Regular Expression
e an estimate of the number of files to search

To remove a pending search from the queue, select its check box and click the Remove
button. There is no confirmation prompt for removing a pending search.

To add a new RegEx search to the queue, click the Add New button. The RegEx Search tab
appears.

RegEx Search Results

You can view pending, running, or finished searches in the Finished Searches or Pending
Searches tabs under Search > Regular Expression Search.

To force a refresh of the tab and view the latest finished searches, click the tab name.

Finished Searches

To view the search results for any searches that have completed, click the Finished
Searches tab.
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Finished RegEx Searches

Home > Search > Regular Expression Search Enterprise Virtual Appliance (Management Station) L5P32 - Jan 13, 2017 00:01:26

Pending Searches @ o

Report Time Timespan of Report Search Name Owner Regular Expression Matches (Click To View) Download Size

RegEx Search  Finished Searches

01/02/17 00:00:00 -
12117 23:56:4 stributed search Thu :56:25 2017 Retrieve A 1126777 100% 1.62 MB (csv, pdf, html)
0112717 23:56:41 01712017 2053-38 distributed search Thu Jan 12 23:56:25 2017 admin Retrie o 126777 11267 100 62 MB (csv, pdf, html
) 01/02/17 00:00:00 - . - . .
01/12/17 23:56:35 01/12/17 205338 requested by 127.0.0.1 at Thu Jan 12 23:56:30 2017  admin Retrieve All () 126777 /212847 60% 1.47 MB (csv, pdf, html)
i 01/02/17 00:00:00 - _ X ! : i -
Q2T 205555 o 05338 distributed search Thu Jan 12 20:55:40 2017 admin  Retrieve All () 21 Click to view results 3.28 MB (csv, pdf, html)

01/02/17 00:00:00 -

01/12/17 20:55:46 01/12/17 205338 requested by 127.0.0.1 at Thu Jan 12 20:-55:46 2017  admin Retrieve All () 212847 /212847 100% 3.03 MB (csv, pdf, html)
01/12/17 00-:00:00 -
01/12/17 20:42:05 DI#‘:Z‘T-’ 20:41:55 distributed search Thu Jan 12 20:41:56 2017 admin Retrieve All ) 67129/67129 100% 91643 KB (csv, pdf, html)
. 01/12/17 00-00:00 - - - . 7 q
01/12/17 20:42:01 requested by 127.0.0.1 at Thu Jan 12 20:42:01 2017  admin Retrieve All 0 67129/67129 100% 836.04 KB (csv, pdf, html)

01/12/17 20:41:55

To view the search results for a particular search, click its number of matches. The
Matches column indicates a ratio of the number of matches found to the total number of
log messages during the selected time period. For example, 126777/212847 in the Matches
column indicates that 212847 messages were logged during the time period in the
Timespan of Report column, and 126777 of those messages matched the search
expression.

To view or download the search results in HTML, PDF, or CSV, click the format extension in
the Download Size column.

Clicking the download size number downloads a .txt file that is compressed to a .txt.gz file,
and hence, the size of the downloaded file is less than the download size displayed. The
file size also varies depending upon the file type. The results are in raw text format with
one log per line in the file and with no metadata added by LogLogic LMI to the file
contents.

The CSV format data is downloaded as a .csv.gz file and decompresses to .csv. When
opened in Excel, it contains five fields of metadata for each raw message.

To delete a past search from the Appliance, select its check box and click the Remove
button.

Search Filters

Search filters are user-created filters that include saved search patterns.
Such filters can be used in:
o Alerts

e |ndex Search
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e RegEx Search
e Index Reports

» Message routing rules

You can also filter your results using the Find field. Enter the keywords in the Find field to
view the filtered results based on your search keywords. You can filter results based on all
columns.

o Note: The Find field does not support the use of Japanese characters.

The All Search Filters page lists all search filters that:
* You created in the Add Search Filter page

* You created and saved from the Index Search History tab (see Saving an Index
Search as a Filter)

» Are available to you, including shareable filters created or owned by other users

o Note: Avoid using a regular expression when a non-regular expression
alternative is available. Regular expressions are almost always less
effective and more error-prone than non-regular expressions. For instance,
instead of using the regular expression r;A[~:]://.\.loglogic\.com/.*$
use "r;url.domain=1loglogic.com”r;. You can also use a wild card symbol
for searches. Using a wild card for regular expression searches indicates
how many occurrences to match. For example, * means matching the
preceding element zero or more times, whereas + means matching the
element one or more times.

Adding a Search Filter

Add a search filter for complex pattern matching by using the Add Search Filter page.

Procedure
1. Select Search > All Search Filters from the navigation menu.

2. Click the Add New button.
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3. Type a name for your new search filter.

4. Sharing - Read Only is the default setting for a new search filter; other users of this
Appliance might see and use the new search filter. Set the radio button to No to
prevent others from seeing and using the new search filter. Set the radio button to
Read Write to allow others to see and modify the new search filter.

5. Type a brief description of the new search filter.

This description helps you remember what the filter is for, and describes it to other
users if you shared the filter.

6. Select a search filter option and enter the search filter criteria. See Search Filter
Options.

For this example, select the following option and a single filter criterion:
a. Select the radio button Use Exact Phrase.
b. Enter Susername in the Use Exact Phrase text field.

7. Click the Add button.

o Note: When adding the very first Search Filter to the Appliance, you might
see the following message immediately after clicking Add:

There s no Search Filter defined in the system

Refresh the appliance memory by clicking Regular Expression Search in
the navigation menu; then click Search Filters in the menu, and your new
Search Filter is displayed in the list.

Search Filter Options

You can use various types of search expressions when adding a search filter.

Search Filter Comparison

Filter type Search criteria Use predefined Where the filter is
RegEx filters? used
Use Words A word, or two words with Yes RegEx Search, Alerts
AND/OR
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Filter type Search criteria Use predefined Where the filter is
RegEXx filters? used

Use Exact A phrase Yes RegEx Search, Alerts

Phrase

Regular Regular expression Yes RegEx Search, Alerts

Expression

Boolean Keyword search using No Index Search and

Expression Boolean expressions Index Report

o Note: Custom reports allow whichever filter types apply to the content of the
custom report. For example, a custom report saved from an Index Search allows
Boolean search filters. When creating a search filter to be used for Index Search
or index report, ensure that you choose the Boolean expression as the filter type.

Use Words

Type a word as your search criteria. If you type more than one word, you can use the
AND/OR list.

To specify any string of characters, use wildcards (*). For example, RADI*UDP would match
the RADIUS opened UDP handle string.

Use Exact Phrase

Type a phrase as your search criteria. The appliance searches for strings including the
phrase you specify.

To specify any string of characters, use wildcards (*). For example, RADI*UDP would match
the RADIUS opened UDP handle string.

You can also define a parameter field using $fieldname. For example, $username $zipcode
$phone displays text entry fields when you select the search filter in the RegEx Search tab.
Field names with spaces in them display only the first word in the RegEx Search tab. For
more information, see Additional Parameters to a Pre-Defined Regular Expression Search
Filter.
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Regular Expression

Type a regular expression as your search criteria; that is, a single character, a string of
characters, or a string of numbers. A regular expression (RegEx) is a pattern that is
matched against a subject string from left to right. Most characters stand for themselves in
a pattern and match the corresponding characters in the subject.

The power of regular expressions comes from the ability to include alternatives and
repetitions in the pattern. These are encoded in the pattern by use of metacharacters,
which are interpreted in a special way (instead of standing for themselves).

o Note: Avoid using a regular expression when a non-regular expression
alternative is available. Regular expressions are almost always less effective and
more error-prone than non-regular expressions. For instance, instead of using
the regular expression A[A:]%://.%\.loglogic\.com/.*$” use
ur'l.domain=1loglogic.com.

You can use a wildcard symbol (*) for searches. Using a wildcard for RegEx searches means
the * matches the preceding element zero or more times.

Once you add a regular expression, the values you enter are stored as parameters in the
database. To use this regular expression with alerts or RegEx Search, select the Pre-
Defined option.

If you are creating a search filter for an alert, the search filter must be a regular expression.

Boolean Expression

Type a keyword that uses Boolean operators such as AND, OR, or NOT. For example:

“Portmapped translation built for gaddr” and NOT 155.363.777.53

Boolean expressions can search only indexed data. Indexing increases performance when
searching unparsed data. It is most effective when used to find a rare occurrence of a
string.

In addition to entering a keyword, you can also type:
¢ Numbers and words that are three or more characters

e Terms less than three characters, preceded by =. For example, for terms such as
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user=a or priority=7,'a' and '7' are indexed.

The Boolean expression should be no longer than 4096 characters in length.

Putting Your Logins Search Filter to Work

You must complete a few steps to start using your Logins search filter.

Procedure
1. Select Regular Expression Search from the navigation menu.
2. On the RegEx Search Filter tab that appears, select the Pre-Defined radio button.
3. In the Pre-Defined text field (Select Expression), click the list arrow, select Logins
search, and click on the filter name. The filter form reloads and now displays Logins
search in the Pre-Defined text field.

o Note: If you specify the parameter Susername in the Use Exact Phrase text
field when you define your Logins search filter, the appliance opens a new
text box next to username in which you can further define the type of user
to search for.

4. Enter admin in the username text field to search for that class of user alone, or enter
the wildcard * to search for logins from all users.

5. Select a Start Time to run your Logins search (immediately in this example).

6. Enter a name for your search in the Search Name text field.

7. Click the Save Custom Report menu expansion arrow and enter a Report Name and
Report Description, and select whether to Share with Others.

8. Click Save Report.

9. Click Run.

Report of Logins by username admin
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Home > Search > Regular Expression Search Enterprise Virtual Appliance (Management Station) LSP32 - Jan 13, 2017 09:32:54

0

RegEx Search  Finished Searches  Pending Searches

Report Time Timespan of Report Search Name Owner Regular Expression Matches (Click To View) Download Size

01/13/17 09:30:00 IS0 00008 Activity by username admin admin Exact Phrase (admin) 2R/7217 1% 2.18 KB (csv, pdf, html)
01/13/17 09:29:59

56: 01/02/17 00:00:00 - i 56 i i Click to view results

01/12/17 23:56:41 01/12/17 20:53:38 distributed search Thu Jan 12 23:56:25 2017 admin Retrieve All () 1 % 1.62 MB (csv, pdf, html)
01/02/17 00:00:00 - " N

01/12/17 23:56:35 e BT requested by 127.0.0.1 at Thu Jan 12 23:56:30 2017  admin Retrieve All () 126777 /212847 60% 1.47 MB (csv, pdf, html)
01/02/17 00:00:00 - . n N

01/12/17 20:55:55 01/12/17 20:53:38 distributed search Thu Jan 12 20:55:40 2017 admin Retrieve All () 212847 /212847 100% 3.28 MB (csv, pdf, html)

01/12/17 20:55:46 01/02/17.00:00:00 - requested by 127.0.0.1 at Thu Jan 12 20:55:46 2017  admin Retrieve All () 212847 /212847 100% 3.03 MB (csv, pdf, html)
01/12/17 20:53:38
01/12/17 00:00:00 - " i ;

01/12/17 20:42:05 PTG distributed search Thu Jan 12 20:41:56 2017 admin Retrieve All () 67129/67129 100% 916.43 KB (csv, pdf, html)
01/12/17 00:00:00 - g B

01/12/17 20:42:01 requested by 127.0.0.1 at Thu Jan 12 20:42:01 2017  admin Retrieve All () 67129/67129 100% 836.04 KB (csv, pdf, html)

01/12/17 20:41:55

10. Click the number of matches to see the detailed report of the logins by username
admin.

Detailed Report of Logins by username admin

Home > Search > Regular Expression Search Enterprise Virtual Appliance (Management Sta

@ Page: 1 of2 Go

RegEx Search Results
192.168.1.252 : Fri 01/13/17 00:00:00 - Fri 01/13/17 09:29:59

Time Source Device Source IP Facility | Severity = Message

<182>)an 13 00:02:01 192.168.1.252 %LOGLOGIC-6-3100: user:admin; module:user_intfc; action:rt_rpt;
status:success; session_id:1406870164; client_ip:127.0.0.1; target_ip:192.168.1.252; info:report_title:"Index
Search" report_type:"SearchExpressionHits" device_type:"all" device_name:"Dynamic rule"
from_time:"01/12/2017 00:00:00" to_time:"01/13/2017 00:00:00"

column_info_0:"name=Time;di: =true;: ize=false;sort=true;direction=up;filter=false;"

1 01/13/17 00:02:02  :ffff:192.168.1.252_logapp  192.168.1.252 22 6 column_info_1:"name=Device IP;display=true;; Ise;
column_info_2:"name=Device Source;display=true;: ter=false;"
column_info_3:"name=Facility;display=true;: ize=false;sort=false;filter=false;
column_info_4:"r ity;display=true;: ize=false;sort=false;filter=false;"
column_info_5:"r i i 3 ; =false;",

orig_session_id,53DB229467C8EC4AFDD7B4117F3DAAF8,

<182>Jan 13 00:02:01 192.168.1.252 %LOGLOGIC-6-3100: user:admin; module:user_intfc; action:rt_rpt;
status:success; session_id:1406870164; client_ip:127.0.0.1; target_ip:192.168.1.252; info:report_title:"Index
Report" report_type:"SearchByUserDefinedFilters" device_type:"all" device_name:"Dynamic rule"
from_time:"01/12/2017 23:00:00" to_time:"01/13/2017 00:00:00" column_info_0:"name=Search Filter

Name;display=

ize=true;sort=false;

2 01/13/17.00:02:02  :ffff:192.168.1.252_logapp ~ 192.168.1.252 22 6 . .
—~'08app ame=Description;display=true;summarize=false;sort=false;filter=false;"

column_info_'
column_info_2:"name=Search Terms;display=true;summarize=false;sort=false;filter=false;"
column_info_3:"name=Search Terms;display=true;summarize=false;sort=false;filter=false;"
column_info_4:"name=Count;di =true; ize=false;sort=true;direction=downfilter=false;"
search_filters:"logapp,admin user,logu" , orig_session_id,53DB229467C8EC4AFDD7B4117F3DAAF8,
<182>Jan 13 01:02:01 192.168.1.252 %LOGLOGIC-6-3100: user:admin; module:user_intfc; action:rt_rpt;
status:success; session_id:2489989507; client_ip:127.0.0.1; target_ip:192.168.1.252; info:report_title:"Index
Search" report_type:"SearchExpressionHits" device_type:"all" device_name:"Dynamic rule"
from_time:"01/12/2017 01:00:00" to_time:"01/13/2017 01:00:00"
column_info_0:"name=Time;display=true;summarize=false;sort=true;direction=up;filter=false;"

3 01/13/17 01:02:02  :ffff:192.168.1.252_logapp 192.168.1.252 22 6 column_info_1:"name=Device IP;display=true;summarize=false;sort=falsefilter=false;"

i iafo. 2 —

Additional Parameters to a Pre-Defined Regular
Expression Search Filter

When creating a pre-defined search filter, you can define a parameter field by using the
expression Sfieldname.

The value you enter in the parameter replaces $field. In our example, we chose Susername
as our expression, and typed admin into the User Name field. This caused the regular
expression search to return admin users wherever Susername was specified.
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The maximum length for each S$field is 25 characters. Regular expressions can be up to
4096 characters in length.

This feature applies only to the Use Exact Phrase search filter and Regular Expression
search.

Creating a Multi-Parameter Pre-Defined Regular
Expression Search Filter

This example shows how to build on your single-parameter Logins search filter.

The example uses two additional parameters: $zipcode and $phone.

Procedure

1.

Create a new pre-defined search filter exactly as the example Logins search filter we
created earlier, except this time type Susername Szipcode $phone in the Use Exact
Phrase field.

Name your new search filter “Multi-parameter search” and click Add.

Note: This time the new search filter appeared immediately after clicking
Add, and both search filters are displayed in the list.

Select Search > Regular Expression Search, and select the Pre-Defined radio
button; then select the pre-defined search filter that you just created (Multi-
parameter search) from the list.

The new form reloads, displaying each text field that corresponds to each new S$field
(search parameter) you define for this new search filter. The maximum length for
each S$field is 25 characters.

Click Save Custom Report at the bottom of the form, and enter a report name and
description.

Click Save Report.

Type Susername Szipcode Sphone in the Use Exact Phrase field.

In this example, we typed Susername Szipcode Sphone in the Use Exact Phrase field.
The Appliance generated a text field in the search form for the part after the $. We
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7.

typed admin in the username field and used the wildcard * in the zipcode and phone
fields to return the maximum number of user logins.

We elected to Save Custom Report, and named it Multi-parameter search, and we
selected Schedule to run immediately for the Hourly Period: Last 24 Hours. See the
results of our multi-parameter search filter query in the following figure.

The detailed Multi-parameter Search Report is revealed by clicking the number of
matches returned by the search (see the arrow at the bottom of the top figure).

o Note: You can define this parameter for the Use Exact Phrase or Regular
Expression fields from the Add or Modify page for any search filter.

Click the Finished Searches tab to see the results of the Parameter Search.

Modifying a Search Filter

In the second example earlier, we created a new search filter and added two more search
parameters: $zipcode and Sphone. As an alternative, we could have modified the first
search filter we created, “Logins by username admin”. The following example
demonstrates how to modify an existing search filter (assuming you no longer want to
retain the original filter configuration).

Procedure

1. Select Search > Search Filters from the navigation menu.

2. Click on the name of the filter you want to change.

3. The Modify Search Filter tab appears with the same options as Adding a Search
Filter.

4. Modify the search filter name, description, filter options and criteria, or sharing with
other users as needed.

5. Now we think that IP address would be more valuable to us than zipcode and phone,
so we elect to modify our multi-parameter search filter to suit our new needs.

o Note: We could also simply delete the filter and create a new one.
6. Click the Update button to modify the search filter.
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7. Select Regular Expression Search from the navigation menu.
8. Click the Pre-Defined radio button on the RegEx Search Filter tab.

9. Select Multi-parameter search from the list in the Select Expression field (but do
not enter search parameters until you complete Step 8).

10. Click the Save Report button at the bottom of the form and enter a new report
name and description. Click Save Report.

11. Return to the search parameter text fields and enter your new parameters (username
=admin, and ipaddress = wildcard *).

12. Click Run.

13. Click Finished Searches and then click the number of matches returned to see the
results.

All Saved Searches

From the Search > All Saved Searches page, you can view a list of all saved searches for
specific types of data based on search expressions and time intervals you have defined and
saved in the past.

All the saved searches and types, such as Index Search, RegEx Search, Index Report, so on,
which are stored in the system, are visible on this page.

Click the Run icon and regenerate the report with a different time range, or click the Edit
icon and change the saved report parameters before rerunning the report. You can also
filter the list of saved reports displayed by title by typing a keyword from the report title in
the Find field and pressing Enter. The keyword or words are highlighted in the resulting
list. To restore the full list of saved reports, clear the Find field and press Enter again.

You can also create reports from this page by clicking the down-arrow in the Create
Report button and selecting from either Index Search or Regular Expression Search.

For more information on  See this topic
Index Search Index Search

Regular Expression Search  Regular Expression Search
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Using and Creating All Index Reports

Use the All Index Reports screen to view a list of all saved searches for specific types of
data based on search expressions and time intervals you defined.
You can use these results to verify information found in your reports.

The results provide the number of hits for each selected search filter, which you can view
in a table or a graphical chart. From the table, you can drill down to view the specific hits
for a filter in detail similar to Index Search results.

Procedure
1. Go to Search > All Index Reports.

2. Click Create Report to open the Properties window.

3. Select log sources from the right-hand pane. You can select sources by Appliance,
and filter returns by Name, IP Address, Group or Type.

 If you picked “Name”, enter a Source Name, a specific Device Name or a Name
Mask. Wild cards are accepted in this field.

 If you picked "Collector Domain", enter the name of the Collector Domain. This
is the name used to identify each message sent from a specific device.

 If you picked “IP Address”, enter a Source IP Address, a specific IP Address or
an IP Address Mask. Wild cards are accepted in this field.

 If you picked “Group”, enter a Group Name, or click the down arrow to the
right of the text field and select “All” or one of the other Group names
displayed in the drop-down box.

 If you picked “Type”, enter a Source Type (a specific device type), or click the
down arrow to the right of the text field and select “All” or one of the other
Device Types displayed in the drop-down box

4. Click <<Add as a rule, and enter a name in the text field of the dynamic rule pop-up.
5. Click OK to add the selected source and filters to the left-hand pane.

6. On the right-hand pane select a device name (or names) from the list by clicking its
name.

7. Click <<Add selected log sources to add devices from the selected source to which
you want to apply the filters when running the report.
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8. Click Columns and Filters to select the columns for your report and choose filters for
your results. Click in the field under the Value column and enter a term for the filter
(such as login, id, and so on). Then click in the field under the Operator column and
pick an operator from the drop-down.

Click Apply. The selected operator and value move to the left-hand column.

9. Click Index Report Search Selections to select from the available expressions to be
used in the report. If none are available, click New Expression... to add a new
Boolean search expression for use in any Index Report.

10. In the Add Search Expression... popup that appears, enter Name, Description,
Expression, and then click Sharing to define whether others can use or modify the
new filter. Click Save.

Note: Do not use < or > in your search expression as these are not valid
characters.

11. Place a checkmark next to the new search expression and click << Apply Selections

to add them to the left-hand pane for use in filtering your report. Then click Save As
>,

12. Enter a name and description of the report in the pop-up. Select Share with others
if desired. Click Save & Close. The new report appears in the list of all saved Index
Reports.

13. Click in the Name field and enter a term to search for entries in the Saved Reports
list. Hit Enter. Any terms found in the list of report titles are highlighted; all other
reports not containing the search term is no longer shown in the list of Saved
Reports. Clear the search term in the Name field and hit Enter to see all Saved
Reports again.

14. Click the Run icon in the Actions column. The Date and Time Range Picker pops up,
with Last Hour as the default setting. Click the down arrow next to Last Hour to
reveal several other options (Last 2, 3, 6, 12, 18, or 24 Hours; Today; Yesterday).
Select the timeframe from the Date and Time Range Picker and click Run again to
execute the report.
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Alerts

Alerts notify you of any unusual traffic on the network or detect anomalies on log sources
or the Loglogic appliance itself.

You can create alerts specific to your monitoring needs, and use alerts that come pre-
configured with TIBCO LoglLogic® Compliance Suite or TIBCO LogLogic® Log Source
Packages. You can also update existing alerts or remove them as needed. Similarly, you
can define a new custom alert template and manage the existing custom alert templates.
Using the template variables, you can define the alert email subject and alert message
body for custom alerts.

You can import/export the custom alert templates and formats between appliances. For
more details, refer to TIBCO LoglLogic® Log Management Intelligence Administration.

For any alert, you can designate SNMP trap receivers, Syslog receivers, and Email recipients
so people can receive notifications of alerts via email.

View and Handle Alerts

The Show Triggered Alerts page lists events triggered by rules defined for this appliance
to monitor and report on.

From the Show Triggered Alerts page you can:
e View all alerts
 Filter shown alerts by alert category, priority, alert type, and keywords
» View all system alerts only, regardless of priority
e Change the alert category to Acknowledged
e Delete the alerts permanently

» (Management Station only) View alerts on a specific managed Appliance or on all
managed Appliances
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o Note: When the Data Privacy mode is enabled, these types of alerts are
not displayed on the Show Triggered Alerts page: VPN Connection Alert,
VPN Statistic Alert, VPN Message Alert, Pre-defined Search Filter Alert,
Cisco PIX/ASA Messages Alert, and Network Policy Alert. For more
information on Data Privacy mode, see the Managing System Settings
section in TIBCO LogLogic® Log Management Intelligence Administration.

When an alert is triggered, Alert Viewer shows the alert category as New.

Filtering and Viewing Alerts

Procedure
1. Choose Alerts > Show Triggered Alerts from the home page.

2. Select the type of alerts to display from the Show list.

e All States shows all alerts in all categories.

e New or Acknowledged Alerts shows only alerts in the selected category.
3. Select the alert priority to view from the second list. The options are:

e All Priorities

e High

e Medium

e Low

e All System Alerts

To view all system alerts regardless of priority, select All System Alerts.

4. Select the type of alert from the third list. To view all types of alerts, select All Types.

5. (Management Station only) Select the appliance from which to view triggered alerts.
To aggregate alerts from all managed Appliances into a single list, select All.

6. To filter using the keywords, enter the keywords in the Find field and press Enter. To
search based on Priority and Type, select the respective lists. For the remaining
columns, enter the keyword in the Find field to filter the list. The filtered results are
displayed.

The Show Triggered Alerts page displays the specified alerts with the following
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details:
Alert Details
Element Description
Time The time when the alert triggered
Source IP Source IP address contained in the syslog message
If an alert is for multiple devices, Device Group is
shown as the Source IP.
Priority The priority of the alert
The priority of an alert is specified in the General tab.
Type The Log appliance alert type

For a list of alert types, see the Preconfigured System
Alerts and Types of Alerts tables.

Alert Destination  Email addresses, trap receivers, or the syslog receiver

where notifications were sent when the alert
triggered.

Paging Through Alerts

You can page through multiple results to your query in various ways.

* Use the navigation buttons to go to the first, previous, next, or last page,

respectively.

* Type the page number and click to view the results on a specific page

Acknowledge, Print, or Remove Alerts

You can acknowledge, remove, or print alerts.

e To move alerts to the Acknowledged category, select their check boxes and click

TIBCO Loglogic® Log Management Intelligence User Guide



73 | Alerts

¢ To delete selected alerts, select their check boxes and click .

® To delete all alerts permanently, regardless of priority, click .

e To print alerts, click =

Tip: Move an alert to the Acknowledged category once you have been notified of
the alert. Remove an alert once the cause of the alert is corrected.

Manage Alert Templates

The Manage Alert Templates menu allows you to define a new alert template format and
manage the custom alert templates.

Using the template variables, you can edit the alert message. The Manage Alert Templates
page displays the following information:

Manage Alert Templates Details

Element

Filter By Names

Name

Type
Template Type
Max Message

Length

Used By Alert(s)

Description

Filter using the template names. Enter the keywords
and press the Enter key to view the filtered list.

Name of the alert template.

Type of the alert.

Type of template.

Indicates the maximum character length (including
the alert email subject and the alert message) that is

displayed.

Click the List link to view a list of alerts used by this
template.

TIBCO Loglogic® Log Management Intelligence User Guide



74 | Alerts

Adding a New Alert Template Format

You can define a new alert template format by using the Add New Alert Format option.

Procedure

1. Go to Alerts > Manage Alert Templates.

2. On the Manage Alert Templates page, click the Add New button.
The Add New Alert Format window is displayed.

3. Define a template name in the Name field. This must be unique for each template.

4. From the Alert Type list, select a type of alert.

Note: For a LoglLogic ST Appliance, only four alert types are available:
Adaptive Baseline Alert, Message Volume Alert, Search Filter Alert, and
System Alert.

5. Select the Template Type from the list. The options are: Email, Alert History, SNMP
Trap, and Syslog. Once you select the template type, the default text for the selected
type appears in the Body field.

6. Select a variable from the Variables list. Once you select a variable, the actual string

for the selected variable appears in the Variable Text field.

The valid variable string definitions are:

Variable Text Description

SALERT_ User-defined alert description.
DESCRIPTION
SALERT_ID A number specific to the alert type. For example, 050300 for Message

Volume Alert.

SALERT_LOG_ A list of log sources assigned to the alert.
SOURCES
SALERT_NAME User-defined alert name.
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Variable Text

SALERT_TIME

SALERT_TYPE

$SALERT_URL

$CUSTOM_
EMATIL_SUBJECT

$CUSTOM_
STRING

$CUSTOM_
SYSLOG_STRING

$FILTER

$FILTER_NAME

$HIGH_
THRESHOLD

$LOG

$LOG_SOURCES

$LOG_SOURCE_
IPS

SLOW_
THRESHOLD

Description
The time when the alert was triggered.
Type of Alerts. For example, Message Volume Alert.

The URL that opens a page with alertable event details. Do not add
any special characters after the SALERT_URL.

A portion of the email subject that is preconstructed based on the
alert type. This field contains alert type-specific details. You cannot
change this field.

A portion of the email body that is preconstructed based on the alert
type. This field contains alert type-specific details. You cannot change
this field.

A portion of the alert syslog message that is preconstructed based on
the alert type. This field contains alert type-specific details. You
cannot change this field.

Text of a search-filter that matched as part of Search-filter alert.

A search-filter name. This filter is assigned to a Search-filter alert.

The high threshold value that was exceeded during alert monitoring.

The log message that triggered the alert.
The log sources that triggered the alert.

IP addresses of log sources that triggered the alert.

The low threshold value that was crossed during alert monitoring.
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Variable Text Description

$NUM_EVENTS The number of alertable events that happened during the reset time.
The reset time temporarily suppresses alerts.

$PRIORITY The alert priority.
SRECIPIENT Email, syslog, and SNMP to which the alert was sent.
SRESET_TIME Alert reset time. Reset time temporarily suppresses alerts.

$SNMP_STRING A portion of the alert SNMP message that is preconstructed based on
the alert type. This field contains alert type-specific details. You
cannot change this field.

$SRC_ The appliance that triggered the alert.
APPLIANCE
STIME_SPAN The time span value used in the alert definition.

STYPE_SYSLOG  Alert type encoding as used in syslog alert message, such as
“MESSAGE_VOLUME_ALERT”.
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o Note:

e The $$ variable is translated as $. For example, $$ALERT_
DESCRIPTION is displayed on alert history as SALERT_DESCRIPTION.

 If you define a number before the variable string, then only the
specified number of characters is displayed in the alert message
when the variable length is longer. For example, if you specify the
variable string as $10ALERT_DESCRIPTION, then only the first 10
characters are displayed as the alert description. The remaining
characters are truncated.

¢ Since some variables, such as $LOW_THRESHOLD and $HIGH_
THRESHOLD, are not supported for a certain alert type, they might be
displayed as empty or 0.

* When some alerts cannot distinguish log sources that have some
messages or do not have any messages, such as Message Volume
Alert and VPN Statistics Alert, they might list all assigned log sources
in the $LOG_SOURCES variable.

7. The Maximum Message Length field displays the default maximum character length
of the alert email subject and alert message that is displayed. You can update this
value anytime. If the length of the alert email subject and the alert message is longer
than the specified value, then the email subject is truncated.

Note: When the selected Template Type is Email, the default maximum
character length is 65503.

8. When you select the Template Type as Email, the Subject field appears with a
default subject. Change the subject if required. The Subject field is mandatory but
the Body field is optional.

o Note: The Subject or Body fields cannot include <subject>, </subject>,
<body>, or </body> tags.

9. Add or change the default body of the selected template type in the Body field. You
can select multiple variables. When adding, make sure you copy and paste the exact
variable string (from the Variable Text field) in the Body field.
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10. Click the Add button to save the new template format.

Result
The newly added template is displayed on the Manage Alert Templates page.

Viewing and Modifying an Alert Template

You can only view the default (system-defined) alert templates, but you cannot edit or
delete them. However, you can update or delete the user-defined templates.

To viewing the default alert template format, go to Alerts > Manage Alert Templates and
click the name of the alert template.

To modify a user-defined alert template format, perform the following steps.

Procedure
1. Go to Alerts > Manage Alert Templates.

2. On the Manage Alert Templates page, click the template name to update the format
details.

You can only update the user-defined alert templates.
3. Make the required changes and then click the Update button to save the changes.

4. To save the template format with a different name for later use, update the template
name and click Save As.

Removing an Alert Template

You cannot delete the default alert templates.

However, you can delete the custom alert templates.

Procedure
1. Choose Alerts > Manage Alert Templates from the navigation menu.

2. Select the check box next to the template name and click the Remove selected
template(s) button (that is located above the list on the top banner). You can delete
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only the custom templates.

3. Click Yes on the confirmation window to delete the selected alert template. The
confirmation window lists all associated alert rules for the selected template.

Note: When you delete the selected template, all associated alert rules
that are using this template use the default templates.

The selected template is removed from the Manage Alert Template list.

Manage Alert Rules

From the Alerts > Manage Alert Rules page, you can define rules to detect unusual traffic
on your network or detect appliance system anomalies.

You can add, modify, or remove alerts. You can configure alerts to generate SNMP events, a
syslog receiver, or send an email notification when the alert rule is triggered. Each
appliance includes a default set of alerts. You can modify these alerts and add to them as
needed. You do not need to set up an SNMP or syslog server for the default alerts.

Note: If you have the Manage Alerts privileges, you can modify or delete alerts
created by other users.

The Manage Alert Rules page displays the following information:

Field or
Column

Find

Name

Type

Priority

Description

Filter using the keywords. Enter the keywords in the Find field and press
Enter.

Name of the alert.

Type of the alert.

The defined priority of the alert.
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Field or Description
Column
Enabled Indicates whether the alert is active:

IE —You must assign a User and Alert Receiver for this alert.

IE —You must assign a Device for this alert.

Description Description of the alert.

Types of Alerts

The following types of alerts are available:

Alert Type

Adaptive Baseline Alert

Cisco PIX/ASA Messages Alert

Message Volume Alert

Triggered when...

The messages/second rate becomes more or less than the
nominal rate for the traffic.

Note: A baseline is established after 1 week from the
alert activation time. After the baseline is established,
the baseline is adjusted every 15 minutes. The new
value is averaged in with a past baseline.

The messages per second rate for a specific PIX/ASA
message code is greater or less than the specified rates.

The messages/second rate is greater or less than the
specified rates. If the user sets the “Zero Message Alert”
check box, an alert is triggered only if zero messages are
received within the timespan set.

Note: Zero message alerts are supported only on local
devices, and not on device groups spanning all
LogLogic LMI appliances.
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Alert Type

Network Policy Alert

Parsed Data Alert

Pre-defined Search Filter Alert

Ratio Based Alert

Triggered when...

A network policy message is received with an Accept or
Deny Policy Action.

The appliance automatically pulls Check Point firewall
rule bases via the Check Point Management Interface
(CPMI), but you still must manually enter rules for a
Network Policy Alert in the Rules tab.

Note: The Rules tab is available for Network Policy
Alerts and is accessible only after the new alert is
initially saved.

The parsed data meets certain conditions specified for
the alert.

Parsed data alerts are different from other alert types;
they are based on Pre-defined Search Filter alerts. See
Creating Parsed Data Alerts.

A text search filter matches message fields. This uses one
of the search filters saved on the appliance:

¢ Use Words
¢ Use Exact Phrase

e Regular Expression

The pre-defined search filter is disabled if there are no
search filters defined on the appliance. To create a pre-
defined search filter, use Search Filters to add the filter.
A search filter for an alert can contain words, phrase or a
RegEx expression.

The specified message count is greater or less than a
specified percentage of total messages. For example,
“Login Success message count is fewer than 10% of total
messages.”

The appliance checks for any conditions that would
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Alert Type

System Alert

Note: The Devices tab is not
available for system alerts.

VPN Connections Alert

VPN Messages Alert

VPN Statistics Alert

o Note:

Triggered when...
trigger a Ratio Based Alert every 60 seconds.

An appliance system criterion is exceeded. For example,
“Disk usage exceeds 80%”.

By default, the priority of system alerts is high. You can
change it to medium or low if needed.

See also: Preconfigured System Alerts

A VPN connection is denied access and/or disconnected.

The VPN Connections Alert is only applicable to Check
Point VPN, Cisco VPN, Nortel VPN, and RADIUS
Accounting device types.

Combinations of specific VPN message area, severity, and
code. This alert is applicable to Cisco VPN devices.

Recorded statistics on VPN or Radius messages match
relative or absolute criteria. This alert is applicable to
Check Point VPN, Cisco VPN, Nortel VPN, and RADIUS
Accounting device types.

» For the Loglogic ST Appliance, an Adaptive Baseline Alert, a Message
Volume Alert, and a Pre-defined Search Filter Alert can be created, along
with a new System Alert.

* A Loglogic LX Appliance can create all types of Alerts.

Preconfigured System Alerts

System alerts notify you when system health and status criteria exceed the acceptable

bounds.
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All LogLogic LMI appliances include several system alerts that are preconfigured and
enabled. By default, these alerts have the following settings:

e Email notifications are sent to the appliance admin user

e Priority is set to high

o Default reset time is 300 seconds except TCP Forward Falling Behind alert has a
default reset time of 3600 seconds

All these alert settings can be customized as needed.

Alert

System Alert -
CPU/System
temperature

System Alert - Disk
Usage

System Alert -
Dropped Message

System Alert -
Emergency Disk
Usage

System Alert -
Engine Status

Description

The temperature of the appliance CPU has exceeded the
specified High Threshold.

Note: This alert is available in LogLogic EVA only if
Loglogic EVA is used as a Management Station that
manages physical Remote Appliances.

The usage of the specified drive on the appliance has
exceeded the specified High Threshold.

The number of messages dropped by the appliance has
exceeded the specified High Threshold.

The disk storage is almost full, which indicates a state of
emergency. An emergency disk usage alert is sent to
warn the user 5% before the threshold is reached. When
emergency purging begins, the alert is sent periodically
until the disk usage level drops below the threshold
value.

An alert is triggered if the status of the selected engine
changes to any of the statuses selected in the Engine
Status section. The engine status values are Init,
Running, Exited, Failsafe, or Disabled, of which Exited,
Failsafe, and Disabled are selected by default. No alert is
triggered for engines related to Advanced Search.

Default High
Threshold

70 degrees
Celsius

80%

10 msg/sec

N/A

N/A
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Alert

System Alert - Fail
Over

System Alert -
Migration
Complete

System Alert -
Network
Connection Speed

System Alert -
Network Interface

System Alert -
RAID Disk Failure

System Alert -
Synchronization
Failure

Description

A failover has occurred on the appliance.

A data migration involving the appliance is successfully
completed.

The speed of the network connection for the appliance
has become lower than the specified Low Threshold.

A problem occurred with the appliance network
interface.
A failure occurred on an appliance RAID disk.

A failure occurred during log data synchronization on
the appliance.

Preconfigured alerts for LoglLogic EVA

Default High
Threshold
N/A

N/A

10-Half

N/A

N/A

N/A

For LoglLogic EVA, only the following preconfigured system alerts are available:

e System Alert - Disk Usage

e System Alert - Dropped Message

e System Alert - Emergency Disk Usage

e System Alert - Engine Status

e System Alert - Fail Over

e System Alert - Migration Complete

e System Alert - Synchronization Failure
The System Alert - CPU/System temperature alert is available in LogLogic EVA only when it

is used as a Management Station that manages physical Remote Appliances.
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Adding a New Alert Rule

Adding an alert to the appliance involves selecting the type of alert, enabling the alert,
specifying the log sources to monitor, and specifying alert recipients (SNMP traps, syslog
receivers, and email user IDs).

Modifying an alert lets you change the same options as those for adding an alert.

Warning: When setting up an alert, do not pick search expressions that include
variables. Doing so treats variables as having a literal meaning.

The Devices, Alert Receivers, and Email Recipients tabs list disabled log sources,
receivers, or recipients marked as (disabled).

Disabled entries are ignored during processing, but are listed on the following pages and
are automatically present when enabled again:

» Log sources: Management > Devices
¢ Receivers: Administration > Alert Receivers

e Recipients: Management > Users

Procedure
1. Go to Alerts > Manage Alert Rules.

2. Click the Add New button.

3. In the Type tab, select an alert type. See Types of Alerts.

After you select an alert type, the General tab for that alert type automatically
appears; and the Devices, Alert Receivers, Email Recipients, and Templates tabs are
enabled.

4. On the General tab, set up the alert.

Options on the General tab vary depending on the alert type. The following table
describes typical options:
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Field
Name

Priority

Alert Criteria

Reset Time

Enable

(Optional) SNMP OID

Description

Enable Schedule

Issue SNMP Trap Clear

Description
Alert name

Alert priority

Default value: High

Alert criteria

This field is available only for a System Alert.

The time in seconds after which the SNMP trap must be
cleared

Click Yes to enable the alert. The alert is enabled after you
click the Add button.

Enter a specific SNMP OID to further define the alert.

For example, by defining this, your administrator or receiver
knows that all alerts triggered with this SNMP OID originate
from a specific device and alert.

Alert description

Tip: Enter a name and description unique enough to
easily identify the alert in a large list.

Select the check box to specify the time period for
scheduling the alerts. Select the appropriate Time and Day
boxes to specify the schedule. The selected box turns blue.

To remove a time slot, click the blue box.

Select the check box to clear the trap after the issue is
resolved.
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Field Description

You can clear the SNMP trap for system alerts where a
critical condition is reported, such as disk usage alerts; but
not for other system alerts that are issued only for
information, such as data migration complete alert.

For example, a disk usage alert might trigger when the disk
usage crosses a threshold. After issuing this alert, if the disk
usage later decreases to below the threshold, an SNMP clear
trap is issued. The trap can only be sent via SNMP and to
the same receiver that is configured for the alert. The trap
contains a text message indicating the condition being
cleared and the name of the alert. A record of the trap
appears on the Show Triggered Alerts page as well as in the
log file sys.log.

5. On the Devices tab, specify log sources for the alert.

All the log sources on the appliance are listed in Available Devices. When you move
a device to the Selected Devices section, the alerts you configure are activated for
those devices. You can define different alerts for different devices.

For available devices where the Collector Domain was specified in LoglLogic Universal
Collector, the following format is displayed:

<collector domainid>_<device IP>_<devicetype>
For example, a Windows machine with an IP address of 10.10.10.10 and collector
domain is displayed as 1_10.10.10.10._windows.

Select the Track all devices individually check box to generate an independent alert
messages for each selected device. The reset time tracks for the group as a whole
and you can change alert properties using one alert for the device group.
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o Note: When configuring an alert (except for System Alerts) on logs
transferred using LoglLogic TCP, the alert reporting can be slightly slower
than in real-time. Because LoglLogic TCP sends data in chunks that the
appliance incrementally merges, an alert can appear anywhere between
real-time and up to 5 minutes later. As a result, for example, Message
Volume rates can be determined when averaging over a 5 minute or
greater increment, but do not provide meaningful averages for smaller
timespans. For Cisco PIX/ASA Messages alerts, the Timespan setting should
be at least 60 seconds.

6. On the Alert Receivers tab, specify SNMP trap receivers and syslog receivers for the
alert.

You can define alerts for both SNMP traps and for syslog receivers and users; or only
for SNMP traps. The Alert Receivers tab lists all the available traps and syslog for the
appliance. You must configure SNMP traps, syslog receivers, and/or add specific
traps. For more information about Alert Receivers, see TIBCO LoglLogic® Log
Management Intelligence Administration.

7. On the Email Recipients tab, specify people who should receive alerts via email.

a. Select templates for each alert type from the list. The Templates tab displays
all available templates for each alert type:

e History
e SNMP
e Syslog
e Email

After you select the template, the format is displayed. To define or modify
template formats, see Adding a New Alert Template Format.

b. By default, the Default option for the Alert Email Template is selected to send
the default email message. In this case, from the Message Size list, select Long
or Short message forms.

c. Select the Enable View Alert Detail from Email check box to provide
additional alert detail in email. The email includes a link that you can click to
open the Alert Notification page on the LoglLogic LMI GUI.
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o Note:

* The size of email messages that include an alert is limited to
1024 bytes. Any additional alert text is truncated.

 If a LoglLogic LMI session is open in a browser and then you
click the link in an alert email received, you might have to log
in again in a newer session. After logging in to the newer
session, you are logged out of the earlier LogLogic LMI sessions
to maintain access security.

You can define alerts for both users and SNMP traps; or only for users. Available
Users lists all the users available for the appliance. For information about adding
users, see TIBCO LogLogic® Log Management Intelligence Administration.

8. The Rules tab is enabled only for Network Policy Alerts. When adding a Network
Policy alert, you must save the alert and then modify it to access the Rules tab. From
the Rules tab, you can define the Accept (or Deny) Source and Destination IP Address
Ranges, Port Ranges, and Protocols parameters for the alert. For example, define the
firewall policy rules you want to monitor for this alert. A single alert can have a single
rule or multiple rules. You must add an alert before defining rules. You can define up
to 1000 rules for each alert. If you leave the fields blank and add the rule, you are still
defining an alert. The appliance accepts all values if you leave the fields blank.

9. Click the Add button to add the new alert to the appliance.

Creating Parsed Data Alerts

Parsed Data alerts are created differently from other alert types.

There is no Parsed Data alert type to select in the interface; its creation is based on a Pre-
defined Search Filter alert. The Filter specifies matching values that are extracted by the
parser from the log messages.

To use Parsed Data alert, you need to know the name of the database table where parsed
logs are stored along with the column names. You can find the exact column names using
the Management > Column Manager page to create the search filter for this alert type.
For more information, see the Managing Column Manager chapter in TIBCO LogLogic® Log
Management Intelligence Administration. When specifying the matching values, data type
should be considered for the relevant table columns. For example, IP addresses must be a
numeric type, that is, a 32-bit integer and not the string representation such as 169.1.1.1.
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Procedure
1. Create a Pre-defined Search Filter:

a. Name the filter.

b. For filter type, select Use Exact Phrase.

c. For the DB table, specify _table=. (Only one _table= entry is allowed.)

d. Specify columns and values to match as name-value pairs separated by

commas. For example, this is a string-matching filter:

_table=Authentication,actionID=2,statusID=4

2. Create a Pre-defined Search Filter alert:

a. Name the Search Filter alert with a prefix _parsed. For example, _parsed_Login

Failure.
b. Select the Pre-defined Search Filter you created for this alert.
Usage notes:
» Parsed data alerts apply only to messages from configured log sources.
» Parsed data alerts apply only to the tables configured in the alert.
e Parsed data alerts are not available on LoglLogic ST Appliances.

» Do not configure the same alert for both real-time and pulled data files.
Instead, create separate alerts for each, with the same search expression.

Modifying or Removing An Alert

You can modify alert settings or remove alerts from the Manage Alert Rules page.
The same tabs appear when you add an alert (see Adding a New Alert Rule).

To modify an alert:

1. Click the alert name in the Name column.

2. View the settings for the Alert Rule on the General tab, the Alert Receivers tab, the
Email Recipients tab, and the Templates tab. Change the settings and click Update
or Cancel to retain.
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To remove an alert;

1. Select the check box next to the alert name.
2. Click the delete icon .

3. On the Remove Alerts page, you can confirm or cancel the removal.
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Real-Time Reports

By using real-time reports, you can search and generate reports for monitoring various
real-time activities.

The real-time activities are derived from the log data that is collected from your log
sources. Each Real-Time report category contains multiple specific reports.

Warning: Depending on LoglLogic LSP packages and your selected log sources,
you might see different types of reports, columns, and optional filters for each
report.

Preparing a Real-Time Report

The real-time reports are a central component to the agile reporting in LoglLogic. By using
the real-time reports, you can quickly view detailed information about the collected log
data, catered to your specific needs.

Real-time reports can take longer than Saved Reports because they run against all up-to-
the-minute raw log data; and not against stored summarized log data. Real-time reports
capture all hits in collected raw log data that meet the report criteria.

Sometimes, the message Message: Unavailable might be displayed in the report result. To
view the accurate detailed messages, run an Advanced Search query by including the sys_
body column.

Note: When two devices have the same IP address but only one device has a
Collector Domain ID, duplicate data (data combined from both domains) might
be displayed.

To generate a real-time report, refer to the procedure and illustrations in Generating a
Report: An Example - Denied Connections Report.
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Selecting Sources and Search Filters

Procedure

1.

In the navigation menu under Reports, select the category and type of report to
generate.

Click Create Report to open the Properties window.

Under Add Log Sources, click the down arrow next to Select and pick a filter (Name,
Collector Domain IP Address, Group or Type) to filter returns.

 If you picked “Name”, enter a Source Name, a specific Device Name or a Name
Mask. Wild cards are accepted in this field.

* If you picked "Collector Domain", enter the name of the Collector Domain. This
is the name used to identify each message sent from a specific device.

 If you picked “IP Address”, enter a Source IP Address, a specific IP Address or
an IP Address Mask. Wild cards are accepted in this field.

* If you picked “Group”, enter a Group Name, or click the down arrow to the
right of the text field and select “All” or one of the other Group names
displayed in the drop-down box.

 If you picked “Type”, enter a Source Type (a specific device type), or click the
down arrow to the right of the text field and select “All” or one of the other
Device Types displayed in the drop-down box

o Note: When adding a large number of devices, create a dynamic rule that
contains all listed devices. To create a rule, first filter by Name or Type to
retrieve the list of devices. Then click << Add filters as a rule. This creates
a dynamic rule containing all listed devices, on the right pane.

If desired, add a second filter by clicking the + sign and repeating Step 3 as often as
you like.

To delete a filter, click the - sign to remove the last selection made (repeat if
needed). Do not click Cancel unless you want to cancel your report.

Click << Add as a rule, and enter a name in the text field of the dynamic rule pop-
up.
Click OK to add the selected source and filters to the left-hand pane.
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8. Select a device name (or names) by clicking its name.

9. Click << Add selected log sources to add devices from the selected source to which
you want to apply the filters when running the report.

10. Click Run to initiate a report of the selected source and devices with the filters you
chose in Step 3.

Selecting Time Frame and Running a Report

Procedure

1. When you click Run in Step 10, the Date and Time Range Picker pops up, with Last
Hour as the default setting. Click the down arrow next to Last Hour to reveal several
other options (Last 2, 3, 6, 12, 18, or 24 Hours; Today; Yesterday).

2. To select a different date range, click the small calendar icon to the right of the
current Date and Hour display and chose any month and day for the start of the
report period. Move to the right and click the second small calendar icon to choose
any month and day for the end of the report period.

3. Click Run again to execute the report.

Operations on the Reports

You can perform various operations on the report results page.
* To resize and move the columns to the positions you prefer, click on them and drag.

» To see detailed information for a particular source device, click the number of
returns for the device in the Count column.

e To download reports in CSV, PDF, or HTML format, click the corresponding icon.

Modifying Report Settings and Time Frame

Procedure
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1. Clicking the Edit Settings button opens up a Properties window again, this time
allowing you to Add Columns and Filters if desired.

2. Enter your selections for Add Columns and Filters (if any) and click Save As.

3. Enter a name and description for the report in the pop-up window. Select Share
with others if desired. Click Save & Close.

4. Click Run Again to execute your report with the new filtering criteria. The new report
is displayed in the list of all Saved Reports (from Reports > All Saved Reports).

5. Click the date range (blue type at top left) to modify the timeframe for your report.
The Date and Time Range Picker appears, with Last Hour as the default setting.
Follow the steps listed in Selecting Time Frame and Running a Report.

6. From the list of Saved Reports (access Reports > All Saved Reports), click Run or
Edit to modify the report settings of any Saved Report.

7. To search for a particular report or report series in the Saved Reports list, click in the
Find field and enter a search term.

8. Press Enter. Any term found in the list of report titles are highlighted; all other
reports not containing the search term is no longer shown in the list of Saved
Reports. Clear the search term in the Find field and press Enter to see all Saved
Reports again.

9. To add a schedule for a Saved Report, click the report Name and then click Schedule
selected.

The Scheduling window opens. You can define a Timeframe, Email Recipients (pre-
defined system users), and Formatting options. Click the Manage Recipients button
to update the appliance address book. Using this option, you can add new or modify
recipient addresses that are non-defined system users (that are not defined under
Management > Users page).

10. To delete a Saved Report from the list, click the report Name and then click Remove
selected.

A pop-up message asking you to Confirm Deletion is displayed.

Formats for Saving a Generated Report

You can save a generated report as a CSV, PDF, or HTML file by clicking the icons at the top
of the report results.
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When saving a generated report in any of the available formats, you can save and display a
maximum of 5,000 lines, even if the number of lines in the generated report exceeds the
defined limit. To change this limit, contact your administrator.

Format Description

Csv Downloads and saves the report data in a comma-separated .csv file, that can be
viewed in spreadsheet applications such as Microsoft Excel. By default, reports
are created in the CSV format. You can download the report by clicking the CSV
icon.

PDF Downloads and saves the report data in a PDF file, viewable in Acrobat format
such as Adobe Acrobat Reader.

HTML Open the report data in a new browser window or tab, from which you can also
download the HTML file for archival.

Rerunning a Saved Report

If you have saved a report earlier, you can change some parameters and rerun it.

Procedure
1. To rerun a saved report, go to Reports > All Saved Reports and select a previously
saved report.

2. To regenerate the report with a different time range, click the Run icon.

3. To change the saved report parameters before rerunning the report, click the Edit
icon. All options are available, not just the ones originally selected.

4. To customize the new report, use new filters and wildcards.

o Note: Wildcard searches are supported for IP addresses and detailed
messages.
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Generating a Report: An Example - Denied
Connections Report

This example shows how to generate a Network Activity report that displays denied
connection activity related to the IP addresses you select.

These steps do not apply to the generation of the following reports on the appliance:

e Check Point Policies report, which lists current Check Point Firewall policy rules on

log sources connected to your appliance.

» All Saved Reports, which lists previous search results, saved as reports, and selected

to be shared with others at the time of generation.

Procedure
1. Select Reports > Network Activity > Denied Connections from the home page
menu.
2. Click the Create Report button.
3. Select the log source connected to the appliance.
4. Select log sources from the list by clicking its name (or names). Click Add selected
log sources to move them to the Log Sources list.
5. Click Run to run the report.
6. Specify the time interval to search for data passing through the appliance and click
Run.
7. On the Denied Connections results page, adjust the order and position of columns.
8. At the top menu, select the CSV, PDF, or HTML icon to export the entire report to a
file.
9. To choose another time to run the Denied Connections report, click the date range in
the upper left section of the report.
10. Select the date and time and click Run.
11. Click the Edit Settings button to revise columns and filters in the report and Run the

report again.
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Rerunning and Editing settings of a previously
saved report (Denied Connections)

Settings of a previously saved report can be edited and you can rerun the report.

Procedure

1.
2.

o 0 &> W

10.

Select Reports > Network Activity > Denied Connections from the Home page.

To run the saved report, click (® and then click the Run button on the Date and
Time Range Picker that pops up.

After the Denied Connections report opens, click the Edit Settings button.
Click Properties to open the Properties Dialog pane.
Enter your data and click OK.

To add a schedule for the Denied Connections report, click the Scheduling link.

The Add a Schedule pane opens on the right side. You can define a Timeframe,
Email Recipients (pre-defined system users), and Formatting options. Click the
Manage Recipients button to update the appliance address book. Using this option,
you can add new or modify recipient addresses that are non-defined system users
(that are not defined under Management > Users page).

Click the Add Schedule button at the bottom of the Timeframe pane to confirm the
schedule for the Denied Connections report.

Click Save and Close on the Properties window to save your entries.
View the saved schedule for the Denied Connections report.

To make further changes to the Denied Connections report, repeat Steps 1 — 9.

Available Operators

Multiple filter operators are available for each report.
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These operators are listed in the Optional Filter Operators table.

Note: Some report columns display as empty when the actual value is either
null or an empty string.

o If the value is null, you can filter using --nul1--.

o If the value is an empty string, you can filter using two single quotes ".

Optional Filter Operators

Operator

not in

like

not like

contain

not contain

start with

Description

Specifies an acceptable substitution for a word in a query.

Specifies to not substitute a word in a query.

Displays data in the results that contains the specified word in a list.
Excludes data in the results that contains the specified word in a list

Displays data that has a partial match to the value you type.

For example, you can use this operator to type a partial IP address such
as 10.2.3.%. This type of search returns all IP addresses which contain
these numbers.

Excludes data that contains a partial match to the value you type.

Displays data that matches the alphanumeric string you type.

For example, you can use this operator to type a string such as 'Accessed
URL' for any detailed message. This type of search returns all detailed
messages which contain, start with, or end with the value 'Accessed
URL'".

Excludes data that matches the alphanumeric string you type.

Displays data that begins with the alphanumeric value you type.

For example, you can use this operator to type a string such as 'Accessed
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Operator

not start
with

end with

not end
with

regexp

not regexp

between

Description
URL' for any detailed message. This type of search returns all detailed
messages which contain, start with, or end with the value 'Accessed

URL'".

Excludes data that begins with the alphanumeric value you type.

Displays data that ends with the alphanumeric value you type.

For example, you can use this operator to type a string such as 'Accessed
URL' for any detailed message. This type of search returns all detailed
messages which contain, start with, or end with the value 'Accessed
URL".

Excludes data that ends with the alphanumeric value you type.

Displays data in the results only that contains the regular expression you

define.

Displays data in the results only that does not contain the regular
expression you define.

Displays only data in the results that is higher than a threshold number.
Displays only data in the results that is less than a threshold number.

Displays data that is between (inclusive) the numeric values you type.

Access Control Reports

To search for and generate reports on the number of times a selected log source executes
an authentication rule, use Access Control reports.

The submenu that appears when you click Reports > Access Control, lists the reports that
are available for each log source.
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Accessing the Access Control Reports

Choose Reports > Access Control > report-name from the navigation submenu, where
report-name is any one of the Access Control reports.

Access Control Reports

Report

Permission
Modification

User Access

User
Authentication

User

Created/Deleted

User Last Activity

Windows Events

Definition

Use the Permission Modification screen to search
for and create a report on changes made to user
permissions on selected log sources during a
specified time interval.

Use the User Access screen to search for and
generate a report on user activities in accessing
resources (for example, service, file, directory,
application) on selected log sources during a
specified time interval.

Use the User Authentication screen to search for
and generate a report on who has authenticated
on selected log sources during a specified time
interval.

Use the User Created/Deleted screen to search for
and generate a report on what users have created
or deleted during a specified time interval.

Use the User Last Activity screen to search for and
generate a report on activity of users during a
specified time interval.

Use the Windows Events screen to search for and
generate a report on data about all log events
from the Microsoft Windows operating systems.
For example, the captured log events include
application, security, and system events.

More information

Permission
Modification
Reports

User Access
Reports

User
Authentication
Reports

User
Created/Deleted
Reports

User Last Activity

Reports

Windows Events
Reports

Preparing a Real-time Report includes the common options that you specify for all Real-
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Time Reports.

Optional columns and filters can be sorted in ascending or descending order. Choose sort
order using the list. Optional filter operators are different for each Access Control report,
and are explained in their respective sections.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Permission Modification Reports

To search for and generate a report on activities related to modification of user
permissions (for example, adding or deleting permissions) on selected log sources during a
specified time interval, use the Permission Modification Real-Time Report.

Menu path: Reports > Access Control > Permission Modification

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional columns and filters can be sorted in ascending or descending order. Choose sort
order using the list. The optional filters are listed in the following table.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Permission Modification Report - Optional Filter Operators

Option Description

Source Device Description of the device that sent these log messages
User User who is making the inquiry

Action Action taken

Status Status of the connection

Source IP IP address of the source host device

Source Domain Domain of the source host device
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Option Description

Target User User for whom the inquiry is being made
Target IP IP address of the accessed Appliance
Target Domain Domain of the accessed Appliance

Type Type of connection

Originating Host The original hostname where the event was originally created

Subsystem The subsystem of the host
Originating IP The original source IP address where the event was originally created
Event Name Name of the event

Application Type The type of application that generated the event

Count Number of connections

User Access Reports

To search for and generate a report on user activities in accessing resources (for example,
service, file, directory, application) on selected log sources during a specified time interval,
use the User Access Real-Time Report.

Menu path: Reports > Access Control > User Access

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional columns and filters can be sorted in ascending or descending order. Choose sort
order using the list. The optional filters are listed in the following table.
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Option
Source Device
User

Source IP
Source Domain
Target User
Target IP
Target Domain
Group

Action

Status

Type

Originating Host

Subsystem
Originating IP

Event Name

Application Type

Count

Description

Description of the device that sent these log messages

User who is making the inquiry

IP address of the source host device

Domain of the source host device

User for whom the inquiry is being made

IP address of the accessed Appliance

Domain of the accessed Appliance

The name of the Policy group

Action taken

Status of the connection

Type of connection

The original hostname where the event was originally created
The subsystem of the host

The original source IP address where the event was originally created
Name of the event

The type of application that generated the event

Number of connections
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User Authentication Reports

To search for and generate a report on who has authenticated on selected log sources
during a specified time interval, use the User Authentication Real-Time Report.

Menu path: Reports > Access Control > User Authentication

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display only the Source Device, User, Source IP, Status, and
Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

User Authentication Report - Optional Filter Operators

Option Description

Source Device Description of the device that sent these log messages

User User who is making the inquiry

Source IP IP address of the source host device

Source Domain Domain of the source host device

Target User User for whom the inquiry is made

Group The name of the Policy group

Originating Host The original hostname where the event was originally created
Subsystem The subsystem of the host

Originating IP The original source IP address where the event was originally created
Event Name Name of the event
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Option Description

Application Type The type of application that generated the event
Status Status of the connection

Type Type of connection

Disconnect Reason Reason the connection was terminated

Count Number of connections

User Created/Deleted Reports

To search for and generate a report on what users have been created or deleted on
selected log sources during a specified time interval, use the Users Created/Deleted Real-
Time Report.

Menu path: Reports > Access Control > User Created/Deleted

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display only the Source Device, User, Source IP, Target User,
Target IP, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

User Created/Deleted Report - Optional Filter Operators

Option Description

Source Device Description of the device that sent these log messages
User User who is making the inquiry

Source IP IP address of the source host device
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Option

Target User
Target IP
Originating Host
Subsystem
Originating IP
Event Name
Application Type
Action

Action Details
Status

Count

Description

User for whom the inquiry is being made

IP address of the accessed Appliance

The original hostname where the event was originally created
The subsystem of the host

The original source IP address where the event was originally created
Name of the event

The type of application that generated the event

Action taken

Details of the action

Status of use

Number of connections

User Last Activity Reports

To search for and generate a report on the most recent activity of all users on selected log
sources during a specified time interval, use the User Last Activity report.

Menu path: Reports > Access Control > User Last Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional columns and filters can be sorted in ascending or descending order. Choose sort
order using the list. The optional filters are listed in the following table.
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Option
Source Device
Time
Connection ID
User

Source IP
Target User
Target IP
Action

Action Details

Status

Originating Host

Subsystem
Originating IP

Event Name

Description

Description of the device that sent these log messages

Time of connection

ID number for the connection

User who is making the inquiry

IP address of the source host device

User for whom the inquiry is being made

IP address of the accessed Appliance

Action taken

Details of the action

Status of the activity

The original hostname where the event was originally created
The subsystem of the host

The original source IP address where the event was originally created

Name of the event

Application Type  The type of application that generated the event

Access Details Details of access

Windows Events Reports

To search for and generate a report on data on all Windows Event IDs, the number of
events for each ID, and a description of each ID for selected log sources running the
Microsoft Windows operating systems, use the Windows Events Real-Time Report.
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For example, the captured log events include application, security, and system events.

Menu path: Reports > Access Control > Windows Events

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display only the Source Device, Event ID, and Count.

For information on saving the generated report, see Formats for Saving a Generated

Report.

Windows Events Report - Optional Filter Operators

Option

Source Device
Event ID

User

Source Domain
Target User
Target Domain
Originating Host
Subsystem
Originating IP
Event Name
Application Type
Action

Status

Description

Description of the device that sent these log messages
Numeric ID corresponding to the source device

User ID on the source device

Domain name of the source device

User ID of the destination device

Domain name of the destination device

The original hostname where the event was originally created
The subsystem of the host

The original source IP address where the event was originally created
Name of the event

The type of application that generated the event

Action taken

Status of use
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Option

Type

Count

Description

Content type of the object as seen in the HTTP reply header

Number of Windows events for the source device

Database Activity Reports

To search for and generate reports on various events occurring on database server log
sources, use the Database Activity reports.

Accessing the Database Activity Reports

Choose Reports > Database Activity > report-name from the navigation menu, where
report-name is any one of the following reports:

Database Activity Reports

Report

All Database
Events

Database
Access

Database Data
Access

Database
Privilege
Modifications

Description

Use the All Database Events screen to search for and

generate a report on the event types that are occurring.

Use the Database Access screen to search for and
generate a report on all database server connections
including user access and failed user access attempts.

Use the Database Data Access screen to search for and
generate a report on user access and changes to your
data for a specified time period.

Use the Database Privilege Modifications screen to
search for and generate a report on database privilege
changes, such as user reconfiguration and privilege
manipulation.

More
information

All Database
Events Reports

Database
Access Reports

Database Data
Access Reports

Database
Privilege
Modifications
Reports
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Report Description More
information
Database Use the Database System Modifications screen to search ~ Database
System for and generate a report on system database changes System
Modifications such as drops and table drops. Modifications
Reports

Preparing a Real-time Report includes the common options that you specify for all Real-
Time Reports.

Optional filter operators are different for each Database Activity report, and explained in
their respective sections.

For information on saving the generated report, see Formats for Saving a Generated
Report.

All Database Events Reports

To search for and generate a report on the event types that are occurring on specified
database server log sources during a specified time interval, use the All Database Events
Real-Time Report.

Menu path: Reports > Database Activity > All Database Events

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. By default, the following options are selected: Source Device, Database,
Event Type ID, Event Type Name, Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

All Database Events Report - Optional Filter Operators

Option Description

Source Device Description of the device that sent these log
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Option

Database

DB User

Sys Priv

Database Object

Name

Status

Severity

OS User

Event Type ID

Event Type Name

Object Priv

Count

Description
messages
Database name on which the action occurred

User name of the database user whose actions were
audited

System privileges granted or revoked

Name of the object affected by the action
Status or return code of the action completion
(numeric value)

Severity level of the event

Operating system login user name of the user whose
actions were audited

Database vendor audit code for the action type

Type of database event such as DROP_TABLE, SQL_
UPDATE, or CREATE_TABLE (names vary by vendor)

Object privileges granted or revoked on the database
object

Number of log entries returned with the given
parameters

Database Access Report

To search for and generate a report on all database server connections, including user
access and failed user access attempts, on specified database server log sources during a
specified time interval, use the Database Access Real-Time Report.

Menu path: Reports

> Database Activity > Database Access
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In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. By default, the following options are selected: Source Device, Database,
Event Type ID, Event Type Name, Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Database Access Report - Optional Filter Operators

Option Description

Source Device Description of the device that sent log data

Database Database name on which the action occurred

DB User User name of the database user whose actions were
audited

Sys Priv System privileges granted or revoked

Database Object ~ Name of the object affected by the action

Name

Status Status or return code of the action completion
(numeric value)

Severity Severity level of the event

OS User Operating system login user name of the user whose
actions were audited

Event Type ID Database vendor audit code for the action type

Access Type The action or method used to access any database
object

Object Priv Object privileges granted or revoked on the database
object

TIBCO Loglogic® Log Management Intelligence User Guide



114 | Real-Time Reports

Option Description
Count Number of log entries returned with the given
parameters

Database Data Access Report

To search for and generate a report on user access and changes to your data on specified
database server log sources during a specified time interval, use the Database Data Access
Real-Time Report.

Menu path: Reports > Database Activity > Database Data Access

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. By default, the following options are selected: Source Device, Database,
Event Type ID, Event Type Name, Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Database Data Access Report - Optional Filter Operators

Option Description

Source Device Description of the device that sent log data

Database Database name on which the action occurred

DB User User name of the database user whose actions were
audited

Sys Priv System privileges granted or revoked

Database Object =~ Name of the object affected by the action
Name
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Option Description

Status Status or return code of the action completion
(numeric value)

Severity Severity level of the event

OS User Operating system login user name of the user whose
actions were audited

Event Type ID Database vendor audit code for the action type

Access Type The action or method used to access any database
object

Object Priv Object privileges granted or revoked on the database
object

Count Number of log entries returned with the given
parameters

Database Privilege Modifications Report

To search for and generate a report on database privilege changes, such as user re-
configuration and privilege manipulation, on specified database server log sources during a
specified time interval, use the Database Privilege Modifications Real-Time Report.

Menu path: Reports > Database Activity > Database Privilege Modifications

In addition to setting the common report options in Real-Time Reports, you can select
optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. By default, the following options are selected: Source Device, Database, DB
User, Modification Type, Object Priv, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Database Privilege Modifications Report - Optional Filter Operators

Advanced Description

Option

Source Device Description of the device that sent log data

Database Database name on which the action occurred

DB User User name of the database user whose actions were
audited

Sys Priv System privileges granted or revoked

Database Object =~ Name of the object affected by the action

Name

Status Status or return code of the action completion
(numeric value)

Severity Severity level of the event

OS User Operating system login user name of the user whose
actions were audited

Event Type ID Database vendor audit code for the action type

Modification Modification action of a user, profile, or role privilege

Type

Object Priv Object privileges granted or revoked on the database
object

Count Number of log entries returned with the given
parameters

Database System Modifications Report

To search for and generate a report on system database changes such as drops and table
drops, use the Database System Modifications Real-Time Report.
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Menu path: Reports > Database Activity > Database System Modifications

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. By default, the following options are selected: Source Device, Database, DB
User, Database Object Name, Access/Modification Type, and Count.

For information on saving the generated report, see Formats for Saving a Generated

Report.

Database System Modifications Report - Optional Filter Operators

Option
Source Device
Database

DB User

Sys Priv

Database Object
Name

Status

Severity

OS User

Event Type ID

Access/Modification
Type

Description
Description of the device that sent log data
Database name on which the action occurred

User name of the database user whose actions were
audited

System privileges granted or revoked

Name of the object affected by the action
Status or return code of the action completion
(numeric value)

Severity level of the event

Operating system login user name of the user whose
actions were audited

Database vendor audit code for the action type

Modification action of a user, profile, or role privilege
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Option

Object Priv

Count

Description

Object privileges granted or revoked on the database

object

Number of log entries returned with the given
parameters

IBM i5/0S Activity Reports

To search for and generate reports on various events occurring on your IBM i5/0S log
sources, use IBM i5/0S Activity reports.

Accessing the IBM i5/0S Activity Reports

Choose Reports > IBM i5/0S Activity > report-name from the navigation menu, where
report-name is any one of the following reports:

IBM i5/0S Activity Reports

Report

All Log Entry
Types

System
Object Access

User Access
by
Connection

User Actions

Description

Use the IBM i5/0S Activity All Log Entry Types screen to
search for and generate a report on all recorded entry

types.

Use the IBM i5/0S Activity System Object Access screen to
search for and generate a report on all failed access
attempts throughout the system.

Use the IBM i5/0S Activity User Access by Connection
screen to search for and generate a report on all system

access and system access attempts by user.

Use the IBM i5/0S Activity User Actions screen to search for

More
information

All Log Entry

Types Reports

System Object
Access Reports

User Access By
Connection
Reports

User Actions
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Report Description More
information
and generate a report on all user actions performed and Reports
attempted.
User Jobs Use the IBM i5/0S Activity User Jobs screen to search for User Jobs
and generate a report on all jobs that users are running. Reports

Preparing a Real-time Report includes the common options that you specify for all Real-
Time Reports.

Optional filter operators are different for each IBM i5/0S Activity report, and explained in
their respective sections.

For information on saving the generated report, see Formats for Saving a Generated
Report.

All Log Entry Types Reports

To search for and generate a report on all recorded entry types, use the All Log Entry Types
Real-Time Report.

Menu path: Reports > IBM i5/0S Activity > All Log Entry Types

Preparing a Real-time Report includes the common options that you specify for all Real-
Time Reports.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Filter Operators

Option Field Description

Source Device devIP IP address of the device that
sent log data
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Option

Journal Type

Journal Description

Journal Job

Journal User

Journal Number

Journal Program

Journal Library

Journal System Name

Journal Remote Port

Journal Remote Address

Action

Action Description

Attribute Name

Field

jrnEntryType

jrnTypeDesc

jobName

jrnUserName

jrnJobNbr

jrnPgm

jrnPgmLib

jrnSyName

jrnRmtPort

jrnRmtIPAdr

action

actionDesc

attribute

Description

Two-character Audit Journal
record (entry) type

Description of the journal
entry type

Name of the job that caused
the entry to be created

Profile name of the user
associated with Journal Job

Job number of the Journal
Job

Name of the program that
created the entry

Program library

Name of the system where
the journal resides

Remote port of the system
associated with the journal
entry

Network address of the
system associated with this

entry

An action associated with the
entry type

Description of the action

Name of an attribute that
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Option Field Description

was the target of the action

Attribute Description attributeDesc Description of the attribute
(if available)
Destination Server destServer Name of a remote

workstation or server in a
network event

DLO Folder DLOFolder Name of the Document
Library Object folder

DLO User DLOUser Name of the Document
Library Object owner or user
creating or accessing the
DLO

Entry Type entryType Type of event or entry in the
journal type (can be
considered a subtype of the
journal type)

Entry Description entryDesc Description of the entry

Job Name jobName Name of the Journal Job or
the job that was the target of
the action described in the
entry

Job Number jobNumber Number of the Journal
Number or the job that was
the target of the action
described in the entry

Job User jobUser The Journal User of profile

name of the user associated
with the job that was the
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Option

Local IP Address

Object Library

Object Name

Object Type

Remote IP Address

Source Server

Status

Status Description

User ID/Profile

Journal Code

Field

[cliPadr

lib

obj

objType

rmtIPadr

srcServer

status

statusDesc

user

details

Description

target of the action
described in the entry

Local IP address of the
system involved in the
network event

Library of the object that was
acted on

Name of the object that was
acted on

Type of object that was
acted on

Remote IP address of the
system involved in the
network event

Name of a workstation or
server where the audited
event occurred, or that was
the source system in a
network event

Status code

Description of the status
code (if available)

A user ID (UID) or user profile
involved in the recorded
event; typically the originator
or target of the event

Provides event details.
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Option Field Description

Count (computed by the appliance) A count of action attempts,
entries, or other count
information; dependent on
Journal and Entry type

System Object Access Reports

To search for and generate a report on all failed access attempts throughout the system,
use the System Object Access Real-Time Report.

Menu path: Reports > IBM i5/0S Activity > System Object Access

Preparing a Real-time Report includes the common options that you specify for all Real-
Time Reports.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Filter Operators

Option Field Description

Source Device devIP IP address of the device that
sent log data

Journal Type jrnEntryType Two-character Audit Journal
record (entry) type

Journal Description jrnTypeDesc Description of the journal
entry type
Journal Job jobName Name of the job that caused

the entry to be created

Journal User jrnUserName Profile name of the user
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Option

Journal Number

Journal Program

Journal Library

Journal System Name

Journal Remote Port

Journal Remote Address

Action

Action Description

Attribute Name

Attribute Description

Destination Server

DLO Folder

Field

jrnJobNbr

jrnPgm

jrnPgmLib

jrnSyName

jrnRmtPort

jrnRmtIPAdr

action

actionDesc

attribute

attributeDesc

destServer

DLOFolder

Description
associated with Journal Job

Job number of the Journal
Job

Name of the program that
created the entry

Program library

Name of the system where
the journal resides

Remote port of the system
associated with the journal
entry

Network address of the
system associated with this

entry

An action associated with the
entry type

Description of the action

Name of an attribute that
was the target of the action

Description of the attribute
(if available)

Name of a remote
workstation or server in a

network event

Name of the Document
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Option

DLO User

Entry Type

Entry Description

Job Name

Job Number

Job User

Local IP Address

Object Library

Field

DLOUser

entryType

entryDesc

jobName

jobNumber

jobUser

[clIPadr

lib

Description
Library Object folder

Name of the Document
Library Object owner or user
creating or accessing the
DLO

Type of event or entry in the
journal type (can be
considered a subtype of the
journal type)

Description of the entry

Name of the Journal Job or
the job that was the target of
the action described in the
entry

Number of the Journal
Number or the job that was
the target of the action
described in the entry

The Journal User of profile
name of the user associated
with the job that was the
target of the action
described in the entry

Local IP address of the
system involved in the
network event

Library of the object that was
acted on

TIBCO Loglogic® Log Management Intelligence User Guide



126 | Real-Time Reports

Option Field Description

Object Name obj Name of the object that was
acted on

Object Type objType Type of object that was
acted on

Remote IP Address rmtlPadr Remote IP address of the

system involved in the
network event

Source Server srcServer Name of a workstation or
server where the audited
event occurred, or that was
the source system in a
network event

Status status Status code

Status Description statusDesc Description of the status
code (if available)

User ID/Profile user A user ID (UID) or user profile
involved in the recorded
event; typically the originator
or target of the event

Journal Code details Provides event details.
Count (computed by the appliance) A count of action attempts,
entries, or other count

information; dependent on
Journal and Entry type

User Access by Connection Reports

To search for and generate a report on all system access and system access attempts by
users, use the User Access By Connection Real-Time Report.
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Menu path: Reports > IBM i5/0S Activity > User Access By Connection

Preparing a Real-time Report includes the common options that you specify for all Real-

Time Reports.

Optional filter operators can be sorted in ascending or descending order. Choose sort order

using the list.

For information on saving the generated report, see Formats for Saving a Generated

Report.

Filter Operators

Option

Source Device

Journal Type

Journal Description

Journal Job

Journal User

Journal Number

Journal Program

Journal Library

Journal System Name

Field

devIP

jrnEntryType

jrnTypeDesc

jobName

jrnUserName

jrnJobNbr

jrnPgm

jrnPgmLib

jrnSyName

Description

IP address of the device that
sent log data

Two-character Audit Journal
record (entry) type

Description of the journal
entry type

Name of the job that caused
the entry to be created

Profile name of the user
associated with Journal Job

Job number of the Journal
Job

Name of the program that
created the entry

Program library

Name of the system where
the journal resides
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Option

Journal Remote Port

Journal Remote Address

Action

Action Description

Attribute Name

Attribute Description

Destination Server

DLO Folder

DLO User

Entry Type

Entry Description

Field

jrnRmtPort

jrnRmtIPAdr

action

actionDesc

attribute

attributeDesc

destServer

DLOFolder

DLOUser

entryType

entryDesc

Description

Remote port of the system
associated with the journal
entry

Network address of the
system associated with this
entry

An action associated with the
entry type

Description of the action

Name of an attribute that
was the target of the action

Description of the attribute
(if available)

Name of a remote
workstation or server in a
network event

Name of the Document
Library Object folder

Name of the Document
Library Object owner or user
creating or accessing the
DLO

Type of event or entry in the
journal type (can be
considered a subtype of the
journal type)

Description of the entry
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Option Field Description

Job Name jobName Name of the Journal Job or
the job that was the target of
the action described in the
entry

Job Number jobNumber Number of the Journal
Number or the job that was
the target of the action
described in the entry

Job User jobUser The Journal User of profile
name of the user associated
with the job that was the
target of the action
described in the entry

Local IP Address [clIPadr Local IP address of the
system involved in the
network event

Object Library lib Library of the object that was
acted on

Object Name obj Name of the object that was
acted on

Object Type objType Type of object that was
acted on

Remote IP Address rmtIPadr Remote IP address of the

system involved in the
network event

Source Server srcServer Name of a workstation or
server where the audited
event occurred, or that was
the source system in a
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Option

Status

Status Description

User ID/Profile

Journal Code

Count

Field

status

statusDesc

user

details

(computed by the appliance)

User Actions Reports

Description
network event
Status code

Description of the status
code (if available)

A user ID (UID) or user profile
involved in the recorded
event; typically the originator
or target of the event

Provides event details.

A count of action attempts,
entries, or other count
information; dependent on
Journal and Entry type

To search for and generate a report on all user actions performed and attempted, use the

User Actions Real-Time Report.

Menu path: Reports > IBM i5/0S Activity > User Actions

Preparing a Real-time Report includes the common options that you specify for all Real-

Time Reports.

Optional filter operators can be sorted in ascending or descending order. Choose sort order

using the list.

For information on saving the generated report, see Formats for Saving a Generated

Report.
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Filter Operators

Option

Source Device

Journal Type

Journal Description

Journal Job

Journal User

Journal Number

Journal Program

Journal Library

Journal System Name

Journal Remote Port

Journal Remote Address

Action

Field

devIP

jrnEntryType

jrnTypeDesc

jobName

jrnUserName

jrnJobNbr

jrnPgm

jrnPgmLib

jrnSyName

jrnRmtPort

jrnRmtIPAdr

action

Description

IP address of the device that
sent log data

Two-character Audit Journal
record (entry) type

Description of the journal
entry type

Name of the job that caused
the entry to be created

Profile name of the user
associated with Journal Job

Job number of the Journal
Job

Name of the program that
created the entry

Program library

Name of the system where
the journal resides

Remote port of the system
associated with the journal
entry

Network address of the
system associated with this
entry

An action associated with the
entry type
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Option
Action Description

Attribute Name

Attribute Description

Destination Server

DLO Folder

DLO User

Entry Type

Entry Description

Job Name

Job Number

Field
actionDesc

attribute

attributeDesc

destServer

DLOFolder

DLOUser

entryType

entryDesc

jobName

jobNumber

Description
Description of the action

Name of an attribute that
was the target of the action

Description of the attribute
(if available)

Name of a remote
workstation or server in a
network event

Name of the Document
Library Object folder

Name of the Document
Library Object owner or user
creating or accessing the
DLO

Type of event or entry in the
journal type (can be
considered a subtype of the
journal type)

Description of the entry

Name of the Journal Job or
the job that was the target of
the action described in the
entry

Number of the Journal
Number or the job that was
the target of the action
described in the entry
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Option Field Description

Job User jobUser The Journal User of profile
name of the user associated
with the job that was the
target of the action
described in the entry

Local IP Address [clIPadr Local IP address of the
system involved in the
network event

Object Library lib Library of the object that was
acted on

Object Name obj Name of the object that was
acted on

Object Type objType Type of object that was
acted on

Remote IP Address rmtIPadr Remote IP address of the

system involved in the
network event

Source Server srcServer Name of a workstation or
server where the audited
event occurred, or that was
the source system in a
network event

Status status Status code

Status Description statusDesc Description of the status
code (if available)

User ID/Profile user A user ID (UID) or user profile

involved in the recorded
event; typically the originator
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Option Field Description
or target of the event
Journal Code details Provides event details.

Count (computed by the appliance) A count of action attempts,
entries, or other count
information; dependent on
Journal and Entry type

User Jobs Reports

To search for and generate a report on all jobs that users are running, use the User Jobs
Real-Time Report.

Menu path: Reports > IBM i5/0S Activity > User Jobs

Preparing a Real-time Report includes the common options that you specify for all Real-
Time Reports.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Filter Operators

Option Field Description

Source Device devIP IP address of the device that
sent log data

Journal Type jrnEntryType Two-character Audit Journal
record (entry) type

Journal Description jrnTypeDesc Description of the journal
entry type
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Option

Journal Job

Journal User

Journal Number

Journal Program

Journal Library

Journal System Name

Journal Remote Port

Journal Remote Address

Action

Action Description

Attribute Name

Attribute Description

Destination Server

Field

jobName

jrnUserName

jrnJobNbr

jrnPgm

jrnPgmLib

jrnSyName

jrnRmtPort

jrnRmtIPAdr

action

actionDesc

attribute

attributeDesc

destServer

Description

Name of the job that caused
the entry to be created

Profile name of the user
associated with Journal Job

Job number of the Journal
Job

Name of the program that
created the entry

Program library

Name of the system where
the journal resides

Remote port of the system
associated with the journal
entry

Network address of the
system associated with this

entry

An action associated with the
entry type

Description of the action

Name of an attribute that
was the target of the action

Description of the attribute
(if available)

Name of a remote
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Option

DLO Folder

DLO User

Entry Type

Entry Description

Job Name

Job Number

Job User

Local IP Address

Field

DLOFolder

DLOUser

entryType

entryDesc

jobName

jobNumber

jobUser

[clIPadr

Description

workstation or server in a
network event

Name of the Document
Library Object folder

Name of the Document
Library Object owner or user
creating or accessing the
DLO

Type of event or entry in the
journal type (can be
considered a subtype of the
journal type)

Description of the entry

Name of the Journal Job or
the job that was the target of
the action described in the
entry

Number of the Journal
Number or the job that was
the target of the action
described in the entry

The Journal User of profile
name of the user associated
with the job that was the
target of the action
described in the entry

Local IP address of the
system involved in the
network event
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Option

Object Library

Object Name

Object Type

Remote IP Address

Source Server

Status

Status Description

User ID/Profile

Journal Code

Count

Field

lib

obj

objType

rmtliPadr

srcServer

status

statusDesc

user

details

(computed by the appliance)

Description

Library of the object that was
acted on

Name of the object that was
acted on

Type of object that was
acted on

Remote IP address of the
system involved in the
network event

Name of a workstation or
server where the audited
event occurred, or that was
the source system in a
network event

Status code

Description of the status
code (if available)

A user ID (UID) or user profile
involved in the recorded
event; typically the originator
or target of the event

Provides event details.

A count of action attempts,
entries, or other count
information; dependent on
Journal and Entry type
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Threat Management Reports

To search for and generate reports on information about threat management, use the
Threat Management reports.

Choose Reports > Threat Management from the navigation menu.

Threat Management Reports

Report

IDS/IPS Activity

Threat Activity

Configuration

Activity

Scan Activity

Security

Summary

DB IPS Activity

HIPS Activity

Description

Use the IDS/IPS Activity screen to search for and
generate a report on all attack activities from Intrusion
Detection/Prevention Systems (IDS/IPS).

Use the Threat Activity screen to search for and
generate a report on threats detected, eliminated,
quarantined, and detected but unable to be mitigated.

Use the Configuration Activity screen to search for and
generate a report on the following data; signature file
installed, software update, configuration loaded.

Use the Scan Activity screen to search for and generate
a report on the following data; scan delayed, scan
aborted.

Use the Security Summary screen to search for and
generate a report on summarized user and computer
activity alongside other product’s security interactions.

Use the DB IPS Activity screen to search for and
generate a report on data (such as username,
client/server IP addresses, so on) for various database
intrusion prevention events.

Use the HIPS Activity screen to search for and generate

a report on alerts from IPS/IDS signatures, DDOS attacks

and port scan occurrences.

See for more details.

More
information

IDS/IPS Activity
Reports

Threat Activity
Reports

Configuration
Activity Reports

Scan Activity
Reports

Security
Summary
Reports

DB IPS Activity
Reports

HIPS Activity
Reports
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Preparing a Real-time Report includes the common options that you specify for Real-Time
Reports.

For information on saving the generated report, see Formats for Saving a Generated
Report.

IDS/IPS Activity Reports

To search for and generate a report on all attack activities from IDS/IPS systems, use the
IDS/IPS Activity Real-Time Report.

Menu path: Reports > Threat Management > IDS/IPS Activity

For this report, you can select to view various options in the generated report for your
Appliance. Optional filter operators can be sorted in Ascending or Descending order.
Choose sort order using the list. The default is to display only Log Source IP, Source IP,
Destination IP, Destination Port, Signature, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

IDS/IPS Activity Report - Optional Filter Operators

Option Description

Log Source IP IP address of the device that sent these log messages

Source IP IP address from which the attack originated

Source Port Port from which the attack originated

Destination IP IP address that was targeted

Destination Port that was targeted

Port

Action Response of the intrusion prevention system (IPS) when it detects an attack

reported by the IDS/IPS
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Option Description

Note: If you do not have an IPS associated with your IDS/IPS, you might
not see any results if using this filter.

Signature 1D Rule or numeric ID for the event

Note: The Signature ID from the vendor might be more consistent than
the Signature.

Protocol Protocol of the destination device

Signature Identifier from IDS/IPS for an event

Sensor Device that sends events to a collector analysis system
Sensor IP IP address of the device that detected the event

Classification Type of attack
Priority Priority level of the attack

Count Number of attacks.

Threat Activity Reports

To search for and generate a report on all threats detected, eliminated, quarantined, and
detected but unable to be mitigated, use the Threat Activity Real-Time Report.

Menu path: Reports > Threat Management > Threat Activity

For this report, you can select to view various options in the generated report for your
Appliance. Optional filter operators can be sorted in Ascending or Descending order.
Choose sort order using the list. The default is to display only Source Device, Event Name,
Category , User Name, Target User, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Threat Activity Report - Optional Filter Operators

Option

Source Device

Event ID
Event Type
Category

Event
Response

Status ID
Severity ID

Severity
Name

User Name
Target User
Target Group
Threat Name
Source IP
Destination IP

Destination
Host

Analyzer
Name

Description

IP address of the device that sent these log
messages

Numeric ID corresponding to the source device
Type of event
The category of the event

Response to the event

The ID of the status
The severity ID

The name of the severity code associated with
the event

Name of the user who is making the inquiry
User for whom the inquiry is being made
Group for who the inquiry is being made
Name of the threat

IP address from which the attack originated
IP address that was targeted

Host that was targeted

Name of the analyzer
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Option Description
Analyzer The version of the analyzer
Version

Data Version The version of the data associated with the event

Action An action associated with the entry type
Status Status of the connection
Count Number of attacks.

Configuration Activity Reports

To search for and generate a report on all data such as; signature file installed, software
update, and configuration loaded, use the Configuration Activity Real-Time Report.

Menu path: Reports > Threat Management > Configuration Activity

For this report, you can select to view various options in the generated report for your
Appliance. Optional filter operators can be sorted in Ascending or Descending order.
Choose sort order using the list. The default is to display only Source Device, Event Name,
Category , User Name, Target User Name, Action, Status, and Count:

For information on saving the generated report, see Formats for Saving a Generated
Report.

Configuration Activity Report - Optional Filter Operators

Option Description

Source Device  Source device that sent these log messages
Event Name Name of the event

Event Type Type of event

Category The category of the event
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Option Description

Severity ID The severity ID

Severity The name of the severity code associated with
Name the event

User Name Name of the user who is making the inquiry
Target User User for whom the inquiry is being made
Name

Threat Type The type of threat associated with the event
Source IP IP address from which the attack originated

Destination IP IP address that was targeted

Analyzer Name of the analyzer
Name

Analyzer The version of the analyzer
Version

Data Version The version of the data associated with the event

Action An action associated with the entry type
Status Status of the connection
Count Number of attacks.

Scan Activity Reports

To search for and generate a report on all scan delayed or scan aborted data, use the Scan
Activity Real-Time Report.

Menu path: Reports > Threat Management > Scan Activity

TIBCO Loglogic® Log Management Intelligence User Guide



144 | Real-Time Reports

For this report, you can select to view various options in the generated report for your
Appliance. Optional filter operators can be sorted in Ascending or Descending order.
Choose sort order using the list. The default is to display only Source Device, Event Name,
Category , User Name, Target User Name, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated

Report.

Scan Activity Report - Optional Filter Operators

Option

Source Device

Event Name
Event Type
Category

Event
Response

Severity ID

Severity
Name

User Name

Target User
Name

Target
Domain

Target Group

Threat Name

Description

Source device that sent these log messages
Name of the event

Type of event

The category of the event

The severity ID

The name of the severity code associated with
the event

Name of the user who is making the inquiry

User for whom the inquiry is being made

Domain of the accessed Appliance

Group for whom the inquiry is being made

The name of the threat
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Option Description
Threat Type The type of threat associated with the event
Source IP IP address from which the attack originated

Destination IP IP address that was targeted

Destination Port that was targeted

Port

Analyzer Name of the analyzer

Name

Analyzer The version of the analyzer

Version

Action An action associated with the entry type
Status Status of the connection

Count Number of attacks.

Security Summary Reports

To search for and generate a report on all summarized user and computer activity
alongside other product’s security interactions, use the Security Summary Real-Time
Report.

Menu path: Reports > Threat Management > Security Summary

For this report, you can select to view various options in the generated report for your
appliance. Optional filter operators can be sorted in Ascending or Descending order.
Choose sort order using the list. The default is to display only Source Device, Source IP,
Destination IP, User, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Security Summary Report - Optional Filter Operators

Option
Source Device
Source IP
Destination IP
Source Port

Destination
Port

User
Source Host

Destination
Host

Type
Event
Action
Status

Count

Description

Source device that sent these log messages
IP address from which the attack originated
IP address that was targeted

Port from which the attack originated

Port that was targeted

User who is making the inquiry
Host from which the attack originated

Host that was targeted

Type of connection

Type of event

An action associated with the entry type
Status of the connection

Number of attacks.

DB IPS Activity Reports

To search for and generate a report on all data (such as username, client/server IP
addresses, so on) for various database intrusion prevention events, use the DB IPS Activity
Real-Time Report.

Menu path: Reports > Threat Management > DB IPS Activity
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For this report, you can select to view various options in the generated report for your
Appliance. Optional filter operators can be sorted in Ascending or Descending order.
Choose sort order using the list. The default is to display only Source Device, Client IP,
Database User, Database IP, SQL Command, and Count.

For information on saving the generated report, see Formats for Saving a Generated

Report.

DB IPS Activity Report - Optional Filter Operators

Option

Source Device

Description

Source device that sent these log messages

Session ID ID of the session

Client IP IP address of the client
Client Host name of the client
Hostname

End User IP IP address of the end user
Database Name of the database user
User

Database IP IP address of the database
Database Host name of the database
Hostname

Database Name of the database on which the action
Name occurred

Schema

Service Name

Database
Type

The name of the service

The type of database
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Option Description
Database Port The database port

SQL
Command

Object name  The name of the object

Source
Program

Count Number of attacks.

HIPS Activity Reports

To search for and generate a report on all alerts from IPS/IDS signatures, DDOS attacks and
port scan occurrences, use the HIPS Activity Real-Time Report.

Menu path: Reports > Threat Management > HIPS Activity

For this report, you can select to view various options in the generated report for your
Appliance. Optional filter operators can be sorted in Ascending or Descending order.
Choose sort order using the list. The default is to display only Source Device, Event Name,
Target User, Threat Type, Source IP, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

HIPS Activity Report - Optional Filter Operators

Option Description
Source Device  Source device that sent these log messages
Event ID the ID of the event

Event Name Name of the event
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Option
Event Type

Event
Response

Severity
Name

Target User
Threat Type
Source IP
Host IP
Destination IP

Destination
Host

Analyzer
Name

Analyzer
Version

Object Name

Destination
Port

Target
Process Name

Count

Description

The type of event

Name of the severity

User for whom the inquiry was made

The type of threat

IP address from which the attack originated
Host from which the attack originated

IP address that was targeted

Host that was targeted

Name of the analyzer

The version of the analyzer

Name of the object affected

Port that was targeted

Name of the target process

Number of attacks.
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Mail Activity Reports

To search for and generate reports on information about mail-related activities on mail
server log sources, use Mail Activity reports.

The Report Information tab that appears when you click on Reports > Mail Activity lists
which reports are available for each log source.

Choose Reports > Mail Activity > report-name from the navigation menu, where report-
name is any one of the following reports:

Mail Activity Reports
Report Description
Exchange Use the Exchange 2000/03 SMTP screen to search for and
2000/03 generate a report on all Exchange 2000/03 SMTP events
SMTP recorded by your mail servers.
Exchange Use the Exchange 2000/03 Activity screen to search for and
2000/03 generate a report on all mail server activity for your Microsoft
Activity Exchange servers.
Exchange Use the Exchange 2000/03 Delay screen to search for and
2000/03 generate a report on all delays in mail activity for your
Delay Microsoft Exchange servers.
Exchange Use the Exchange 2000/03 Size screen to search for and
2000/03 generate a report on mail size for all your Microsoft Exchange
Size server mail activity.
Server Use the Server Activity screen to search for and generate a
Activity report on server activity.
Exchange Use the Exchange 2007/10 Activity screen to search for and
2007/10 generate a report on all mail server activity for your Microsoft
Activity Exchange servers.

More
information

Exchange
2000/03 SMTP
Reports

Exchange
2000/03
Activity
Reports

Exchange
2000/03 Delay
Reports

Exchange
2000/03 Size
Reports

Server Activity
Reports

Exchange
2007/10
Activity
Reports
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Report Description More
information
Exchange Use the Exchange 2007/10 Mail Size screen to search for and Exchange
2007/10 generate a report on mail size for all your Microsoft Exchange  2007/10 Mail
Mail Size server mail activity. Size Reports

Preparing a Real-time Report includes the common options that you specify for all Real-
Time Reports.

Optional filter operators are different for each Mail Activity report, and explained in their
respective sections.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Exchange 2000/03 SMTP Reports

To search for and generate a report on all mail server activity for selected Microsoft
Exchange servers during a specified time interval, use the Exchange 2000/03 Activity Real-
Time Report.

Menu path: Reports > Mail Activity > Exchange 2000/03 SMTP

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. By default, all options are shown except the Source User, Source
Host, Domain Name, and Time Taken (ms).

For information on saving the generated report, see Formats for Saving a Generated
Report.

Exchange 2000/03 SMTP Report - Optional Filter Operators

Option Description
Source Device Description of the device that sent these log
messages
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Option Description

Source User User of the source device

Source IP IP address of the source device
Source Host Host name of the source device
Domain Name Domain name of the source device
Destination IP IP address of the destination device

Destination Port Port of the destination device

Method Request method to obtain an object; for example,
GET

URL Query URL requested

Status SMTP result codes

Size Number of bytes transferred

Time Taken (ms)  Time to complete the event

Count Number of cache views

Exchange 2000/03 Activity Reports

To search for and generate a report on all delays in mail activity for selected Microsoft
Exchange servers during a specified time interval, use the Exchange 2000/03 Delay Real-
Time Report.

Menu path: Reports > Mail Activity > Exchange 2000/03 Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.
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You can select to view various options in ascending or descending order. Choose the sort
order by using the list. By default, the Source Device, Recipient Domain, Status, and Count
are shown:

For information on saving the generated report, see Formats for Saving a Generated
Report.

Exchange 2000/03 Activity Report - Optional Filter Operators

Option Description

Source Device Name of the Microsoft Exchange device
Message ID Numeric identifier of the message
Sender Email address of the sender

Sender Domain Domain name of the sender’s email
Recipient Email address of the recipient

Recipient Domain  Domain name of the recipient’s email
Status Exchange status

Count Number of emails

Exchange 2000/03 Delay Reports

To search for and generate a report on all mail server activity for selected Microsoft
Exchange servers during a specified time interval, use the Exchange 2000/03 Activity Real-
Time Report.

Menu path: Reports > Mail Activity > Exchange 2000/03 Delay

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. By default, the Source Device, Recipient Domain, Average Delay,
Max Delay, and Count are shown.
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For information on saving the generated report, see Formats for Saving a Generated
Report.

Exchange 2000/03 Delay Report - Optional Filter Operators

Option Description

Source Device Name of the Microsoft Exchange device
Message ID Numeric identifier of the message
Sender Email address of the sender

Sender Domain Domain name of the sender’s email
Recipient Email address of the recipient

Recipient Domain  Domain name of the recipient’s email

Average Delay Average delay of each message
Max Delay Maximum delay of each message
Count Number of emails

Exchange 2000/03 Size Reports

To search for and generate a report on mail size for all server mail activity for selected
Microsoft Exchange servers during a specified time interval, use the Exchange 2000/03 Size
Real-Time Report.

Menu path: Reports > Mail Activity > Exchange 2000/03 Size

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. By default, the Source Device, Sender, Total Size (Bytes), Max Size
(Bytes), Count, and Actual Count are shown.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Exchange 2000/03 Size Report - Optional Filter Operators

Option Description

Source Device Name of the Microsoft Exchange device
Message ID Numeric identifier of the message
Sender Email address of the sender

Sender Domain Domain name of the sender’s email
Recipient Email address of the recipient

Recipient Domain  Domain name of the recipient’s email
Total Size (Bytes)  Total number of bytes transferred
Max Size (Bytes) Maximum number of bytes transferred
Count Number of emails

Actual Count

Server Activity Reports

To search for and generate a report on server activity, use the Server Activity Real-Time
Report.

Menu path: Reports > Mail Activity > Server Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. By default, the Source Device, Source IP, Source Port Destination IP,
Destination Port , and Messages are shown.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Server Activity Report - Optional Filter Operators

Option Description

Source Device Name of the Microsoft Exchange device
Source IP IP address of the source host device
Source Port Port of the source host device
Destination IP IP address that was targeted

Destination Port Port that was targeted

Messages Number of log messages received representing
this connection

Exchange 2007/10 Activity Reports

To search for and generate a report on all delays in mail activity for selected Microsoft
Exchange servers during a specified time interval, use the Exchange 2007/10 Real-Time
Report.

Menu path: Reports > Mail Activity > Exchange 2007/10 Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. By default, the Source Device, Sender, Recipient, and Count are
shown.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Exchange 2007/10 Activity Report - Optional Filter Operators

Option Description

Source Device Name of the Microsoft Exchange device
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Option Description

Sender Email address of the sender
Recipient Email address of the recipient
Source

Count Number of emails

Exchange 2007/10 Mail Size Reports

To search for and generate a report on mail size for all server mail activity for selected
Microsoft Exchange servers during a specified time interval, use the Exchange 2007/10 Mail
Size Real-Time Report.

Menu path: Reports > Mail Activity > Exchange 2007/10 Mail Size

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. By default, the Source Device, Sender, Total Size (Bytes), Max Size
(Bytes), and Count are shown.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Exchange 2007/10 Mail Size Report - Optional Filter Operators

Option Description
Source Device Name of the Microsoft Exchange device
Sender Email address of the sender

Total Size (Bytes)  Total number of bytes transferred
Max Size (Bytes) Maximum number of bytes transferred

Count Number of emails
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Network Activity Reports

To search for and generate reports on information about connections on log sources, use
Network Activity reports.

Choose Reports > Network Activity > report-name from the navigation menu, where
report-name is any one of the following:

Network Activity Reports

Report
Accepted

Connections

Active FW
Connections

Active VPN
Connections

Application
Distribution

Denied Connections

FTP Connections

Description

Use the Accepted Connections screen to search

for and generate a report on IP connections
that were accepted by a log source.

Use the Active FW Connections screen to
search for and generate a report on current
active sessions from the selected firewall log
sources.

Use the Active VPN Connections screen to
search for and generate a report on current
active sessions through Check Point Interface,
Cisco VPN 3000, Nortel Connectivity, and
RADIUS Acct Client log sources.

Use the Application Distribution screen to
search for and generate a report on
information about messages, grouped by
application ports, that were accepted by a
device.

Use the Denied Connections screen to search
for and generate a report on connections
denied by the selected firewall log sources.

Use the FTP Connections screen to search for
and generate a report on syslog messages
related to FTP traffic through the selected
firewall log sources.

More information
Accepted

Connections Reports

Active FW
Connections Reports

Active VPN
Connections Reports

Application
Distribution Reports

Denied Connections

Reports

FTP Connections
Reports
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Report

VPN Access

VPN Sessions

VPN Top Lists

Web Cache Activity

Web Surfing Activity

DHCP Activity

DHCP
Granted/Renewed
Activity

DHCP Denied
Activity

NAT64 Activity

Description

Use the VPN Access screen to search for and
generate a report on the number of VPN
connections that the log source either
completed or denied.

Use the VPN Sessions screen to search for and
generate a report on data about separate
invocations of sessions on log sources during a
specified time interval.

Use the VPN Top Lists screen to search for and
generate a report on the top users and IP
addresses and statistics.

Use the Web Cache Activity screen to search for
and generate a report on locally stored web
information served during a specified time
interval.

Use the Web Surfing Activity screen to search
for and generate a report on web information
served during a specified time interval.

Use the DHCP Activity screen to search for and
generate a report on events related to all DHCP
activity.

Use the DHCP Granted/Renewed Activity screen
to search for and generate a report on events
related to DHCP requests that were granted or
renewed.

Use the DHCP Denied Activity screen to search
for and generate a report on events related to

DHCP requests that were denied.

Use the NAT64 Activity screen to search for and

More information

VPN Access Reports

VPN Sessions
Reports

VPN Top Lists
Reports

Web Cache Activity
Reports

Web Surfing Activity
Reports

DHCP Activity
Reports

DHCP
Granted/Renewed
Activity Reports

DHCP Denied
Activity Reports

NAT64 Activity
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Report Description More information

generate a report on each binding when Reports
sessions are built and destroyed.

Preparing a Real-time Report includes the common options that you specify for all Real-
Time Reports.

Optional filter operators are different for each Network Activity report, and explained in
their respective sections.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Accepted Connections Reports

To search for and generate a report on IP connections that were accepted by selected
firewall log sources during a specified time interval, use the Accepted Connections Real-
Time Report.

o Note:

e Accepted Connections data is summarized in 10 minutes and 1 hour. If the
report time interval is less than 2 hours, the time range is cut to 10
minutes, and if it is more than 2 hours, it is cut to 1 hour.

e To view the detail report, you must enable the Administration > System
Settings > General tab > Enable Accept Detail option. This might require
additional time and storage in downloading this report.

Menu path: Reports > Network Activity > Accepted Connections

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display all the following options:

o Note: Column headings differ for PIX and non-PIX devices.

TIBCO Loglogic® Log Management Intelligence User Guide



161 | Real-Time Reports

Accepted Connections Report - Optional Filter Operators

Option

Source Device

Translated IP

Source IP

Destination IP

Port
Protocol
Description

Messages

In Bytes

Out Bytes

Action

Description

Description of the device that sent these log
messages

IP address as translated by the device*

IP address of the source host (non-PIX devices
only)

IP address of the destination host device (non-PIX
devices only)

Port number (service) of the destination host
Protocol of the destination host
Description of the port (service)

Number of log messages received representing
this connection

Number of incoming bytes (Check Point Interface,
Cisco PIX, and Juniper Firewall only)

Number of outgoing bytes (Check Point Interface,
Cisco PIX, and Juniper Firewall only)

Accept or encrypt - Identifies if the connection
was accepted or accepted with encryption (Check
Point Interface only)

o Note: * Under certain conditions Network Address Translation (NAT) addresses
can show up as 0.0.0.0 in real time reports such as Accepted Connections
Reports. This is not a bug since System Alert messages of a certain type (e.g.,
FWSM-4-106100 in Cisco Catalyst 6500 Series Switches) do not have a translated
(mapped) address present in the logs. Therefore, zero is correct because there is
no relevant IP address in the parsed logs for FWSM-4-106100.
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For information on saving the generated report, see Formats for Saving a Generated
Report.

Active FW Connections Reports

To search for and generate a report on current active sessions through selected Cisco PIX
Firewall log sources, use the Active FW Connections Real-Time Report.

The Active Firewall Connection report is generated by monitoring the start and end
messages of a particular connection in progress. Connections that have generated a start
message but have not yet generated an end message are assumed to be active for a period
of time before being timed-out.

Menu path: Reports > Network Activity > Active FW Connections

In Active FC Connections reports, you must specify the log source:
Element Description
IP Address  IP address for the log source

Port Port number for the log source

Protocol Protocol type (from the list)

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display all the options.

For information on saving the generated report, see Formats for Saving a Generated
Report.

o Note: The generated list displays in real-time. As a result, the last page of
connections might be closed/no longer active by the time you scroll to the last
page. This results in no data displaying in the last page of the report
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Active FW Connections Report - Optional Filter Operators

Option
Create Time

Connection

Protocol

Translated
IP/Port

Source IP/Port

Destination
IP/Port

Direction

Description
Time the session began

ID in the log message assigned to the unique
connection

IP Protocol (TCP, UDP, so on) of the connection

Public (NAT’ed) IP address of the source host (IP
address only)

IP address of the internal host device (IP address
only)

IP address of the external host device (IP address
only)

Inbound or Outbound connection attempt

Active VPN Connections Reports

To search for and generate a report on current active sessions through selected VPN and
RADIUS log sources, use the Active VPN Connections Real-Time Report.

Menu path: Reports > Network Activity > Active VPN Connections

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display all the following options.

For information on saving the generated report, see Formats for Saving a Generated

Report.

o Note: The generated list displays in real-time. As a result, the last page of
connections might be closed/no longer active by the time you scroll to the last
page. This results in no data displaying in the last page of the report.
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Active VPN Connections Report - Optional Filter Operators

Option Description

Source Device Description of the device that sent these log
messages

Connections Number of log messages received representing

connections

Application Distribution Reports

To search for and generate a report that summarizes accepted traffic by application ports
through selected firewall log sources during a specified time interval, use the Application
Distribution Real-Time Report.

Note:
1. The Application Distribution data is summarized in 10 minutes and 1 hour.
If the report time interval is less than 2 hours, the time range is cut to 10
minutes, and if it is more than 2 hours, it is cut to 1 hour.

2. To view the detail report, you must enable the Administration > System
Settings > General tab > Enable Accept Detail option. This might require
additional time and storage in downloading this report.

Menu path: Reports > Network Activity > Application Distribution

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display all the following options.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Application Distribution Report - Optional Filter Operators

Option

Source Device

Port
Protocol
Description
Messages
Src -> Dest
Bytes

Bar Graph

Percentage

Dst -> Src
Bytes

Description

Description of the device that sent these log
messages

Port number (service) of the connection
IP protocol (TCP, UDP, so on.) of the connection
Description of the port (service)

Number of log messages received representing
this connection

Number of outbound bytes sent (not for Nortel
VPN)

Percentage of total outbound bytes represented
as a bar graph

Number of outbound bytes represented as a
percentage

Number of inbound bytes received (not for Nortel
VPN)

Denied Connections Reports

To search for and generate a report on denied connections by selected firewall log sources
during a specified time interval, use the Denied Connections Real-Time Report.

Menu path: Reports > Network Activity > Denied Connections

In addition to setting the common report options in Preparing a Real-time Report, you can

select:

» The type of information the appliance aggregates for the generated report

 Various optional filter operators in the generated report for your appliance
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Denied Connections Report - Summary Methods

Method

Src IP/Any-
-> Any/Port

Src IP/Any
--> Dest
IP/Port

Denied by
Port

Description

Aggregates records from a specific Source IP and any port going to any
destination IP and a specific destination port. The system derives the Source
IP and destination port from your Device Type and Source Device selections.

Aggregates records from a specific Source IP and any port going to a specific
Destination IP and specific Destination port. The system derives the Source IP

and Destination IP from your Device Type and Source Device selections.

Aggregates records from the port numbers only

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display all the following optional filter operators.

For more information on saving the generated report, see Formats for Saving a Generated

Report.

Denied Connections Report - Optional Filter Operators

Option

Source Device

Attempts*
Src IP

Src Port
Dest IP
Dest Port
Protocol

Description

Description

Description of the device that sent these log messages
Number of times log messages denied the connection
IP address of the source host device

Port number of the source host device

IP address of the destination host device

Port number of the destination host device

IP protocol (TCP, UDP, so on.) of the connection

Description of the destination port (service)
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Option Description

Access Group  (Cisco PIX/ASA only) Lists any group of which you are a member

Rules (Check Point Interface only) Condition set on the firewall to complete the
security policy; identifies what is allowed and not allowed through a specific
interface.

Policy ID Unique policy identifier of the device on the firewall (Juniper Firewall only)

Direction (Check Point Interface, Cisco PIX/ASA/FWSM, Juniper Firewall, and Nortel

Connectivity only) Inbound or Outbound connection attempt. Direction is
stored as a number internally, for INBOUND use 1, for OUTBOUND use 2, and
for INTERNAL use 3.

Note: “Attempts” for Cisco router by “src IP/any” are larger than the number
shown in the Denied Connections Report because IP packets are measured in
this instance, instead of the actual number of messages sent.

FTP Connections Reports

To search for and generate a report on all syslog messages related to FTP traffic through
the selected firewall device during a specified time interval, use the FTP Connections Real-
Time Report.

Menu path: Reports > Network Activity > FTP Connections

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display all the options.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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FTP Connections Report - Optional Filter Operators

Option Description

Source Device Description of the device that sent these log
messages

Source Device IP address of the source device that sent these

IP log messages

From IP address of the source device

To IP address of the destination device

Count Number of times syslog messages related to FTP

traffic were generated

VPN Access Reports

To search for and generate reports on the VPN connections that the selected log sources
either completed or denied during a specified time interval, use the VPN Access Real-Time
Report.

Menu path: Reports > Network Activity > VPN Access

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display all the options.

For information on saving the generated report, see Formats for Saving a Generated
Report.

VPN Access Report - Optional Filter Operators

Option Description
Source Device Description of the device that sent these log
messages
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Option Description

Public IP Public IP address originating the VPN connection
Group VPN group of which the source device is a part
User VPN user ID

Target User VPN user ID of the originating VPN connection
Connections Number of log messages received representing

connections

Denies Number of denied connection messages received
Avg Duration Average duration of each connection
Byte Count Number of bytes transferred during the session

Avg Bandwidth Average bandwidth used for each connection
(Bytes/Sec)

Appliances cannot receive disconnected messages. A VPN session is recorded permanently
in the database table authentication after it is disconnected, prior to that the session is
considered active. A Check Point VPN session is considered disconnected when a new
connection attempt is made by the same user from the same IP address.

VPN Sessions Reports

To search for and generate a report on data about VPN sessions (including initiation and
conclusion times) on selected log sources during a specified time interval, use the VPN
Sessions Real-Time Report.

Menu path: Reports > Network Activity > VPN Sessions

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.
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Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display only the Source Device, User, Avg Duration, Avg
Bytes, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

VPN Sessions Report - Optional Filter Operators

Option Description

Source Device Description of the device that sent these log
messages

User User ID

Target User User ID on the device with which the source

device attempted to connect

Source IP IP address of the device that sent these log
messages
Target IP IP address of the device with which the source

device attempted to connect

Avg Duration Average duration of each connection
Avg Bytes Average number of bytes
Count Number of VPN sessions

Appliances cannot receive disconnected messages. A VPN session is recorded permanently
in the database table authentication after it is disconnected, prior to that the session is
considered active. A Check Point VPN session is considered disconnected when a new
connection attempt is made by the same user from the same IP address.

VPN Top Lists Reports

To search for and generate a report on the top users, IP addresses, and other statistics, use
the VPN Top Lists Real-Time Report.
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Menu path: Reports > Network Activity > VPN Top Lists

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Choose the Method from the list. The options are: Top Disconnect Reasons, By IP Address,
and By User. Depending on the method selection, the default column options changes.
Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. The default is to display all the options for Top Disconnect Reasons

For information on saving the generated report, see Formats for Saving a Generated
Report.

VPN Top Lists Report - Types

Report Type Description

Source Device The description of the source device
Connections Number of connections to the source device
Disconnect Reason Reason for disconnection

A Warning: If you run a report for the Top Disconnect Reasons, the “unknown”
that displays in the Disconnect Reasons column, represents the disconnect
reasons reported by RADIUS. If you have not properly plugged in your RADIUS
server, all reasons display as “unknown”. Click a Connections number or Source
Device to drill-down and view the Disconnect Details column. This column
displays the VPN syslog messages associated with the disconnect reason.

Web Cache Activity Reports

To search for and generate a report on all URLs accessed through proxy or cache servers
on specified log sources during a specified time interval, use the Web Cache Activity Real-
Time Report.

Menu path: Reports > Network Activity > Web Cache Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.
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You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Source IP, Destination
IP, Status, Size, Filter Category, Filter Result, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Web Cache Activity Report - Optional Filter Operators

Option

Source Device

Source User
Source IP
Source Host
Domain Name
Destination IP

Destination
Port

Peer IP
Peer Host

Peer Status

Method

URL

Description

Description of the device that sent these log
messages

User of the source device

IP address of the source device
Host name of the source device
Domain name of the source device
IP address of the destination device

Port of the destination device

IP address of the peer device

Host name of the peer device

A code that explains how the request was
handled; for example, by forwarding it to a peer

or returning the request to the source

Request method to obtain an object; for example,
GET

URL requested
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Option Description

Cache Code Information on the result of the transaction: the
kind of request, how it was satisfied, or in what
way it failed

Status HTTP result codes

Type Content type of the object as seen in the HTTP

reply header

Size Number of bytes transferred
Filter The category of the filter
Category

Filter Result The results after using the filter
Count Number of cache views

When you drill down on the report results, there is no default sort-by selection. The drill-
down results are generally in order by time. If you specify a sort-by selection for this
report's drill-down, performance in generating the drill-down results is slower.

Web Surfing Activity Reports

To search for and generate a report on all URLs accessed via firewalls or web servers on
selected log sources during a specified time interval, use the Web Surfing Activity Real-
Time Report.

Menu path: Reports > Network Activity > Web Surfing Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device IP, Source IP, Destination
IP, Status, Size, and Count.

For information on saving the generated report, see Formats for Saving a Generated Report
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Web Surfing Activity Report - Optional Filter Operators

Option

Source Device IP

Source User

Source IP

Source Host
Domain Name
Destination IP
Destination Port

Method

URL

Status

Type

Size
User Agent
Referred By

Count

Description

IP address of the device that sent these log
messages

User ID of the source device

IP address of the device originating the
connection

Host name of the source device
Domain name of the source device
IP address of the destination device
Port of the destination device

Request method to obtain an object; for example,
GET

URL requested
HTTP result codes

Content type of the object as seen in the HTTP
reply header

Number of bytes transferred

Number of syslog messages received for this
connection and status code
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When you drill down on the report results, there is no default sort-by selection. The drill-
down results are generally in order by time. If you specify a sort-by selection for this
report's drill-down, performance in generating the drill-down results is slower.

DHCP Activity Report

To search for and generate a report on events related to all DHCP activity, use the DHCP
Activity Real-Time Report.

Menu path: Reports > Network Activity > DHCP Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, MAC Address, Client
Name, Lease Address, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Optional Filter Operators

Option Description

Source Device Device that sent these log messages
MAC Address MAC IP address

Client Name Name of the client

Lease Address

Action Action taken
Status Status of the activity
Count Number of connections
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When you drill down on the report results, there is no default sort-by selection. The drill-
down results are generally in order by time. If you specify a sort-by selection for this
report's drill-down, performance in generating the drill-down results is slower.

DHCP Granted/Renewed Activity Reports

To search for and generate a report on events related to DHCP requests that were granted
or renewed, use the DHCP Granted/Renewed Activity Real-Time Report.

Menu path: Reports > Network Activity > DHCP Granted/Renewed Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, MAC Address, Client
Name, Lease Address, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Optional Filter Operators

Option Description

Source Device Device that sent these log messages
MAC Address MAC IP address

Client Name Name of the client

Lease Address

Action Action taken
Status Status of the activity
Count Number of connections
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When you drill down on the report results, there is no default sort-by selection. The drill-
down results are generally in order by time. If you specify a sort-by selection for this
report's drill-down, performance in generating the drill-down results is slower.

DHCP Denied Activity Report

To search for and generate a report on events related to DHCP requests that were denied,
use the DHCP Denied Activity Real-Time Report.

Menu path: Reports > Network Activity > DHCP Denied Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, MAC Address, Client
Name, Lease Address, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Optional Filter Operators

Option Description

Source Device Device that sent these log messages
MAC Address MAC IP address

Client Name Name of the client

Lease Address

Action Action taken
Status Status of the activity
Count Number of connections
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When you drill down on the report results, there is no default sort-by selection. The drill-
down results are generally in order by time. If you specify a sort-by selection for this
report's drill-down, performance in generating the drill-down results is slower.

NAT64 Activity Reports

To search for and generate a report on each binding when sessions are built and
destroyed, use the NAT64 Activity Real-Time Report.

Menu path: Reports > Network Activity > NAT64 Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Time, Translated IPv6,
Original IPv4, Original IPv6 Port, Original IPv4 Port, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Optional Filter Operators

Option Description
Source Device Device that sent these log messages
Time Time of connection

Translated IPv6 The translated IPv6 address
Original IPv4 The original IPv4 address
Original IPv6 port  The port of the original IPv6
Original IPv4 port  The port for the original IPv4

Count Number of connections
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When you drill down on the report results, there is no default sort-by selection. The drill-
down results are generally in order by time. If you specify a sort-by selection for this
report's drill-down, performance in generating the drill-down results is slower.

Operational Reports

To search for and generate reports on information about syslog messages on log sources,
use Event Logs reports.

The Report Information tab that appears when you click on Reports > Operational lists
which reports are available for each log source.

Choose Reports > Operational > report-name from the navigation menu, where report-
name is any one of following reports:

Operational Reports

Report

All
Unparsed
Events

Firewall
Statistics

Total
Message
Count

Security

Events

System
Events

Description

Use the All Unparsed Events screen to search for and
generate a report on unparsed syslog messages for selected
devices.

Use the Firewall Statistics screen to search for and generate
a report summarizing firewall syslog messages classified as
security messages.

Use the Total Message Count screen to search for and
generate a report summarizing firewall or Nortel VPN device
syslog messages classified as system messages.

Use the Security Events screen to search for and generate a
report on firewall syslog messages classified as security
messages.

Use the System Events screen to search for and generate a
report on firewall or Nortel VPN device syslog messages
classified as system messages.

More
information

All Unparsed
Events Reports

Firewall
Statistics
Reports

Total Message

Count Reports

Security Events
Reports

System Events
Reports
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Report Description More
information
VPN Events  Use the VPN Events screen to search for and generate a VPN Events
report on the number of Cisco VPN syslog messages that Reports

appear with the type called “System Type”.

Preparing a Real-time Report includes the common options that you specify for all Real-
Time Reports.

Optional filter operators are different for each Event Logs report, and explained in their
respective sections.

For information on saving the generated report, see Formats for Saving a Generated
Report.

All Unparsed Events Reports

To search for and generate a report on syslog messages that are not parsed into the
Security, System, or VPN Events reports, or into any other report table (for example,
Authentication) for selected log sources during a specified time interval, use the All
Unparsed Events Real-Time Report.

Menu path: Reports > Operational > All Unparsed Events

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report. Optional filter operators are not
visible if you select the Boolean Search in the Search Filter criteria.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. By default, the following options are all selected:

For information on saving the generated report, see Formats for Saving a Generated
Report.

All Unparsed Events Report - Optional Filter Operators

Option Description

Source Device Description of the device that sent the log messages
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Option Description

Source Device IP  IP address of the source device that sent the log

messages

Facility Syslog facility associated with the message
Severity Severity code associated with the message

Count Number of times syslog messages were generated

Firewall Statistics Reports

To search for and generate a summary report of event types and messages per firewall, for
selected log sources during a specified time interval, use the All Unparsed Events Real-Time
Report.

Menu path: Reports > Operational > Firewall Statistics

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report. Optional filter operators are not
visible if you select the Boolean Search in the Search Filter criteria.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. By default, the following options are all selected.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Firewall Statistics Report - Optional Filter Operators

Option Description
Source Device Description of the device that sent the log
messages

System Messages  The number of system messages

Security The number of security messages
Messages
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Option Description
Accepted The number of accepted messages
Messages

Denied Messages  The number of denied messages

Total Messages The total number of messages

Total Message Count Reports

To search for and generate a summary report of log messages for selected log sources at a
specified time interval, use the Total Message Count Report.

Menu path: Reports > Operational > Total Message Count

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report. Optional filter operators are not
visible if you select the Boolean Search in the Search Filter criteria.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. By default, the following options are all selected.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Total Message Count Report - Optional Filter Operators

Option Description

Time Time the syslog message was generated

Source Device Description of the device that sent the log messages
Messages The total number of messages
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Security Events Reports

To search for and generate a report on firewall syslog messages classified as security
messages for selected log sources during a specified time interval, use the Security Events
Real-Time Report.

Menu path: Reports > Operational > Security Events

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. By default, the following options are all selected.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Security Events Report - Optional Filter Operators

Option Description

Source Device Description of the device originating the connection

Source Device IP IP address of the source device

Message Code Code number of the security message

Message Code Description of the security message (Cisco PIX only)

Description

Module Juniper Netscreen module name, that is, system (Juniper Firewall
only)
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Option Description
Severity List of severity codes:
0 Emergency: system is unusable
1 Alert: action must be taken
immediately
2 Critical: critical conditions
3 Error: error conditions
4 Warning: warning conditions
5 Notice: normal but significant
condition
6 Informational: informational
messages
7 Debug: debug-level messages
(Juniper Firewall only)
Count Number of syslog messages classified as security messages

generated

System Events Reports

To search for and generate a report on firewall or Nortel VPN device syslog messages
classified as system messages for selected log sources during a specified time interval, use
the System Events Real-Time Report.

Menu path: Reports > Operational > System Events

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.
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Optional filter operators can be sorted in ascending or descending order. Choose sort order
using the list. Optional filter operators are not visible if you select Boolean Search in the
Search Filter criteria. By default, the following options are all selected.

For information on saving the generated report, see Formats for Saving a Generated
Report.

System Events Report - Optional Filter Operators

Option Description

Source Device Description of the device originating the connection

Source Device IP IP address of the source device

Message Code Code number of the security message

Message Code Description of the security message (Cisco PIX only)

Description

Module Juniper Netscreen module name, that is, system (Juniper Firewall
only)
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Option Description
Severity List of severity codes:
0 Emergency: system is unusable
1 Alert: action must be taken
immediately
2 Critical: critical conditions
3 Error: error conditions
4 Warning: warning conditions
5 Notice: normal but significant
condition
6 Informational: informational
messages
7 Debug: debug-level messages
(Juniper Firewall only)
Count Number of syslog messages classified as security messages

generated

VPN Events Reports

To search for and generate a report on Cisco VPN, Check Point VPN, Nortel VPN, or RADIUS
syslog messages of the System Message type for selected log sources during a specified
time interval, use the VPN Events Real-Time Report.

Menu path: Reports > Operational > VPN Events

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

By default, the following options are all selected.
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For information on saving the generated report, see Formats for Saving a Generated
Report.

VPN Events Report - Optional Filter Operators

Option Description

Time Time the syslog message was generated

Source Device IP address of the device originating the
connection

Group VPN group name

User VPN user ID

Public IP Public IP address originating the VPN connection

Severity Severity Code associated with the message

Code Code number of the system message

Area Name of the defined VPN area

Detail Message Text of the syslog message

Appliances cannot receive disconnected messages. A VPN session is recorded permanently
in the database table authentication after it is disconnected, prior to that the session is
considered active. A Check Point VPN session is considered disconnected when a new
connection attempt is made by the same user from the same IP address.

Policy Reports

To search for and generate reports on information about policies that were exercised on a
log source, use Policy reports.

The Report Information tab that appears when you click on Reports > Policy Reports lists
which reports are available for each log source.

Choose Reports > Policy Reports > report-name from the navigation menu, where report-
name is one of:
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Policy Reports

Report

Check Point
Policies

Network Policies

Rules/Policies

ECM Policy

Reports Provide

The Check Point Policies report lists current Check
Point Firewall policy rules on log sources connected to
your Appliance.

Use the Network Policies screen to search for and
generate a report on the number of times a particular
network policy has been exercised by a selected firewall
device.

Use the Rules/Policies screen to search for and
generate a report on enforcement of a particular rule or
policy by a selected firewall device.

Use the ECM Policy screen to search for and generate a
report on data leak protection events captured by the
log source device.

More
information

Check Point

Policies Reports

Network Policies
Reports

Rules/Policies
Reports

ECM Policy
Reports

Preparing a Real-time Report includes the common options that you specify for all Real-

Time Reports.

Optional filter operators are different for each Event Logs report, and explained in their

respective sections.

For information on saving the generated report, see Formats for Saving a Generated

Report.

Check Point Policies Reports

To search for and generate a report listing current Check Point Firewall policy rules on log
sources connected to your appliance, use the Check Point Policy Real-Time Report.

Menu path: Reports > Policy Reports > Check Point Policy

For information on saving the generated report, see Formats for Saving a Generated

Report.
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Check Point Policy Screen Elements

Element Description

LEA Server  LEA servers connected to your system.

Package Security package that Check Point organizes for policy rules. For example, you
can install one package on a firewall, but you can define several packages at the
same time.

Rule Index  Rule numbers (represents Check Point indices) the CPMI process retrieves. You
can view Check Point policy rules only if you configured your LEA server to use
auto discovery (CPMI).

Note: Rule 0 is not assigned by Check Point. It is assigned by LogLogic as a
default for parsed messages that do not automatically have a rule number
assigned by Check Point.

Rule Description of the rule.

Network Policies Reports

To search for and generate a report on the number of times a particular network policy has
been exercised by selected firewall log sources during a specified time interval, use the
Network Policies Real-Time Report.

Menu path: Reports > Policy Reports > Network Policies

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Log Source IP, Source IP, Destination
IP, Destination Port, Signature, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Network Policies Report - Optional Filter Operators

Option Description

Log Source IP IP address of the device that sent these log
messages

Source IP IP address of the device that exercised the policy

Source Port Port of source device

Destination IP IP address of the destination device

Destination Port Port of the destination device

Protocol Protocol of the destination device
Signature Identifier of the policy

Classification Classification of the policy

Priority Priority of the policy

Count Number of times a policy was exercised

Rules/Policies Reports

To search for and generate a report on information about enforcement of a particular rule
or policy by selected firewall devices during a specified time interval, use the Rules/Policies
Real-Time Report.

Menu path: Reports > Policy Reports > Rules/Policies

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display all the following options:

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Rules/Policies Report -

Option

Interface
Rule

Policy

Type

Messages
Bar Graph
Percentage
Package

Rule Description

ECM Policy

Optional Filter Operators

Description

Name (or IP address) of the network interface
that enforced the policy

Rule number that was enforced (Check Point
Interface only)

Policy number that was enforced
Type of rule/policy that was enforced

Number of messages received representing this
policy

Number of messages received expressed as a bar
graph

Number of messages received expressed as a
percentage

Security policy package (Check Point Interface
only)

Displays Rule Details: Source, Destination, Service

Description and Rule Actions: Permit, Deny, so
on. (Check Point Interface only)

Reports

To search for and generate a report on data leak protection events captured by the log
source device use the ECM Policy Real-Time Report.

Menu path: Reports > Policy Reports > ECM Policy

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.
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You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Source Device IP,
Performer Name, Parent Name, Event, Event Name, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

ECM Policy Report - Optional Filter Operators

Option Description
Source Device Device that sent these log messages
Source Device IP [P address of the device that exercised the policy

Performer Name  Name of the performer

Parent Name Name of the parent

Object Name Name of the object that was acted on
Event The type of event

Event Name Name of the event

Source Name Name of the source host device
Count Number of attacks

Enterprise Content Management Reports

To search for and generate reports on information about enterprise content management,
use Enterprise Content Management reports.

The Report Information tab that appears when you click on Reports > Enterprise Content
Management lists which reports are available for each log source.

Choose Reports > Enterprise Content Management > report-name from the navigation
menu, where report-name is one of:
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Policy Reports
Report Reports Provide More
information
ECM Activity Use the ECM Activity screen to generate a report for ECM ECM Activity
activity. Reports
Content Use the Content Management screen to generate a report  Content
Management containing logs of events which correspond to some Management
action done on the contents of the site. Reports
Security Use the Security Settings screen to generate a report Security
Settings containing logs of all the events related to creation, Settings
deletion, modification of user/group/roles. Reports

Expiration and
Disposition

Use the Expiration and Disposition screen to generate a
report containing logs of all events related to object
expiration and disposition approvals.

Expiration and
Disposition
Reports

Preparing a Real-time Report includes the common options that you specify for all Real-

Time Reports.

Optional filter operators are different for each Event Logs report, and explained in their
respective sections.

For information on saving the generated report, see Formats for Saving a Generated

Report.

ECM Activity Reports

To search for and generate a report on ECM activity use the ECM Activity Real-Time Report.

Menu path: Reports > Enterprise Content Management > ECM Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Source Device IP,
Performer Name, Parent Name, Event, and Count.
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For information on saving the generated report, see Formats for Saving a Generated

Report.

ECM Activity Report - Optional Filter Operators

Option

Source Device
Source Device IP
Performer Name
Parent Name
Object Name
Event

Event Name
Source Name
Source IP
Destination IP
Source Port
Destination Port
Protocol

Count

For information on saving the generated report, see Formats for Saving a Generated

Report.

Description

Device that sent these log messages
IP address of the device that exercised the policy
Name of the performer

Name of the parent

Name of the object that was acted on
The type of event

Name of the event

Name of the source host device

IP address of the source host

IP address that was targeted

Port from which the attack originated
Port that was targeted

Protocol of the destination device

Number of attacks
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Content Management Reports

To search for and generate a report containing logs of events which correspond to some
action done on the contents of the site use the Content Management Real-Time Report.

Menu path: Reports > Enterprise Content Management > Content Management

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Source Device IP,
Performer Name, Parent Name, Object Type, Event, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Content Management Report - Optional Filter Operators

Option Description
Source Device Device that sent these log messages
Source Device IP  IP address of the device that exercised the policy

Performer Name Name of the performer

Parent Name Name of the parent

Object Type Type of object that was acted on
Object Name Name of the object that was acted on
Event The type of event

Event Name Name of the event

Source Name Name of the source host device
Count Number of attacks
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Security Settings Reports

To search for and generate a report containing logs of all the events related to creation,
deletion, modification of user/group/roles use the Security Settings Real-Time Report.

Menu path: Reports > Enterprise Content Management > Security Settings

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Source Device IP,
Performer Name, Parent Name, Event, and Count.

For information on saving the generated report, see Formats for Saving a Generated

Report.

Security Settings Report - Optional Filter Operators

Option

Source Device
Source Device IP
Performer Name
Parent Name
Object Name
Event

Event Name
Source Name

Count

Description

Device that sent these log messages

IP address of the device that exercised the policy
Name of the performer

Name of the parent

Name of the object that was acted on

The type of event

Name of the event

Name of the source host device

Number of attacks

For information on saving the generated report, see Formats for Saving a Generated

Report.
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Expiration and Disposition Reports

To search for and generate a report containing logs of all events related to object
expiration and disposition approvals use the Expiration and Disposition Real-Time Report.

Menu path: Reports > Enterprise Content Management > Expiration and Disposition

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Source Device IP,
Performer Name, Parent Name, Object Name, Event, Event Name, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Expiration and Disposition Report - Optional Filter Operators

Option Description
Source Device Device that sent these log messages
Source Device IP  IP address of the device that exercised the policy

Performer Name Name of the performer

Parent Name Name of the parent

Object Name Name of the object that was acted on
Event The type of event

Event Name Name of the event

Source Name Name of the source host device
Count Number of attacks
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HP NonStop Audit

To search for and generate reports on information about HP NonStop systems and
generate Audit and EMS log data , use HP NonStop Audit reports.

The Report Information tab that appears when you click on Reports > HP NonStop Audit
lists the reports that are available for each log source.

Choose Reports > HP NonStop Audit > report-name from the navigation menu, where
report-name is one of:

HP NonStop Audit Reports

Report

Configuration
Changes

Failed and
Successful
Logins

Object Changes

HP NonStop
Audit Activity

User Actions

Object Access

Reports Provide

Use the Configuration Changes screen to generate a
report for all configuration changed done on an HP
NonStop server during a specified time.

Use the Failed and Successful Logins screen to generate
a report for all successful and failed logins on an HP
NonStop Audit server.

Use the Object Changes screen to generate a report for
all objects that are accessed on an HP NonStop Audit
server.

Use the HP NonStop Audit Activity screen to generate a
report for all audit activities on an HP NonStop Audit
server.

Use the User Actions screen to generate a report for all
user actions done on an HP NonStop Audit server.

Use the Object Access screen to generate a report for a
list of all objects created, deleted, or modified on an HP
NonStop Audit server.

More
information

Configuration
Changes
Reports

Failed and
Successful
Logins Reports

Object Changes
Reports

HP NonStop
Audit Activity
Reports

User Actions
Reports

Object Access
Reports

Preparing a Real-time Report includes the common options that you specify for all Real-

Time Reports.
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Optional filter operators are different for each Event Logs report, and explained in their
respective sections.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Configuration Changes Reports

To search for and generate a report on all configuration changes done on an HP NonStop
server during a specified time use the Configuration Changes Real-Time Report.

Menu path: Reports > HP NonStop Audit > Configuration Changes

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, User Name, Creator User
Name, Target User, Event Name, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Configuration Changes Report - Optional Filter Operators

Option Description

Source Device Device that sent these log messages
User Name Name of the user making the inquiry
Creator User Username of the creator

Name

Target User User for whom the inquiry is being made
User Group Name of the group

Reported Time Time the event was reported
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Option Description

Process Name Name of the process

Event Name Name of the event

Object Type Type of object that was acted on
Action Action taken

Status Status of the connection

Count Number of attacks

Failed and Successful Logins Reports

To search for and generate a report for all successful and failed logins on an HP NonStop
Audit server use the Failed and Successful Logins Real-Time Report.

Menu path: Reports > HP NonStop Audit > Failed and Successful Logins

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, User Name, Creator User
Name, Target User, Event Name, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Failed and Successful Logins Report - Optional Filter Operators

Option Description

Source Device Device that sent these log messages
User Name Name of the user making the inquiry
Creator User Username of the creator
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Option Description

Name

Target User User for whom the inquiry is being made
User Group Name of the group

Reported Time Time the event was reported
Process Name Name of the process

Event Name Name of the event

Object Type Type of object that was acted on
Action Action taken

Status Status of the connection

Count Number of attacks

Object Changes Reports

To search for and generate a report for all objects that are accessed on an HP NonStop
Audit server use the Object Changes Real-Time Report.

Menu path: Reports > HP NonStop Audit > Object Changes

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, User Name, Creator User
Name, Target User, Event Name, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Object Changes Report - Optional Filter Operators

Option
Source Device
User Name

Creator User
Name

Target User
User Group
Reported Time
Process Name
Event Name
Object Type
Action

Status

Count

Description
Device that sent these log messages
Name of the user making the inquiry

Username of the creator

User for whom the inquiry is being made
Name of the group

Time the event was reported

Name of the process

Name of the event

Type of object that was acted on

Action taken

Status of the connection

Number of attacks

HP NonStop Audit Activity Reports

To search for and generate a report for all audit activities on an HP NonStop Audit server
use the HP NonStop Audit Activity Real-Time Report.

Menu path: Reports > HP NonStop Audit > HP NonStop Audit Activity

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.
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You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, User Name, Creator User
Name, Target User, Event Name, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

HP NonStop Audit Activity Report - Optional Filter Operators

Option Description

Source Device Device that sent these log messages
User Name Name of the user making the inquiry
Creator User Username of the creator

Name

Target User User for whom the inquiry is being made
User Group Name of the group

Reported Time Time the event was reported
Process Name Name of the process

Event Name Name of the event

Object Type Type of object that was acted on
Action Action taken

Status Status of the connection

Count Number of attacks

User Actions Reports

To search for and generate a report for all user actions done on an HP NonStop Audit
server use the User Actions Real-Time Report.
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Menu path: Reports > HP NonStop Audit > User Actions

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, User Name, Creator User
Name, Target User, Event Name, Action, Status, and Count:

For information on saving the generated report, see Formats for Saving a Generated
Report.

User Actions Report - Optional Filter Operators

Option Description

Source Device Device that sent these log messages
User Name Name of the user making the inquiry
Creator User Username of the creator

Name

Target User User for whom the inquiry is being made
User Group Name of the group

Reported Time Time the event was reported
Process Name Name of the process

Event Name Name of the event

Object Type Type of object that was acted on
Action Action taken

Status Status of the connection

Count Number of attacks
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Object Access Report

To search for and generate a report for a list of all objects created, deleted, or modified on
an HP NonStop Audit server use the Object Access Real-Time Report.

Menu path: Reports > HP NonStop Audit > Object Access

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, User Name, Creator User
Name, Target User, Event Name, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Object Access Report - Optional Filter Operators

Option Description

Source Device Device that sent these log messages
User Name Name of the user making the inquiry
Creator User Username of the creator

Name

Target User User for whom the inquiry is being made
User Group Name of the group

Reported Time Time the event was reported
Process Name Name of the process

Event Name Name of the event

Object Type Type of object that was acted on
Action Action taken
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Option Description
Status Status of the connection
Count Number of attacks

IBM z/0OS Activity

To search for and generate reports on information about IBM z/0S system generated

operational and audit logs in binary format,

use IBM z/OS Activity reports.

The Report Information tab that appears when you click on Reports > IBM z/0S Activity
Reports lists which reports are available for each log source.

Choose Reports > IBM z/0S Activity Reports > report-name from the navigation menu,

where report-name is one of:

IBM z/Activity Reports

Report Reports

Provide

Use the
Resource Access
screen to
generate a
report for
resource access
on z/0S.

Resource Access

Security Modifications Use the Security
Modification
screen to
generate a
report for
security
modification on

z/0S.
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Report Reports More information
Provide

System Use the System  System
Access/Configuration Access/ Access/Configuration

Configuration Reports

screen to

generate a

report for

access and

configuration

on z/0S.

Unix System Services Use the Unix Unix System Services
System Services  Reports
screen to
generate a
report for Unix
system services
on z/0S.

Login/Logout Use the Login/Logout Reports
Login/Logout
screen to
generate a
report for login
and logout
activities on
z/0S.

Violation Use the Violation Reports
Violation screen
to generate a
report for
violation
activities on
z/0S.

Preparing a Real-time Report includes the common options that you specify for all Real-
Time Reports.
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Optional filter operators are different for each Event Logs report, and explained in their
respective sections.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Resource Access Reports

To search for and generate a report on resource access on z/OS use the Resource Access
Real-Time Report.

Menu path: Reports > IBM z/OS Activity > Resource Access

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Record Type
Description, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Resource Access Report - Optional Filter Operators

Option Description
Source Device Device that sent these log messages

Record Type ID The ID of the record type

Record Type Description of the record type
Description

SubType Description of the sub type
Description

Event Type Type of event in the journal type

Logon ID/User ID A user ID or login ID involved in the recorded
event
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Option Description

Job Name Name of the journal job or the job that was the
target of the action described in the entry

Target Object Name of the object that was acted on

Name

Target Object Type of target object that was acted on

Type

Action Action taken

Status Status of the connection

Count A count of action attempts, entries, or other
count information dependent on journal and
entry type.

Security Modifications Reports

To search for and generate a report for security modification activities on z/OS use the
Security Modifications Real-Time Report.

Menu path: Reports > IBM z/0S Activity > Security Modifications

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Record Type
Description, Event Type, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Security Modifications Report - Optional Filter Operators

Option
Source Device
Record Type ID

Record Type
Description

SubType
Description

Event Type

Logon ID/User ID

Job Name

Target Object

Name

Target Object
Type

Action
Status

Count

Description
Device that sent these log messages
The ID of the record type

Description of the record type

Description of the sub type

Type of event in the journal type

A user ID or login ID involved in the recorded
event

Name of the journal job or the job that was the
target of the action described in the entry

Name of the object that was acted on

Type of target object that was acted on

Action taken
Status of the connection

A count of action attempts, entries, or other
count information dependent on journal and

entry type.

System Access/Configuration Reports

To search for and generate a report for access and configuration activities on z/OS use the

System Access/Configuration Real-Time Report.
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Menu path: Reports > IBM z/0S Activity > System Access/Configuration

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Record Type
Description, Event Type, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated

Report.

System Access/Configuration Report - Optional Filter Operators

Option
Source Device
Record Type ID

Record Type
Description

SubType
Description

Event Type

Logon ID/User ID

Job Name

Action
Status

Count

Description
Device that sent these log messages
The ID of the record type

Description of the record type

Description of the sub type

Type of event in the journal type

A user ID or login ID involved in the recorded
event

Name of the journal job or the job that was the
target of the action described in the entry

Action taken
Status of the connection
A count of action attempts, entries, or other

count information dependent on journal and
entry type.
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Unix System Services Reports

To search for and generate a report for Unix system services on z/OS use the Unix System
Services Real-Time Report.

Menu path: Reports > IBM z/0S Activity > Unix System Services

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Record Type
Description, Event Type, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated

Report.

Unix System Services Report - Optional Filter Operators

Option
Source Device
Record Type ID

Record Type
Description

SubType
Description

Event Type

Logon ID/User ID

Job Name

Target Object
Name

Description
Device that sent these log messages
The ID of the record type

Description of the record type

Description of the sub type

Type of event in the journal type

A user ID or login ID involved in the recorded
event

Name of the journal job or the job that was the
target of the action described in the entry

Name of the object that was acted on
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Option Description

Target Object Type of target object that was acted on

Type

Action Action taken

Status Status of the connection

Count A count of action attempts, entries, or other
count information dependent on journal and
entry type.

Login/Logout Reports

To search for and generate a report for login and logout activities on z/0OS use the
Login/Logout Real-Time Report.

Menu path: Reports > IBM z/0S Activity > Login/Logout

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Record Type
Description, Event Type, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Login/Logout Report - Optional Filter Operators

Option Description
Source Device Device that sent these log messages
Record Type ID The ID of the record type

Record Type Description of the record type
Description
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Option Description

SubType Description of the sub type
Description

Event Type Type of event in the journal type

Logon ID/User ID A user ID or login ID involved in the recorded

event
Target User User for whom inquiry is being made
Job Name Name of the journal job or the job that was the

target of the action described in the entry

Action Action taken

Status Status of the connection

Count A count of action attempts, entries, or other
count information dependent on journal and
entry type.

Violation Reports

To search for and generate a report for violation activities on z/OS use the Violation Real-
Time Report.

Menu path: Reports > IBM z/0S Activity > Violation

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Record Type
Description, Event Type, Action, Status, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Violation Report - Optional Filter Operators

Option

Source Device

Record Type ID

Record Type
Description

SubType
Description

Event Type

Logon ID/User ID

Target User
Job Name
Target Object
Name

Target Object
Type

Violation
Occurred

Action
Status

Count

Description
Device that sent these log messages
The ID of the record type

Description of the record type

Description of the sub type

Type of event in the journal type

A user ID or login ID involved in the recorded
event

User for whom inquiry is being made

Name of the journal job or the job that was the
target of the action described in the entry

Name of the object that was acted on

Type of target object that was acted on

Action taken
Status of the connection
A count of action attempts, entries, or other

count information dependent on journal and
entry type.
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Storage Systems Activity Reports

To search for and generate reports on information about file and directory access, use
Storage Systems Activity reports.

The Report Information tab that appears when you click on Reports > Storage Systems
Activity Reports lists which reports are available for each log source.

Menu path: Reports > Storage Systems Activity Reports > report-name

Storage Systems Activity Reports

Report Reports Provide More
Information
Filer Use the Filer Access screen to generate a report for individual Filer Access
Access file and directory access events such as user, timestamp, result, Reports
on z/0S.

Preparing a Real-time Report includes the common options that you specify for all Real-
Time Reports.

Optional filter operators are different for each Event Logs report, and explained in their
respective sections.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Filer Access Reports

To search for and generate a report for individual file and directory access events use the
Filer Access Real-Time Report.

Menu path: Reports > Storage Systems Activity > Filer Access

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, User, Filer IP, Filer
Name, Action, Status, and Count.
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For information on saving the generated report, see Formats for Saving a Generated
Report.

Filer Access Report - Optional Filter Operators

Option Description

Source Device Device that sent these log messages
User User who is making the inquiry
Source IP IP address of the source host device
Target User User for whom inquiry is being made
Filer IP IP address of the filer

Filer Name name of the filer

Action Action taken

Status Status of the connection

Count Number of connections

Flow Activity Reports

To search for and generate reports on information about application usage, user browsing
and top users, use Flow Activity reports.

The Report Information tab that appears when you click on Reports > Flow Activity
Reports lists which reports are available for each log source.

Choose Reports > Flow Activity Reports > report-name from the navigation menu, where
report-name is one of:
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Flow Activity Reports
Report Reports Provide More
information

Application Use the Application Usage screen to generate a report Application Usage
Usage for application usage seen across all traffic. Reports
User Use the User Browsing Statistics screen to generate a User Browsing
Browsing report for site destination statistics by user. Statistics Reports
Statistics
Top Users Use the Top Users screen to generate a report for top Top Users

traffic users. Reports

Preparing a Real-time Report includes the common options that you specify for all Real-
Time Reports.

Optional filter operators are different for each Event Logs report, and explained in their
respective sections.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Application Usage Reports

To search for and generate a report for application usage seen across all traffic use the
Application Usage Real-Time Report.

Menu path: Reports > Flow Activity > Application Usage

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Time, Category,
Application Name, Bar Graph, Percentage, Total Traffic, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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Application Usage Report - Optional Filter Operators

Option Description

Source Device Device that sent these log messages
Time Time of connection

Category The type of category

Application Name Name of the application

Bar Graph Percentage of total bytes represented as a bar
graph

Percentage Number of bytes represented as a percentage

Total Traffic Total amount of traffic

Count Number of connections

User Browsing Reports

To search for and generate a report for site destination statistics by user use the User
Browsing Statistics Real-Time Report.

Menu path: Reports > Flow Activity > User Browsing Statistics

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Time , User IP,
Destination Name, and Number of times Accessed.

For information on saving the generated report, see Formats for Saving a Generated
Report.
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User Browsing Statistics Report - Optional Filter Operators

Option Description

Source Device Device that sent these log messages
Time Time of connection

User IP IP address of the user making the inquiry
Destination IP address that was targeted

Address

Number of times  The number of times accessed
Accesses

Top Users Reports

To search for and generate a report for top traffic users use the Top Users Real-Time
Report.

Menu path: Reports > Flow Activity > Top Users

In addition to setting the common report options in Preparing a Real-time Report, you can
select optional filter operators in the generated report.

You can select to view various options in ascending or descending order. Choose the sort
order by using the list. The default is to display the Source Device, Time , User IP, Bar
Graph, Percentage, Total Traffic, and Count.

For information on saving the generated report, see Formats for Saving a Generated
Report.

Top Users Report - Optional Filter Operators

Option Description
Source Device Device that sent these log messages
Time Time of connection
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Option Description

Category The type of category

User IP IP address of the user making the inquiry

Bar Graph Percentage of total bytes represented as a bar
graph

Percentage Number of bytes represented as a percentage

Total Traffic Total amount of traffic

Count Number of connections

All Saved Reports

The All Saved Reports screen displays a list of all saved reports for specific types of data
based on search expressions and time intervals you have defined and saved in the past.

All saved searches and types, such as Index Search, RegEx Search, Index Report, and so on,
that are stored in the system are visible on this page.

You can click the Run icon and regenerate the report with a different time range, or click
the Edit icon and change the saved report parameters before rerunning the report. All
options are available, not just the ones originally selected. You can customize the new
report using new filters and wildcards. You can also filter the list of saved reports displayed
by title or by typing a key word from the report title in the Find field and pressing the
Enter key. The key word or words are highlighted in the resulting list. To restore the full list
of saved reports, clear the Find field and press the Enter key again.

For more information on saving the generated report, see Formats for Saving a Generated
Report.
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User Preferences

The admin icon on the home page allows you to set values for your Account Information,
System Preferences, and to Change Password.

Viewing Your LogApp Account

Procedure
1. Click the user icon on the home page.

2. Review and accept or change the default settings as explained in the Account
Options table.

Account Options

Element Description
Account Information
User Login  The login name of the current user.

Email The email address of the current user. This can be reset by the system
Address administrator or user.

System Preferences

Rows per The number of rows that display in each report page. Can be set from 10
Page to 1000 rows by user.

Page The page refresh rate in seconds. Can be set from 30 to 600 seconds by
Refresh user.

Rate

Session Session Timeout can be set from 5 to 300 minutes by user. The default is
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Element Description
Timeout 300 minutes (5 hours).
Enable Checking this check box enables display of multiple lines in PDF and
Multiline HTML reports.
View
Login The page that appears immediately after logging into the LoglLogic LMI
Landing appliance. You can change this at any time. For instructions, see Changing
Page Login Landing Page.

3. Click Save.

Changing the Login Landing Page

The login landing page appears immediately after logging in to the LoglLogic LMI appliance.
The LogLogic Overview page is the default landing page. To change the landing page,
perform the following steps.

Procedure

1. Click the user icon at the top of the home page.

2. From the Login landing page list, select a page from the following options:

LogLogic Overview
Triggered Alerts
Index Search

All Saved Reports

All Saved Searches
Advanced Dashboard
Advanced Search

Monitoring Console

3. Click Save.
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Result

The next time you log in to the appliance, the new home page that you selected in this
step is displayed.

Changing the Account Password

You can change your password at any time.

Procedure

1. Click the user icon on the home page.

2. Click the Change Password button.

3. The Change Password dialog box appears. It displays date of last password update.

4. In the Current Password field, enter your current password.

5. In the New Password field, enter your new password as per the password
requirements specified on the window.
By default, the password must be at least six characters, containing at least one non-
alphabetical character, and cannot be the same as the user ID. Spaces at the
beginning and end of the password are removed before being stored in the system.
The password requirements might differ if password control has been enabled in
LogLogic LMI.

6. In the Confirm New Password field, enter your new password again for verification.
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Advanced Features

This section describes advanced features in LoglLogic LMI.

By default, these features are disabled. A user with administrator privileges can enable the
Advanced Features, or set up a High Availability pair for Advanced Features, or both. For
more information on enabling the features or setting up High Availability, see TIBCO
LogLogic® Log Management Intelligence Administration.

Advanced Search

Advanced Dashboards

Bloks: Filter Bloks, Correlation Bloks, and Time Bloks
Data Models

Enrichment Lists

Exporting and Importing Configurations

Only an administrator with CLI access using root can use this feature. For more
information on exporting and importing configurations, see the "Import or Export
Entities Between Appliances" section in TIBCO LogLogic® Log Management Intelligence
Administration.

Monitoring Console
Monthly index
Queries

° Search queries

© Scheduled queries

° Tail queries

o Distributed Advanced Search queries
REST API support for Advanced Search
Rule Management:

o Triggers
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° Aggregation rules

° Distributed aggregation rules

Important Considerations

° You cannot access advanced features on a standby node in a high availability
setup. However, you can access them from the public IP address or the IP
address of the active node.

Before configuring HA, you must disable Advanced Features on both active and
standby appliances.

° Use caution when enabling advanced features on LX4025, ST4025, MX4025,
ST2025-SAN, or LX1025R1 models, because the memory requirements of these
features when in use might cause performance issues. Also, continuous use of
Advanced Features on these models can cause the appliance to run out of
memory and lead to engine restarts or failure.

° On an appliance where the memory is less than the minimum required 32 GB,
you cannot enable Advanced Features from the GUI. You must enable it from
the CLI, by running the system logu enable command.

° For information about the behavior of Advanced Aggregation and Monitoring
Console features after upgrading to LoglLogic LMI 6.4.0, see the Upgrade
Considerations section in TIBCO LogLogic® Log Management
Intelligence Configuration and Upgrade.

Advanced Search

Using Advanced Search, you can easily interact with your data. You can run simple and
complex searches, save search elements and time ranges in the form of Bloks, and retrieve
results to analyze failures or other anomalies.

The simple search mechanism retrieves all events that match the search terms. Advanced
searches retrieve results by a "pipeline" concept, where expressions are separated by pipes
("|"). LogLogic LMI uses Event Query Language (EQL), which is an intuitive and efficient
search query language that enables you to search large data and view results in seconds. A
Structured Query Language (SQL) dialect is also supported.

For more information about how to form a search query and sample queries, see Search
Syntax Reference.
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You must specify the time in the Search or Time field. The Search and Time fields can be
combined (by using AND) or used individually as described:

« If you define the time in either the Search or Time field, the results are retrieved for
the specified time period.

 If you define the time in both, the Search field and the Time field, the results are
retrieved for the time period that is common to both the fields.

Note: All dates and time values are defined in the local time zone of the
installed system. They are not based on the browser’s time zone.

By navigating to Management > Advanced Features > Queries and then to the Search
page, you can view search queries that are currently running or are completed. From this
page, you can select and delete any query, if required. Deleting the query from this page
closes the search tab for that query from the Advanced Search page.

o Note: Queries used in Advanced Dashboards are not listed on this page.

For complex queries, you can create different types of Bloks that can be reused in future
searches. Bloks are query fragments that can be easily referenced from queries. For
detailed steps about how to build and use Bloks, see Bloks.

For sample search examples, see Search Examples.

On the Advanced Search page, you can click to open multiple search tabs. You can run
multiple searches using different search elements on the same data to analyze any
anomalies.
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The Search Field

You can enter queries in any of the supported languages (SQL or EQL), retrieving data from
data models, with filters of any kind such as LIKE, regular expressions, comparison
operators, math, functions, and so on. You can use single or multiple terms.

e To start an EQL statement, enter USE.

e To start an SQL statement, enter SELECT.

You can also search data based on Bloks. For details on how to add a new Blok or use the
existing Bloks, see Bloks.

For example, enter the following query in the Search field to retrieve events from the
system data model within the last hour:

use system | sys_eventTime in -1h:NOW

The system data model refers to all the data in the system.
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o Note: Copying a query from a Rich Text Format (RTF) application (such as
Microsoft Word) to LoglLogic LMI might interfere with query processing. For
example, when you copy the query, extraneous characters might be added, or
straight quotation marks (") might be replaced with curly quotation marks (”),
which are not part of a correct query string. Therefore, when copying from a
rich-text source, review the search query syntax and correct any errors before
proceeding.

When used in an Advanced Search query or an expression, the name must be enclosed in
square brackets ([ ]) in any of the following scenarios:

Name Examples

starts with a number  [123]
[12model]

[1col_0]

contains a hyphen [data-a]
[-coll]

[aBc-]
contains all numbers  [1234]

contains a space [abc model]

To view system notifications, if any, click the icon in the upper-right corner of the page.

To close all search tabs at once, click the Close icon (X).

To view search results, click the Run button m

Additional assistance

You can use the following components to help you form a query quickly:
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Log source picker

Instead of using data model names in the Advanced Search query, you can search by
specific log sources. Click Select Log Sources, and then select multiple log sources from
the log source picker. A query is automatically generated and displayed in the search
field. For more information, see Log Source Picker.

Content Assist

You can use suggestions from a content assistant to help you create the search query.
As you start typing, the Content Assist feature shows contextual matches and
completions for each keyword into the Search field. For more information, see Content
Assist.

Content Assist

The Content Assist feature shows type-ahead or contextual matches and completions for
each keyword as you type in the Search field.

These contextual matches are retrieved from your data. You can get assistance for
language syntax, column names, data model names, recent search history, and Blok
names. You can disable Content Assist by clicking the Disable Content Assist button.

As you start typing in the Search field, the Content Assist panel is displayed:
» Suggestions help you build your search query by suggesting the next matching term.

e Models let you choose data models to be used in your query. Data models are the
equivalent of tables in SQL.

» History displays all recent search entries that you can choose from to run a query.
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Select Log Sources e USE
Suggestions  Models  History Clear query
FY FY
Loglogic_Database_Table_Status
EQL symtax

Cizco_ASA EQL Symtax EQL, Event Query Language, is useful for

finding patterns in datasets and for correlating events.
Guardium_SOLGuard_Audit With EQL, you can define fileers, regular expressions,
sources, and time ranges. The EQL guery is composed of
one or More expressions, separated by a pipe delimiter | |

Apache_WebServer ' == - )
)} Pipe-delimited expressions are cumulative.

Cisco_ESA Examples

- -

Click the term to select and add it in the Search field.

Log Source Picker

Instead of using data model names in the Advanced Search query, you can select log
sources from the log source picker, and a query including the selected sources is generated
for you. You can also use filters to create a dynamic rule to generate the search query.

The generated query includes the system data model and a filter for the selected log
sources. For example:

USE system | sys_device IN ('::ffff:198.51.100.2_
otherUnix','::ffff:198.51.100.3_otherUnix")

USE system | DeviceInGroup("All Other Unix") OR sys_device = '::1
logapp'

USE system | sys_concentratorId IN ('198.51.100.2', '198.51.100.30")

Limitations

The log source picker in Advanced Search has the following limitations:
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e Even if you have access permissions to Remote Appliances in a Management Station
setup, you cannot specify a Remote Appliance in the log source picker and then
select the log sources created on that appliance.

* In the generated query, only the system columns are displayed in the results and in
the Columns panel, and you can filter the results by the system columns. To make
other data model columns available for filtering or parsing, you must replace the
system data model with the appropriate one in the search query. For example:

USE Other_UNIX | sys_device IN ('::ffff:127.0.0.1_
otherUnix','::ffff:10.128.132.92_otherUnix"')

For steps about using the log source picker and creating a dynamic rule, see Selecting Log
Sources.

Selecting Log Sources

If you use the log source picker to select log sources, an Advanced Search query including
the selected log sources is automatically generated for you. Then you can specify the time
range in the Time field and run the query.

Procedure
1. Click the Select Log Sources button to open the log source picker.

2. From the List of Log Sources pane, select the check box of the required log sources.

You can filter the list of log sources by the following parameters. After selecting a
filter, type the value or select from the drop-down list to filter further:

Filter field Additional information field

Device Name Enter the device name or select from the list

Group Name Enter the device group name or select from the list

Type Enter a source type (a specific device type) or select from the list.

In a Management Station setup, you can select Remote Appliance as
the type
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Filter field Additional information field

Collector Enter the name of the collector domain.
Domain

Description Enter a description of the log source.

IP Address Enter the specific IP address of the log source.

You can apply multiple filters by clicking the + button. Click Reset filters to clear all
filters.

You can also use the Search field to filter the list of devices and then select from the
filtered list.

3. To add the selected devices and filters to the Selected Log Sources pane, select the
log sources and then click Add Selected Log Sources.

4. (Optional) To add a large number of devices, you can create a dynamic rule that
contains all listed devices. You can create multiple rules, if required.

a. Use a filter to retrieve the list of devices.
b. Click Add Filters as a Rule.

c. Enter a name for the dynamic rule in the dialog box and click Create.

A dynamic rule containing the listed devices is created and displayed in the Selected
log sources pane.

o Note: The dynamic rules created in a Search tab can be used only in the
same Search tab and until the Search tab is active.

5. Review the list of log sources in the Selected log sources pane. Repeat the steps, if
required, to add log sources by filters, or by selecting their check boxes, or by
creating more dynamic rules.

Note: You can remove selected sources or dynamic rules by clicking
Delete source.

6. Click Set.
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Result

A search query that includes the selected log sources is automatically generated and
displayed in the search field.

If you selected remote appliances as log sources, then:

e Selecting one appliance adds sys_concentratorId = 'IP' in the search query;
where /P is its IP address.

e Selecting multiple appliances adds sys_concentratorId IN ('IP1', 'IP2') in the
search query; where IP1 and /P2 are their IP addresses.

» Using the Type filter to add all appliances adds sys_concentratorId IN ('ALL') in
the search query; where ALL indicates that all remote appliances and the
management station are included.

What to do next
Specify the time range in the Time field and then click the Run button m to run the

query.

The Time Field

In the Time field, you can enter absolute and relative time ranges.

You can also search based on Bloks.

From the Search tab, enter the time period in the Time field and click the Run button
m. For details on how to add a new time Blok or use the existing Blok, see Time
Bloks.

Note: All dates and times are defined in the local time zone of the appliance
rather than being based on the client system time zone.

For example, enter -5h to retrieve all events that occur in the last 5 hours.
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o Note: The Time field must be empty when using infrastructure search queries.

An example of invalid infrastructure search query is:

use Loglogic_Config_Bloks | sys_eventTime in -5d

Search Results

After running a search query, you can view search results in the Result tab.

You can visualize results using Timeline Charts or Data panel. After running a query, if you
retrieve lots of results, you can group the results without having to issue a new query, and
then drill-down into the information. You can see both aggregated counts as well as create
visualization elements to better isolate trends and issues. You can include multiple filters
to narrow your results. Create a filter in the context of an event, and view results based on
a specific filter.

After clicking Run, a progress bar is displayed above the search tab name showing the
progress of the query. Based on your data, it might take a few minutes to retrieve results
into all panels. By default, results are returned in ascending order. After the query is run,
the number of results is displayed above the tab name. Twenty results are displayed per
page. You can jump to other pages using the pagination controls at the bottom of the
panel.

If you use a GROUP_BY clause in the query, you can save the query as an aggregation rule
by clicking the icon D

o Note: By default, a maximum of 100,000 results are displayed in the Result tab.
To increase the limit, use the LIMIT clause in your query. For details, see LIMIT
Statement.

Querying a large data set using Advanced Search might display an error or an
exception if the result contains more than a few million records.

e LoglLogic_Monitor_Cpu
e Loglogic_Monitor_Cpu_Load

» Loglogic_Monitor_Diskspace
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e LoglLogic_Monitor_Memory
e Loglogic_Monitor_Node_Memory

Click the Add icon 7] to add multiple result tabs to view the same data in different forms.
When results are grouped together, a new Result tab is displayed showing the grouped
results for the selected value.

Tip: If you are using multiple search tabs, closing a tab that is no longer
required frees the memory being used for displaying search results.

The Result tab is divided into the following panels:

e Data display data in raw format and normalized tabular format on the Raw data and
Table tabs within the panel.

e Columns provide all available columns and their associated values based on each
search query. You can turn the Columns view off by using the switch on the top of
the panel.

e Timeline Charts display the distribution of events in time using a line chart at the top
of the panel. The Timeline Charts view is on by default. You can turn the view off by
using the slider at the top of the panel.

* Filters displays the filters you have used in the results. You can filter the search
results based on time range or column values. You can also edit the filter values.
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To page through the results, click the next arrow; to return to the previous page click the
previous page arrow. You can also return to the first page or go to the last page by clicking
on the first page and last page arrows, respectively. You can also jump to a page by
entering the page number in the Go to field.

Timeline Charts

A chart is a visual representation of your data against time. By using elements such as lines
(in a line chart), a chart displays a series of numeric data in a graphical format.

You can add multiple result tabs to view the same data in different formats. The timeline
chart displays the event distribution for a specified time period. You can use different
options to view chart details, zoom in and out of the chart, and show or hide the chart
panel.

Note: Timeline charts are not available in GROUP BY queries. In case of queries
that do not require a time filter (such as infrastructure queries), timeline charts
are off by default. If turned on, the message No data to display is displayed.

From the Timeline Charts panel, you can perform the following tasks:

TIBCO Loglogic® Log Management Intelligence User Guide




238 | Advanced Features

¢ Showing or hiding the Timeline Charts panel

Click the slider icon Lo § located in the upper-right corner of the results to show
or hide the panel.

Zooming in or zooming out of timeline charts

You can zoom in or zoom out of a particular area of the timeline chart using the
time-range picker.

Raw Table Columns m Wordwrap u Charts m El & B
I

f13:30 i 1345

Grab the handles on the X-axis time-range picker, it turns into a slider. Drag the slider
across the X-axis to define the time range that you want to zoom in. The timeline
chart is updated for the selected time.

The following timeline chart displays the zoomed in data for a specified time range
and the Data panel shows the filtered results for the corresponding time range.

Resul.. +
"l Columns 9 columns found @ Raw Table Columns m Wordwrap m Charts m El & m
—
Q search {
[v] selectal Y A T | S | T |
" 13:30 12:40 13:50 14:00
sys_eventTime oo » 12:35 13:45 13:55 14:05
Il_deviceTypelD » i i
fig:30 R . JAES ) o0
n
|_evertstartTime 4 1 4
e 1. 2019-03-28 06:57:01.000 =<T14=Mar 28 13.27:01 logapp MGMT: ®LOGLOGIC-6 module:engine_collector(26746); -
Y Filters filters found file:stlog.cinsertBFQMetaData,677); action:STDF: INSERT INTQ logapprirpt.stDataFiles (time,
filename, messages, timespan, originalFilesize, checksum, checksumType, compressed,
X compressedFilesize, compressicnLevel, expiration, indexRetention insertOrderfileKey) VALUES
sys_eventTime X ; ; . ; . - -
(1553779560, Yloglogic/data/vol1/2019/03/28/1300/rawdata_10027_1553779560_60-365.txt.gz',
BETWEEN 2012-03-28 27, 60, 4730, '724b5bda035a498ab6bbd3eadfeSadt', 1, 1, 262144, 1, 1585315621,
06:27:01.000 AND 2015-02-28 365,1553779621083,100272019032813000) ;
07:08:21.853
Il deviceTypelD:  IleventStartTime:  ILpRulelD:  IlLeventiD: Il sourcelser:
nul nu nu nu! null
Il sourceDomain: Il eventActionlD:  ILeventStatusiD:  IleventAction:  IL_eventStatus:
nul null nu nu nu
_sourcalP- ll_targetlP: ll_duration: lI_targetUsar sys_eventTime:
nul null nul null 2019-03-28 06:27:01.000 T
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You can expand and collapse the time range by dragging the borders of the selected
time range to the desired location. Once you define the time range, position the
mouse inside the selected time range and drag the slider to define the new time
range. Similarly, you can define a specific time by clicking on the timeline chart. The
time range can be adjusted at any time.

Note: As you adjust the time range on the timeline chart, the Columns and
the Data panels are adjusted automatically for the selected time range.

¢ Viewing timeline chart details

Hover your mouse over any part of the timeline chart to view the time and the
number of messages.

Message count: 10600

i

13:40 Thursday, Mar 28, 13:49:55.103 14:00

13:35

o Note: When you use Correlation Bloks in advanced search, hovering your
mouse over any part of the chart displays the number of correlation events
instead of the message count.

 Filtering results based on the time range

You can fine-tune your search results based on the time range. Click the event count
(the line that represents the number of events) on the timeline chart or define the
time range by zooming in on the timeline chart to view results in the Data panel. A
new filter is added for the defined time and the filtered results are displayed on the
Data panel.

Columns
Based on your search query, all available columns are displayed in the Columns panel.

You can group together your results based on any column and the value associated with
that column. Similarly, filtering helps you fine-tune your search results when analyzing
large data sets.
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System columns are columns with event metadata that are present in all data models by
default. For a list of system columns, see Types of Columns. Additional columns are
available depending on the data models involved in the query.

Columns @

[ [
LA
il
i1
[n]
o

Sys_eventTime »

[<]

sys_deviceType »

[<]

sys_device ¢

From the Columns panel, you can perform the following tasks:

Showing or hiding the Columns panel

Click the hide icon located on the right corner to hide the Columns panel. Click

to show the Columns panel.

Finding columns

You can quickly find the desired column by typing the column name in the Search
field. As you start typing a column name in the Search field, all possible columns
that start with the letters that are typed get displayed in the pane. The Columns
panel is refreshed based on the selection.

Showing or hiding columns from the Data panel

Select the check box to show the column in the Data panel. Clear the check box to
hide the column from the Data panel. Click Select all to select or clear all columns.

The add columns icon ¥ located on the left side of the column name defines that

the column is displayed in the Data panel. The Data panel gets updated immediately
based on your selection.

Viewing column value details

Click the column value and then select Show values to view the details of the
selected value. The window displays a maximum of 100 distinct values for the
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selected column. The Percent column is calculated using the maximum 100 distinct
values. When the distinct values for a column exceed 100, the Percent column is not
displayed. If you filter on a particular column value, then the percent value on the
top shows the percentage of occurrence of this particular column value in the entire
result set.

The following illustration displays values for the column sys_eventTime.

sys_eventTime (categorical)
Value Count Percent A
1 2016-11-30 10:50:18.029 2 2
2 2016-11-30 11:15:00.917 1 1
3 2016-11-30 10:53:11.564 1 1
4 2016-11-30 10:50:37.238 1 1
5 2016-11-30 10:40:46.210 1 1
6 2016-11-30 11:10:53.943 1 1
7 2016-11-30 11:10:53.547 1 1
8 2016-11-30 11:05:16.882 1 1
9 2016-11-30 10:40:45.481 1 1
10 2016-11-30 11:21:16.195 1 1
11 2016-11-30 11:20:45.971 1 1 (¥

* Filtering results based on the column value

Click the Value link and select Include this filter to filter results based on that value.
If you select the Exclude this filter option, the results are displayed without the
defined value. You can add multiple filters. Select Remove this filter to remove the
selected filter from the results. The blue icon [®l represents included values and red
icon |2 represents excluded values from filtering data on the Data panel.
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hit (Categorical) hit is in 10% of results

Value
1 1~
2 ®341 ~
3 ® Include this filter
2 O Exclude this filter

Remove this filter

5 6
6 80 ~

The following illustration displays filtered results based on the value filter Other UNIX
included for a column sys_deviceType.

5560
Search 1 + X

Select Log Sources z USE system 0 5 Last-Hour -4 m
Resul.. +
"l Columns 5 columns found @ Raw  Table Columns m Wordwrap m Charts m H & B
—
Q search \
Select all \I 0
R— - - 20000 20:10 20:20 20:30
Sg's-e’e”-r'""e - 20:05 20015 20:25 20:35
sys_deviceType 4
> Iy [
| _20:00 20:10 20:20 | 20:30
sys_device 4 . 0] v
,
- 2 hd 1. 2019-03-30 01:28:07.000 <G=Mar 29 12:45:52 logapp kemel:[ 341.165434] system 00:09: [io OxfceD-0xfcff] has been -
T Fiters 1 filters found fEsErvEd
sys_eventTime: sys_collectiP:  sys_collectorDomain:  sys_deviceType:
sys_body X 9-03-2 =1 empty General Syslog
INCLUDES logapp sys_device:
:1_General
2. 2019-03-3001:25:07.000 <G=Mar 29 12:45:52 logapp kernel[ 341.165597] system 00:09: [mem 0xf0000000-
0ufFFFH] has been reserved
sys_eventTime: sys_collect!P: sys_collectorDomain: sys_deviceType:
2 3-29 12:58:07.0 10.128.132.92 empty Other UMIX
-
P Showing 1 to 20 of 5560 « 2 3 456 .. 278 =
a

o Editing value filters to refine results

Based on your selection, a new filter is added in the Data panel and the refined
results are displayed based on the filter. Click inside the value filter box to edit the
value. Click the check mark to update the value changes. The Data panel results are
refreshed based on the updated filters.
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Note: When updating the time value, enter it in the YYYY:MM:DD HH:mm:ss

format.
Resyl +
unn | Enter value »
T L
| LogLogic Appliance | m 1
SYs5L —
EQ Other UNIX

e Grouping by values

Click the column value and then select Group by to view grouped results. A new
Result tab opens showing the results that are grouped by the column. The number of
groups is displayed against the column name in the Columns pane. However, for
time-based columns, the number of unique values is displayed instead of the number
of groups.

Show Values

Group by

The following illustration displays the results grouped by the activity column.
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Result1 x Group sys_deviceType X +
= C 5 found :
M coumrs 1 columns found @ Table o
Q search # sys_deviceType COUNT()
Selma” 1 LogLogic Appliance 191
2 LogLogic Logu 72
s Ti =100 P
sys_eventTime 3 Other UNIX 219
sys_deviceType EN ¢
sys_device EI
-
T Fitters 1 filters found
Group_by
COL sys_deviceType

You can group by different time ranges. Click the timestamp value, and select the
Group Dates by option. From the list, select the option to group your results by

different time periods. A new Result tab opens showing the results that are grouped
by different time units.

Show Values

(O Group dates by Seconds

Minutes

Day

o Add aggregation

You can aggregate columns that have Integers and Long values. Click the column
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value and select Add aggregation. Define how to group values in the aggregation
column. The options are: SUM, MIN, MAX, AVG. A new column is added in the Data
panel.

Note: The aggregation menu is only available after a GROUP BY operation,
and only for numeric columns. However, if a GROUP BY operation is
already used in the query, the results cannot be aggregated further.

The following illustration displays a new aggregation column (AVG) added in the Data
panel.

Show Values

Add Aggregation SUM (length(sys_ody))

AVG (lengthisys_body))

MIN {length{sys_bodyl)

MAX {lengthisys_body))

Example
1. Run the following query:

use LoglLogic_Appliance | columns sys_eventTime, sys_body, length
(sys_body)
2. In the left pane, click the column sys_eventTime and group by minutes.

3. Click the length column, and choose an aggregation type from the Add aggregation
sub-menu, for example, AVG(length(sys_body)).
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G} Table
I
# sys_eventTime
2 2020-01-24 031
3 ", 403
4 202 24 031

AVG([length{sys_body)]) COUMNT(*)

Types of Columns

There are two types of columns: system columns and parsed columns.

The system columns are available by default in all data models. System columns contain
event metadata such as event body (sys_body), event time (sys_eventTime), or the device
name that produced the event (sys_device).

Parsed columns are specific to data models. They are defined in the data model and their
values are parsed from the body of the event.

The following list describes all system-generated columns.

Name
sys_body

sys_collectIP

sys_collectTime

sys_collectorDomain

Sys_
collectorDomainld

sys_concentratorld

Type
String

InetAddress

Long

String

long

String

Description
The text of the event

The IP from where the event originated. This
supports both IPv4 and IPv6.

The time when the event was ingested

Currently unused.
Name of the collector domain for this event

ID of the collector domain for this event

IP address in IPv4 format, of the LoglLogic LMI

TIBCO Loglogic® Log Management Intelligence User Guide




247 | Advanced Features

Name

sys_device
sys_deviceType

sys_eventKey

sys_eventTime

sys_filename

sys_sourceSubType

sys_sourceType

Type

String
String

String

Timestamp

String

String

Integer

Description

appliance or group of appliances on which a
distributed Advanced Search query is run.

Name of the device for this event
Name of the device type for this event

A unique key that identifies the event in the LoglLogic
storage

The UTC time of the event in Epoch milliseconds.

For syslog data, sys_eventTime is the time the event
was collected.

For file log data, sys_eventTime is the original event
time.

The file name for event collected from a file

Sub-classification of the source type

Currently unused.

ID of the device type
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o Note: Some system columns are not returned by default in queries that retrieve

all columns, such as a SELECT * query, as they are not generally needed in

regular queries or they are currently unused. To obtain their values, their name

must be explicitly specified in the SELECT or COLUMNS statement. Those

columns are:
e sys_collectTime
» sys_collectorDomainid
e sys_concentratorld
e sys_domain
e sys_eventKey
e sys_filename
e sys_sourceSubType

e Sys_sourceType

Data

Based on your search query, the retrieved data is displayed in a normalized tabular format,

and each event is summarized per row.

You can view data in the raw data format or table format.

Columns m Waordwrap ﬂ

<14>Feb 26 21:44:47 logapp MGMT: #LOGLOGIC-6 module:engine_ntp{67115);

Raw Table

1. 2019-02-27 11:14:47.000

2. 2019-02-27 11:14:47.000 <14=Feb 26 21:44:47 logapp MGMT: #LOGLOGIC-6 module:engine_ntp(67115);

filezengine_ntp.clupdate_ntpd_status_te_file, 426); action:Total number of peers: 1 ;

3. 2019-02-27 11:14:47.000 <14=Feb 26 21:44:47 logapp MGMT: HLOGLOGIC-6 module:engine_ntp{67115);

filezengine_ntp.clupdate_ntpd_status_to_file 427); action:List of the peers: ;

W Tes . W ommaFao T TR SO N—T

Showing 1 to 20 of 1269

I_deviceTypelD: ll_eventStartTime: Il_pRulelD: lI_eventID: I_sourcelser:

null null null null nul null
ll_ewentStatus|D: ll_eventAction: l_sventStatus: ll_sourcelP: I_targstIP: ll_duration:
null null nu null nu null
sys_sventTime: sys_collectiP: zys_collectorDomain: sys_deviceType:
2019-02-26 21:44:47.000 10.0.0.11 empry Loglogic Appliance

_devicaTypelD: ll_sventStartTime: Il_pRulelD: Il_swentiD: I_sourcelser:

null null null null nul null
lI_ewentStatusiD: I_eventAction: l_eventStatus: ll_sourcelP: I_targetiP: Il_duration:
null null nu null nu null
sys_sventTime: sys_collect!P: sys_collectorDomain: sys_deviceType:
2019-02-26 21:44:47.000 10.0.0.11 empty Loglogic Appliance

Charts

I_sourceDomain:

=

filerengine_ntp.clupdate_ntpd_status_to_file 425); action:Mext poll will happen after: 64 sec. Tue Feb 26 21:45:51 2019;

ll_eventActionlD:

null
Il targetlzer:
mul
sys_device:
offff10.0.0.11 _logapp

I_sourceDomain:

ll_eventActionlD:
null

I_targetUser:

nul

sys_device:

offff:10.0.0.11 logapp

(1]

&y

K
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From the Data panel, you can perform the following tasks:

e Viewing event count

The total number of retrieved events is displayed on the bottom-left side.

* Filtering search results

You can create a filter using the column value and event body text to fine-tune your
search results.

Click to show or hide filters from the Data panel.

* Filtering data

Click the column value and select Include this Filter to filter the data based on the
value. If you select Exclude this Filter, the results exclude the specified value.

Note: To filter by any text in the body of the log events (sys_body
column), turn on the Messages view, select the required text, and right-
click the selected text.

Include this filter

Exclude this filcer

Include this filter an result tab

Exclude this filcer from result tab

The Data panel displays results immediately based on the defined filters. You can add
multiple filters to fine-tune your search results. You can update the existing filter
value. Click the value to open the Enter value field. Update the value in the field
and click Bd. The results are refreshed immediately based on the new filter.

The following image displays the raw data showing filtered results for sys_body
CONTAINS 'logapp':

TIBCO Loglogic® Log Management Intelligence User Guide



250 | Advanced Features

5560
Search 1 + a X
Select Log Sourcss = USE system 0" % Last-Hour & m
Resul... +
HI columns 5 columns found @ Raw  Table Columns ﬂ Wordwrap m Charts m B & 3
—
Q search
Select all \ o
R P 20:00 20:10 20:20 20:30
52'*-5“'9”-'””'5 20:05 20018 20:25 20:35
szls_cev ceType 4 \ U
\___z0:00 20:10 20:20  20:30
sys_device 4 i »
,
hd 1. 2019-03-30 01:28:07.000 <G=Mar 29 12:45:52 logapp kernel: 341.165434] system 00:09: [io Oxfce0-0xfcff] has been -
T Fiers filters found resenEd
sys_svereTime: sys_collectlP: sys_collzctorDomain sys_deviceType:
sys_body X 2019-03-29 12:58:07.000 =1 empty General Syslog
INCLUDES logapp sys_device:
=1_General
2. 2019-03-30 01:28:07.000 <G=Mar 29 12:45:52 logapp kernel:] 341.165597] system 00:0%: [mem Oxf0000000-
0uf 7] has been reserved
sys_collectiP: sys_collectorDomain:  sys_deviceType:
10.128.132.92 empty Other UNIX
o
P Showing 1 to 20 of 5560 « 23 456 278 »
i

The following image displays the table showing filtered results for threadid='8158".

Seeciog Sources Z  usesystem | sys_body CONTAINS ‘logapp'
Result 1 +
Il columns 6 columns found ® Rawdata  Table
. # i
Q search sys_eventTime
selectall
1 2021-05-1 04:37:00.000
sys_collectlP »
sys_eventTime >
[] sys_coliectormomain >
D sys_concentratorld >
[] sys.cevce 8
[7] svs_deviceType L~
“
T Fitters filters found ®
sy5_body X
INCLUDES threadic:8158
Showing 1101 0f 1

n om
Messages 0K ) Highighs @ | Timeline chart E & O
sys_collectlP sys_body
<14>May 18 04:37:00 logapp MGMT: $5LOGLOGIC-6 modulerengine_Ix_scheduler23796); filesql_wrappers.c
1012813280 check register_db_thread 377 actiorrdb_threac: ki; Breadici6158; typeunregistered; ressomidle.too_long;

idle:347, query:;

o Click to show or hide filters from the Data panel.

° Click the column value and select Include this filter on the Result tab to filter

the data based on the value in a new Result tab. If you select Exclude this
filter from Result tab, a new Result tab displays results excluding the

specified value.

° You can filter based on the event body. In the Table mode, ensure that the
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Messages option is set to on. Then drag the mouse to select the event body
and select Include this filter to filter your results based on the event body
filter. The selected keyword is highlighted in the results. If you select Exclude
this filter, then the results exclude the specified event body.

The following image shows results based on the event body threadid='8158".

=4 use system | sys_body CONTAINS ‘logapp' 10m m
Result 1 +
Messages i s il
Columns [C] Rewdata Table essages EOK ) Highisns @ ) T Chart B & 3
- sys_eventTime sys.collectlp sys body
<14>May 18 04:37.00 logapp MGMT: %LOGLOGIC-6 moduleengine_x_scheduler{23796); filesql_wrappers.c
Selectall
1 5 04 0.128.13280 check_register_db_tnread 377); actionab_thread: kil; iAeadigi15E; typeunregisterad; reasonidie too_long;
sys_collectP ide:947, queny:;
sys_eventTime
sys_collectorDomain
deviceType -
“
Filters
sys_body
INCLUDES threadic:8158
Showing 1101 of 1 coto: [HEI

» Highlighting keywords

By default, the Highlights option is set to on for queries that include CONTAINS or
LIKE statements. Click the Highlights on or off link to highlight keywords or remove
highlighting from the keywords. This option is not visible for queries that do not

include CONTAINS or LIKE statements.
Highlighting in the Raw data mode

In the following image, the keyword logapp is highlighted when the search query is:

USE system | (sys_body CONTAINS 'logapp ')
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Rawdata Table Columns m Wordwrap m Highlights m Charts
——

1. 2019-03-30 01:258:07.000 <6=Mar 29 12:45:52 logapp kernel:[ 341.165434] system 00:09: [io Oxfce0-0xfcff] has been reserved

sys_eventTime: sys_collectlP: sys_collectorDomain sys_deviceType: Sys_device:
2015-03-2 o001 empty General Syslog :1_Genera

2. 2019-03-30 01:28:07.000 <6=Mar 20 12:45:52 logapp kernel:[ 341.165597] system 00:09: [mem 0xf0000000-0xf7Hfff{] has been reserved

sys_eventTime:
2019-03-29 12

sys_collectlP: sys_collectorDomain: sys_deviceType: sys_device:
000 10112813292 empty Other UNIX «ffff10.128.13

otherlUnix

3.2019-03-30 01:25:07.000 =6=Mar 29 12:45:52 logapp kernel:[ 341.165760] system 00:09: [mem 0xfe800000-0xfeafffff] has been reserved

sys_eventTime: sys_collectlP: sys_collectorDomain: sys_deviceType: sys_device:
2019-03-29 1 000 10.128.132.92 empty Other UNIX «ffff10.128.13

_otherUnix
4. 2015-03-30 01:23:07.000 <7=Mar 29 12:45:52 logapp kernel:[ 341.165925] system 00:09: Plug and Play ACPI device, |Ds PMNPOC0Z (active)

sys_eventTime: sys_collectiP: sys.collectarDomain:  sys_deviceTyps:  sys_device:
2019-03-29 12:58:07.000 1012813292 empty Other UNIX ~ffff-10.128 132 92_otherUnix

5. 2019-03-30 01:28:07.000 <@=Mar 29 12:45:52 logapp kernel:[ 341.169813] pnp: PnP ACPI: found 10 devices

sys_eventTime: sys_collectlP: sys_collectorDomain: sys_deviceType: sys_device:
2015-03-2 000 10.128.132.92 empty Other UNIX «ffff:10.128.13

6. 2019-03-30 01:25:07.000 =6=Mar 29 12:45:52 logapp kernel.[ 341.169993] ACPI: bus type PNP unregistered

Highlighting in the Table mode
In the following image, the keyword logapp is highlighted when the search query is:

use system | sys_body CONTAINS 'logapp'

Rawdata  Table Messages u Highlights a Timeline Chart HE & B
# sys_eventTime sys_collectlP sys_body
<14>May 18 04:36:06 logapp MGMT: %LOGLOGIC-6 modulerengine_ntp(15651); fileengine_ntp.clupdate_nt
1 2021-05-18 04:36:08.000 10.128.132.80
pd_status_to_file 425); action:Next poll will happen after: 256 sec. Tue May 18 04:140:24 2021 ;
<14 >May 18 04:36:05 logapp MGMT: %6LOGLOGIC-6 modulerengine_ntp(15651); fileengine_ntp.c{update_nt
2 2021-05-18 04:36:08.000 10.128.132.80
ppd_status_to_file 426); action:Total number of peers: 1;
<14=May 18 04:36:05 logapp MGMT: %LOGLOGIC-6 modulerengine_ntp(15651); fileiengine_ntp.clupdate_nt
3 2021-05-18 04:36:08.000 10.128.132.80
pd_status_to_file 427); actioniList of the peers: ;
<14=May 18 04:36:08 logapp MGMT: %LOGLOGIC-6 modulerengine_ntp(15651); fileiengine_ntp.c{update_nt
4 2021-05-18 04:36:08.000 10.128.132.80
ppd_status_to_file 429); action: remote refid st t when poll reach delay offset jitter ;
<14=May 18 04:36:05 logapp MGMT: %LOGLOGIC-6 modulerengine_ntp(15651); fileiengine_ntp.c{update_nt
5 2021-05-18 04:36:08.000 10.128.132.80
pd_status_to_fle431); action:*10.128.132,32 216.239.35.5 2 u 169 256 377 0.234 -0651 0.482;
<14=May 18 04:36:10 logapp MGMT: %LOGLOGIC-6 moduleiengine_|x_parser{16402); file:rtf_r.c(rif_open_filk
& 2021-05-18 04:36:11.000 10.128.132.80
5490} actioniopening current file at time 1621337770 Tue May 18 04:36:10 2021 ;
<14=May 18 04:36:15 logapp MGMT: %LOGLOGIC-6 modulerengine_|x_parser{16402); filexrtf_r.c(rif_add_file,
T 2021-05-15 04:36:16.000 10.128.132.80 -
AR actiononened (01 Aoalonic/datafe 1720210618100 rawdata 10037 1R21337760 AO-3R5.txf.nz -

e Sorting columns

You can sort on any column, including group-by count(*) column, group-by
aggregation-columns, and other columns. Click the column value and then select
Sort Ascending to sort columns in order. Click the column value and then select Sort
Descending to sort columns in descending order.
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41 Sort Ascending

il SortDescending

Group by

Include this filter

Exclude this filker

Include this filter on result tab

Exclude this filter from result tab

e Grouping by values

Click the column value and select Group by to view grouped results. A new Result
tab opens showing grouped results for the selected value. The number of groups is
displayed against the column name in the Columns pane. However, for time-based
columns, the number of unique values is displayed instead of the number of groups.

Show Values

Group by

To group by different time range options, click the time value, select Group Dates by
option, and then select the period to group your results by different time periods.
The Table panel is refreshed showing the results that are grouped by the defined
time period. When grouped by sys_eventTime, the results are sorted in ascending
order.

e Hiding columns

Click the column header and then select Hide to hide the selected column from the
Data panel.

e Adding a new data model
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You can add a new data model from the Data panel. Click located on the upper-

right corner of the Data panel to add a new data model. All events that are displayed
in the Results tab are copied in the Create Data Model panel. For instructions on
how to add a new data model, see Creating a Data Model in Graphical Mode.

Note: If a search query contains a single data model, then the defined
source filter is copied. If there are multiple data models defined in the
query, the Create source filter panel does not display any value.

You can edit custom data models from the Data panel. Click |2 located on the

upper-right corner of the Data panel to edit the data model. All events that are
displayed in the Results tab are copied in the Create Data Model panel. For
instructions on how to update data models, see Editing Data Models.

o Note: The edit icon is only visible when search results are retrieved

using custom data models. You cannot edit the system data models and
the LoglLogic LMI built-in data models.

e Creating filtered query as a new search query

After adding filters on your results, click the = icon, located on the upper-right

corner of the Data panel, to create a new search query in a new Search tab for the
same conditions.

In the following image, a filter condition sys_body INCLUDES logapp is added on the
Data panel in the Search 1 tab.

TIBCO Loglogic® Log Management Intelligence User Guide



255 | Advanced Features

5560
Search 1 + 6 x
Select Log Sources p=4 USE system 0" % Last-Hour & m
Resul... +
HI columns 5 columns found @ Raw  Table Columns m ) Wordwrap m ) Charts m ) B & 3
—
Q search \
Select all . o - . o
- By . P 20:00 20:10 20:20 20:30
52'*-5"9”-'””'5 o 20:05 20018 20:25 20:35
szls_oev ceType 4 U
4 S SRS U 2 (-1 |71 2 0 . 0: 3 B -
sys_device 4 ‘ i »
,
hd 1. 2019-03-30 01:28:07.000 <G=Mar 29 12:45:52 logapp kernel: 341.165434] system 00:09: [io Oxfce0-0xfcff] has been -
T Fiiters 1 filters found resenvea
sys_svereTime: sys_collectlP: sys_collzctorDomain sys_deviceType:
sys_body X 2019-03-29 12:58:07.000 =1 empty General Syslog
INCLUDES logapp sys_device:
=1_General
2. 2019-03-30 01:28:07.000 <G=Mar 29 12:45:52 logapp kernel:] 341.165597] system 00:0%: [mem Oxf0000000-
0uf 7] has been reserved
sys_eventTime: sys_collectiP: sys_collectorDomain:  sys_deviceType:
2019-03-29 8:07.000 10.128.132.92 empty Other UNIX
sys_nevice: <
P Showing 1 to 20 of 5560 « 23 456 278 »
i

Now if you click the L icon in the Search 1 tab, a new tab Search 2 opens, showing
the conditions in the Search field.

0
‘ + Q ~
Select Log Sourcss =4 | USE system | (sys_body CONTAINS ‘logapg ) | a Last-Haour -4 m
Resul... +
I coumns 5 columns found @ Raw  Table Columns m ) Wordwrap m Highlights m ) Charts m
—
A Search 25K
Select all \ . N N - - )
- By . PN 20:00 20000 20:20 20:30 20:40 20:50
5&‘*-5“9”-1—'”'2 - 20:05 20115 20:25 20:35 20:45
sys_deviceType 4 1
3 [} ]
\goo0  zoas  20:30 2045
sys_device 4 ‘ (1] v
v
- s -
TR n 1.2019-03-30 01:23:07.000 <G=Mar 29 12:45:52 logapp kernel 341.165434] system 00:0%: [io Oxfce0-Oxfcff] has been
T Filters reserved
sys_eventTime: sys_collectl®  sys_collectorDomain:  sys_deviceType:
2019-03-29 12°58:07 000 =1 empty General Syslog
sys_device:
=1_General
2. 2019-03-30 01:28:07.000 <G>Mar 29 12:45:52 logapp kernel] 341.165597] system 00:09: [mem 0xf0000000-
0uf 7] has been reserved
sys_eventTime: sys_collectlP sys_collectorDemain sys_deviceType:
2019-03-29 12:58:07.000 10.128.132.92 empty Other UNIX
sys_device: <
P Showing 1 to 20 of 6086 « n 2 3456 .. 305 »
i

» Downloading search results

You can download the search results as a CSV or PDF file. In the upper-right corner of
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the Data panel, click the download icon *s and then specify your option in the

Download Results dialog box.

You can also select how much data you want to download:

o All data: All pages, all columns

° All data - Selected columns: All pages, selected columns, applied filters

° Current view: Current page, selected columns, applied filters

Download Results

File format csv

® All data
(All pages, all columns)

O All data - Selected columns

O Current view

CSV: Faster report generation with minimum formatting.
PDF: Fully formatted, print-ready report; takes longer for large result sets.

(All pages, selected columns, applied filters)

(Current page, selected columns, applied filters)

b 4

-

If you select CSV as the file format, the report is generated and downloaded to your
computer. Whereas if you select PDF as the file format, the report generation starts in
the background. After the PDF is ready, it is saved on the LoglLogic LMI appliance and

a notification appears in the notification area of the GUI.

Download the POF report for your advanced search
¥, Search 1 and result set Result 1 by clicking the
download icon
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After clicking the download icon in the notification area, the PDF file is saved to

your computer.
For PDF download:
° You can initiate a PDF report for different result sets simultaneously.

° While a PDF report is being generated for one result set, you cannot initiate another PDF
for the same result set. You must wait till the current report generation is complete.

° If you clear the notification from the notifications panel or close the search tab, then the
PDF report is deleted from the appliance and is no longer available for download.

° If you close the search tab for which a PDF report is being generated, the PDF
generation is terminated.

For more information about data formats, see the following topics.
e Raw Data Format

e Table Format

Raw Data Format

Based on your search query, the results are displayed in Raw data format. Each event is
summarized per row.
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The column value options are displayed in the following illustration:

£l sart Ascending

£l Sort Descending

Group by

Include this filter

Exclude this filter

Include this filter on result tak

Exclude this filter from result tab

The same result set can be viewed in the Table Format.
Using the raw data format, you can perform the following tasks:

e Showing or hiding columns from the Raw data

Click the Columns button to on or off to show the selected columns below the event,
or to hide columns to view events in the raw format.

* Wrapping long events

Click the Wordwrap button to on or off to indicate if long event should break at
normal word break points or to display long events.

Table Format

Based on your search query, the results are displayed in normalized table format. Each
event is summarized per row.
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Raw  Table Messages | OFF Charts | OFF H & E
——

# sys_eventTime sys_collectlP sys_deviceType sys_device
1 2019-03-29 12:58:07.000 w1 General Syslog w1_Ger -
2 2019-03-29 12:58:07.000 10.128.132.92 Cither UNIX w10,

3 2019-03-29 12:58:07.000 112813292 Cither UNIX affff 10,

£ 2019-03-29 12:58:07.000 10.128.132.92 Cither UNIX sfiff 10,

5 2019-03-29 12:58:07.000 1012813292 LogLogic Appliance wffff 10,

6 2019-03-29 12:58:07.000 10.128.132.92 Cither UNIX sfiff 10,

7 2019-03-29 12:58:07.000 112813292 Cither UNIX affff 10,

8 2019-03-29 12:58:07.000 10.128.132.92 Cither UNIX wffff 10,

9 2019-03-29 12:58:07.000 112813292 Cither UNIX affff 10,
10 2019-03-29 12:58:07.000 10.128.132.92 Cither UNIX sfiff 10,

11 2019-03-29 12:58:07.000 10.128.132.92 Cither UNIX wfFff 10,
12 2019-03-29 12:58:07.000 10.128.132.92 Cither UNIX sfiff 10,
13 2019-03-29 12:38:07.000 1012813292 Other UNIX w0,
+ g
Showing 1to 20 of 5584 a 2 3 456 .. 280 =

The same result set can be viewed in the Raw Data Format.
Using the table format, you can perform the following tasks:

e Showing or hiding event body

Click Messages on or off to show or hide the event body in the sys_body column.

Rawdata  Table Messages u ) Charts | ©% B & O
—

# sys_eventTime sys_collectlP sys_deviceType sys_device sys_body

1 2019-03-29 12:38:07.000 M General Syslog =1_General <@>Mar 29 12:45:52 logapp kernek] 341.165434] system 00:09: | *

<6=Mar 29 12:45:52 logapp kernel:| 341.165597] system 00:09: |
2 2019-03-29 12:58:07.000 10.128.132.92 Other UNIX =fffi:10.128.132.92_otherUnix
resenved

<6>Mar 29 12:43:52 logapp kernel:| 341.165760] system 00:08: |
3 2019-03-29 12:58:07.000 10.128.132.92 Other UNIX ffff10.128.132.92_otherUnix
reserved

<T>Mar 29 12:45:52 logapp kernel:[ 341.165925] system 00:09: |
4 2019-03-29 12:3807.000 10.128.132.92 Other UNIX offfi10.128.132.92_otherUnix
(active]

<181> Mar 29 12:58:07.543875 =ffff:10.128.132.92 %LOGLOGIC-

5 2019-03-29 12:38:07.000 10.128.132.92 Leglogic Appliance uffff10.128.132.92_logapp

actionstartup; infoiprocess was started
[ 2019-03-29 12:5807.000 10.128.132.92 Other UNIX offff10.128.132.92_otherUnix <@>Mar 29 12:45:52 logapp kernel:| 341.169813] pnp: PP ACPI:
7 2019-03-29 12:58:07.000 10.128.132.92 Orther UNIX =fffi:10.128.132.92_otherUnix <fi=Mar 29 12:45:52 logapp kernel:| 341.169993] ACPI: bus type

<7=Mar 29 12:45:52 logapp kernel:[ 341.191500] pci 0000:00:15.
8 2019-03-29 12:58:07.000 10.128.132.92 Crther UNIX affff:10.128.132.92_otherUnix
OxDOOFTFT 64bit pref] to [bus 03] add_size 200000 add_align 100t
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Monthly Index

When enabled, the monthly index feature increases the performance of the searches
spanning monthly time ranges.

The monthly index adds a month-based index on top of the existing hourly indexes and
enables searches to quickly locate the search terms within a given month.

o Note:

e Only the advanced search uses monthly indexing.

* Monthly indexing can be enabled only if the Advanced Search features are
enabled. To enable the advanced features and the monthly index feature,
contact your administrator.

» To troubleshoot performance issues, you can disable monthly indexes in a
query by specifying useMonthlylndex=false after the OPTIONS keyword. For
example:

use system | OPTIONS useMonthlyIndex=false | 'logapp' |
group by hours(sys_eventTime)

Artificial Intelligence Queries

LoglLogic LMl includes artificial intelligence and machine learning capabilities to classify
information from unknown log sources. This is achieved by using the TensorFlow trained
model to automatically classify logs of access or audit types. By using an additional
classifier in the advanced search query, you can view the additional information in the
search results.

You can use the training model classification in advanced search queries, correlation,
aggregation rules, and Bloks.

Before using the training model, ensure that Advanced Features are enabled on the
appliance. To ensure that the training model is set up on the appliance, contact your
LogLogic LMI administrator.
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Example - Advanced Search

To search logs of a particular log source using the TensorFlow training model, use the
following advanced search query:

Use system | options useClassifier='1l1_tax_v1l'

SelectLogSources © . usesystem | options useClassfer=1Ltax 11" e Lastweek [ |

11l columns ® Columns Wordwrap Highights Timeine chart B &O
Rawdata  Table

15:00 21:00 03:00 09:00 15:00 21:00 03:00 09:00 15:00
> 18:00 Jan 19 06:00 12:00 18:00 Jan 20 06:00 12:00 18:00

GG

18:00 Jan19 06:00 12:00 1800 Jan 20 06:00 1200
w

©

©
3

©

4 75.2022-01-18 13:52:38.000

sys.collectip >

©

A 76.2022:01-18 135238000

0

77.2022:01-18 13:52:38.000

I1tax ¢

NEQ unknown X
78.2022-01-18 13:52:38.000

NEQ VPN flow X

sys dovice:
sys_body X 111£127.00.1_logapp

DOES NOT INCLUDE kernel 79.2022-01-1813:52:38.000  <14>Jan 18 0GIC: tart_process,277); :_backup will be run

sy

s device: "
111£127.00.1_loga E

80.2022.01-18 13:52:38.000  <12>Jan 18 13:52:21 0GIC4

. D

Showing 61 to 80 of 16127

For more information about the classifier options and the result columns, see OPTIONS
Statement.

Enrichment Lists

Running searches is often a very static experience. Users search for key words or phrases
that they know in order to return specific results. An enrichment list is used to map a
lookup key to an enriched value.

If the data you want to search is more dynamic and changes often, it might be difficult to
create a query that would collect the right information. In such cases, you can use an
enrichment list and reference the list in any query or in Predefined EQL Functions to
achieve accurate results. From the Advanced Search tab, you can use an enrichment list in
your search query. LoglLogic LMI provides some built-in enrichment lists, for example,
mapRuleAction. You can refer to the built-in lists as a guideline to create your own.

Use the following syntax to run a search query with an enrichment list:
use <nameOfDataModel> | $<NameofEnrichmentlList>(<lookup_key> [,<default_
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value>])="<comparison_value>' where:
e <nameOfDataModel> is the name of the data model to be queried
o <NameofEnrichmentList> is the name of the enrichment list

o <lookup_key> is the key to be looked up. If it is a column name, the value of the
column for each row returned is used to look up the enriched value. It can also be a
constant, in which case it always returns the same result. If there is no mapping for
the lookup key, the enriched value is NULL.

o default_value is an optional parameter which, when provided, is the default return
value when there is no mapping for the lookup key.

e <comparison_value> is the value that you want compared with the enriched value
produced by the enrichment list.

For example, consider the search query:

use Loglogic_Appliance |$ipBlackList(sys_collectIP)="blacklisted'

The Enrichment List ipBlackList contains some value mapped to the key name
blacklisted. This value is searched in the column sys_collectIP of the data model
LogLogic_Appliance. We want the search result to display all log events that match the
comparison value blacklisted.

o Note: The behavior of the operators = and != is similar to that in regular SQL. If
one side of the comparison has the value NULL, regardless of which operator is
used, the result of the comparison is NULL, which is evaluated as FALSE in a
WHERE clause. This results in both = and != returning FALSE if there is no
mapping for <lookup_key>, which might not be what you expect, especially for
I=. A better solution is to use the !== operator instead of !=. This returns TRUE if
one side of the comparison is NULL, which is a more expected result. For more
information about the operators == and !==, see FILTER Statement.

See also:
e Creating an Enrichment List
e Editing an Enrichment List

e Using enrichment lists in distributed Advanced Search
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Note: This feature is available only if the Advanced Features option is enabled
by using the Advanced Features option on the Administration > System
Settings > General Settings page.

Viewing and Searching Enrichment Lists

From the Management > Advanced Features > Enrichment Lists page, you can view, find,
or filter enrichment lists in the following ways:

Task Steps
View You can use filters to easily find enrichment lists. Click the View list to
enrichment lists select the required filter. The following options are available:

based on filters . Al

e Created by me

e Created by system

e Imported
Find You can quickly find the desired enrichment lists by typing the
enrichment lists enrichment lists name in the Find field. As you start typing the

enrichment lists name in the Find field, the Enrichment Lists page is
automatically refreshed showing your selection.

Sort You can sort any column in ascending or descending order. Click on the
enrichment lists column name or click the arrow (that is displayed on the right side of the
column name when you click in the column) to sort the column.

Show or hide You can show or hide columns, except the mandatory column, from the

columns table. Click @ to view all available columns in the table. Select the check
box to show the column. Clear the check box to hide the column from
the table. The Enrichment Lists page is updated immediately.
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Managing Enrichment Lists

You can manage enrichment lists from the Management > Advanced Features >
Enrichment Lists page:

€) Note: The duplicate ' delete [, and move & icons are enabled after you
select one or more enrichment lists.

Task Steps

View and search See Viewing and Searching Enrichment Lists
enrichment lists

Create or edit an See:
enrichment list ) . .
e Creating an Enrichment List

e Editing an Enrichment List

Delete Select the enrichment list and click the delete icon [Il. After you delete

an enrichment list, it cannot be recovered.

Note: You cannot delete built-in and system-created enrichment

lists.
Duplicate Select the enrichment list and click the duplicate icon o,
Move Select the enrichment list and click the move icon E3. Select the group

to which you want to move it.

Note: You cannot move built-in and system-created enrichment
lists.

Rename Select the enrichment list and click Edit in the Details panel. Then
rename the enrichment list and click Save.
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Task Steps

Note:
* You cannot rename an enrichment list using the rename icon
T

e You cannot rename built-in and system-created enrichment
lists.

Enrichment List Groups

The Management > Advanced Features > Enrichment Lists page displays lists in groups.
The All Enrichment Lists group displays all enrichment lists.

For information about groups, types of groups, and managing groups, see the Groups
section.

Creating an Enrichment List

You can create an enrichment list from Management > Advanced Features > Enrichment
Lists.

LoglLogic LMI provides a few built-in Enrichment Lists. You can create your own, if required.

1. Go to Management > Advanced Features > Enrichment Lists.
2. Click Create New Enrichment List.

3. In the Add Enrichment Lists dialog box, specify the following fields for the
enrichment list:

» Parent Group: Select a parent group where you want to save the list.

You can create a new group or select the User group, or select any user-created
group

Default parent group: When creating a nested group within any 'All' group (for
example, All Rules, All Bloks, and so on), the User group is the default
group. Otherwise, the current parent group is selected as the default group.

¢ Name: The name can include letters, numbers, or underscore (_).
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e Description

e Value Type

e Mappings
4. Click Save.

Add Enrichment Lists

Parent Group

Description:

Value Type:
string -
Mappings:
{
"192.0.2.10" "watchlP”,

"192.0.2 20" "watchlP"
}

Result
The Enrichment List is displayed on the page.

If the mappings section contains the key default and there is no other mapping for the key
used during lookup, the mapped value is returned as a default value. To override this
default value at query time, specify the optional <default_value> parameter as a second
parameter.
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o Note: Clicking any Enrichment List name in the list displays its information in a
separate Details pane.

Enrichment List
E Q Find View A - O
ForcepointSeverity 2019-03-29 12:58:15 2019-03-24 07:26:36  System string -
Details X

Fortinet 2019-03-29 12:58:15 2019-03-24 07:26:36 system string
Fortinet_id 2019-03-29 12:58:15  2019-03-2407:26:36  System string Enrichment List Edit
Gridserver 2019-03-29 12:58:15 2019-03-24 07:26:37  System string

Mame: ipBlacLlist
httpstatuscode 2019-03-29 12-58:15 2019-03-24 07-26-37  System string

Description: blacklisted IP addresses
HITpStatusTostatusiD 2019-03-29 12:58:15 2019-03-24 07:26:37 system String Last change: 2019-03-30 07:42-34

ge: 2019-03-30 01:42:3
D IpBlacLiist 2019-03-30 01:42:34 2019-03-30 01:42:34 admin string Created on:- 2019-03-30 01:42-34

ISSSiteProtector_Action 2019-03-2012:58:15  2018-04-2216:11:19  System string Created by: admin
1SSSiteProtector_ActioniD 2019-03-29 125815  2018-04-2216:19-19  System string Value type: string

Mappings:
Is5SiteProtector_StatusiD 2019-03-29 12:58:15 2018-04-22 16:22:28 System string "10.97.170.168""blacklisted","10.97.170.175""

blacklisted"}
ISsSiteProtectorTcpipProtocolNumber 2019-03-29 12:58:15 2018-04-22 15:3241 System string
mapRuleAction 2019-03-29 12:58:15 2019-03-24 07:26:37  System string
mapRuleAction|d 2019-03-28 12-58:15 2019-03-24 07-26:37  System string
mapRulestatus 2019-03-29 12:58:15 2019-03-24 07:26:37 System string

Editing an Enrichment List

You can edit an existing enrichment list from Management > Advanced Features >
Enrichment Lists.
To edit an enrichment list, perform the following procedure. To delete an enrichment list,

select the list and click the delete icon .
Procedure

1. Navigate to Management > Advanced Features > Enrichment Lists.

2. Click the name of the enrichment list and modify the required fields.
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Update Enrichment List

MName:

Description:

Value Type:
string

Mappings:

{"10.97.170.168""blacklisted","10.97.170.175""blacklisted”, "10.57.123.142": "placklisted"}

Note: When the mappings are stored, any white space characters are
removed. Therefore, you might see the mappings in one line.

3. Click Save.

Infrastructure Queries

Infrastructure queries retrieve statistical information about LoglLogic LMI data, such as its
configuration or the amount of data ingested into LogLogic LMI. They work in the same
way as other queries, except where indicated.

Infrastructure queries are not necessarily related to log events and do not contain an event
time-stamp column like other data models. Thus, a time value need not be specified in
infrastructure queries. If you use the Time field rather than embedding the time span
explicitly in the query, then you must delete the value from the time Blok field to
successfully execute an infrastructure query.
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Fetching the Ingested Data

Fetching the Advanced Application Pack Schema

Correlation Alert SLA Status

Aggregation Rule Metrics

Fetching the Ingested Data

Query

USE Loglogic_System_Ingest_And_Index_Stats

Description

The data ingest count is taken when the files are collected by the appliance, whereas the
index count is taken when those files (or, in the case of large pulled files, parts of those
files) are actually indexed.

If a large amount of data is ingested in 1 hour, most of it might be indexed in the
subsequent hour, resulting in a higher index count than the ingest count for that hour.

In a relatively quiet system, the data ingest count is updated only periodically, whereas the
index count is updated every time a file is indexed. Therefore, the index count might be
updated before the data ingest count. As a result, the index count might be more than the
data ingest count for the most recent hour.

Therefore, for up-to-date values, check the count shortly after the end of any particular
hour.

Query result

The following fields are returned in the search results:
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Field Description

lls_time Time period to be queried

lls_ingestBytes Number of data bytes ingested during the specified time period
[ls_indexBytes Number of bytes indexed during the specified time period
[ls_indexSizeDelta Change in the size of the physical disk space consumed by the index

lls_indexMsgCount ~ Number of messages indexed
lls_ingestMsgCount ~ Number of messages ingested

[ls_unindexBytes Number of bytes that are not indexed yet

Examples

1. USE LoglLogic_System_Ingest_And_Index_Stats
Returns: the results in one-hour buckets

2. USE LoglLogic_System_Ingest_And_Index_Stats | COLUMNS 1ls_time, 11ls_
ingestBytes / 1024.0 / 1024.0 / 1024.0 AS IngestGB, 1ls_indexBytes /
1024.0 / 1024.0 /1024.0 AS IndexGB

Returns: the results in GB

3. USE LoglLogic_System_Ingest_And_Index_Stats | COLUMNS DAYS(1lls_time) as
myTime, SUM(1lls_ingestBytes ) / 1024.0 / 1024.0 / 1024.0 AS
IngestGBPerDay, SUM(1lls_indexBytes ) / 1024.0 / 1024.0 / 1024.0 AS
IndexGBPerDay| GROUP BY DAYS(lls_time)

Returns: the result in one-day buckets in GB

Fetching the Advanced Application Pack Schema

The Advanced Application Pack (AAP) Schema query displays the metadata on the
Advanced Search page.

Query

use Loglogic_AapSchema
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Description

By using the LoglLogic_AapSchema infrastructure query, you can view the common schema
used by the built-in data models in LogLogic LMI, and the common schema used in
creating custom data models. By using the common schema, you can leverage the
normalization done in the Loglogic LMI models and optimize searches and reporting.

Query result

When you run this query, the fields from the AAP schema file are displayed in the search
results area, for example:

e ll_eventID

* |l_deviceCategory
* [l_sourceUser

o |l_targetUser

e ||_sourcelP

o |l_targetlP

Correlation Alert SLA Status

The correlation alert SLA status query displays the status of correlation alerts.

Query

use LoglLogic_AdvancedAlerts_SLA

Description

This query displays the status of alerts that are currently triggered in the system.
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Query result

The following fields are returned in the search results:

Field Data type
lls_alertTime TIMESTAMP
[ls_slaExpiration DURATION
lls_ruleName STRING
lls_state STRING
lls_ackTime TIMESTAMP

lls_timeToRespond = DURATION

lls_category STRING
lls_severity STRING
lls_comment STRING

Description

Date and time when the alert is created

Time to expiration, displayed as Duration data type
Rule name

Alert state

Time when the alert is acknowledged

Time to respond to or acknowledge the alert

Displayed as Duration data type.
Alert category
Alert severity

Comments you provide when acknowledging an alert

Aggregation Rule Metrics

To view the progress of aggregation computation, run the Aggregation Rule Metrics query

in Advanced Search.

Query

USE Loglogic_Aggregation_Rules_Metrics
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Description

When a new aggregation rule is created, it starts computing the metrics for the given
GROUP BY expressions. It aggregates data for all events received in the system after rule
start time and the data for the past events specified in the Compute aggregation for field.
To view the progress of the aggregation computation, you can run this infrastructure query

in the Advanced Search.

Query Result

The following fields are returned in the search results:

Field
aggregationRuleName
totalEventCount

successCount

errorCount

savedRecordCount

dataSizelnMB

replayProgress

replayPercentage

isMerged

Description
The name of the aggregation rule
The number of events processed by the aggregation rule

The number of valid events computed by the aggregation rule
query

The number of events that failed to validate by the aggregation
rule query

The number of records stored in the database for the aggregation
rule

The size of saved records in megabytes (MB)
The number of events processed out of the total events for

historical computation (the aggregation computed before rule
creation)

Applicable only if the aggregation start time is specified in the
Compute aggregation for field.

Percentage progress of the historical computation

Indicates (Yes or No) if the historical computation results are
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Field Description

merged in the database with the ongoing, real-time computation
results

Queries

You can view the following types of queries in the system:

Query Description

Scheduled Queries A list of EQL and SQL queries that are scheduled to be executed at the
frequency that you have set.

Search Queries A list of Advanced Search queries that are currently running in the
system or have completed.

Tail Queries Queries that run on near-real-time data after the data is indexed.
Distributed Advanced Search queries that are run on a Management Station and
Advanced Search distributed to Remote Appliances.

Scheduled Queries

You can schedule search queries to run at a selected time and frequency.

You can create a schedule to run the Advanced Search queries at the required time
intervals and have the reports sent as email attachments.

o Note: Only SQL and EQL queries are supported.

You can view a list of scheduled queries from any of the following locations:

* By clicking Search > Advanced Search > (2] > Show Scheduled Queries
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o Note: This option is disabled if there is no text in the search field.

e By navigating to the Management > Advanced Features > Queries > Scheduled
page

From the Scheduled Queries page, you can:

e View a list of scheduled queries.

Click a query to open the Details pane that displays more information about the
query.

Create, update, or delete a scheduled query.

Configure multiple schedules to execute the query and save its reports.

Enable or disable query schedules:

° To enable or disable selected schedules, click the toggle button next to the
schedule name.

° To disable all schedules, click the toggle button next to the title Schedules.

Download the search results or send the results as email attachments. For more
information, see Configuring Query Schedules.

Adding Scheduled Queries

You can add a query and then configure schedules to execute the query. You can configure
multiple schedules per query.

o Note: Only SQL and EQL queries are supported.

Procedure
1. Navigate to any of the following locations:

* On the Advanced Search page, type your query and then click | > save as
Scheduled Query. The Add Scheduled Query dialog box opens, in which your
query is already available in the Query field.

* Go to Management > Advanced Features > Queries > Scheduled tab and click
(2], The Add Scheduled Query dialog box includes the following sections:
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* Query - Displays the name, description, and query text.

» Schedules - displays a list of schedules for the query. For information on
how to add or modify schedules, see Configuring Query Schedules.

2. Type the name, description, and query.
The following options are available:
» Click Validate to check whether the query syntax is correct.
* Click Format to format the query keywords.

When saving an infrastructure query as a scheduled query, if you include a time filter
in the query, the query is saved successfully. However, after the report is saved in the
system, an error is displayed in the Query Scheduled > View Executions section.

3. Click Save.

Result
The query is added to the list of queries on the Scheduled Queries page.

Configuring Query Schedules

You can schedule the execution of your queries and set the frequency of execution.

Procedure
1. Open the Scheduled Queries page in one of the following ways:

* Click Management > Advanced Features > Queries > Scheduled.
* On the Advanced Search page, click (=] > Show as Scheduled Queries.
2. On the Scheduled Queries page, click a query to open its Details pane.

3. On the Details pane, click Edit. On the Edit Scheduled Query page, configure the
query schedule.

4. To add a schedule, click the plus icon + or the Add Schedule button. The default
schedule name is displayed, but you can change it, if required.

5. In the Time Frame section, enter the following information.
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Field Description
Run Select one of the following frequency types:
Frequency Type Description
Once every few Select the hourly interval from the Hourly Interval
hours drop-down list.
Once a day Select the time of the day from the At drop-down
list.
Once every few days a. Select the number of days from the Interval
drop-down list.

b. Select the time of the day from the At drop-
down list.

Once a week a. Select the time of the day from the At drop-
down list.

b. Select the day of the week from the Every
drop-down list.

Once a month a. Select the time of the day from the At drop-
down list.

b. Select the day of the month from the Every
drop-down list. You can also select Last day
of the month.

For the Type the period on which the query should be executed. The default value
Period is -12h. For valid time ranges, see Time Range Expressions.

6. To run the query immediately, click Run Now.

Note: The Run Now button is enabled only when you are editing a
schedule that has already been saved earlier.

The previous and next execution time is displayed in the Previous Execution and
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Next

Execution fields.

7. In the Number of reports to be saved in the system field, enter the number of
execution results that you would like to be stored in the system.

To view the stored reports, click View Executions. From the Executions page you can
delete or download selected reports as a CSV file.

Note: The View Executions link is visible only when you are editing a
schedule that has already been saved earlier. The link is not available
when adding a new schedule.

<= Back

Executions

to schedule details

Executlion Time Disk Cache Size

10/10/2017, 2:33 PM 428 R

8. (Optional) Email Recipients section: If you want the report to be sent by email, enter
the name and email ID of the email recipients and click the check mark to save. You
can send the email attachments as a PDF, HTML, or CSV file.

If a user with the name and email ID is found in the database, the login name
of the user is filled automatically in the Login Name field.

The file name of the attachment includes the schedule name followed by the
date and time when the email is sent. The file name format is
<scheduleName><date>T<time>.<fileExtension>. For example, CiscoASA_
Schedule_1_2019-12-23T01:03:22.226017.csv.

» The attachments are compressed before being attached to the email. If the

attachment size is more than the maximum permitted value, the email does
not include the attachment. You must download the attachment from the
Executions page. To have the attachment size limit increased, contact your
administrator.

If the number of columns you selected or the content within the columns is too
large, then the PDF report might be distorted. In such a case, reduce the
number of selected columns. Otherwise, select the CSV or HTML format as the
report type.
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° Tip: If there is any error while executing the query or sending emails, an
error icon is displayed. Hover over the error icon to read the error
messages.

If you do not receive an email, then check if the mail has been redirected
to the Spam folder.

Search Queries

The Management > Advanced Features > Queries > Search page displays the queries
that are currently running in the system or have completed.

The following query information is displayed as a table:
e Query ID
* Query
» Total events

 Progress percentage

To delete queries, select the queries by clicking the corresponding check boxes, and then

click [,

Even if the execution of a query has completed, the query remains in the system cache
until it is deleted. A query can be deleted in any of the following ways:

e On the GUI:

° By closing the Advanced Search tab for the query

° By deleting the query from the Queries > Search page
e From the REST API:

° By using the deleteQuery() API

o If the time to live value of the query elapses.

The timeToLive parameter is applicable only to queries created with REST API.
It indicates the number of seconds of time after which the query is
automatically deleted. The default value is 120 seconds.
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Tail Queries

Tail queries run on near-real-time data after the data is indexed.

The query results display new incoming events that match the query criteria. Because of
the nature of these queries, they never end; you must cancel or delete them manually.

You can query real-time data from the Advanced Search or the Data Grid widget, by using
any of the following methods:

Use the TAIL keyword in the query

Select Real Time from the time filter list (only on the Advanced Search tab)

Features of TAIL queries

Real-time search results are appended to the results list. Navigate to the last page to
view the latest results.

Similar to other search queries, you can click Pause or Resume at the top of the
results page to control the streaming of logs.

Real-time streaming stops if you switch to another page or log out. However, it
automatically resumes when you return to the search page or log in again.

You can use LIMIT and BUFFER statements in a tail query:

o LIMIT specifies the maximum number of results that must be displayed. The
results are displayed in three pages. After retrieving more results, the same
number of initial results are removed from the first page. Thus, if the limit is 50,
only the latest 50 results fetched are displayed.

° BUFFER specifies the maximum streaming time to wait before returning results
for the Tail query. You can use BUFFER with the TAIL keyword; not with the
Real Time option from the time filter.

Example of TAIL query

The example query that includes the TAIL keyword:

USE system |TAIL BUFFER 500 ms | LIMIT 50

In the following example, the time filter is set to Real Time:
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Home > Search > Adwanced Search

Enterprise Virtual Appliance LSP34.1 - Mar 18, 2019 22:13:03 PDT

Search 1

Selea Log Sources z USE system B 5 Real Time - m
a
lI columns columns found ® Raw  Table Tail Query is paused Resume Columns m Wordwrap ﬂ =
—
Q. search 61.2019-03-1910:41:02.119  <B6=Mar 18 22:11:01 logapp sudo: pam_unix{sudo:session): session closed for -
r
o T user root
-
selectal sys_eventTime: sys_collectlP:
2019-03-18 22:11:02119 10:128.132.100
sys_eventTime 62 2019-03-1910:41:02129  <14=Mar 18 22:11:01 logapp MGMT: %LOGLOGIC-6
» module:engine_lx_parser(15090); file:rtf_r.c(rtf_remove_file,245); action:closing 0
sys_collecti? offsen 3 218
» Noglogic/datafvol1/2019/03/19/0500/rawdata_10011_1552972200_60-365.wrgz;
D sys_collectorDom... sys_eventTime: sys_collectiP:
»

2019-03-18 22:11:02.129 10:128.132.100
D sys_deviceType
» 63.2019-03-1910:41:02139  <14=Mar 18 22:11:01 logapp MGMT: %LOGLOGIC-6
. module:engine_lx_parser{15090); file:rtf_r.c(rtf_open_files,490); actionzopening
[ == current file at time 1552972261 Mon Mar 18 22:11:01 2019 ;

sys_eventTime: sys_collectlP:
2019-03-18 22:11:02.139 10:128.132.100

64, 20159-03-19 10:41:07.157 =14=Mar 18 22:11:06 logapp MGMT: %LOGLOGIC-6
module:engine_lx_parser{15090); file:rtf_r.c{rf_open_files,490); actionzopening
current file at time 1552972266 Mon Mar 18 22:11:06 2019 ;

sys_eventTime: sys_collectlP:
2019-03-18 22:11:07.157 10:128.132.100

65.2019-03-1910:41:1216%  <B6=Mar 18 22:11:11 logapp sudo: parn_unix{sudo:session):

Showing 61 to 78 of 78

Limitations

Tail queries have the following restrictions:
e The results are always sorted by time.
* Filter options and the timeline chart view are not available.

e The options to download the results and to open search in a new tab are not
available.

e The Tail keyword cannot be used in:
° Infrastructure queries
° Distributed Advanced Search
°© GROUP BY statement (aggregation)
° Distributed aggregation functions

° SQL queries
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Instead, use the where clause to achieve the same results. For example:
® EQL query: use LoglLogic_Appliance | TAIL

B SQL query: select x* from LoglLogic_Appliance WHERE sys_
collectTime > NOW

Distributed Advanced Search

Running a query on one appliance returns results only from that appliance. Distributed
Advanced Search queries can be run on a Management Station and distributed to multiple
Remote Appliances in the setup. The results from all appliances are consolidated by the

Management Station.
To run a distributed Advanced Search query on multiple appliances, specify a list of

appliances by using the sys_concentratorId column or the DeviceInGroup query function
within the query that you run on the Management Station.

0 Important: The query is sent to only those appliances to which you have access
permissions. Furthermore, on the Remote Appliances, the query is run only on
those log sources to which you have access permissions. If you run a query on
the Management Station and omit the appliance list, the query is run only on
the Management Station and not on the Remote Appliances.

Requirements to run distributed Advanced Search
queries

You can use distributed queries in Advanced Search if all of the following requirements are
met:

* The Management Station setup includes the required Remote Appliances. For
information about how to set up a Management Station, see "Manage Appliances
with Management Station" in the TIBCO LogLogic® Log Management
Intelligence Administration.

* You have permission to access the Remote Appliances and devices on which the
search query is to be run.

e Advanced Features are enabled on the Management Station and Remote Appliances.
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» The data node port (9621) on each Remote Appliance is accessible by the
Management Station.

Using the sys_concentratorld column

You can specify the value of sys_concentratorId using =, ==, or the IN construct. Valid
values for sys_concentratorId can be any of the following:

e Explicit appliance IP addresses, where the IP addresses must exist in the
Management Station list on the Management > Management Station page.

» Appliance grouping shortcuts, similar to those used in the Log Source Picker in
Advanced Search.

e Enrichment lists

Examples with IP addresses and shortcuts used in the sys_concentratorId column

Type of
value

Appliance IP
address

Appliance

grouping
shortcuts

Value of sys_
concentratorId

sys_concentratorld
="127.0.0.1"

sys_concentratorld
IN ("127.0.0.1,
<IP1>")

Sys_
concentratorld="
<|P2>"

sys_concentratorld
IN "ALL"

sys_concentratorld
IN "ALL_LX"

sys_concentratorld
IN "ALL_ST"

The query is sent to...

Only to the Management Station, which is always
specified as 127.0.0.1. This is the default value if sys_
concentratorId is not specified.

The Management Station itself and the specified Remote

Appliance having IP address IP1.

Only to the specified Remote Appliance having IP
address IP2.

All members of the Management Station setup.

The types of appliances specified in the shortcut.
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Type of Value of sys_ The query is sent to...
value concentratorId

sys_concentratorld
IN "ALL_MX"

sys_concentratorld
IN "ALL_LX_MX"

sys_concentratorld
IN "ALL LX MX"

sys_concentratorld
IN "ALL LX/MX"

Using Enrichment Lists in the sys_concentratorid column

Enrichment lists can also be used in distributed Advanced Search queries to specify sets of
appliances to which the query must be sent.

For example, you can create an enrichment list called MyApplianceSets with mappings
such as:

{ "setl" : "127.0.0.1, <IP1>, <IP2>",
"set2" : "<p3>" }

If you run a query like this:

USE system | sys_concentratorId = $MyApplianceSets('setl') | sys_body
CONTAINS 'joe'

the query is sent to the IP addresses in setl.

The following query is an example of using an enrichment list when using a device group in
a distributed Advanced Search:

USE system | DeviceInGroup('MyLoglLogicAppliances', S$MyApplianceSets
('setl') ) | sys_body CONTAINS 'joe'
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o Note: The IP addresses in the enrichment list must match those in the
Management Station setup.

Examples with enrichment lists used in the sys_concentratorId column

Type of value  Value of sys_concentratorid The query is sent to...
Enrichment list  sys_ All appliances in setl from the
concentratorld=$MyLogLogicAppliances Enrichment List
("set1") MylLoglLogicAppliances
Enrichment list  sys_concentratorld IN All appliances in set2 from the
and IN (SMyLogLogicAppliances("set2") ) Enrichment List
MyLoglLogicAppliances
Combination sys_concentratorld IN ( "</P_1>", "ALL_ The following appliances:

LX", SMyLogLogicAppliances("set1") ) « The appliance with IP
address IP_1

e All LogLogic LX
Appliances

e All appliances in setl
from the Enrichment List
MyLogLogicAppliances.

Using the DevicelnGroup function

You can specify a list of local or global device groups by using the DeviceInGroup function:

DeviceInGroup ("<Group Name>", "<IP list or appliance grouping shortcuts>"")
where:
e <Group Name> is the name of the device group

e <IP list or appliance grouping shortcuts> specifies the list of appliance concentrator IP
addresses on which the device group is to be evaluated
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Examples of the DeviceInGroup function

Value of DevicelnGroup

DevicelnGroup
("MyLogLogicAppliances",
IIALLll)

DevicelnGroup
("GlobalGroup", "ALL_LX")

DevicelnGroup
("LocalGroup", "</P1>")

DevicelnGroup
("LocalGroup", "<IP2>,
<IP3>")

DevicelnGroup
("GlobalGroup",
SMyLogLogicAppliances
("setl"))

Local device groups

The query is sent to...

All log sources in the device group MyLoglLogicAppliances on
all appliances on which you have access permission.

All log sources in the device group GlobalGroup on all LoglLogic
LX Appliances which have group members and on which you
have access permission.

All log sources in the device group LocalGroup on the
appliance at IP address IP1.

All log sources in the device group LocalGroup on the
appliances at IP address IP2 and IP3.

All log sources in the global group GlobalGroup on the
appliances specified in the setl entry in the Enrichment list
MyLogLogicAppliances. The query is sent to only those
appliances with members in GlobalGroup and on which you
have permission.

You can also run the query on local device groups that use the same name on multiple
appliances. For example, if the local device group MyLocalGroup exists on two
appliances, Appliancel (having IP address IP1) and Appliance2 (having IP address IP2),
and you have permissions on MyLocalGroup on both appliances, then using the
following function in a distributed Advanced Search query on the Management Station:

DeviceInGroup("MyLocalGroup", "</P1>, </p2>")

causes the query to be sent to both appliances Appliancel and Appliance2, for their
corresponding local group MyLocalGroup. Search results from all devices belonging to
the MyLocalGroup device group on both appliances are sent back to the Management

Station.
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Global device groups

If you create a global device group GlobalGroup on the Management Station that
includes log sources from Appliancel and Appliance2, you can use the global group
name in the DeviceInGroup function:

DeviceInGroup ("GlobalGroup", "ALL")

This query is sent to Appliancel and Appliance2.

Global Dynamic Device Groups

In regular expression search, you cannot run distributed queries on dynamic device
groups because dynamic device groups cannot have a global scope.

However, for distributed Advanced Search queries, if you create local dynamic device
groups that have the same group name on the appliances involved, and run a
distributed Advanced Search query for those local dynamic device groups, you can
achieve the effect of a global search result on dynamic device groups.
For more information about device groups, see "Device Group Management" in T/IBCO
LoglLogic® Log Management Intelligence Administration Guide.

Limitations and errors

Limitations
You cannot use the Tail functionality in distributed Advanced Search.
Errors
An error is displayed if:
» The specified appliance shortcut is invalid.

e An appliance specified in the distributed query is not a member of the
Management Station setup.

Examples of distributed Advanced Search queries

These are a few examples of complete queries that you can use in distributed Advanced
Search:
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Using sys_concentratorId:
o USE system | sys_concentratorld="ALL" | sys_eventTime in -10m
e USE system | sys_concentratorld IN ("127.0.0.1") | sys_eventTime in -10m

e USE system | sys_concentratorld IN (SMyApplianceGroups("remotes") ) | sys_
eventTime in -10m

Using DeviceInGroup function:
e USE system | DevicelnGroup("<group name>", "ALL") | sys_eventTime in -1y

e USE system | DevicelnGroup("<group name>", "RemoteAppliancel") | sys_
eventTime in -1y

Using DeviceInGroup in the projection:

e USE system | sys_deviceType = "General Syslog" | COLUMNS sys_collectIP,
DevicelnGroup("LocalGroupl") as dig | sys_concentratorld = "ALL" | sys_eventTime
in-ly

e USE system | COLUMNS sys_deviceType, sys_device, sys_eventTime,
DevicelnGroup("All Other UNIX") as isOtherUnix | sys_eventTime in -1h

Bloks

To analyze your data faster, you can create different types of Bloks in LogLogic LMI to help
you accelerate your search process.

A Blok is a contextual element or filter that fits with other elements to form a search query.
Bloks are reusable elements of a query. You can combine many types of Bloks together to
create complex queries. Build and save different Bloks that can be used in future searches
rather than searching every time by manually typing the same filter.

LoglLogic LMI supports the following types of Bloks:
* Filter Bloks: contain filter statements, aggregation rules
e Correlation Bloks: contain correlation rules
e Time Bloks: contain absolute and relative time ranges

You can add one or more filters in a Blok. If you realize that you need to add another filter
to the existing Blok, you can add more filters or build another Blok.
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You can add new Bloks and modify existing Bloks from the Search tab. Similarly, you can
manage all types of Bloks in a central location by clicking the Management > Advanced
Features > Bloks menu.

When entering a Blok name in the search query field, start with the prefix defined for each
type of Blok. Content assist can help you by showing all possible values for that type of
Blok. For time Bloks, you can select the Blok in the time range field. The following is a list
of prefixes that you can use in the search query field:

e filter.Blok name
e correlation.Blok name

For detailed information on how to create a Blok, see Creating a Blok.

Blok Groups

The Management > Advanced Features > Bloks page displays Bloks in groups. The All
Bloks group displays all Bloks.

For information about groups, types of groups, and managing groups, see the Groups
section.

Filter Bloks

You can create filter Bloks that contain one or more filters.

Each filter comprises one or more terms. A filter Blok supports valid EQL or SQL
statements.

You can have one or more filters in a Blok. If you realize that you need to add another filter
to the existing Blok, you can add more filters or build another Blok. Multiple Bloks of
different types can be used in a single search query. For detailed information about valid
filters, see FILTER Statement.

Example

Create a filter Blok and use it in a search query:
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Create and save a filter Blok that includes sys_deviceType='0ther UNIX' AND sys_body
like '%security%'. Now when you run a query using this Blok, only events with Other
UNIX and security are retrieved.

Use this filter Blok and add another element or filter to it, for example, type sys_
deviceType='Cisco ASA' to the same query to create a more complex query. For example,
filter.Blok name AND sys_deviceType='Cisco ASA'. Now when you run a query using
this Blok, events with Other UNIX, security, and Cisco ASA are retrieved.

Correlation Bloks

For your forensic needs, you can search data using Correlation Bloks.

Correlation Bloks are created using Event Correlation Language Reference (ECL). You create
a correlation Blok and use the Bloks on real-time data to set up triggers. The triggers are,
in turn, configured to send alerts on the real-time data.

You can also use correlation Bloks in Advanced Search to search historical data and
analyze the patterns in the data. When entering a Blok name in the Search field, start with
the prefix correlation. for any existing correlation Blok. Content assist can help you by
showing all possible values for that type of Blok. The correlation search results are
displayed every time the rule's conditions are met. For more information, see Using
Correlation Bloks in Advanced Search.

You cannot combine a correlation Blok with other Blok types in a single query. Only one
correlation Blok can be used at a time in a query. In a correlation Blok query if there are
more than one million events for the defined time duration, only the first one million
events are processed for better performance. In such cases, it is a best practice to reduce
the time duration to retrieve accurate results.

o Note:

e The Blok name cannot contain a period (.).

* On the Advanced Search page, you cannot filter search results for
Correlation Blok by clicking the timeline chart or using the chart time
slider. This is because LoglLogic LMI does not support adding filters and
running subqueries on the search results for a Correlation Blok.
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Using Correlation Bloks in Advanced Search

You can use correlation Bloks in Advanced Search to search historical data and analyze the
patterns in the data.

Procedure

1. Click D next to the Search field, click Choose Blok, and then select the correlation
Blok from the list.

2. Enter the time period in the Time field and click Run.

Note: For valid time expressions, see Time Range Expressions. If you enter
an invalid value in the Time field, the range 1970-2070 is used.

The correlation results display all events that contributed to the triggering of the
correlation rule. Based on the correlation rule, the columns (correlation events and
event groups) are extracted in a table format. Each row helps you analyze the
associated values of the columns and event groups. If you refresh the search tab by
clicking Search > Advanced Search or refresh the browser, the search tab closes.

The following illustration displays the defined correlation rule in the Search field and
retrieved events in the Timeline Charts, Columns, and Data panels. When you use
Correlation Bloks in advanced search, hovering your mouse over any part of the chart
displays the number of correlation events instead of the message count.

Correlation Rule and Timeline Charts

Q correlation.testCorrelationt Last Hour N

2215 22:25 22:35 22:45 22:55 23:05

2017 100.000 24 1 24
2017 01.000 2 1 27
2017-10-26 22:17:02.000 2 gl B
2017-10-26 22:18:06.000 26 1 2

gl
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3. Click the event count link to view the event details on a new Search tab.

Note: The event count link is available only when the count is less than
1024.

Click the event count link (22 in the illustration), and the new search tab opens with
the auto-generated EQL query in the Search field for the events associated with that
event count. The Timeline Charts, Columns, and Data panels display the results
associated for that event count as shown in the following illustration.

testCorrelation! - g1_ev. +

; evemkey o % oroswsoramreszer [
760672011881 50  8760672015C2 57EDT2017AF . y .

8 . '876D672021C1 .
D67202C4" "876D672051C","876D672061 "87606720DC9".

221502 221506 153 2814 2151 21522 221526 221530 221534 22153 22154 21506 22155 221554
221504 22:15:08 21512 22156 22:15:20 221524 221528 2215:32 221536 2215:40 22154 221548 21552

221595 221510 221515 221520 221525 221530 223535 221590

2z15:45 221550 221555 2

roceceng ne colsctor 1263 e stog o 7 STDF: INSERT INT

< K K E R

19="10.1145571" targatP=" scsor="ska/Loguluzer Dacatloce HesitsManar

SourcelP="10.114.96.71" targetP=" acior="akka/Loguluser/DacalNode/HeamMoritor

Time Bloks

Analyzing events based on a certain time range can help correlate results and find the root
cause faster.

You can narrow your search results to a specific time range using the Time Blok. You can
use the preset time Blok or create your custom time Blok that you can use any time.

Each time Blok is translated in a statement before executing the query. When entering the
time Blok name in the Search field, start with the prefix time for any existing time Blok.
You can use Content Assist to see all possible values for that type of Blok. For detailed
information on how to create a time Blok, see Adding a Time Blok.

By default, the time range is set to last hour. You can define the absolute or relative time.
For valid time ranges, see Time Range Expressions.
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Viewing All Time Bloks

The default or user-defined time Bloks can be easily used to quickly search your data.
The default time Bloks have preset time ranges. You cannot modify or delete the default
time Bloks. However, you can update or delete user-defined time Bloks.

Procedure

1. From the Search page, click located next to the Time field, and select Choose
Blok.

2. In the Find field, type the Blok name to quickly find the desired time Blok.

3. Select the Blok name from the list of Bloks. The Description and Source statement
fields are auto-filled based on the selected Blok.

4. Click Save to add the Blok in the Time field. The selected time Blok is displayed in
the Time field.

5. Click ﬂ to view results for the defined time range.

Adding a Time Blok

If you usually search for events that are in the specific time range, you can create a custom
time Blok for that time range and save it for later use.

Procedure

1.

4,

From the Search page, click | located next to the Time field and click Select a date
range to open a window.

Specify the date and time in the From and To fields. Time must be in Hours and
Minutes and click OK. The selected date and time range is displayed in the Time
field. Alternatively, type in the time expression in the Time field. Content Assist
shows you typeahead or contextual matches and completions for each keyword as
you type it into the search field. To define a valid time statement, see Time Range
Expressions.

To save a new time Blok, click | next to the Time field and select Save as Blok.
Alternatively, to add a new Blok, select New Blok.

In the Add new Blok window, enter the information in the following fields:
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Field Description

Name Enter the name of the Blok. It must be a unique name that consists of
a single word. This is a mandatory field.

Description Enter the description of the Blok.
Source The statement of the source (time expression).
Statement

5. Click Save to save the new time Blok. The new time Blok is added in the Choose
Blok list.

Modifying Time Bloks

You can modify the custom time Bloks at any time.
You cannot modify default time Bloks.

Procedure
1. From the Search tab, update the time range expression in the Time field. For
detailed information about valid time statements, see Time Range Expressions.

2. To save a new time Blok or update the existing Blok, click | next to the Time field and
select Save as Blok.

3. Update the information. For information about each field, see Adding a Time Blok.

4. Click Save to save the new time Blok. The new time Blok is added in the Choose
Blok list.

Viewing and Searching Bloks

You can view and search Bloks, or use Bloks to search data.

You cannot modify or delete the system Bloks. However, you can update or delete any
custom Bloks. See Managing Bloks.
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Viewing Bloks

From the Management > Advanced Features > Bloks page, you can view, find, or filter
Bloks in the following ways:

Task
View Bloks

based on
filters

Find Bloks

Sort Bloks

Show or
hide
columns

Steps

You can use filters to easily find Bloks. Click the View list to select the required
filter. The following options are available:

o All
e Created by me
e Created by system

e Imported

You can quickly find the desired Blok by typing the Blok name in the Find field.
As you start typing the Blok name in the Find field, the Bloks page is
automatically refreshed showing your selection.

You can sort any column in ascending or descending order. Click on the column
name or click the arrow (that is displayed on the right side of the column name
when you click in the column) to sort the column.

You can show or hide columns, except the mandatory column, from the table.
Click @ to view all available columns in the table. Select the check box to show
the column. Clear the check box to hide the column from the table. The Bloks
page is updated immediately.

Searching Data by Using Bloks

From the Search > Advanced Search page, you can use the system or existing Bloks to
quickly search your data.

Procedure

1. From the Search > Advanced Search page, click D located next to the Search field,
and select Choose Blok.
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2. Select the type of Blok from the list. The options are All, Filter, Correlation, and Time
Bloks.

3. In the Find field, type the Blok name to quickly find the desired Blok.

4. Select the Blok name from the list of Bloks. The Description and Source >
statement fields are auto-filled based on the selected Blok.

5. Click OK to add the Blok in the Search field. If you select a time Blok, it is displayed
in the Time field.

6. Click ﬂ to view results for the defined Blok.

Managing Bloks

A Blok is a contextual element or filter that fits with other elements to form a search query.
Build and save different Bloks that can be used in future searches rather than searching
every time with the same filter.

The system Bloks have preset values. You cannot modify or delete the system Bloks.

You can manage all types of Bloks from the Management > Advanced Features > Bloks
page.

€) Note: The duplicate ' delete [, and move & icons are enabled after you
select one or more Bloks.

Task Steps

View and See Viewing and Searching Bloks.
search

Bloks

Create and » Creating a Blok

edit Bloks

» Editing a Blok

Note: You cannot edit system-generated Bloks.
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Task Steps
Delete Select the Blok and click the delete icon [
Note:

e You cannot delete built-in and system-created Bloks.

* You can delete a user-defined Blok at any time. After the Blok is
deleted, search queries are not affected; but you cannot run a new
query with a deleted Blok. Queries in the Search > History tab that
use the deleted Blok cannot be run again.

Duplicate Select the Blok and click the duplicate icon ) .

Move Select the Blok and click the move icon ES. Select the group to which you want
to move it.

Note: You cannot move built-in and system-created Bloks.

Rename Select the Blok and click Edit in the Details panel. Then rename the Blok and
click Save.

Note: You cannot rename a Blok using the T icon.

Creating a Blok

If you usually search for events that provide you with specific information such as user
name or severity, you can create a custom Blok for that criteria and save it for later use.

Procedure

1. From the Search page, click the Choose Blok icon “ located next to the Search
field, and select New Blok.

Alternatively, go to Management > Advanced Features > Bloks and click Create
New Blok.

2. In the Add new Blok dialog box, provide the following information:
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a. Parent Group: Select a parent group where you want to save the Blok.

You can create a new group or select the User group, or select any user-created
group

Default parent group: When creating a nested group within any 'All' group (for
example, All Rules, All Bloks, and so on), the User group is the default
group. Otherwise, the current parent group is selected as the default group.

b. Select the Blok type from the list.

c. Name: It must be a unique name that consists of a single word with no special
characters.

The Blok name cannot include a period (.).The name can include letters,
numbers, hyphen, or underscore (_).

d. Description

e. Enter the statement of the source in the Source statement field. Make sure to
enter a valid syntax. Filter and Time Bloks support SQL, EQL, and ECL syntax.
For syntax information, see:

e EQL Search Syntax Reference
e ECL Search Syntax Reference

3. Click Save.

Result
The new Blok is added in the Choose Blok list and is displayed in the Search field. It is
also displayed on the All Bloks page and in the parent group that you selected.

Editing a Blok

You can modify the user-defined Bloks at any time.

o Note: You cannot edit system-generated Bloks.

Procedure
1. From the Search page, update the statement in the Search field. Content assist
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shows you contextual matches and completions for each keyword as you type into
the Search field. For syntax information, see Search Syntax Reference.

2. Click the Choose Blok icon located next to the Search field and select Save as
Blok.

3. Update the information. For information about each field, see Creating a Blok.

4. Click Save to save the Blok as a new Blok.

Result
The new Blok is added in the Choose Blok list and is displayed in the Search field.

Rules

From Management > Advanced Features > Rules, an administrator can add, edit, or
delete triggers and aggregation rules.

e Triggers: can be created after defining a correlation Blok. Triggers describe what
action should be taken once a correlation Blok is triggered.

e Aggregation rules: can optimize the performance of aggregation search queries.

Managing Triggers

Triggers describe what action should be taken when a correlation Blok is triggered. If
several triggers are associated with the same correlation Blok, all of them are triggered.

Adding a Trigger
You can add triggers from the Management > Advanced Features > Rules > Triggers tab.

1. Enter a name and description for the trigger. The name can include letters, numbers,
or underscore (_).

2. Enable or disable the trigger.

You can enable or disable triggers at any time, but they must be synchronized in
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order to be activated.

3. Specify a trigger group, severity, category, and correlation Blok. The built-in group
System is provided, but you can also create your own trigger groups. However, you
cannot delete a trigger group from the GUI.

4. Set the maximum number of alerts and the frequency (hour, minute, day).

5. (Optional) Set up alert notifications to be sent out when the trigger is activated.
Notifications can be in the form of email, syslog, or SNMP and you can set multiple
notifications for a single alert.

For SNMP notifications, if you select the SNMP version as v3, the Snmp Community
field is not included in the log data that is displayed in the search results.

For more information about alerts, see Advanced Alerts. For information about managing
triggers and alerts by using REST API, see REST API for Aggregation Rules.

Synchronizing Triggers
Any updates to the trigger settings requires synchronization for the changes to take effect.

Click the Sync triggers icon I:I on the Triggers tab and select the trigger groups to be
synchronized. The synchronization process deploys all enabled and disabled triggers in the
selected groups to the correlation node. If you create a new trigger, you must synchronize

the trigger group containing the new trigger by clicking the Sync triggers icon I:I

o Note: Even if you select a single trigger and click the Sync triggers icon I:I, the
trigger group for that trigger is selected for synchronization and all triggers
contained in that trigger group are synchronized. You can select multiple trigger
groups to be synchronized.

Aggregation Rules

You can define aggregation rules to optimize the performance of aggregation (GROUP BY)
queries.

After you create and enable aggregation rules, the system precomputes the aggregations as
and when log events arrive in the system. The aggregations are used to compute search
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query results. As time progresses, the aggregations are precomputed at real time, providing
query results much faster than the queries that were not optimized. Such optimized
aggregation queries can be vital for creating responsive dashboards.

Note: To use aggregation rules, Advanced Features and Advanced Aggregation
must be enabled. Contact your administrator to enable the features.

An aggregation rule is defined as a regular EQL or SQL query that contains a GROUP BY
statement and aggregated projections. For details, sese GROUP BY Statement.

For example, consider the data model for BW process information. This data model has
columns such as Domain, AppSpace, Application, Process, Activity, exectionTime,
success, and failure.

Consider the aggregation query as:

USE BWProcesses | GROUP BY Domain, AppSpace, Application, Process
COLUMNS avg(executionTime), max(failure), min(success)

For this search query, the aggregation rule maintains the aggregate metrics avg
(executionTime), max (failure), min(success) for each combination of the GROUP BY
fields: Domain, AppSpace, Application, and Process. The computation happens on every
relevant log event ingested in the system at real time.

When you use an aggregation query for which there is a matching aggregation rule, the
query is a candidate for optimization. If pre-computed metrics are already present, the
results are returned without any query-time computation.

The time filters in the aggregation query must be within the optimized scope of the rule,
that is, between the time specified in the Compute aggregation for field and the time of
the query.

For example, suppose the rule was created at 10 am on Jan 1, with a retention period of 2
weeks. After 2 days, on Jan 3, if you query for aggregated data which matches the rule but
with a time filter condition of -2w, the result is still unoptimized because 2 weeks from the
time of search results in time range starting from Dec 19, but the aggregation rule was not
created on Dec 19. However, if you specify the Compute aggregation for value as -2w
while creating the aggregation rule, then the aggregation is computed from Dec 19
onwards.

Aggregation rules also support grouping by time aggregates. The supported time
aggregations are:
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Time function Groups by
years(sys_eventTime, [multiplier]) Years
months (sys_eventTime, [multiplier]) Months
weeks (sys_eventTime, [multiplier]) Weeks
days(sys_eventTime, [multiplier]) Days
hours(sys_eventTime, [multiplier]) Hours
minutes(sys_eventTime, [multiplier]) Minutes
seconds(sys_eventTime, [multiplier]) Seconds

In these functions, the multiplier parameter is optional. For more information, see: Time
functions.

For example:

USE BWProcesses | GROUP BY Domain, AppSpace, Application, Process, days
(sys_eventTime), hours(sys_eventTime), minutes(sys_eventTime, 10)
COLUMNS avg(executionTime), max(failure), min(success)

This rule computes the metrics avg(executionTime), max (failure), min(success) for each
combination of Domain, AppSpace, Application, and Process across every 10 minutes,
every hour, and every day.

Such queries retrieve the time series data for trend analysis. For example, avg
(executionTime), max (failure), min(success) for AppSpace=‘appSpacel’ AND
Process='Processl' AND Domain='domainl' aggregated for each hour for the
day='Monday".

This query can be used in the Advanced Dashboard to create a time series chart showing
the trend, for example, average execution time for a process across hours of the day.
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° Tip: After an aggregation rule is created, a filter Blok is automatically created in
the system. If there are multiple time clauses in the GROUP BY query, multiple
filter Bloks are created - one for each time clause. To save on query response
time, you can use the filter Blok in Advanced Dashboards instead of typing the
entire query.

An aggregation query can be equal to or subset of another rule query if all of the following
conditions are met:

The USE or FROM clauses are equal

The GROUP BY non-time aggregates are exactly equal

The time aggregates are equal or subset

The projection aggregates of the two queries are equal or subset

Examples

The following examples illustrate how a search query is considered to match an existing
aggregation rule.

Consider the aggregation rule as:

USE LoglLogic_Monitor_Cpu | GROUP BY 1l_nodeId, weeks(sys_eventTime),
days(sys_eventTime), hours(sys_eventTime, 5)

COLUMNS max(ll_systemCPU), max(ll_processCPU), avg(ll_systemCPU), avg
(11l_processCPU)

Now consider the following search queries:
Queryl

USE LoglLogic_Monitor_Cpu | GROUP BY 11l_nodeId, weeks(sys_eventTime)
COLUMNS max(ll_systemCPU) ,avg(ll_processCPU)

Queryl matches the aggregation rule because all conditions match:

* The USE clause in Queryl is the same as that of the aggregation rule.
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* The GROUP BY non-time aggregate (11_nodeId) in Queryl is exactly the same as
that in the aggregation rule.

e The time aggregate column weeks (sys_eventTime) is a subset of that in the
aggregation rule. So, the GROUP BY clause of Queryl is a subset of the GROUP BY
clause of the aggregation rule.

e The projection aggregates in Queryl, max (11_systemCPU), avg(ll_processCPU),
are a subset of that in the aggregation rule.

Query2

USE LoglLogic_Monitor_Cpu, Loglogic_Appliance | GROUP BY 11_nodeld,
weeks (sys_eventTime) COLUMNS max(ll_systemCPU), avg(ll_processCPU)
Query2 does not match the aggregation rule because:

The USE clause in Query2 is not same as that of the aggregation rule; it has an extra
data model Loglogic_Appliance.

Query3

USE LoglLogic_Monitor_Cpu | GROUP BY 11l_nodeId, 11_pRuleID, weeks(sys_
eventTime) COLUMNS max(ll_systemCPU), avg(ll_processCPU)
Query3 does not match the aggregation rule because:

The GROUP BY non-time aggregate in Query3 is not exactly the same as that in the
aggregation rule; it has an extra column 11_pRuleID.

Query4

USE LoglLogic_Monitor_Cpu | GROUP BY 11_nodeId, minutes(sys_eventTime)
COLUMNS max(ll_systemCPU), avg(ll_processCPU)

Query4 does not match the aggregation rule because:

The time GROUP BY in Query4 is not equal to or a subset of that in the aggregation rule;
it has a different column minutes(sys_eventTime).
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Query5

USE LoglLogic_Monitor_Cpu | GROUP BY 11l_nodeId, minutes(sys_eventTime)
COLUMNS max(ll_systemCPU), sum(ll_processCPU)
Query5 does not match the aggregation rule because:

The projection columns in Query5 are not equal to or a subset of that in the aggregation
rule; it has a different column sum(11_processCPU).

Limitations

You cannot create precomputed aggregation sets for infrastructure queries.

Aggregation Rule Groups

The Management > Advanced Features > Rules > Aggregation page displays rules in
groups. The All Rules group displays all aggregation rules.

For information about groups, types of groups, and managing groups, see the Groups
section.

Viewing and Searching Aggregation Rules

From the Management > Advanced Features > Rules > Aggregation page, you can view,
find, or filter rules in the following ways:

Task Steps

View rules  You can use filters to easily find rules in the system. Click the View list to select
based on the required filter. The following options are available:
filters . Al

e Created by me

e Created by system

e Imported
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Task

Find rules

Sort rules

Show or
hide
columns

Steps

You can quickly find the desired rule by typing the rule name in the Find field.
As you start typing a rule name in the Find field, the Aggregation page is
automatically refreshed showing your selection.

You can sort any column in ascending or descending order on the Aggregation
page. Click the column name or click the arrow (that is displayed on the right
side of the column name when you click in that column) to sort the column.

You can show or hide columns. except the mandatory column, from the table.
Click the column picker icon '@' to view all available columns in the table.

Select the check box to show the column. Clear the check box to hide the
column from the table. The Aggregation page is updated immediately

Managing Aggregation Rules

You can view all aggregation rules, add a new rule, edit existing rules, or delete rules from

the system.

You can manage rules from the Management > Advanced Features >
Rules > Aggregation page.

o Note: The duplicate ] , delete [l, and move &= icons are enabled after you

select one or more rules.

Task

View and
search rules

Create a
new rule

Edit a rule

Steps

See Viewing and Searching Aggregation Rules.

See Creating an Aggregation Rule.

Clicking a rule displays the Details panel, in which more information about the

query is displayed. You can click Edit to modify the information. See Editing an
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Task Steps
Aggregation Rule.

Note: You cannot edit built-in and system-created rules. However, you can
duplicate the built-in or system-created rule, save it in the User group or a
user-created group, and then edit the information in the duplicated rule.

Duplicate Select the rule and click the duplicate icon O, Modify the query and then save

the new rule to the User group or a user-created group.

Delete Select the rule and click the delete icon [I. After you delete a rule, it cannot be

recovered. When an aggregation rule is deleted from the system, the
aggregated data for that rule is deleted and the query is not optimized.
Similarly, the corresponding filter Blok is also deleted from the system.

Move Select the rule and click the move icon E3. Select the group to which you want
to move the rule.

Rename You can rename groups but not rules.
Enable or Aggregation rules can be disabled. After a rule is disabled, it stops computing
disable aggregations and all the existing aggregated data that was precomputed for

that rule is deleted. The optimization starts only after the rule is enabled.

To enable or disable a rule, click Enabled.

Creating an Aggregation Rule

When a new aggregation rule is created, it starts computing the metrics for the given
GROUP BY expressions. It aggregates data for the events starting from the aggregation start
period up to the rule creation time. When an aggregation query matches an aggregation
rule, the query results are fetched from the collected aggregation data. After an
aggregation rule is created, a filter Blok is automatically created in the system. If there are
multiple time clauses in the GROUP BY query, multiple filter Bloks are created - one for
each time clause.

Attention:

e When creating aggregations for small periods, for example using GROUP BY minutes
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or seconds, use the data type as long for the columns in your custom data model.

» When using your own data model to create aggregation rules, if you edit any column
types of the data model after creating an aggregation rule, then for the changes to
take effect you must either create a new aggregation rule again, or edit and save the
existing aggregation rule.

Note: Editing an aggregation rule causes all existing data to be purged,
and the rule starts computing the aggregation using the updated query.

Procedure
1. Go to Management > Advanced Features > Rules and click the Aggregation tab.

2. Click Create New Rule.
3. In the Add Aggregation Rule dialog box, provide the following information:

a. Parent Group: Select a parent group where you want to save the rule.

You can create a new group or select the User group, or select any user-created
group
Default parent group: When creating a nested group within any 'All' group (for

example, All Rules, All Bloks, and so on), the User group is the default
group. Otherwise, the current parent group is selected as the default group.

b. Name: The name can include letters, numbers, hyphen, or underscore (_). The
rule name cannot start with a number.

c. (Optional) Description of the rule.

d. Query: Ensure that you enter a valid syntax of a search query. An EQL or SQL
query that contains GROUP BY statement and aggregated projections are
supported. For details, see GROUP BY Statement. Note the following
exceptions:

e Time functions in the GROUP BY statement can only have sys_eventTime
as an argument. Any other timestamp column is not supported.

e Restrictions on GROUP BY statement:

°© GROUP BY statement can include both column names or
expressions. However, only time functions are supported, for
example, days(sys_eventTime), weeks (sys_eventTime). Generic
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expressions such as length(Process) /16 are not supported.

o Special characters in column names should be escaped, for
example, [Process Name] or [% Memory]

e Restrictions on the projection clause (COLUMNS):

° The projection items must contain aggregate functions such as sum
(), avg().

° Projection items can be a complex expression, for example,
concatenate(max(cpu), '_vs_', min(cpu)), but it should contain
aggregation functions. An aggregation function can contain only
simple functions as arguments. For example, max (Memory) is
supported but max (sqrt(Memory)) is not.

Click Validate to verify the query statement.

e. Select or clear the appropriate Aggregation time check boxes to add or
remove time functions in GROUP BY clause of the query.

When you select this option, the time aggregation you selected is inserted in
the GROUP BY clause of the rule query. The default time aggregation functions
are:

o weeks(sys_eventTime)
e days(sys_eventTime)

e hours(sys_eventTime)
e minutes(sys_eventTime)

f. In the Retention period field, enter the retention time for which the computed
aggregation values remain stored in the aggregated data.

You can search based on the same aggregation functions until the specified
time has passed. By default, it is set to -1w (1 week).

For example, if the retention period is -2w (2 weeks), then pre-computed results
remain in the system for 2 weeks since the time of rule creation.

g. In the Compute aggregation for field, specify the time when the aggregation
computing must start. A one-time calculation of aggregation happens on the
data that was already collected prior to the creation of the aggregation rule. To
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start computing as soon as the rule is created, leave the field empty. To
compute aggregation for the data that exists prior to rule creation, specify the
time relative to rule creation time. For example, -1d, -1w, and so on.

o Note:

e The Compute aggregation for period cannot be more than
the retention period.

* To modify the Compute aggregation for period, first modify
the retention period and then the Compute aggregation for
period.

The data model Loglogic_Aggregation_Rules_Metrics provides a disk usage
statistics of all aggregation rules in the system. You can run the infrastructure
query Aggregation Rule Metrics and view the results.

h. In the Maximum Aggregated Data Storage Size in MB field, enter the
maximum storage size of aggregated data. The minimum value is 1 MB, the
maximum value is 2147483647, and the default is 1024 MB if the field is empty
or 0. You can specify the limit based on the storage availability in your setup.

Data is purged daily, based on the retention period and the maximum storage
values. Purging is triggered 24 hours after rule creation time. When one of these
values is exceeded, the oldest 24 hours data is purged to match the values that
you specified in the aggregation rule. For example, with the retention period as
-lw and maximum storage size as 1024 MB, suppose that the aggregation data
on the first day is 1000 MB and on the second day, is 2024 MB. On the second
day, the oldest 24 hours data (in this example, 1000 MB data of the first day) is
purged to match the storage size limit of 1024 MB.

i. To activate the aggregation rule, set Enabled to ON.

The optimization starts only after the rule is enabled. The disabled rule does
not compute real-time events.

4. Click Save.

Result

The newly added rule is displayed in the All Rules group and in the parent group that you
selected.
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Saving an Advanced Search Query as an Aggregation Rule

If the query is not already included in any saved aggregation rule, then the Optimize icon is
displayed.

Procedure
1. On the Advanced Search page, click the optimize icon + to open the Add
Aggregation Rule dialog box.

The query that you typed on the Advanced Search page is automatically filled in the
Query field.

2. Enter the other fields in the Add Aggregation Rule dialog box and then click Save.

The aggregation rule is saved in the system.

Editing an Aggregation Rule

When the existing aggregation rule is updated in the system, the aggregated data is reset
and computation starts again from the updated time, and the corresponding filter Blok is
also updated automatically.

Important Considerations

 If you update any of the fields, the aggregation start time is updated on the
Aggregation page.

 If you update the description or re-enable a disabled rule, the precomputed
aggregation data before the updated rule start time is not purged from the system
until the retention time elapses.

* If you update any other field, the existing precomputed data for the given
aggregation rule is purged and the data is recomputed starting from the time
specified in the Compute aggregation for field, or from the current time if this field
is empty.

Procedure

1. Go to Management > Advanced Features > Rules and click the Aggregation tab.

2. On the Aggregation page, click the rule name that you want to update.
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The Details panel opens on the right side of the page.

3. Click Edit and make the necessary updates.

For more information about fields, see the steps in the Adding an Aggregation Rule
section.

4. Click Save to save the updated information.

Result
The updated rule is displayed on the Aggregation page.

Viewing the Statistics of Aggregation Rule Computations

When a new aggregation rule is created, it starts computing the metrics for the given
GROUP BY expressions. It aggregates data for the events starting from the aggregation start
period up to the rule creation time. To view the progress of the aggregation computation,
you can run the following infrastructure query in the Advanced Search:

USE Loglogic_Aggregation_Rules_Metrics

For more information about the infrastructure query, see Aggregation Rule Metrics.

Distributed Aggregation Rules

Starting from LoglLogic LMI 6.3.0, you can create an aggregation rule on a Management
Station and distribute the rule to multiple Remote Appliances in the setup.

Using the distributed aggregation rule, you can run an optimized search query on the
Management Station, which in turn runs on the specified Remote Appliances. The results
from the specified Remote Appliances are consolidated by the Management Station.

Requirements to use distributed aggregation rules

You can use distributed aggregation rules in Advanced Search if all of the following
requirements are met:

e The Management Station setup includes the required Remote Appliances. For
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information about how to set up a Management Station, see "Manage Appliances
with Management Station" in the TIBCO LogLogic® Log Management
Intelligence Administration.

* You have permission to access the Remote Appliances and devices on which the
search query is to be run.

e Advanced Features are enabled on the Management Station and Remote Appliances.

» Advanced Aggregation is enabled on the Management Station and Remote
Appliances.

Important Considerations

 After the aggregation rule is created and distributed, the rule can be modified or
deleted only from the Management Station GUI. The rule cannot be modified or
deleted from the GUI of Remote Appliances.

» After the aggregation rule is created and distributed, if you change the Management
Station setup (add or remove Remote Appliances), the rule is redistributed to only
those appliances to which the rule creator user has access.

Creating distributed aggregation rules

You create an aggregation rule on the Management Station and specify the list of
appliances to which the rule is to be distributed. The rule is then distributed to the
specified appliances. You specify the appliances using the appropriate values in sys_
concentratorId column or the DeviceInGroup function.

Modifying distributed aggregation rules

If you modify a distributed aggregation rule on the Management Station, the rule is also
updated on the appliances where the rule had been distributed at rule creation time. You
can modify other fields and parameters in the rule except the list of appliances. If you want
to modify the list of appliances in the distributed aggregation rule, you must delete the
existing rule and create a new one for redistribution.
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Deleting distributed aggregation rules

If you delete a distributed aggregation rule on the Management Station, the rule is also
deleted on the Remote Appliances. However, if the appliances registered in the
Management Station are modified after rule creation time, then the rule is deleted from
only those Remote Appliances that are members of the Management Station at deletion
time. When a rule is deleted, all aggregated data created by that rule is also deleted.

Searching using the distributed aggregation rule

If you run an optimized Advanced Search query on a Management Station, the query is run
on all appliances specified in the aggregation rule, and the results are consolidated by the
Management Station. The query is run on only those appliances that are accessible at run
time, and search results from only those appliances are consolidated by the Management
Station.

You can run the optimized distributed query by specifying the exact rule query or by using
a filter Blok created for the rule.

Example using a query:

USE LoglLogic_Appliance | GROUP BY 1l1_pRuleID | sys_concentratorId =
"ALL'

Example using a filter Blok: If you save the query as a filter Blok LogLogicApplianceBlok,
you can search using the filter Blok:

filter.LoglLogicApplianceBlok

For more information about distributed Advanced Search and how to specify the list of
appliances, see Distributed Advanced Search.

Limitations and errors

Limitations
* You cannot use the Tail functionality in distributed aggregation rules.

* You cannot use Enrichment Lists as a value in the sys_concentratorId parameter
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and in the DeviceInGroup function in distributed aggregation rules.
Errors
An error is displayed if:
» The specified appliance shortcut is invalid.

» An appliance specified in the distributed query is not a member of the
Management Station setup.

Advanced Alerts

Alerts are generated when real-time events match a correlation Blok that has an active
trigger linked to it. For information on how to define triggers, see Managing Triggers.

Alerts can be distributed by email to a pre-defined list of people. To receive email
notifications, the SMTP connection must be configured. To configure the SMTP connection,
contact your administrator.

The default retention period for all generated alerts is 90 days.

Note: Advanced alerts work only if the Advanced Features are enabled. To
enable Advanced Features, contact your administrator.

Viewing and Searching Advanced Alerts

From the Alerts > Advanced Alerts page, you can view, find, or filter alerts in the following
ways:

Task Steps

View alert ~ See Viewing Alert Details.
details

View alerts  You can use filters to easily find alerts. Click the View list to select the required
based on filter. The following options are available:
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Task Steps

filters All - all alerts in the system

Acknowledged - alerts that have been acknowledged

High Severity - alerts with high severity

Unacknowledged - alerts that have not been acknowledged

Find alerts  You can quickly find the desired alert by typing the alert name in the Find field.
As you start typing the alert name in the Filter field, the Alerts page is
automatically refreshed showing your selection.

Sort alerts  You can sort any column in ascending or descending order. To sort by a column,
click on the column name or the arrow next to the column name.

Show or You can show or hide columns. except the mandatory column, from the table.
hide Click the column picker icon '@' to view all available columns in the table.
columns

Select the check box to show the column. Clear the check box to hide the
column from the table. The Alerts page is updated immediately.

The following table describes the Alerts information displayed on the Alerts page:

Column Description

Severity The severity of the trigger. The options are:
* Info
e Low
e Medium
e High
Note: An admin (a user with administrator privileges) can

configure severity options. The options might differ if they have
been configured.

SLA Expiration The Service Level Agreement (SLA) expiration time is the time by
which an operator is expected to acknowledge the alert. When the
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Column

Status

Acknowledged

Name
Trigger Group
Description

Category

Description

SLA time expires,
this column field.

The icon indicate

(8] expired

it displays the time in negative hours or days in

s the alert status:

(o] acknowledged

[®] unacknowledged

A check mark indicates that the alert is acknowledged.
Otherwise this field is blank.

The trigger name

associated with the alert.

The group to which the trigger belongs.

The description of the alert.

The category of the trigger. The options are:

e Attack ont
e Authorized
e Authorized

* Emergency

hird party
Activity
security testing

changes

» False positive

e Known error

* Loglogic Event

¢ Network Noise

e Security Alert

e Suspicious

e Unauthoriz

Activity
ed Activity
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Column

Elapsed time

Last updated

Limitation

Description
e Unknown

Note: An admin (a user with administrator privileges) can
configure the category options. The options might differ if they
have been configured.

The time since the alert was created

The time when the alert was last updated

If you use a correlation Blok in an Advanced Search and the result includes 'null’ values,
the triggered alerts does not include the items including 'null’ values.

Managing Advanced Alerts

From the Alerts > Advanced Alerts page, you can view all triggered alerts, and
acknowledge or filter them. From the Alerts page, you can perform the following tasks:

Task
Acknowledge
alerts

View and

search alerts

View alert
details

Auto-refresh
the list of alerts

Steps

Acknowledging an alert indicates that you have recognized the alert. Once
you acknowledge the alert, your user name gets associated with that alert.
For instructions on how to acknowledge alerts, see Acknowledging Alerts.
See Viewing and Searching Advanced Alerts.

See Viewing Alert Details.

Click the down arrow next to the refresh button to set the refresh
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Task Steps

interval in seconds. Enter the time in seconds. The Alerts table is refreshed
as per the defined time interval. By default, it is refreshed every 30 seconds.
Clicking the Pause button halts refreshing, and the Pause button changes
to Resume. Clicking Resume resumes refreshing the list of alerts.

Delete alerts Select alerts from the list and delete them by clicking Delete

Limitation

If you use a correlation Blok in an Advanced Search and the result includes 'null’ values,
the triggered alerts does not include the items including 'null’ values.

Acknowledging Alerts

Acknowledging an alert indicates that you have received and recognized the alert. Once
you acknowledge the alert, your name is associated with that alert.

Procedure
1. Navigate to Alerts > Advanced Alerts.

2. Select the check box for the alerts you want to acknowledge. To select all alerts,
select the check box located to the left of the column headings.

3. Click Acknowledge to acknowledge the selected alerts.

4. Enter the following information:

Field Description

Severity Alert severity

Category Alert category

URL Web address of an external web page such as a customer relationship
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Field Description

management system or a defect tracking system. This enables you to
track actions triggered by the alert.

Comments Comments about the alert
(Optional)

5. Click Acknowledge to acknowledge alerts.

Result

The Alerts table shows a E icon in the Status column and a checkmark in the
Acknowledged column for the acknowledged alerts.

Viewing Alert Details

You can view details of any generated alert.

Procedure
1. Navigate to Alerts > Advanced Alerts.

2. From the Alerts page, click the alert name to view its details.

In the Details window, you can view alert details, history, associated correlation rule,
and event group details. An event group count is displayed with a clickable number.
For more information, see Viewing Event Group Details.
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test

Details

Mame test

Created 20M7-12-11 22:43:33

Created by S5YSTEM

Description

S5LA 2017-12-14 16:00:00 Expires in 3 days

Last Updated Mon Dec 11 22:44:32 PST 2017

History
SYSTEM Created Alert 20171211 22:43:33
Rule
Rule testc
2 D "eedff3a-7239-491 c-af9d-0bac 9fdfdo)”
3 Use system
4 Within Tm
5 Event Group G1
G1(58)

sys_eventTime Mon Dec 11 22:42:33 PST 2017

3. To acknowledge the alert, click Acknowledge. For details, see Acknowledging Alerts.

Viewing Event Group Details

Each event group describes the criteria that must combine events to be grouped together
as part of the correlation rule. This is equivalent to a single search query defined in EQL.

Procedure

1. Navigate to Alerts > Advanced Alerts.

2. From the Alerts page, click the alert name to view its details.
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In the Details window, you can view alert details, history, associated correlation rule,
and event group details.

test

Details

Mame test

Created 20171211 22:43:33

Created by SYSTEM

Description

SLA 2017-12-14 16:00:00 Expires in 3 days

Last Updated Mon Dec 11 22:44:32 PST 2017

History
EYSTEM Created Alert 20171211 22:43:33
Rule
Rule testc
2 JUID "6ed0ff3a-7239-491 c-af9d-0bact 9fdfdcd”
3 Use system
4 Within Tm
5 Event Group G1
G1(58)

sys_eventTime Mon Dec 11 22:42:33 PST 2017

3. To view the associated event count query, click the event group count link, for
example, (58) as shown in the example.

Note: The event count link is available only when the count is less than
1024.

A new search tab is added showing the event count query in the Search field. The
Result tab displays the retrieved results in the Timeline Charts, Columns, and Data
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panels.

testc > G1 > detalls

Result 1 +

B crans

|'Ir \u

Find 1. 2017-12-11 22:42-33.366
Seiectat |
| sys_eventTime 58
+ sys_collectip 1 2 20171211 22:42:33.375
sys_deviceType 2
sys_device 2

3. 2017-12-11 22:42:34.386
sys_collectorDom...

f
~ [\ ~ N I\ /A
\ —A\N —\ PRV U, W A W B Van VAL VAN N~ ~ N '}
22:42-35 22:42:45 22:42-55 224305 22:43:15 22:43:25
22:42:40 22:42:50 22:43:00 22:43:10 224320 22:43:30
224240, N\ zzapsg M\ zzdse— ) |\ /22:43:10 A 22-43:20 224
w

q
=) . o) =0
(E) columns & columns founs 1G] (E) pata Rawdata Table Columns on Wordwrap on Snowing 1 to 30 of BB T =] + (K]

<14-Dex

sourceNodeld="" targetNodeld=""type="INFO" tenant="" sourcelP="10.114.98.33" targatl
Iegzer="com tico apollo.correlationnods instance Instance” seurcellser=""targetUser=""id=" msg="Starting Correlation Instance 203480a0-1d6o-dad2-
825¢ e5a5edcd4ETE

sys_eveniTime:  201712-1122:42:33366  syscollectP  10.11408.33

<12=Dec

sourceNodeld="" targethodeld="" type="WARN" tenant="" sourcelP="10.114.98.33" targatlP="" actor=""
logger="com fibca.cap.karnel.core.rete. BeTransaction” sourcalser="targatlser=""id="" msg="TBE] Support for B2 Transaction not availaole.”

sys_evertTime:  2017-12-11 22:42:33.375 sys_collectiP: 10.114.08.33

<14=Dec

type="INFO" tenant="" sourcalP=""targetlP="" actor="skka://Logu/user/Correlati ingClient/ss”
logger="com fibca.apallo streaming stream. SubscriptionActor” sourcellser=" targetser=" id=" msg="Start sweaming from datanode-0000C00000"

2,015 of 2,015 events processed 100%  Stop

11 22:42:33 logapp llon application="logu” eventTime="2017-12-12T06:42-33.1582" systemld="" nodeld="correlationnode-0000000000"

actor=""

11 22:42:33 logapp llon application="legu” eventTime="2017-12-12106:42:33.2331" systemid="" nodald="correlationnode-0000000000™

1122:42:34 logapp llon application="logu” eventTime="2017-12-12T06:42:34.013Z" systemid="" nodald="" sourcaNodeld="""targatNodsld=""

Advanced Dashboards

An Advanced Dashboard contains a collection of data widgets that provide a graphical
representation such as a chart, a bar, or a count.

The use of dashboards is endless. For example, as an IT administrator, you can focus on all
machines in your enterprise by creating a widget in a dashboard. Dashboards can be built
as per your specifications. You can add multiple widgets in a dashboard.
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Home > Dashboards > Advanced Dashboards Enterprise Virtual Appliance LSP36.1 - jun 23, 2021 23:38:16 PDT
Advanced dashboard groups ® All dashboards Create Group | | Create Nested Group | E—
-
— Syst:
I All Dashboards 34 ystem
B System 2
-_ User o
I LSP 30
— System Status Retention Policies
I Distributed 0 . i #r - vy r
B Default 0
L5P
n ComplianceSuites ]
B Ashwini 7
+ Crests Group
Microsoft Active Directory Amazon CloudTrail AWS Elastic Load Balancer
f s o J 2027062 008 o

Dashboard Groups

The Dashboards > Advanced Dashboards page displays dashboards in groups. The All
Dashboards group displays all dashboards. The System built-in group includes the
following built-in dashboards:

e System Status

e Retention Policies

For information about groups, types of groups, and managing groups, see the Groups
section.

Managing Advanced Dashboards

You can view all dashboards, add a new dashboard, copy or move an existing dashboard,
or delete any dashboard in the system.

The Advanced Dashboards page displays all dashboards existing in the system. From the
Advanced Dashboard page, you can perform the following tasks:

o Note: You cannot move or delete built-in dashboards.
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Task

Create a new
dashboard

e Move

¢ Delete

e Mark as
favorite

e Duplicate

In grid view...

1. Click Create Dashboard.

2. Enter a name for the dashboard.

In list view...

3. Parent Group: Select a parent group where you want to save the

dashboard.

You can create a new group or select the User group, or select any

user-created group

Default parent group: When creating a nested group within any
'All" group (for example, All Rules, All Bloks, and so on), the User
group is the default group. Otherwise, the current parent group is

selected as the default group.

To move or delete a single
dashboard: Click the context menu
on the top-right corner and then
click the icon for the required
action.

To move or delete multiple
dashboards: Select the dashboards
by clicking the top-left corner of the
dashboard card. From the pane at
the bottom of the screen, click the
icon for the required action.

Note: You cannot move or delete
built-in and system-created
dashboards.

To duplicate a single dashboard
or mark as favorite: Click the
context menu on the top-right
corner and then click the icon for
the required action.

Select one or more dashboards
and then click the move or delete
icons at the top of the list.

Select one or more dashboards
and then click the favorite or
duplicate icons at the top of the
list.
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Task

View dashboards
based on filters

Find dashboards

Sort dashboards

Show or hide
columns

In grid view...

To duplicate multiple dashboards
or mark as favorite: Select the
dashboards by clicking the top-left
corner of the dashboard card. From
the pane at the bottom of the
screen, click the icon for the
required action.

Not applicable

You can quickly find the desired
dashboard by typing the dashboard
name in the Search field. As you
start typing a dashboard name in
the Search field, the dashboard
page is automatically refreshed
showing your selection.

Not applicable

Not applicable

In list view...

You can use filters to easily find
dashboards. Click the View list to
select the required filter. The
following options are available:

o All - all dashboards in the
system

e Favorite - dashboards
marked as favorite

Search: Same as in grid view.

Filter: Select a filter from the
View drop-down list. The filter is
not available in the grid view.

You can sort the list of dashboard
groups by any column. Click the
column name or click the arrow
(that is displayed on the right side
of the column name when you
click in that column) to sort by
the column.

You can select the columns to be
used in the list. Click to view

all available columns in the table.
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Task

In grid view... In list view...

Select the check box to show the
column. Clear the check box to
hide the column from the table.
The Dashboard page is updated
immediately.

System Group of Dashboards

The built-in System group includes the following dashboards for quick reference:

e System Status dashboard

e Retention Policies dashboard

System Status

The System Status dashboard provides an overview of the current status of the system.
You can view this dashboard on the Dashboards > Advanced Dashboards > Advanced
System Status page.

This dashboard displays the following widgets:

» Widgets displaying availability of disk space and archive storage:

o

(e]

o

o

o

o

Free Disk Space

Used Disk Space

Total Disk Space

Tables: stDataFile, indexFiles, metalndexFiles - Size in MB
Remote Archive Storage

Estimated time to reach maximum disk usage

e Line chart widgets depicting CPU usage:

o

o

CPU Usage - 1 Minute
CPU Usage - 10 Minutes
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o

CPU Usage - 15 Minutes

On these charts, the X-axis displays the time and the Y-axis displays the CPU load.

e Line chart widgets depicting the message rate:

o

o

o

o

Message Rate - 1 Minute
Message Rate - 5 Minutes
Message Rate - 15 Minutes

Message Rate - 30 Days

On these charts, the X-axis displays the time and the Y-axis displays the message

rate.

e Bar widgets depicting the ingested and indexed data over the last 24 hours:

o

o

(e]

o

o

Ingested and Indexed Message Count - Last 24 hours
Ingested and Indexed Bytes - Last 24 hours

Real Time - Message Count - Last 24 hours

File Pull - Message Count - Last 24 hours

Ingested vs Indexed Messages in MB - Last 24 hours
Ingested Messages in MB - Last 24 hours

Indexed Messages in MB - Last 24 hours

Indexed vs Unindexed Messages in MB - Last 24 hours

These bar widgets use two different colors for the message count or message bytes.
On this chart, the X-axis displays time and the Y-axis displays the message count or
message bytes.

» Widgets displaying status of rules:

(e]

o

o

Message Routing Rules
Forwarder Rules

File Transfer Rules

e Widgets displaying infrastructure information:

o

|0 Statistics

° Status of LoglLogic LMI engines
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Retention Policies

To view this dashboard, go to Dashboards > Advanced Dashboards > Retention Policies.
The Retention Policies dashboard includes the following widgets:

e Number widgets showing default policy for raw message retention and default index
retention in days:

© Default Period of Raw Retention
° Default Period of Index Retention

e Current Values of Data Retention Rules: An inverted bar chart that displays the
number of retention in days for each rule. The X-axis displays the retention value in
days and the Y-axis displays rule names.

Widgets

Widgets provide a graphical view of the data corresponding to a query. An advanced
dashboard can include different types of widgets.

Some widgets are built-in and available on the built-in dashboards. See System Group of
Dashboards. You can create more widgets for your use.

Managing Widgets

On an advanced dashboard page, you can perform the following widget tasks:

Task Description
Add a new widget Click a widget type from the Widgets pane to add a new widget. For
instructions, see Adding Widgets to an Advanced Dashboard.
Configure or edit a Click @ to update the configuration. You can configure, edit, delete,
widget move, or duplicate the widget by clicking the appropriate icon.
S -
.

S W |
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Task

View a widget in full-
screen mode

View chart details

View value details

Description

Click 9 to view the widget in full-screen mode. Click 9 to exit full-
screen mode.

In full-screen mode, you can open the View data panel to view the
raw data displayed on the widget.

Hover your mouse over a certain area of the chart to view the details.

Hover your mouse over the widget to view the value at that point.
Clicking the value opens the search results of that value on an
Advanced Search tab. However, if the widget query includes aliases
(AS statement), then the Advanced Search tab displays search results
for the entire query.

Resize a widget

Widget Types

Line Widget

Bar Widget

Bubble Chart Widget
Pie Widget

Number Widget
Gauge Widget
Stacked Column Widget
Combined Widget
Treemap Widget
Heat Map Widget
DataGrid Widget
Range Bar

Geomap Widget

Grab any corner of the widget and resize as required.
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Line Widget

This widget is used to show the distribution of the total count of one selected column over
its distinct values.

Use the following information to configure the widget:
e Fetch data from source

* Line widget configuration

Field Description
Fetch data from source

Query Enter a search query.
e To start an EQL statement, enter USE.

e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the Line widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

Date & Time You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.

Line widget configuration

X-axis data Select the column name to define the X-axis.
X-axis label Define the label name for the X-axis that is displayed on the widget.
Y-axis data Select the two columns to define the Y-axis of the widget.
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Field
Y-axis label

Categorize by
Widget description

Auto load

Auto refresh

Refresh widget every

Example

For the search query:

Description
Define the label name for the Y-axis that is displayed on the widget.

Define the column name by which the Y-axis data is combined into a
series.

Enter a short description for the widget. The description is displayed
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.

Default:
» Disabled for widgets created in LoglLogic LMI 6.3.1 and later

* Enabled for the widgets created in LoglLogic LMI 6.3.0 and
earlier

Turn on the toggle to refresh the widget every few seconds.

This setting is enabled only if the Auto Load option is enabled.
Default: OFF

If Auto refresh is set to ON, then enter a time interval in seconds to

refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.

use LoglLogic_Monitor_Memory | COLUMNS sys_eventTime, (ll_memTotal-11_
memFree) as memUsed, 1ll_memTotal as memTotal

the X-axis is sys_eventT-ime, and the Y-axis is memUsed, memTotal.
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Memory consumption over 1hr interval

9c

8C

70

66

5G
07:50 08:00 08:10 08:20 08:30 08:40

— memUsed — memTotal

Related Topics
o Widgets
e Adding Widgets to an Advanced Dashboard

Bar Widget

This widget is used to show the distribution of the total count of one selected column over
its distinct values.

Use the following information to configure the widget:
» Fetch data from source

e Bar widget configuration
Field Description

Fetch data from source

Query Enter a search query.
e To start an EQL statement, enter USE.
e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
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Field Description

options in the Bar widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

Date & Time You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.

Bar widget configuration

X-axis data Select the column name to define the X-axis.

X-axis label Define the label name for the X-axis that is displayed on the widget.

Y-axis data Select the two columns to define the Y-axis of the widget.

Y-axis label Define the label name for the Y-axis that is displayed on the widget.

Show legends Select the check box to display legends on the chart.

Show inverted Select the check box to invert the X-axis and Y-axis values.

Categorize by Define the column name by which the Y-axis data is combined into a
series.

Widget description Enter a short description for the widget. The description is displayed

on the Advanced Dashboard when you hover over the widget.

Auto load Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.
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Field

Auto refresh

Refresh widget every

Example

For the search query:

Description

Default:
 Disabled for widgets created in LoglLogic LMI 6.3.1 and later
* Enabled for the widgets created in LoglLogic LMI 6.3.0 and
earlier
Turn on the toggle to refresh the widget every few seconds.
This setting is enabled only if the Auto Load option is enabled.
Default: OFF
If Auto refresh is set to ON, then enter a time interval in seconds to

refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.

use LoglLogic_Monitor_Memory | COLUMNS sys_eventTime, (ll_memTotal-11_
memFree) as memUsed, 1l_memTotal as memTotal

the X-axis is sys_eventTime, and the Y-axis is memUsed, memTotal.

Total vs Used Memory

oG

Memory
<

" 2

3] [l

~
i
[l

10-34 10:36

10-38 10-:40 1042 1044 10:46 10-48|

memUsed Il memTotal

Related Topics

o Widgets
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e Adding Widgets to an Advanced Dashboard

Bubble Widget

This widget displays data as a bubble chart or scatter plot. In a bubble chart, three
dimensions of data are displayed - data from two columns is displayed on the x- and y-
axes, and data from the third column is displayed through a bubble. In a scatter plot, two
dimensions of data are displayed, and a third dimension can be displayed by coloring the
points with different colors.

Use the following information to configure the widget:
» Fetch data from source

» Bubble widget configuration

Field Description
Fetch data from source

Query Enter a search query.
e To start an EQL statement, enter USE.

e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the Bubble widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

Date & Time You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.
Bubble widget configuration

Bubble type e To display a bubble chart, select Bubble.
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Field

X-axis data
X-axis label
Y-axis data
Y-axis label

Bubble weight

Buffer size

Use bubble color

Use color threshold

Use color value

Widget description

Auto load

Description
e To display a scatter plot, select Scatter.
Select the column name to define the X-axis.
Define the label name for the X-axis that is displayed on the widget.
Select the two columns to define the Y-axis of the widget.
Define the label name for the Y-axis that is displayed on the widget.

Select the column to be displayed as bubbles. The size of the bubble
is proportionate to the column value.

Enter the number of rows to be displayed in the widget after
refreshing the widget. For example, if the buffer size is 100 and the
query returns 150 results, the latest 100 results are displayed.

Default: 1000 rows

Select the color of the bubbles or scatter points on the widget. Click
the color value to change the color.

Define the threshold range for the colors on the widget.

Define the column name by selecting the column.

You can use an Enrichment List or EQL conditional functions such as
IIF in the query to return specific color values.

Enter a short description for the widget. The description is displayed
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
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Field Description

Dashboard to load its data.
Default:

 Disabled for widgets created in LoglLogic LMI 6.3.1 and later

* Enabled for the widgets created in LoglLogic LMI 6.3.0 and
earlier

Auto refresh Turn on the toggle to refresh the widget every few seconds.
This setting is enabled only if the Auto Load option is enabled.
Default: OFF

Refresh widget every  If Auto refresh is set to ON, then enter a time interval in seconds to

refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.

Example of bubble chart

For the search query:

USE General_Syslog | GROUP BY sys_collectIP , sys_eventTime

the X-axis is sys_collectIP, Y-axis is sys_eventTime, and Bubble value is count (x).
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Bubble Chart
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Example of scatter plot

For the search query:

USE General_Syslog | GROUP BY sys_collectIP, sys_deviceType

the X-axis is sys_collectIP and Y-axis is count(*).

Scatter Chart
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Related Topics
o Widgets
e Adding Widgets to an Advanced Dashboard
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Pie Widget
This widget uses one column at a time.

Each pie slice represents a distinct column value. The Pie widget data varies based on the
selected column. Values that are not displayed in the specified the number of slices are
grouped together into the 'Others’ slice.

Use the following information to configure the widget:
e Fetch data from source

» Pie widget configuration

Field Description
Fetch data from source

Query Enter a search query.
e To start an EQL statement, enter USE.
e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the Pie widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

Date & Time You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.

Pie widget configuration

Slice name Select the column name to define the slice of the pie. If the column
name is already defined in the search query, the Slice name column is

automatically filled. Otherwise, as you start typing in the field, the
available matching column names are displayed and you can select
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Field

Slice value

Show up to

Widget description

Auto load

Auto refresh

Refresh widget every

Description
the appropriate one.
Enter the slice value of the pie.

Enter the number of slices to be displayed on the pie. If the slices are
more than this number, they are combined and shown as 'Others'. For
example, if number of slices is 5 and the value of Show up to is 3,
then the third, fourth, and fifth slices are combined and shown as
'Others'.

Enter a short description for the widget. The description is displayed
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.

Default:
 Disabled for widgets created in LoglLogic LMI 6.3.1 and later

e Enabled for the widgets created in LogLogic LMI 6.3.0 and
earlier

Turn on the toggle to refresh the widget every few seconds.

This setting is enabled only if the Auto Load option is enabled.
Default: OFF

If Auto refresh is set to ON, then enter a time interval in seconds to

refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.

If the difference between the values of two pie slices is 1000 or more, the slice with the
lesser value might not be displayed on the pie chart. To see the smaller slice, hide the
larger slice by clicking it.
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Example
For the search query:

use Loglogic_Appliance | GROUP BY 1l1l_eventAction | COLUMNS 11_
eventAction AS EventAction, count(x) AS EventCount | (ll_eventAction IS

NOT NULL)

the Slice Name is EventAction, and the Slice Value is EventCount.

Event Action O & ®
¥ login 1M ri_rpt logoff
[ SystemReboot [l Disp-Sys-Settings
I Others

Related Topics

o Widgets
¢ Adding Widgets to an Advanced Dashboard

Number Widget

A numerical value widget displays an important metric for single glance analysis.
Use the following information to configure the widget:

e Fetch data from source
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e Number widget configuration

Field

Description

Fetch data from source

Query

Date & Time

Enter a search query.
e To start an EQL statement, enter USE.
e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the Number widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.

Number widget configuration

Show value of

Unit label

Result label

Range

Threshold

Select the column name from the list.
Select the appropriate option or enter the desired unit.

Enter a label for the result. This label is displayed below the number
on the widget.

Specify the range values to define the size of the number widget and
the range of each threshold slider.

After selecting the Threshold check box, you can specify the
threshold value. The color on the chart depends on the threshold
values.

e When the number is less than or equal to the minimum
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Field

Widget description

Auto load

Auto refresh

Refresh widget every

Description

threshold value, the color changes to green.

e When the number is greater than the minimum threshold value
but less than or equal the maximum threshold value, the color
changes to yellow.

e When the number is higher than the maximum threshold value,
the color changes to red.

Enter a short description for the widget. The description is displayed
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced

Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.

Default:

 Disabled for widgets created in LoglLogic LMI 6.3.1 and later
* Enabled for the widgets created in LoglLogic LMI 6.3.0 and
earlier
Turn on the toggle to refresh the widget every few seconds.
This setting is enabled only if the Auto Load option is enabled.
Default: OFF
If Auto refresh is set to ON, then enter a time interval in seconds to

refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.
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Example

For the search query:

use LoglLogic_Appliance | COLUMNS count(x)

the threshold value is set to 10000.

Message Count ) B ®

9932

Total Messages

Related Topics

e Widgets
e Adding Widgets to an Advanced Dashboard

Gauge Widget

Gauge chart displays information in the form of a dial. The values of selected columns can
be displayed using a needle, as concentric circles, or like a speedometer.

All charts are configured in the same way, but displayed differently depending upon the
type of gauge selected.

Use the following information to configure the widget:
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e Fetch data from source

e Gauge widget configuration

Field Description
Fetch data from source

Query Enter a search query.
e To start an EQL statement, enter USE.

e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the Gauge widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

Date & Time You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.

Gauge widget configuration

Gauge type Select the type of gauge:
* Needle
» Solid
* Wheel
Default: Needle
Show value of Select the columns to be displayed. You can select up to three

columns of numeric type.

» For Needle and Solid types, if you select more than one
column, multiple charts are displayed, one per selected column.
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Field

Unit label

Range

Threshold

Widget description

Auto load

Auto refresh

Description

e For the Wheel type, one chart is displayed, and the selected
columns are displayed as concentric circles.

Type the desired unit.

Specify the range values to define the size of the gauge chart and the
range of each threshold slider.

After selecting the Threshold check box, you can specify the
threshold value. The color on the chart depends on the threshold
values.

e When the number is less than or equal to the minimum
threshold value, the color changes to green.

* When the number is greater than the minimum threshold value
but less than or equal the maximum threshold value, the color
changes to yellow.

* When the number is higher than the maximum threshold value,

the color changes to red.

Enter a short description for the widget. The description is displayed
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.

Default:
 Disabled for widgets created in LoglLogic LMI 6.3.1 and later

e Enabled for the widgets created in LoglLogic LMI 6.3.0 and
earlier

Turn on the toggle to refresh the widget every few seconds.
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Field Description

This setting is enabled only if the Auto Load option is enabled.

Default: OFF

Refresh widget every  If Auto refresh is set to ON, then enter a time interval in seconds to
refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.

Example

For the search query:

USE Other_UNIX | 1l_eventActionID = 62 and 1ll_eventStatusID = 4 | GROUP
BY 1l_eventActionID , 1l_eventStatusID

the Show value is ll_eventActionID , lI_eventStatusID and Count(*).
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Related Topics
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o Widgets

e Adding Widgets to an Advanced Dashboard

Stacked Column Widget

This widget is used to show the distribution of the total count of one selected column over
its distinct values.

Use the following information to configure the widget:
» Fetch data from source

o Stacked column widget configuration

Field Description
Fetch data from source

Query Enter a search query.
e To start an EQL statement, enter USE.

e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the Stacked column widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

Date & Time You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.

Stacked column widget configuration

X-axis data Select the column name to define the X-axis.
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Field

X-axis label
Y-axis data
Y-axis label

Categorize by

Widget description

Auto load

Auto refresh

Refresh widget every

Description

Define the label name for the X-axis that is displayed on the widget.
Select the two columns to define the Y-axis of the widget.

Define the label name for the Y-axis that is displayed on the widget.

Define the column name by which the Y-axis data is combined into a
series.

Enter a short description for the widget. The description is displayed
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.

Default:
» Disabled for widgets created in LoglLogic LMI 6.3.1 and later

* Enabled for the widgets created in LoglLogic LMI 6.3.0 and
earlier

Turn on the toggle to refresh the widget every few seconds.

This setting is enabled only if the Auto Load option is enabled.
Default: OFF

If Auto refresh is set to ON, then enter a time interval in seconds to

refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.
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Example

For the search query:

use Loglogic_Logu | GROUP BY 1ll_node, 1l1_loglevel | COLUMNS 11_node, 11_
loglevel, count(x)

the X-axis is 11_loglevel, the Y-axis is count (x), and the Categorize by is 11_node.

Stacked widget
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Related Topics
o Widgets
e Adding Widgets to an Advanced Dashboard

Combined Widget

This widget is used to show the distribution of the total count of a selected column over its
distinct values.

Use the following information to configure the widget:
» Fetch data from source

* Combined widget configuration
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Field Description
Fetch data from source

Query Enter a search query.
e To start an EQL statement, enter USE.

e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the Combined widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

Date & Time You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.

Combined widget configuration

X-axis data Select the column name to define the X-axis.

X-axis label Define the label name for the X-axis that is displayed on the widget.

Y-axis data Select the two columns to define the Y-axis of the widget.

Y-axis label Define the label name for the Y-axis that is displayed on the widget.

Show Average Select the check box to show the average in the line format.

Show Total Select the check box to show the total in the pie format.

Categorize by Define the column name by which the Y-axis data is combined into a
series.

Widget description Enter a short description for the widget. The description is displayed
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Field

Auto load

Auto refresh

Refresh widget every

Description
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.

Default:
» Disabled for widgets created in LoglLogic LMI 6.3.1 and later
* Enabled for the widgets created in LoglLogic LMI 6.3.0 and
earlier
Turn on the toggle to refresh the widget every few seconds.
This setting is enabled only if the Auto Load option is enabled.
Default: OFF
If Auto refresh is set to ON, then enter a time interval in seconds to

refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.

The Combined Widget displays the pie, bar graph, and line graph for the results of the
query. The pie and bar graphs display the values by the selected X-axis. The line graph
joins the average values in each category. To calculate the average values, the sum of the
Y-axis values is divided by the total number of items on the category.

Hover your mouse over the widget to view the value at that point. Clicking the value opens
the search results of that value on an Advanced Search tab. However, if you click on the
average line in the widget, the Advanced Search tab displays search results for the entire

query.

To view the line and bar graphs properly, you can drag the pie to any area of the widget.
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Example

For the search query:

USE Loglogic_Logu GROUP BY 1ll_node | COLUMNS 11l_node, count(x)

the X-axis is 11_node, the Y-axis is count (*), and Categorize by is 11_node.

Combined Widget
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Related Topics
e Widgets
e Adding Widgets to an Advanced Dashboard

Treemap Widget
This widget is used to visualize various thresholds in the form of a colored treemap.

The treemap widget is useful to view thresholds such as CPU, memory, indexer, and disk
thresholds. You can visualize if some factors in the system have issues or are normal.

Use the following information to configure the widget:
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e Fetch data from source

e Treemap widget configuration

Field

Description

Fetch data from source

Query

Date & Time

Enter a search query.
e To start an EQL statement, enter USE.
e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the Treemap widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.

Treemap widget configuration

Tile Name

Tile Value

Categorize by

Select the column name. If the column names are already defined in
the search query, the Tile Name column is automatically filled.
Otherwise, as you start typing in the field, the available matching
column names are displayed.

Select the column name by which the treemap tile is to be
represented. The value of this column is used for the size of the tile.

If the column names are already defined in the search query, the Tile
Value column is automatically filled. Otherwise, as you start typing in
the field, the available matching column names are displayed.

Define the column name by which the Y-axis data is combined into a
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Field

Use Color Axis

Use Color Value

Widget description

Auto load

Auto refresh

Refresh widget every

Description

series.

In the Min Color and Max Color fields, specify the range of minimum
and maximum values of the color to be represented on the axis.

To get the right color spread for the tile values, you must adjust the

color axis.

Define the column name by selecting the column. The color
represented by the Use Color Value field is used to color the tiles on
the chart.

To return specific color values, you can use Enrichment List or EQL
Conditional functions such as IIF in the query.
If this field is specified, the Use Color Axis field is ignored.

Enter a short description for the widget. The description is displayed
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.

Default:

 Disabled for widgets created in LoglLogic LMI 6.3.1 and later

e Enabled for the widgets created in LoglLogic LMI 6.3.0 and
earlier

Turn on the toggle to refresh the widget every few seconds.
This setting is enabled only if the Auto Load option is enabled.

Default: OFF

If Auto refresh is set to ON, then enter a time interval in seconds to
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Field Description

refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.

Note: Clicking the widget opens Advanced Search with the same query that you
used for the widget.

Examples

For the search query:

use Loglogic_Appliance | GROUP BY 11l_eventStatus, ll_sourceIP | COLUMNS
11l_eventStatus, 1l_sourceIP, count(*) as count | ll_eventStatus is NOT
NULL | (ll_eventStatus != '")

the Tile Name is 11_eventStatus, and the Tile Value is count(*). The treemap widget
using the Color Axis value:

success failed

success

failed success success

0 2 4 6

The widget using Color Axis with Categorize By 11_sourceIP:
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10.114.128.190 10.114.128.163 =
success success
failed
failed 10.98.50.54 10.98.192.143
0 2 4 6

For the search query

use Loglogic_Appliance | GROUP BY

11l_eventStatus, 1ll_sourceIP | COLUMNS 11_eventStatus, ll_sourceIP,
count(*) as count, IIF(ll_eventStatus ='failed', 'red', 'green') AS
color | ll_eventStatus is NOT NULL | (ll_eventStatus != ''")

using the color value column as color (from the query) and Categorize By 11_sourceIP:

HI05IN4%1128%63]

success, success

failed

Related Topics
o Widgets
e Adding Widgets to an Advanced Dashboard

Heat Map Widget

This widget is used to visualize various thresholds in the form of a colored heat map.

The Heat Map widget is useful to visualize data in the form of a heat map.
Use the following information to configure the widget:

e Fetch data from source
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e Heatmap widget configuration

Field

Description

Fetch data from source

Query

Date & Time

Enter a search query.
e To start an EQL statement, enter USE.
e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the Heatmap widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.

Heatmap widget configuration

X-axis data

Y-axis data

Tile Value

Use Color Axis

Select the column name to define the X-axis.
Select the two columns to define the Y-axis of the widget.

Select the column name by which the treemap tile is to be
represented. The value of this column is used for the size of the tile.

If the column names are already defined in the search query, the Tile
Value column is automatically filled. Otherwise, as you start typing in
the field, the available matching column names are displayed.

In the Min Color and Max Color fields, specify the range of minimum
and maximum values of the color to be represented on the axis.

To get the right color spread for the tile values, you must adjust the
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Field

Use Color Threshold

Use Color Value

Widget description

Auto load

Auto refresh

Description
color axis.

Define the threshold range for the colors on the heat map.

* If Tile Value is below the threshold range, the tile color is
green.

« If Tile Value is above the threshold range, the tile color is red.

 If Tile Value is in between the threshold range, the tile color is
orange.

Define the column name by selecting the column. The color
represented by the Use Color Value field is used to color the tiles on
the chart.

To return specific color values, you can use Enrichment List or EQL
Conditional functions such as IIF in the query.
If this field is specified, the Use Color Axis field is ignored.

Enter a short description for the widget. The description is displayed
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.

Default:
 Disabled for widgets created in LoglLogic LMI 6.3.1 and later

* Enabled for the widgets created in LoglLogic LMI 6.3.0 and
earlier

Turn on the toggle to refresh the widget every few seconds.

This setting is enabled only if the Auto Load option is enabled.
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Field

Refresh widget every

Examples

For the search query:

Description
Default: OFF

If Auto refresh is set to ON, then enter a time interval in seconds to
refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.

use LoglLogic_Appliance | GROUP BY 11_eventStatus, ll_sourceIP | COLUMNS
11l_eventStatus, 1l_sourceIP, count(*) as count | ll_eventStatus is NOT
NULL | (ll_eventStatus != '")

the X-axis is l|_eventStatus and the Y-axis is ll_sourcelP

The following are examples of a Heat widget:

e Using default values of color axis

10.98.192.143

10.114.128.163

10.114.128.172

Values

10.98.50.54

10.114.128.190

1

2 9

1

1

3 8

Q’i‘\ed s‘,cd'ss
0 2.5 5 7.5 10

» Using threshold values 4 and 8
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10.98.192.143

10.114.128.163

Values

10.98.50.54

10.114.128.190

.

&

]
e
<
G

For the search query:

use LoglLogic_Appliance | GROUP BY 11l_eventStatus, ll_sourceIP | COLUMNS
11l_eventStatus, ll_sourceIP, count(*), IIF(ll_eventStatus ='failed',
'red', 'green') AS color | 1l_eventStatus is NOT NULL | (ll_eventStatus

1= ||)

10.98.192.143

10.114.128.163

Values

10.98.50.54

10.114.128.190

S S

@&

s
<<
oW

Related Topics

o Widgets
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e Adding Widgets to an Advanced Dashboard

DataGrid Widget

This widget is used to visualize query results in the form of a table.

The DataGrid widget is useful to view results in the form of a table. TAIL query results are
also displayed in the widget.

Use the following information to configure the widget:
e Fetch data from source

e DataGrid widget configuration

Field Description
Fetch data from source

Query Enter a search query.
e To start an EQL statement, enter USE.

e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the DataGrid widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

Date & Time You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.
DataGrid widget configuration

Column(s) Column value of the selected field is used to plot the widget.
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Field Description

Options Select the required options to display in the widget result:
e Show Row Numbers
e Show Table Header
e Hide Column Separator
* Enable Column Selection
* Enable Context Menu
e Enable CSV Export

» Enable Excel Export

Even if you select the Enable CSV Export or Enable Excel Export
options, the relevant menu options are available in the Filter menu
only if the Enable Context Menu option is also selected.

Filter menu This menu is available only if Enable Context Menu is selected in the
Options field.

LogLogic Appliance logs & ﬂﬂ
Total events: 1000

# sys_eventTime sys_body

1 2021-05-18 05:30:35.000 <14 >May 18 05:30:34 logapp MGMT: B2l OGLOGIC-A mnduleiengine_x_scheduler{16

2 2021-05-18 05:30:35.000 <idsMay 18 05:30:34 logap;  onow filters ulerengine_Ix_scheduler(16

3 2021-05-18 05:30:35.000 <14>May 18 05:30:35 logap| | |0C (DI header uleengine_Ix_scheduler(16

4 2021-05-18 05:30:35.000 <14>May 18 05:30:35 logap POt 35 €5V * Ulmengine_lx_scheduler16

5 2021-05-18 05:30:35.000 <14>May 18 05:30:35 logap| POt 28 BXCe ? Uleengine_lx_scheduler(16

6 2021-05-18 05:30:35.000 <14 >May 18 05:30:35 logapp MGMT: %LOGLOGIC-6 modulelengine_lx_scheduler{16

7 2021-05-18 05:30:35.000 <14 = May 18 05:30:35 logapp MGMT: 3LOGLOGIC-6 modulerengine_|x_scheduler{16 o

»

If Enable Context Menu is selected in the Options field, then the
following options are available after right-clicking the widget:

e Show/Hide filters

» Show/Hide table header (if the Show Table Header option is
also selected in the Options field)

» Export as CSV - all data or selected data (if the Enable CSV
Export option is also selected in the Options field)
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Field

Buffer size

Font size

Maximum number of
decimal places

Widget description

Auto load

Description

e Export as Excel - all data or selected data (if the Enable Excel
Export option is also selected in the Options field)

Enter the number of rows to be displayed in the DataGrid after
refreshing the widget. For example, if the buffer size is 100 and the
query returns 150 results, the latest 100 results are displayed.

Default:1000 rows
Select the font size of the text that is displayed on the DataGrid
widget. Available options:
e Comfortable: 12 px
e Cozy: 11 px
e Compact: 10 px
Default: Comfortable (12 px)
Enter the maximum number of decimal places to display for the

columns that display float type of data. You can specify a value
between 0 and 10.

Default: 2

Enter a short description for the widget. The description is displayed
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.

Default:
 Disabled for widgets created in LoglLogic LMI 6.3.1 and later
* Enabled for the widgets created in LoglLogic LMI 6.3.0 and
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Field Description
earlier
Auto refresh Turn on the toggle to refresh the widget every few seconds.

This setting is enabled only if the Auto Load option is enabled.

Default: OFF

Refresh widget every  If Auto refresh is set to ON, then enter a time interval in seconds to
refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.

Example

For the search query:

use Loglogic_Appliance

e The columns are sys_eventTime and sys_body.

e The total number of events is displayed if the Options field includes Show Table
Header.

e The filter menu is available in the results if the Options field includes Enable Context

Menu.

Loglogic Appliance logs o ﬂﬂ
Total events: 1000

# sys_eventTime sys_body

1 2021-05-18 05:30:35.000 <14 >May 18 05:30:34 logapp MGMT: SaLOGLOGIC-6 modulesengine_lx_scheduler{16

2 2021-05-15 05:303:35.000 <14>May 18 05:30:34 logapp MGMT: SaLOGLOGIC-6 modulerengine_lx_scheduler{16

3 2021-05-18 05:30:35.000 <14>May 18 05:30:34 logapp MGMT: SeLOGLOGIC-6 modulerengine_lx_scheduler{1&

b 2021-05-18 05:30:35.000 <T14=May 18 05:30:34 logapp MGMT: SeLOGLOGIC-6 modulerengine_|x_scheduler{1&

5 2021-05-18 05:30:35.000 <14x=May 18 05:30:34 logapp MGMT: 3LOGLOGIC-6 modulerengine_lx_scheduler{16

& 2021-05-18 05:303:35.000 <14 >May 18 05:30:34 logapp MGMT: SaLOGLOGIC-6 modulesengine_lx_scheduler{16

7 2021-05-18 05:303:35.000 <14>May 18 05:30:34 logapp MGMT: SeLOGLOGIC-6 modulerengine_Ix_scheduler{16

2
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Related Topics
e Widgets

e Adding Widgets to an Advanced Dashboard

Range Bar

This widget is used to show a range of values as a bar graph. Unlike a bar graph, the bars
in a range bar need not start at zero. Each bar is rendered as a range of specified values.

Use the following information to configure the widget:
e Fetch data from source

» Range bar widget configuration

Field Description
Fetch data from source

Query Enter a search query.
e To start an EQL statement, enter USE.

e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the Range bar widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

Date & Time You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.

Range bar widget configuration
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Field

X-axis data

X-axis label

Y-axis data (ranges)
Y-axis label

Show legends

Show Column Labels

Show inverted

Categorize by

Widget description

Auto load

Auto refresh

Description

Select the column name to define the X-axis.

Define the label name for the X-axis that is displayed on the widget.
Select the two columns to define the Y-axis of the widget.

Define the label name for the Y-axis that is displayed on the widget.
Select the check box to display legends on the chart.

Turn on the toggle to show or turn off to hide the data point on the
range.

Default: ON
Select the check box to invert the X-axis and Y-axis values.

Define the column name by which the Y-axis data is combined into a
series.

Enter a short description for the widget. The description is displayed
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.

Default:
 Disabled for widgets created in LoglLogic LMI 6.3.1 and later

* Enabled for the widgets created in LoglLogic LMI 6.3.0 and
earlier

Turn on the toggle to refresh the widget every few seconds.
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Field Description

This setting is enabled only if the Auto Load option is enabled.
Default: OFF
Refresh widget every  If Auto refresh is set to ON, then enter a time interval in seconds to

refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.

Example Search Query

use LoglLogic_System_CPU_Load_1_Min | GROUP BY hours(lls_time, 1) |
COLUMNS hours(lls_time, 1) AS Time, MIN(1lls_loadAvg) AS MinLoad, MAX
(1ls_loadAvg) AS MaxLoad, COUNT(lls_loadAvg) | lls_time IN -1d

In this example, 11s_time values are plotted on the X-axis, and the range between
MinLoad and MaxLoad on the Y-axis.

o
L]
A

®7 @53 60 @59 @55 12

Related Topics
o Widgets
¢ Adding Widgets to an Advanced Dashboard

Geomap Widget
At times, geographical distribution of data is as important as the data itself.

The Geomap widget gives you a unified view of your data visualization and its geographical
distribution. For example, you can plot VPN connection logs and the IP addresses from
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which they originate. The widget displays the IP addresses as points or a bubble chart on
the geographical map.

Geomap widget uses the IP address and location information from your data model to plot
the data on a map. You can select the geographical map as a particular region or country,
or the world map. You can plot IP addresses as points or as a bubble for a region on the
map.

o Note: To use this widget, the MaxMind database must be available on your
appliance. Contact your administrator.

Use the following information to configure the widget:
e Fetch data from source

e Geomap widget configuration

Field Description
Fetch data from source

Query Enter a search query. The query must include the geoiplookup()
function. For more information, see Miscellaneous Functions.

e To start an EQL statement, enter USE.

e To start an SQL statement, enter SELECT.

You can search based on filter and time Bloks as well. After you enter
the search query, the columns from the query are used as field
options in the Geomap widget configuration section.

For more information about EQL search syntax, see Event Query
Language Reference.

Date & Time You can enter absolute and relative time ranges.

For example, enter -5h as a relative time range to display results for
events that occurred in the past 5 hours.

For more information and examples, see Time Range Expressions.

Geomap widget configuration
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Field Description

Source IP Select the data model column in which IP addresses are stored and
that has a data type as INET_ADDR.

Location Select the column with the location of the area. You must use the
geoiplookup () function and specify the location parameter along
with the Source IP field so that the geoiplookup() function calculates
the latitude and longitude of the area:

geoiplookup (<columnName>, 'location')

Location tooltip Select the column with the geographical information of the required
area. You must use the geoiplookup() function, such as country, city,
postal, and so on, depending on the configuration of the geographical
database available on your appliance.

» The value of selected information is displayed as the tooltip.

o |If the field is empty, then the IP address is displayed as the
tooltip of the point on the map.

For example, if you use the country option, the country name is

displayed as a tooltip of the point on the map.

Bubble weight Select the column that can be used to indicate a number of
IP addresses for the selected location. If multiple IP addresses belong
to that region on the map, then a bubble is displayed instead of a dot.
The size of the bubble is proportionate to the column value.

Add series (+) Click + to add another row of the Source IP, Location, Location
tooltip, and Bubble weight fields.

You can add multiple series to the chart. For example, if a data model
includes multiple columns that return an INET_ADDR type.

Region border color Select the color of the region border.

Default: #A0AOAO0

Map background Select the background color of the region.
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Field
color

Map

Widget description

Auto load

Auto refresh

Refresh widget every

Description
Default: #E9E9QE9

Select a map type from the available list.
Default: World continents

Enter a short description for the widget. The description is displayed
on the Advanced Dashboard when you hover over the widget.

Turn on the toggle to automatically load widget data on the Advanced
Dashboard as soon as you save the widget or when you navigate to
the dashboard.

Disabling the Auto load option also disables the Auto refresh option.
However, you can manually refresh the widget on the Advanced
Dashboard to load its data.

Default:
 Disabled for widgets created in LoglLogic LMI 6.3.1 and later

* Enabled for the widgets created in LoglLogic LMI 6.3.0 and
earlier

Turn on the toggle to refresh the widget every few seconds.

This setting is enabled only if the Auto Load option is enabled.
Default: OFF

If Auto refresh is set to ON, then enter a time interval in seconds to

refresh the widget. Refresh action starts after the data is completely
retrieved and displayed.

Example Search Query

use system | COLUMNS sys_collectIP, geoiplookup(sys_
collectIP,"location"), geoiplookup(sys_collectIP,"country"), count(sys_
collectIP) | (sys_collectIP != '127.0.0.1"' AND sys_collectIP !=
'198.51.100.0"' AND sys_collectIP != '::1') | group by sys_collectIP

In this example, IP addresses of locations are marked as separate points and country
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names are displayed as the tooltip. The IP address 198.51.100.0 is an example. Replace it
with the IP address of your appliance.

c N

B8.14. Sweden

5.10 - Netherlands
8.14. - United States 46.199; - Cyprus 1.0, - China
T1.78. - United States
8.14. ‘- Mexico
41.74. - Rwanda
8.14. - Brazil
8.14. - Chile 1.0.0 - Australia

sys_collectlP

o Note: Political boundaries or place names contained in the maps do not
necessarily reflect TIBCO's view of any particular disputed border or place name
and TIBCO does not warrant the accuracy of such boundaries or place names.

Related Topics
o Widgets

* Adding Widgets to an Advanced Dashboard

Adding Widgets to an Advanced Dashboard

You can create a new dashboard with multiple widgets based on your requirements.
For best performance, limit the number of widgets to 20 per dashboard.

° Tip: After an aggregation rule is created, a filter Blok is automatically created in
the system. If there are multiple time clauses in the GROUP BY query, multiple
filter Bloks are created - one for each time clause. To save on query response
time, you can use the filter Blok in Advanced Dashboards instead of typing the
entire query.
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Procedure
1. Click Dashboards > Advanced Dashboards to display the All Dashboards page.

2. (Optional) Create a dashboard or a dashboard group to add the widget.
e To create a new dashboard, click Create Dashboard.

e To create a new dashboard group, click Create Group or Create Nested Group.

3. Click the dashboard to open the dashboard view.
o Note: You can add widgets with identical names in one dashboard.

4. From the Widgets pane, click the type of widget that you want to add.

5. To configure the widget, click the Configure link or click the Settings icon & on the
upper-right corner of the widget.

a. To edit the widget name, click Untitled widget and enter the name of the
widget in the field.

b. Edit the fields as required. The configuration fields are different for each type of
widget. See the Widgets section.

6. Click Save to save the widget.

Result

The widget is added and the retrieved results are displayed on the dashboard. While the
data is loading, you can click the Stop button and change the widget configuration, and
click Start to reload the data.

Note: By using columns with large content, the content might become
unreadable on a widget, for example, if you use sys_body on the X-axis while
using a Bar Chart widget.

Data Models

LoglLogic LMI parses log data into structured formats to enhance search and analysis.
Based on the log source type, you can define how to parse your data and which columns
to extract.
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From the Management > Advanced Features > Data Models page, you can view all data
models available on your appliance.

Using data models, LoglLogic LMI parses log data in a structured format to enhance search
and analysis. Based on the log source type, you can define parsing rules within the data
models to decide how to parse your data and which columns to extract.

The data models in LoglLogic LMI can be broadly classified into the following categories:

e Advanced Data Models, which use parser types such as syslog, Regex, JSON, and so
on.

e GP Parser-Based Data Models, which are data models that use a grouped-pattern
parser (GP parser). GP parsers are especially efficient in handling complex Regex
parsing rules that work on heterogeneous free-text logs.

Functions of Data Models

Using data models you can:
» Define parsing rules that extract columns from your data.
» Define a schema for an event.

» Name and specify the data types for extracted columns.

Parsing Rules

A data model can be associated with multiple parsing rules. Sometimes within the same
source, some logs are completely different to others, and it is not practical, or even
possible, to match them all with a single rule. You need a different way of parsing for each
kind of log, and you can do that by defining several rules, each targeting one type of log.

If a data model has more than one parsing rule defined, then the extracted column set is
the union of the column sets of all parsing rules and the additional system-defined
columns. For example, create a data model and define a parsing rule, Rulel, to extract four
defined columns and Rule2, to extract eight different defined columns. Now, when you run
a search query on this data model, the 12 columns are displayed.

Parsing rules are applied top to bottom in the order they are defined in a data model. For
example, if Rulel matches some of your data then it is used to extract column values. If
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Rulel fails to match with your data, then only Rule2 is applied, and so on. You can change
the order of parsing rules.

For an overview of the parsers in advanced data models, see Types of Parsers in Advanced
Data Models. In GP parser-based data models, there is only one type of parser. See
GP Parser-Based Data Models

For an overview of each parser, see Types of Parsers in Advanced Data Models.

Advanced Data Models

Advanced data models use different types of parsers to parse the logs from different log
sources.

You can create a data model that defines which log source to use for parsing, based on the
data relevance. For multiple log sources, the order of precedence can be defined in a
specified query. The system columns are event metadata. All system columns are displayed
with the prefix sys_ and all columns from built-in parsers are displayed with the prefix 11_
in the Columns panel.

LogLogic LMI also provides built-in data models. For the list of built-in data models, see the
Supported Log Sources list in TIBCO LogLogic® Log Source Packages Installation and
Upgrade, which is available on the TIBCO eDelivery website or TIBCO Support website after

logging in.

Downstream Parsing

By configuring downstream parsing, you can chain a parsing rule of an advanced data
model to another advanced or GP parser-based data model to further process the columns
retrieved from the main parsing rule. This method of using two levels of parsing one after
another helps to parse log messages having mixed formats. Consider the following
example.

Example

In Windows Snare logs, the tab character is escaped with a backslash (\) and hence is a
two-character sequence (\t). Consider the following sample log message received in
LogLogic LMI:
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<13>Apr 15 00:54:19 10.199.187.140
MSWinEventLog\t0\tSecurity\t406243509\tSat Dec 25 17:16:57

2004\ t4699\tMicrosoft-Windows-Security-Auditing\tSYSTEM\tUser\tSuccess
Audit\tX78UNT2AJIC1Y\tObject Access\t\tA scheduled task was deleted.
Subject: Security ID: S-1-5-21-2798475463-3993569027-3406240830-
49243 Account Name: QPAGjyT74D Account Domain: BJ Logon
ID: Ox6b441b23 Task Information: Task Name: \dEmG_
Jclbu7ZtMGKUmLe3vArEqF_\erCw\TACZZvZ4mbn\M36kGL-2mYD-
0I\cefE4AJTOAOrGj1lV7GOLLcTmen_ Task Content: <Task version="1.2"
xmlns="http://schemas.microsoft.com/windows/2004/02/mit/task">
<RegistrationInfo> <Date>2017-04-21T17:54:26.989698</Date>
<Author>BJQPAG]jyT74D</Author> </RegistrationInfo> <Triggers/>
<Principals> <Principal id="Author"> <RunLevel>LeastPrivilege</RunLevel>
<UserId>BJQPAG]jyT74D</UserId> <LogonType>S4U</LogonType> </Principal>
</Principals> <Settings>
<MultipleInstancesPolicy>IgnoreNew</MultipleInstancesPolicy>
<DisallowStartIfOnBatteries>true</DisallowStartIfOnBatteries>
<StopIfGoingOnBatteries>true</StopIfGoingOnBatteries>
<AllowHardTerminate>true</AllowHardTerminate>
<StartWhenAvailable>false</StartWhenAvailable>
<RunOnlyIfNetworkAvailable>false</RunOnlyIfNetworkAvailable>
<IdleSettings> <StopOnIdleEnd>true</StopOnIdleEnd>
<RestartOnIdle>false</RestartOnIdle> </IdleSettings>
<AllowStartOnDemand>true</AllowStartOnDemand> <Enabled>true</Enabled>
<Hidden>false</Hidden> <RunOnlyIfIdle>false</RunOnlyIfIdle>
<WakeToRun>false</WakeToRun>
<ExecutionTimeLimit>P3D</ExecutionTimeLimit> <Priority>7</Priority>
</Settings> <Actions Context="Author"> <Exec>
<Command>CWindows\System32\svchost.exe</Command> </Exec>
</Actions></Task>\t4054120554

Such log messages, which include a two-character tab, are not parsed in LoglLogic LMI. To
accurately parse such logs, you can create a new data model, create a parsing rule with
parser type as Regex, and add the following pattern in the Regex pattern field:

A(x)

Next, select the downstream data model as Microsoft_Windows and provide an expression
to substitute the two-character \t with a single-character \t:

e Data model: Microsoft_Windows

e Expression: substitute($1,"\\t", "\t")
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The main parsing rule captures the entire log message in the $1 variable. The $1 variable is
used as the parameter of the function performing the character substitution. Its output is
used as the input of the downstream data model.

Downstream Parser Matrix

The following matrix depicts the combination of parsers that can work (indicated by OK),
and the combinations that have limitations in downstream parsing. The row indicates the
main parser type and the columns in that row indicate the downstream parser type.

For an overview of each parser, see Types of Parsers in Advanced Data Models.

Downstream Syslog  KVP JSON XML Column Regex CEF GP
parser type

-

Main
parser type
I

Syslog N/A OK OK OK OK OK OK OK
Key-value OK N/A Limited Limited Limited OK Limited OK
parser (KVP)

JSON OK OK N/A OK OK OK OK OK
XML OK OK OK N/A OK OK OK OK
Columnar OK OK OK OK OK OK OK OK
Regex OK OK OK OK OK OK OK OK
parser

CEF OK OK OK OK OK OK N/A OK
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Limitations of Downstream Parsing

You can configure the downstream parsing only for one parsing rule and to only one
advanced data model. Only that parsing rule must be enabled and all other parsing
rules must be disabled.

If the main parser type is KVP, then there are limitations to configure JSON, XML,
columnar, or CEF parsers as the downstream parser type:

° When using JSON, XML, or columnar as the downstream parser type: the key
separator must not be comma (,) and the JSON statement must be enclosed in
single quotes (').

° When using CEF as the downstream parser type: the key separator must not be
vertical bar (|) and the JSON statement must be enclosed in single quotes (').

When using GP as the downstream parser type, you must be extremely careful to
provide an accurate and precise expression. The result of that expression must be a
string that meets the downstream parser requirements.

Tip: You can copy the exact expression from the GP parser-based data
model and then paste it in the Expression field.

Types of Parsers in Advanced Data Models

The following types of parsers are available in advanced data models:

Key-value Parser
JSON Parser
XML Parser
Columnar Parser
Regex Parser
CEF Parser

Syslog Parser

Key-value Parser

This parser uses simple key-value pair parsing rules to extract keys and values. The parser
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recognizes patterns such as ki=v1, k2=v2, k3=v3. You can use key-value pair separators,
for example, space, comma (,), or semi-colon (;), and key and value separators, for
example, equal sign (=) or colon (:). Separators can be either one or more characters that
have to be matched exactly or they can be regular expressions.

When referring to a value in a column expression, it is referred to as $<key name>. So, for a
key with the name ‘user’ the value is referred to as $user.

Regular expressions can also be used to parse data from the beginning and ending of the
event. This can be useful when parsing events that either start with or end with data that is
not in the key-value pair format. If these regular expressions contain named groups, then
those groups are extracted and can be used to populate columns.

You can specify the name of the last key in the data. Any data after that last key is treated
as the value of that last key. This can be useful in situations where the last value in the
data contains characters that might be interpreted as separators.

JSON Parser

This parser parses JSON logs and accepts valid JSON as input. The parser recognizes key-
value pairs, key-object pairs, and arrays.

When referring to a key in a column expression, the column name is referred as $<key
name>. When referring to array elements, the column name is referred as $<key name>_
<index_of_array>, where <index_of_array> starts with 0. When referring to objects, the
column name is referred as $<key name>_<object name>.

For example, for the following XML elements:

{"keyl":"valuel", "key2":"value2"}

the column names would be:
e keyl

o key2
You might need to change the default column names to ensure that only the supported
characters are used. You can use underscore (_) and alphanumeric characters. However, a
column name cannot begin with a number.

XML Parser

This parser parses XML logs, and accepts syntactically valid XML as input. The parser
recognizes element nodes, text nodes, and attribute nodes.
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When referring to a key in a column expression, the column name is referred as $<key
name>. When referring to sibling elements, the column name is referred as $<key name>_
<index_of_element>, where <index_of_element> starts with 1. When referring to XML
elements, the column name is referred as $<key name>_<element_name>.

For example, for the following XML elements:

<Root>
<child> This is childl</child>
<child> This is child2</child>
</Root>

the column names would be:
e Root_child 1

e Root_child_2
You might need to change the default column names to ensure that only the supported
characters are used. You can use underscore (_) and alphanumeric characters. However, a
column name cannot begin with a number.

Columnar Parser

The data is extracted into different columns. This parser operates on data that is separated
by a character or a sequence of characters, for example, comma or tab. There is no
keyvalue; just the value. The data from different log sources extract different columns
depending on keys identified in the data. When referring to a column in a column
expression, it is referred to as $<column number>. So the first column is referred to as $1,
the second column is $2, and so on.

You can also use regular expressions to parse data from the beginning and end of an event,
for example, when parsing events that either start with or end with data that is not in
columnar format. If the regular expressions contain named groups, those groups are
extracted and are used to fill values in the columns.

Regex Parser

Regular expressions (Regex) are a sequence of characters that form a search pattern,
mainly for use in pattern matching with strings or string matching. LoglLogic LMI can use
regular expressions for extracting columns from matched events.
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o Note: Working knowledge of regular expressions is a prerequisite.

Each character in a regular expression is either a meta character with its special meaning,
or a regular character with its literal meaning. Together, they can be used to identify
textual material of a given pattern, or process a number of instances of it that can vary
from a precise equality to a very general similarity of the pattern.

LogLogic LMI supports the regular expression meta characters, based on Java regular
expressions. For details, see Supported Regular Expression Characters.

Columns are extracted using either the capturing group pattern (simple parenthesis), the
named capturing group pattern (?<name>), or a combination of both. When referring to a
column in a column expression, when using named capturing groups the column name is
that specified by the group name, preceded by “$”. When using unnamed capturing
groups, the name is “$” followed by the group index. So the first unnamed group column is
referred as $1, the second as $2, and so on, while a group named “user” is referred as
$user. When using a combination of named and unnamed capturing groups, the named
capturing group columns must be referred to by their given names rather than by "$"
followed by their index.

CEF Parser

HP ArcSight Common Event Format (CEF) is an open log management standard. CEF
defines a syntax that comprises a standard header and a variable extension, formatted as
key-value pairs. Based on the ArcSight Extension Dictionary, the CEF header columns
Version, Device Vendor, Device Product, Device Version, Signature ID, Name, and Severity
are extracted into columns with their names, and expressions set to ScefVersion,
ScefDeviceVendor, ScefDeviceProduct, ScefDeviceVersion, ScefSignaturelD, ScefName, and
ScefSeverity respectively.

The name of a column for an extension listed in the ArcSight Extension Dictionary is the full
name of the extension. The name of a column for an extension that is not listed in the
ArcSight Extension Dictionary is the key name as it is displayed in the data preceded with

“S”

The expressions of the non-timestamp extension columns are the CEF Key Names as
defined in the ArcSight Extension Dictionary. The expressions of the timestamp extension
columns are of the form ToTimestamp(<$CEF Key Name>, <proposed format>) where
<proposed format> is a suggestion for the correct format to use when parsing the data.
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Some extensions in the ArcSight Extension Dictionary have names that start with the
asterisk (*). Since LogLogic LMI does not allow column names to start with asterisk (*), an
asterisk (*) is omitted from the column name. For example, the *sourceProcessld extension
is extracted into a column named sourceProcessld.

When the event was written, the pipe (|), equal sign (=), and backslash (\) characters might
have been escaped by inserting a backslash (\) in front of them. The CEF parser removes
the backslash (\) character, returning the data to its original form. For example, if the value
of the Name header in the event is "detected a \| in message", the value of the cefName
column is "detected a | in message".

Syslog Parser
Data conforming to the Syslog standard defined in RFC-5424
(https://tools.ietf.org/html/rfc5424) can be parsed using the Syslog Parser.

o Note: The older, obsolete format described in RFC-3164 is not supported.

All the header fields defined in the format are extracted as is the Message component. If
the log data contains Structured Data elements, those are extracted as well with the names
of the resulting columns being composed of <element-name>.<key name> as shown in the
following example:

<165>1 2003-10-11T22:14:15.003Z mymachine.example.com evntslog - ID47
[exampleSDID@32473 iut="3" eventSource="Application" eventID="1011"] An
application event log entry
The following columns are extracted:
« facility = local4;
e severity = notice;
e version = 1;
e timestamp = 2003-10-11 15:14:15 (if LogLogic LMI is running in the PDT time zone);
e hostname = mymachine.example.com;
e appname = evntslog;
e procid = <null>;

e msgid = |D47;
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exampleSDID@32473.iut = 3;

exampleSDID@32473.eventSource = Application;

exampleSDID@32473.eventID = 1011;

e msg = An application event log entry

Managing Data Models

You can manage data models from the Management > Advanced Features > Data Models
page:

o Note: The duplicate icon O , delete icon [, and move icon E= are enabled
after you select one or more data models.

Task Steps

View and See Viewing and Searching Data Models.

search data

models

Create a You can add data models using two modes. You can switch between the modes
new data at any time. All information associated with a data model is preserved when
model you switch from graphical to raw mode.

e Creating a Data Model in Graphical Mode: This is the default mode. A
wizard helps you add data models and the associated rules.

e Creating a Data Model in Raw Mode: This is for advanced users who
understand the JSON syntax. Use JSON syntax to add a data model and
associated rules.

Edit a data See Editing Data Models.
model

Duplicate Select the data model and click the duplicate icon O,

Note: You cannot duplicate data models in the System group.
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Task

Delete

Move

Rename

Enable or
disable

Steps

Select the data model and click the delete icon ﬂ.ﬂ After you delete a model, it

cannot be recovered.

Note: You cannot delete built-in and system-created data models.

Select the data model and click the move icon E3. Select the group to which
you want to move it.

Note: You cannot move built-in and system-created data models.

Select the data model and click Edit in the Details panel. Then rename the data
model and click Save.

Note:
e You cannot rename built-in and system-created data models.

e You cannot rename a data model using the rename icon T .

Data models can be enabled or disabled at any time. Select the data model
and click Enabled.

Note: By default, the built-in and system-created data models are enabled.

Data Model Groups

The Management > Advanced Features > Data Models page displays data models in
groups. The All Data Models group displays all data models.

For information about groups, types of groups, and managing groups, see the Groups

section.

Viewing and Searching Data Models

From the Management > Advanced Features > Data Models page, you can view, find, or
filter data models in the following ways.
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Task

View models

based on
filters

Find data
models

Sort data
models

Show or
hide
columns

Searching
data models

Description

You can use filters to easily find models. Click the View list to select the
required filter. The following options are available:

o All
e Created by me
* Created by system

e Imported

You can quickly find the desired model by typing the model name in the Find
field. As you start typing a model name in the Find field, the Data Models page
is automatically refreshed showing your selection.

You can sort any column in ascending or descending order on the Data Models
page. Click the column name or click the arrow (that is displayed on the right
side of the column name when you click in that column) to sort the column.

You can show or hide columns, except the mandatory column, from the table.
Click to view all available columns in the table. Select the check box to

show the column. Clear the check box to hide the column from the table. The
Data Models page is updated immediately.

All enabled data models can be searched using the source filter on the Search
> Advanced Search page.

For more information and other operations on data models, see Managing Data Models.

Creating a Data Model in Graphical Mode

From the Management > Advanced Features > Data Models page, you can create a data
model and enable it. Then you can use the data model to analyze results in the normalized

format.

In graphical mode, a wizard helps you to create a data model in the following steps:

1. Define a source filter

TIBCO Loglogic® Log Management Intelligence User Guide



387 | Advanced Features

2. Add sample events and parsing rules

3. Manage columns and data types

Procedure
1. Go to Management > Advanced Features > Data Models.

2. Click Create New Data Model. By default, the graphical mode opens.
For instructions on how to add in raw mode, see Creating a Data Model in Raw Mode.
3. On the Add data model page, provide the following information:

a. By default, the data model is enabled. Click the slider to OFF to disable the
model.

b. Parent Group: Select a parent group where you want to save the data model.

You can create a new group or select the User group, or select any user-created
group

Default parent group: When creating a nested group within any 'All' group (for
example, All Rules, All Bloks, and so on), the User group is the default
group. Otherwise, the current parent group is selected as the default group.

c. Name: Enter the name of the data model.

The name can include letters, numbers, or underscore (_).
d. (Optional) Enter the description in the Description field.
4. Add a new source filter. For instructions, see Defining a Source Filter.

5. Add sample events and define a parsing rule. For instructions, see Adding a Parsing
Rule in an Advanced Data Model

6. Manage your custom columns. For instructions, see Managing Columns and Data
Types.

7. Click Save.

Result

The new data model is displayed on the All Data Models page and in the parent group
that you selected.
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Defining a Source Filter

You can add a new source filter that is assigned to the data model. The source filters bind
multiple data models to a log source.

Procedure
1. In the Source filter field, enter the source filter statement that is assigned for this
data model. Source filters can only be used on one or more system columns. All filter
statements in the FILTER Statement section are supported. However, when running a
full text search, the filter statement must be specified explicitly.

In the following example, 165 is the device type ID that is retrieved from LoglLogic LMI
and the log message contains <searchstring>:

sys_sourceType=165 AND sys_body CONTAINS 's<searchstring>"

o Note: If you specify multiple data models, the first model whose filter
matches with the event is used to parse that event, extracting all columns
specified by that model.

2. Click Validate to validate the filter statement.

3. To add a new parsing rule, click 2. Add sample events and parsing rules or click
the right-arrow icon > | located on the right side of the page, or, to add only the

source filter and save the data model, click Save.

What to do next
e To add or edit a parsing rule in an advanced data model, see Adding a Parsing Rule
in an Advanced Data Model.

e To edit a GP parsing rule, see Editing GP Parser Rules.

Adding a Parsing Rule in an Advanced Data Model

You can add one or more parsing rules that define how to parse log events.
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o Note: You cannot add a new GP parsing rule in a data model. You can duplicate
an existing GP parsing rule, and make the required changes. For details, see
Editing GP Parser Rules.

Procedure
1. Paste the sample log data in the Sample events panel.

This data can be helpful in defining the parsing rule based on the log source. After
saving the data model, the sample data is always available when editing the same
data model or associated parsing rules.

o Note: You can paste a maximum of 100 KB sample data.

2. In the Parsing rules panel, click Add new rule to add a new parsing rule.
You can add multiple rules for the same data model.

3. In the Name field, enter the name of the rule.

The name must contain an alphanumeric character. It can also contain an underscore
(_) and hyphen (-).

4. To enable the parsing rule, ensure that the slider is set to ON. To disable the rule,
click the slider to OFF.

5. In the Filter field, enter the filter that is assigned to the parsing rule. All regular
expression patterns are supported.

o Note: If you do not define the filter, all events are matched with this rule.
Parsing rules that are listed after such parsing rule are ignored.
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Models

Add Data Model @D

Switch to raw mode

1. Create source filter 2. Add sample events and parsing rules

Sample events  Paste a sample event here (Max size 100 KB)

Name fataModel Enter description

3. Review configuration

Parsing rules  Add rules for parsing the events

1 i 1] 1] ingApp| process:Callinfo|

:4|success:2| fault:2 | responseTime:235

Add new parsing rule
Name il (M
Filter Match all events

Key-Value parser

Values separator

CE—

Key-value separator Regix (O oFF)

Beginning (RegEx)

6. From the Choose parser list, select the type of parser you want to use. Depending
upon the selected parser, you must provide additional information in various fields:

see Parser Field Reference - Advanced Data Models.

7. To configure downstream parsing for this parsing rule to another data model, enable

the Manage downstream parsing field.

o Note: By default, this field is disabled. You can configure the downstream

parsing only for one parsing rule and to only one advanced data model.

Only that parsing rule must be enabled and all other parsing rules must be

disabled.

Field Description

Data model

Select the data model whose parsing rules you want to apply

immediately after the parent rule.

Expression
parsing rule.

Select the expression to apply to the columns generated by the parent

For more information about downstream parsing, see Downstream Parsing.

8. To extract columns based on the parser type, click Auto generate columns. All
custom columns are extracted in the Manage columns for this rule panel.
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a. (Optional) By default, the Store rule identifier on a new column field is
disabled. To store the rule identifier in the ll_parsingRuleName column,
enable this field. Doing so displays the rule identifier in Advanced Search
results. Then you can filter by the rule identifier column, and check which log
messages matched this parsing rule. From the search results you can easily
detect if the parsing rule works precisely or needs changes.

b. You can add, edit, or delete custom columns. To add a column, click [ To edit
any values, click inside the Column and Expression fields. To delete a custom
column, click the Delete I icon for that column.

Column field: The name of the column that is displayed in the results.
Click in the row to add or update any column name. The content assist
shows contextual matches of the existing custom column names and you
can select the required one.

o Note: Two columns cannot have the same name. Column
names are not case sensitive. When defining column names,
follow the guidelines described in the COLUMNS Statement
section.

Expression field: Define how to map the values extracted by the parser
into the defined columns. You can use arithmetic operators and
conversion functions when defining an expression. The conversion
functions are typically used when you need to define new columns where
the expressions for new columns can use conversion functions to convert
between data types and combine them using various operators. For more
information, see the following topics:

» For details about the arithmetic operators, see FILTER Statement.
e For conversion functions, see Predefined EQL Functions.

» The type of expression depends on the parser type: see Parser Field
Reference - Advanced Data Models.

9. Click the Refresh <7 icon. The Parser preview panel displays all extracted columns
and their data types that are matched by the corresponding parsing rule.

If you have configured downstream parsing, then the Parser preview panel displays
the following information:
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* Null as the values - if downstream parsing failed.

» Values as per the parsed fields - if downstream parsing is successful.

For easy readability, each event that matches with the corresponding rule is
identified in the same color. To change the supported data type of a custom column,
click in the corresponding Type field and select the appropriate data type from the
list.

o Note: The parser preview is displayed only if log data exists in the Sample
events panel and if at least one parsing rule is enabled.

appliation  appspace  domain

ssssssssssssssssssssssssssssssssssssssssssssssssssssssssss

10. To save the new parsing rule, click the Save E4 icon.

The Parsing rules panel displays the newly added rule.

11. Click 3. Review configuration or click |Z| located on the right side of the page.

What to do next

Manage columns, review the configuration, and save the data model. For more information,
see Managing Columns and Data Types.

Parser Field Reference - Advanced Data Models

While adding a parsing rule, you must provide different information depending upon the
parser you have selected.

¢ Key-value e XML parser e Regex
parser « Columnar parser

e JSON parser e CEP
parser parser
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Key-Value Parser

Field

Values
separator

Key-value
separator

Beginning
(RegEx)

Ending

Description

Enter the delimiter that you want to use to separate key-
value pairs. You can add only one separator at a time. The
delimiters are case sensitive. For example,
user=bob,vm=windows where user=bob is one pair and
vm=windows is another pair separated with delimiter
comma (,). The delimiter can be a single character, a string
that has to be matched exactly, or a Java regular
expression.

RegEx: Select ON to use as a Java regular expression or OFF
to use as a literal string.

Enter the delimiter that you want to use to separate keys
from their values. The delimiters are case sensitive. For
example, user=bob where user is a key and bob is a value
separated with delimiter equal sign (=). The delimiter can be
a single character, a string that has to be matched exactly,
or a Java regular expression.

RegEx: Select ON to use as a Java regular expression or OFF
to use as a literal string.

If you want some initial characters in each line to be
ignored, enter a regular expression for it. If a segment at the
beginning of the line matches this regular expression, it is
ignored. For example, if a line starts with Login and then
followed by keyvalue pairs, then if you enter Login in this
field, the first word Login is ignored when extracting
columns. Named groups in the regular expression are
extracted as columns.

Note: For sending logs through UDP, when you create a

field so that LoglLogic LMI can parse the logs correctly.

To ignore some characters at the end of each line, enter a
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Field

(RegEx)

Predefined
Columns

Last key

Description

regular expression for those characters. If a segment at the
end of the line matches this regular expression, then it is
ignored. Named groups in the regular expression are
extracted as columns.

Used to define a fixed list of columns to be parsed. If
predefined columns are specified:

e The Key-value parser parses only the specified
columns from logs.

e The value in the Last key field is ignored.

¢ The values in the Values separator and Key-value
separator fields are considered as string literals. The
Regex option is not supported.

This field is useful when the column names are more than
one word and separator is a space. For example, for the log:

Account Name:accl, Account Domain:loglogic,
Caller Computer Name:dell

specify "Account Name", "Account Domain", and "Caller
Computer Name" in the Predefined Columns field to have
the columns and their values extracted correctly.

Enter a key name. Whenever that key is found in a line, the
parser stops searching for more key-value pairs in that line
and the value for that key is the remaining content of the
line. For example, if the line ends:

Severity="high",EventSubClass="1",0bjectID="389576426"

then if you specify Severity as the last key, then the value
for severity is:

"" EventSubClass="1",0bjectID="389576426".

TIBCO Loglogic® Log Management Intelligence User Guide



395 | Advanced Features

Field Description

Note: To specify a <space>, enter \s (backslash followed
by s).

For a <tab>, enter \t (backslash followed by t).

Expression The expression uses a key name preceded with “$” to
extract the value for the column. For example, Suser is the
value of the key "user" in the log line or empty if the key is
not present.

Back to Adding a Parsing Rule in an Advanced Data Model

JSON Parser

Field Description
Beginning Beginning (RegEx): If you want some initial characters in each line to be
(RegEx) ignored, enter a regular expression for it. If a segment at the beginning of the

line matches this regular expression, it is ignored. For example, if a line starts
with Login and is followed by array or objects, then if you enter Login in this
field, the first word Login is ignored when extracting columns. Named groups
in the regular expression are extracted as columns.

Note: For sending logs through UDP, when you create a new data model,

the logs correctly.

Ending To ignore some characters at the end of each line, enter a regular expression

(RegEx) for those characters. If a segment at the end of the line matches this regular
expression, then it is ignored. Named groups in the regular expression are
extracted as columns.

Root The starting node of the JSON. In case of structured JSON, the root element

element specifies the starting column in the JSON structure. If the field is empty, all the
keys within the JSON are mapped to individual columns. For example:
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Field

New Line
Delimiter

Description

Log Root Meaning

element
{"key1":"valuel","key2": key2[0] Start parsing from Oth
["value2","value3"]} element of key2 array
{"key1":"valuel","key2": key2.key3 Start parsing from inner
{"key3":"value3"}} structure key3

This field is required when the parser operates on multiline logs, especially
those arriving from TIBCO LogLogic® Universal Collector. It is recommended to
assign the same delimiter that is set in LoglLogic® Universal Collector so that
the parser removes the delimiters and the logs are parsed successfully.

Back to Adding a Parsing Rule in an Advanced Data Model

XML Parser

Field

Beginning
(RegEx)

Ending
(RegEx)

Description

Beginning (RegEx): If you want some initial characters in each line to be
ignored, enter a regular expression for it. If a segment at the beginning of the
line matches this regular expression, it is ignored. For example, if a line starts
with Login and then followed by array or objects, then if you enter Login in
this field, the first word 'Login' is ignored when extracting columns. Named
groups in the regular expression are extracted as columns.

Note: For sending logs through UDP, when you create a new data model,

the logs correctly.
To ignore some characters at the end of each line, enter a regular expression
for those characters. If a segment at the end of the line matches this regular

expression, then it is ignored. Named groups in the regular expression are
extracted as columns.
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Field

Root path

New Line
Delimiter

Description

If you need to extract a portion of the XML log, you can provide the starting
point from a specific hierarchy within the XML log. If you leave the field empty
or provide "/", the parser parses the entire XML log. To provide a starting
point, use "/" as the separator between elements. For example,
/files/fileInfo_1/location. If the XML log contains sibling elements with
same name, you can address them using "[index]". For example,
/files/fileInfo[1l] or /files/fileInfo[2]. If an XML element has
attributes, the attribute name is also separated by underscore (_) in the
column name. For example, if the XML log is:

<files>

<fileInfo sizeUnit = "kb">
<fullName>/vaibhav/data.txt</fullName>
<fileName>vaibhav.txt</fileName>
<location>/vaibhav</location>

</fileInfo>

<fileInfo sizeUnit = "kb">
<fullName>/shane/data.txt</fullName>
<fileName>shane.txt</fileName>
<location>/shane</location>

</fileInfo>
</files>
Root path Meaning
(empty) Start parsing the entire XML from the root element
/files/fileInfo Start parsing from the location element of the first
[1]/location fileInfo element.
[files/fileInfo [2] Start parsing from the second element fileInfo

This field is required when the parser operates on multiline logs, especially
those arriving from TIBCO LogLogic® Universal Collector. It is recommended to
assign the same delimiter that is set in LoglLogic® Universal Collector so that
the parser removes the delimiters and the logs are parsed successfully.

Back to Adding a Parsing Rule in an Advanced Data Model
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Columnar Parser

Field

Separator

RegEx

Escape
character

Beginning
(RegEx)

Ending
(RegEx)

Max columns

Description

Enter the delimiter that you want to use as a column separator. The separator
can be a string of one or more characters, or a Java regular expression. The
delimiters are case sensitive. For example, bob ,windows where comma (,) is a
character used to separate two columns.

Use this option to define how the separator should be interpreted. Select ON
to use as a Java regular expression or OFF to use as a literal string.

Define a character that is actually used to escape the character used as a
column delimiter. The delimiters are case sensitive. For example, if you use a
comma as a column separator and your column value has a comma in it, then
that value has to be escaped so that a parser does not think that the instance
of the comma is the start of a new column.

If you want some initial characters in each line to be ignored, enter a regular
expression for it. If a segment at the beginning of the line matches this regular
expression, it is ignored. For example, if a line starts with Login and then
followed by columnar data, then if you enter Login in this field, the first word
Login is ignored when extracting columns. Named groups in the regular
expression are extracted as columns.

Note: For sending logs through UDP, when you create a new data model,

the logs correctly.

To ignore some characters at the end of each line, enter a regular expression
for those characters. If a segment at the end of the line matches this regular
expression, then it is ignored. Named groups in the regular expression are
extracted as columns.

Enter the maximum number of columns to be extracted. If more columns than
maxColumns are found, then the content of the additional columns is
included in the last column. For example, if the separator is <space> and the
maxColumns value is 3 for a message like “a b ¢ d”, then there are 3 columns
with values “a”, “b” and “c <space> d”.
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Field

Trim values

Expression

Description

If defined ON, then the extra (white) space that is generated at the beginning
and end of the column is removed. If defined OFF, the extra space is not
removed.

The expression uses the $<n> identifier where n is the column number for the
value of column n. For example, $2 is the value of the column "2".

Back to Adding a Parsing Rule in an Advanced Data Model

Regex Parser

Field

Regex
pattern

Expression

Description

Make sure to enter a valid PCRE regular expression that contains the groups
(named or unnamed) to extracted into column values from the log event. Also,
it is good practice to use one or more sample events to validate your regular
expression and make sure that the correct values are extracted from the
event. For a list of supported regular expression meta characters, based on
Java regular expressions, see Supported Regular Expression Characters. For
example,

(?<Sequence>\d+) . x (2<ACL>\%\w+ \-\d\-\w+)\:\s(?<Name>\w+)\s(?
<Version>\w+) \s(?<Status>\w+)\ s(?<Protocol>\w+)\s(?<
SourceIP>\d{1,3}\.\d{1,3}\.\d{ 1,3}\. \d{1,3}).x(?<
DestinationIP>\d{1,3}\.\d{1,3} \.\d{1,3}\.\d{1,3}).*

This extracts 8 fields: Sequence, ACL, Name, Version, Status, Protocol,
SourcelP, and DestinationlP.

The columns are extracted using the capturing group pattern the named
capturing group pattern or a combination of both. If you select the parser and
the column list is empty, the parser tries to guess columns from the sample
data.

Back to Adding a Parsing Rule in an Advanced Data Model
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CEP Parser
Field Description
Expression Based on the ArcSight Extension Dictionary, the CEF header columns are
extracted and the remaining data is formatted as key-value pairs. For
example,

Sep 19 08:26:10 host
CEF:0|Security|threatmanager|1.0|100|worm successfully
stopped|10| src=10.0.0.1 dst=2.1.2.2 spt=1232

This extracts these columns and their values as follows:

$cefVersion=0, $cefDeviceVendor=Security,
$cefDeviceProduct=threatmanager, $cefDeviceVersion=1.0,
ScefSignatureID=100, S$cefName=worm successfully stopped,
ScefSeverity=10, $sourceAddress=10.0.0.1,
SdestinationAddress=2.1.2.2, $sourcePort=1232

Back to Adding a Parsing Rule in an Advanced Data Model

Managing Columns and Data Types

From the Review configuration page, you can update columns and data types for the
associated data model.
You can also review column statistics for each defined parsing rule.

Procedure

1. In the Columns panel, all system and custom columns are displayed. To add or
remove columns, select the check box next to the column name. You can update any
column name and type.

e Name: The name of the column that is displayed in the results. To add or
remove a column, click the check box next to the column name. To update the
name of a user-defined column, click the column name.

e The name can include letters, numbers, or underscore (_).
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* When used in an Advanced Search query or an expression, the name must
be enclosed in square brackets ([ ]) in any of the following scenarios:

Name Examples

starts with a number  [123]
[12model]

[1col_0]

contains a hyphen [data-a]
[-coll]

[aBc-]
contains all numbers  [1234]

contains a space [abc model]

e A column name cannot include a period (.).
e Two columns cannot have the same name.

* You cannot use reserved keywords as the column name. For a list of
reserved keywords, see Reserved Keywords.

e Type: The data type of the column. Click in the column to add or update the
supported data types. Select the data type from the list.

e Parser rules: The rule name that includes the defined column.
2. Select the Show system columns check box to show all system columns.

By default, some system columns are selected. If the check box is not selected, only
the user defined columns and some default system columns are displayed. For a list
of system columns, see Types of Columns.

3. After modifying column list, click < to refresh the Parser preview panel to view all
extracted columns and their data types for the defined parsing rule.

* If you have configured downstream parsing, then the columns extracted from
the parent rule and the downstream parser are displayed.
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* To change the supported data type for custom columns, click in the Type field,
and select the data type from the list.

The Match statistics panel displays overall information about events that are
matched by specified parsing rules. It displays how many rules are enabled, how
many columns are extracted by the rule, and how many events are matched with

1. Create source filter 2. Add sample events and parsing rules 3. Review configuration | <
Columns show system columns [ Match statistics | 29/30 Events matched
Name Type Parser rules m # Name Enabled Columns Matched events
STRING alert_cleared alert_received,microagent,rulebase 1 alert_cleared YES 7 5/30
2 alert_received YES 10 15/30
STRING alert_cleared,alert_received,microagent,rulebase
3 microagent YES 6 1/30
[ STRING alert dleared.alert received.microagent.rulebase ™
o . ]l
4 rulebase YES 7 8/30
Parser preview Refresh after making change
Matched By # Action Host DNS Hostlp NetworkiP AlertiD Reason Rulebase =
STRING STRING STRING STRING STRING STRING STRING STRING
| rulebase 1 RULEBASE_STATE_CHANGED  esbga01 none 1921682109 19216820 -nulk -null- HawkAC-ESB_Portal Service-ESB Portal Se.. |-
alert_received 2 ALERT_RECEIVED esbga0? none 1921682109 19216820 15210 -null- HawkAC-ESB_Portal Service-ESB_Portal_Se.
| rulebase 3 RULEBASE_STATE_CHANGED  esbga01 none 1921682109 19216820 -nulk -null- HawkAC-Shared_CLE_ Core_ExceptionMgmt...
alert_received 4 ALERT_RECEIVED esbga0? none 1921682109 19216820 15211 -null- HawkAC-Shared_CLE Core_ExceptionMgmt...
alert_received 5 ALERT_RECEIVED esbga0? none 1921682109 19216820 15211 -null- HawkAC-Shared_CLE_ Core_ExceptionMgmt...
alert_received 6 ALERT_RECEIVED esbga0? none 1921682109 19216820 15210 -null- HawkAC-ESB_Portal Service-ESB_Portal_Se.

4. Click Save to save the data model.

What to do next
You can use the data model in advanced search (Search > Advanced Search menu).

Creating a Data Model in Raw Mode

You can add a new data model that can be activated to analyze results in the normalized
format. All enabled models can be searched using the source filter from the Search tab.

Before you begin

This option is for advanced users who understand JSON syntax to create a new parsing
rule. If otherwise, use the graphical mode to create new data model. For details, see
Creating a Data Model in Graphical Mode.

Procedure
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1. Go to Management > Advanced Features > Data Models.
On the Data Models page, click Create a New Data Model.

Click Switch to raw mode to add a new model in raw mode.

> W N

In the Sample events panel, paste the sample events to analyze data in normalized
format. This data can be helpful in defining the parsing rule based on the log source.
Once you add the data model, the sample data is always available when editing the
same data model or associated parsing rules.

o Note: You can paste maximum of 100 KB sample data.

5. In the Raw configuration mode panel, enter the parsing rule. Ensure to define
source filter, parsing rule, and parser properties in a valid JSON syntax. The content
of your JSON file might vary depending on the fields selected and configured for your
parsing rule.

Note: For an example of the JSON file and syntax, you can open an
existing data model and view its parsing rule in the raw mode.

6. Click Validate to ensure that the rule syntax is valid. Click Format to format the
JSON.

7. Click [Z] to refresh the Parser preview panel to view all extracted columns and their
data types that are matched by the defined parsing rule. Click in the Type field to
change the supported data types and select the data type from the list.

o Note: This option is available only when the data is pasted in the Sample
events panel and at least one parsing rule is enabled.

8. Click Save to add a new data model. The Data Models page displays the newly added
model.

Editing Data Models

You can edit existing data models or save the same model as a new one.
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o Note: You cannot edit the system data model and built-in data models. For the
list of built-in data models, see the Supported Log Sources list in TIBCO
LogLogic® Log Source Packages Installation and Upgrade, which is available on
the TIBCO eDelivery website or TIBCO Support website after logging in.

Procedure
1. Go to Management > Advanced Features > Data Models.

2. On the Data Models page, click the model name that you want to update.
The Details panel opens on the right side of the page.

3. Click the Edit link to edit the data model.
For detailed information, see Creating a Data Model in Graphical Mode.

4. Click 7 to refresh the Parser preview panel to view all extracted columns and their
data types that are matched by the corresponding parsing rule. Each event that
matches with the corresponding rule are identified in the same color for easy
readability.

5. Perform one of the following:
e To save the updated information, click Save.

e To save the data model as a new one, click Save As. Enter the new data model
name in the Name field and click OK.

The page is updated immediately.

Managing Parsing Rules

You can manage parsing rules within a data mode when you edit the data model.

Task Steps

Define the sequence  See Defining the Sequence of Parsing Rules.
of parsing rules

Create a new See Adding a Parsing Rule in an Advanced Data Model.
parsing rule
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Task
Edit a parsing rule

Duplicate

Delete

Reorder

Rename

Enable or disable

Steps
See Editing Parsing Rules in Advanced Data Models.

Select the parsing rule and click the duplicate icon 0.
Select the parsing rule and click the delete icon .

Note: You cannot delete parsing rules that are defined for the
system data model and LogLogic LMI built-in data models.

You can a parsing rule (move up or down), to change the sequence of
the rules within the data model.

Note: You cannot move a parsing rule from one data model to
another.

D.ouble-click the parsing rule, rename the rule, and click the Save icon
(v

Select the parsing rule and click Enabled.

Defining the Sequence of Parsing Rules

When multiple parsing rules are defined for a single data model, you can set the rule

sequence.

Columns are extracted per the first rule definition that matches the event and subsequent
rules are not applied. For example, if Rulel matches some of the data, it is used to extract
column values. If Rulel fails to match with your data, Rule2 is applied, and so on.

Therefore, sometimes you might want to change the sequence of the parsing rules for the

data model.

Procedure

1. In the Parsing rules panel, hover over the rule row near the dragD icon and the
cursor turns into a hand, which you can use to drag the row up or down to change

the sequence.
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2.

3.

To refresh the Parser preview panel to view all extracted columns and their data

types that are matched by the corresponding parsing rule, click the Refresh icon I:I
Each event that matches with the corresponding rule is identified in the same color
for easy readability.

To save the data model, click Save.

Editing Parsing Rules in Advanced Data Models

You can add or modify parsing rules within the data models that use one of the advanced
data model parsers. See Types of Parsers in Advanced Data Models.

Procedure

1.
2.

In the Parsing rules panel, double-click the rule that you want to update.

In the Edit parsing rule panel, update the rule information. For details about each
field, see Adding a Parsing Rule in an Advanced Data Model.

Click the Refresh icon to refresh the Parser preview panel to view all extracted

columns and their data types that are matched by the corresponding parsing rule.
Each event that matches with the corresponding rule is identified in the same color
for easy readability.

1. Create source filter 2. Add sample events and parsing rules 3. Review configuration | < | | > ‘
Sample events  Paste a sample event here (Max size 100 KB) Parsing rules  Add rules for parsing the events ‘ Add new rule |
'
# Name Enabled Filter
| alert_cleared on O ALERT_CLEARED
alert_received (on O ALERT_RECEIVED
microagent (on O MICROAGENT
rulebase on ) RULEBASE_STATE_CHANGED
0 v
Parser preview Refresh after making change
Matched By # Action Host DNS HostlP NetworkIP AlerdD Reason Rulebase ol
STRING STRING STRING STRING STRING STRING STRING STRING
| rulebase 1 RULEBASE_STATE_CHANGED  esbga01 nane 1921682109 192.168.2.0 -null- -nuill- HawkAC-ESB_Poral_Service-ESB_Portal Se.. |-
alert_received | 2 ALERT_RECEIVED esbgal? none 1921682109 19216820 15210 -null- HawkAC-ESB_Portal_Service-ESB_Portal_Se...
| rulebase 3 RULEBASE_STATE_CHANGED  esbga01 none 1921682109 192.168.2.0 -nulk -null- HawkAC-Shared_CLE_Core_ExceptionMgm...
alert_received | 4 ALERT_RECEIVED esbga0! none 1921682108 19216820 15211 -null- HawkAC-Shared_CLE_Core_ExceptionMgmt...
alert_received | 5 ALERT_RECEIVED esbga0? nane 1921682109 19216820 15211 -null- HawkAC-Shared_CLE_Core_ExceptionMgmt..

4. Click the Save icon to save the updated information. The Parsing rules panel is

TIBCO Loglogic® Log Management Intelligence User Guide



407 | Advanced Features

updated immediately.

GP Parser-Based Data Models

The data models in LoglLogic LMI can be broadly classified into the following categories:

e Advanced Data Models, which use parser types such as syslog, Regex, JSON, and so
on.

e GP Parser-Based Data Models, which are data models that use a grouped-pattern
parser (GP parser). GP parsers are especially efficient in handling complex Regex
parsing rules that work on heterogeneous free-text logs.

GP parsers are very different in structure and syntax from the advanced data model
parsers. The parsing rules in a GP parser use Regex patterns, and it is recommended that
you have preliminary knowledge of Regex patterns. GP parsing rules have been designed to
handle a large set of such complex rules. You cannot create a new data model or edit a
built-in data model that uses the GP parser. However, you can duplicate a built-in data
model, and then edit its parsing rules as required.

Usage: GP parser-based data models

Sometimes, if the format or pattern of the logs received in LoglLogic LMI are slightly
different than expected, then the logs are not parsed with the parsing rules defined in the
built-in data model. Before LoglLogic LMI version 6.4.0, you could not identify which parsing
rules failed to match, or which rules were the closest match for such logs, or to edit the
parsing rules expressions to accommodate the parsing of the changed log format.

Starting version 6.4.0, you can:
» View a graphical representation of the entire node tree of parsing rules.
* Identify or filter out rules sharing a given node.

e Validate a sample log event against the built-in parsing rules and inspect the
graphical view to identify at which node the parsing failed, or the closest matching
rule that you might need to tweak.

 Edit the rule expression as required, and save the modified rule or save it as a new
rule. See Editing GP Parser-Based Data Models.
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Note:
e To edit parsing rules of advanced data models, see Editing Parsing Rules in
Advanced Data Models.

e For a list of parsers in advanced data models, see Types of Parsers in
Advanced Data Models.

List and Graphical Views of GP Parsing Rules

GP parsing rules are displayed as a list on the Rule list tab and as a node tree on the Node
tree tab.

Rule list tab

The Rule list tab displays a list of rules as a table. Each row in the table displays the
rule number, its rule ID, and its Regex pattern. After clicking the Edit icon [4] , the page

displays a table that includes the rule ID and pattern; followed by basic rules and the
event descriptor fields. To reorder (move up or down), edit, duplicate, or delete a rule,
click the corresponding icon in the rule row.

Node tree tab

The Node tree tab displays the list of rules as a tree. Initially, in the node tree, the first
node is green and all others are gray. After parsing a sample log that you provide in the
Sample event field, the colors of the nodes change - depending on whether the node
was visited; or whether the node pattern matched or failed.

The state of each node is displayed in a tooltip box after hovering over the node and
also represented by the following colors:

» Grey: The node has not been visited during the parsing process
» Green: The node has been visited and matched

e Red: The node has been visited but pattern matching failed
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o Note:

» The colors red and green reflect the node parsing status when a sample
log has been provided.

 In the collapsed state, the colors of the nodes are darker than in the
expanded state. For example, dark green in collapsed state; but light
green in expanded state.

In the node tree area, you can perform the following actions:

To view node information: If you hover on a node, the node ID, pattern, and rule
pattern of that node are displayed as a tooltip box.

To zoom in or out of the tree: Move the mouse roller or use the mouse trackpad in
the tree area.

To move the tree: Click the background and drag the tree area (keep the mouse
button pressed while dragging).

To filter rules by node: Click the tooltip box of a node. The view switches to the
Rule list tab; displaying a filtered list of rules. To clear the filters and view the

entire rule list, click the Refresh icon I:I

To collapse or expand a node: Click the node. This action triggers an update of the
tree layout and changes the view of the node tree. Expanding a node zooms in on
the tree; collapsing a node zooms out and might display the entire tree in
compact form.

Note: In the collapsed state, the colors of the nodes are darker than in the
expanded state. For example, dark green in collapsed state; but light green in
expanded state.

Editing GP Parser-Based Data Models

Starting from LogLogic LMI 6.4.0, you can edit the parsing rules of data models that use the
GP parser. Because these are built-in data models, you cannot edit them directly. You must
duplicate a built-in data model, save it in the User group or any other user-created group,
and then edit the parsing rules of your new data model.

TIBCO Loglogic® Log Management Intelligence User Guide



410 | Advanced Features

Similarly, you cannot create a new GP parsing rule. You can edit an existing rule, and then
save it either as the same rule or as a new rule (the new rule is automatically assigned a
new rule ID). By default, the GP parsing rules are enabled, and cannot be disabled.

A Caution: The editing option is intended for advanced users who understand the
complex Regex patterns. For assistance in editing GP parser rules, contact

TIBCO Support.

Editing parsing rules involves the following steps:

1. Defining a source filter.
This procedure is the same as that for advanced data models. See Defining a Source
Filter.

2. Editing GP Parser Rules

3. Reviewing the Data Model Configuration

Editing GP Parser Rules

To edit a GP parser rule, you must add a sample event and then perform the following
steps.

Procedure
1. In the Sample events box, paste a sample event.

This data can help in defining the parsing rule based on the log source. After saving
the data model, the sample data is always available when editing the same data

model or associated parsing rules.

Sample events Paste a sample event here (Max size 100 KB)

Oct 24 14:00:15 susetest sudo: aees4 : TTy=pts/1 ; PWD=/home/a@e4 ; USER=root ;
COMMAND=/bin/date
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o Note:

* You can paste a maximum of 100 KB of sample data.

e The tree view shows the node status only for the first event in the
Sample events box.

2. Click the Refresh icon I:I . The Parser preview panel displays all extracted columns
and their data types that are matched by the corresponding parsing rule.

I i
Parser preview Refresh after making change | =J

Sy5_eventTime

TESTAME - |_eventaction Il_sventactioniD |_deviceTypelD Il_pRuleID II_parentrulelD I_devn
STRING LOMNG LOMNG LOMG LONG STRIMC
2021-10-24 14:00:15 1 Privilege Escalation 74 11111 1111100881 1111109042 opera

3. Click the Node tree tab to see the tree view. The node tree displays nodes with
different colors:

» Grey: The node has not been visited during the parsing process
¢ Green: The node has been visited and matched

* Red: The node has been visited but pattern matching failed
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Rule list Node tree

o Note:

* The colors red and green reflect the node parsing status when a
sample log has been provided.

 In the collapsed state, the colors of the nodes are darker than in the
expanded state. For example, dark green in collapsed state; but light
green in expanded state.

4. To zoom in or out of the view, move the mouse roller till you have a better view of
the matching node. To view the node information of a node, hover over the node.
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Rule list Node tree

To see node information, hover over the node. To filter rules by node, click the node tooitip. To zoom infout, move the
4 J J L

mouse roller. To move the tree, click the DDI_"’.g."C‘LJ.'TG and drag the mous
=

S

m

Node 1D:2203
Pattern:\A[\s\r\n\f]*\Z
Rule Pattern
\ANS\AN\f]*\Z

o0a8ed o9 B8
feassaseaannnan

ISR RERRRRRRRERRRERRRRRRRRRRI
LA L B A L il Al Rl el RE YNy}

o
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5. After clicking the tooltip box, the view switches to the Rule list tab, and only those
parsing rules that share the node you clicked are displayed. Scroll to the rule you
want to edit and click its Edit or duplicate icon (4

Rule list Node tree

To mowe (up or down), edit, duplicate, or delete a rule, click the corresponding icon in the rule row.

Clear filters

= Rule ID Pattern

405 1111100881 \A:<%PRI%>)? \AU20* WA-ZH1){a-ZH220:\d+020\d\d+Ad+020+ 2D
%6DOMAINSS \A\x20+ 35DAEMONS6 \AR-\[%PID%\] | \x20%PID%(?=\x20))2:2
\x20+ %SRC_USER \A\x20+\x20+(2-%FAILURE_REASON%(?=:):\x20+)?
TTY\= %6TTY% \AWX20+\x20+ \APWD\= 3%6PWD% \A\x20+\x20+ \AUSER\=
3USERY \A\X20+;(2\x20TSID=\5+\x20;)2\x 20+ \A\x20*COMMAND\=
%COMMAND \A[\S\PAM\f]*\Z

6. In the Edit or duplicate rule section, you can edit any fields of the parsing rule
except the Rule ID field. For detailed information about the syntax, description, and
format rules, see the Field Reference section.
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Rule list MNode tree

To move (up or down), edit. duplicate, or delete a rule, click the corresponding icon in the rule row.

Edit or duplicate rule E

Validate

-

Rule ID: 1111100881

\A(7:<%PRI1%=)? \A\x20™* \A[A-ZJ{1}[a-Z]
— {2}\x20+\d+\x20\d+-\d+:\d+\x20+ %DOMAIN%
' \AWx20+ %DAEMON% \A(?-\[%PID%\] | \x20%PID%(? -
=\x20))?:\x20+ %SRC_USER% \A\x20+:\x20+

e _ _— #
Basic Rules:
Token Name Token Value
%PRI% \d+ s 0
%DAEMON®% \Asu(2:do)2(2=[:\[\x20]) Pl
%PID% \d+ P
//Field Declarations
string field ||_eventAction;
Event int field ll_eventAction|D;
descriptor: int field ll_deviceTypelD;
string field ll_sourceDomain;
string field Il_sourceHost; =
string field ||_logRefID; y =

7. After modifying the required fields, click Validate. If validation of the rule is
successful, a message is displayed at the top of the section. If not successful, an error
message is displayed, providing the reason for failure.
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Rule list Node tree
To move (up or down), edit, duplicate, or delete o rule, click the correspond. '__ Ion in e e
Validation successful Edit or duplicate rule
%DAEMONS% VAsu(?:do)2(?=[:\[\x20]) 2T -
%PID% \a+ 7 0

//Field Declarations

string field ll_eventAction;
Event int field ll_eventActionID;
descriptor: int field ll_deviceTypelD;

string field ll_sourceDomain;

string field ll_sourceHost;

string field Il_logRefID; h

8. You can either save the changes in the same rule or save the rule as a new rule
(duplicate the rule):

e To save the changes in the same rule, click the Save icon .
e To save a copy of the rule, click the Save as icon 123,

e To cancel the changes, click the Cancel icon .

o Note:

» The Save and Save as icons are enabled only after making changes

in at least one field (except the Rule ID field) and if validation is
successful.

e Saving the parsing rule also saves the data model.

What to do next

Review the configuration and save the changes to the data model. See Reviewing the Data
Model Configuration.
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Reviewing the Data Model Configuration

From the Review configuration page, you can update columns and data types for the
associated data model. You can also review column statistics for each defined parsing rule.

Procedure
1. In the Columns panel, all system and custom columns are displayed.

Field Description
Name The name of the column that is displayed in the results.
Type The data type of the column.

Parser rules The rule name that includes the defined column.

2. Select the Show system columns check box to show all system columns. By default,
some system columns are selected. If the check box is not selected, only the user-
defined columns and some default system columns are displayed. For a list of system
columns, see Types of Columns.

3. The Match statistics panel displays overall information about events that are
matched by specified parsing rules. It displays how many rules are enabled, how
many columns are extracted by the rule, and how many events are matched with
each rule.

What to do next
You can use the data model in advanced search (from the Search > Advanced Search
menu).

Field Reference

This section explains the fields in a GP parser. You can edit any fields of the parsing rule
except the Rule ID field. For information about how to edit these fields, see the Editing GP
Parser Rules section.

A GP parsing rule is a sequence of pattern-matching nodes that parse a log. Each rule is
made of pattern-matching nodes and event descriptors. Each node includes a set of basic
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rules. The basic rules contain token definitions, which are the patterns to be used to match
and capture substrings from the log. Such substrings are then assigned to the specified
database columns. The definition of which substrings are stored in which database
columns is stored in the Event Descriptor field. If a log matches the entire node sequence,
an event is generated as defined in the Event descriptor field.

The following table describes the fields in a GP parsing rule:

Field Name

Rule ID

Pattern

Basic Rules

Event
descriptor

Description

The unique identifier of the rule in a data
model. It is displayed in Advanced Search
results. The rule ID is an auto-generated
number and cannot be modified.

The Pattern field contains the rule definition.

The Basic Rules field contains the list of
token names and their corresponding
patterns. The token names can be reused in
the Event Descriptor field to extract
substrings. These substrings can be used as
function variables or field values. See the
Event Descriptor Language Reference
section.

This field includes a set of columns with the
values extracted from the log after the
parsing rule completes parsing the log. The
columns and their values are displayed in
the Parser preview pane. This is a very
large section, and includes other
subsections.

Format

Numeric, integer. Format : [0-
9]+

It is a sequence of Regex or
token nodes (%SOMETHING%).
Note: The nodes are
separated by a space character
(" ). Therefore, to use a space
character in the pattern, you
must use \x20 or \s in the
pattern.
%('A"..'Z"|'a".."Z" || '0" ..
'9')+%

You must follow the language
syntax as described in the
Event Descriptor Language
Reference section.
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Event Descriptor Language Reference

The event descriptor language is used in the parser rule file. Similar to other programming
languages, it includes declarations, statement types, array constructs, and so on.

The following table describes the terms used in this section.

Term

Token

Static string

Field or
temporary
variable

Function call

Expressions

Used in

Used in the Basic
Rules and Event
Descriptor fields.

A token is a pattern-
capturing group. You
can use a token to

reference the strings in

the Event Descriptor
field.

Used in the Event
Descriptor field for
constants

Used in the Event
Descriptor field

Used in the Event
Descriptor field

Used in the Event
Descriptor field for
passing arguments to
function calls.

Format Example
%('A"..'Z"|'a".. 'z | |0 ll_eventID :=

. '9")+% %EVENTID%
Any character sequence "Some string",
between double quotes. "with a \"”

(escape character: '\)

LETTER ( LETTER | DIGIT )* ll_eventID

Where LETTER includes
upper case letters ('A' .. 'Z"),

lower case letters ('a' .. 'z"),
or underscore ('_")
FUNCTNAME (expressions) concat2(“prefix_”,

%EVENTID%
Where the format of ° o)

FUNCTNAME is: LETTER (
LETTER | DIGIT )*

It can be a one-to-many e "string"
static string, token, function
call, or temporary field.

When specifying a list of e join("a", "b")

* %TOKEN%
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Term Used in Format Example

expressions, the separator is
comma (,).

Basic Operations

This section describes the syntax and format of the following operations:

e Declare a field.

Declare a temporary variable.

Assign a value to a field or variable.

Use conditional statements. Iterate over an array.

Generate multiple events for a log.

Operation Syntax Example

Declare a fi
eclare a field TYPE field IDENT; int field 11l_eventID;

e TYPE is the type of
the field: int, string,
inetAddr,
timestamp

¢ |IDENT is the field
name. It can be
either a function or
an enrichment list
(user-defined
mapping function).

Format: LETTER ( LETTER
| DIGIT )*

Declare a temporary temp IDENT e A simple temp variable: temp

variable variable;
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Operation

Assign a value to a field
or temporary variable

Conditional statement

Syntax Example

e An array variable: temp array_

<ARRAY_MARKER> ;

var(];

IDENT is the name
of the temp
variable.

ARRAY_MARKER []
indicates the
variable as an
array. Optional.

¢ |l_eventID := %EVENTID%;

IDENT :=
expression; o |l_eventStatusID :=1;

¢ |l_eventAction := "some string
value";

e ||_eventActionID :=
actionidentification
(%EVENTID%);

o if (strstr("success",

if ( expression )

{ statements } %OUTCOME%)){ [l

( else ( if_ eventStatusID = 1; }

statement | ({
statements } ) )

)?

o if (strstr("success",
%OUTCOME%)){ Il
eventStatusID = 1; } else{ lL_
eventStatusID = 2};

o if (strstr("success",
%OUTCOME%)){ Il
eventStatusID = 1; } else if
(strstr("failure",
%OUTCOME%)){ Il
eventStatusID = 2; } else{ ll_
eventStatusID = 0;}
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Operation Syntax Example

‘Foreach’ statement

Foreach my_var 1in Foreach my_var 1in myTvar {
myTvar { //create output data :
statements set fields;
} insert;
}
‘insert’ statement insert;

Foreach my_var in myTvar {
//create output data :
set fields;
insert;

Used in combination with
foreach, it can be used
to create multiple output }
data records for a single

log.

Functions

The following table describes a few functions, their syntax, and usage information.

Function name Description

addnum Returns the sum of the expressions.
(expressionl,
expression2)

concat2 Concatenates the two expressions and returns the resultant string.
(expressionl,
expression2)

ipAddress Converts the expression into an inetAddr value. The expression can be a
(expression) 32-bit number or a string.
join(string, Concatenates multiple expressions with the value of string.

expressions)

logAppld() Returns the app ID of the GP parser rule. It is an internal identifier and
cannot be modified.
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Function name
logld()
logRuleid()
logsource()
logtime()

mapRuleAction
(expression)

mapRuleStatus
(expression)

match(<regex>,
expression)

matchList(<some_
regex>, expression)

matchN (group_id)

Description

Returns the log identifier.

Returns the ID of the matching rule.
Returns the log source name.
Returns the log collection time.

Calls the enrichment list function for a data model, using the expression
for the specific rule ID:

<Data model name>_mapRuleAction(Rule_ID)

Returns the corresponding value from the enrichment list.

Calls the enrichment list function for a data model, using the expression
for the specific rule ID:

<Data model name>_mapRuleStatus(RuleID_expression)

Returns the corresponding value from the enrichment list.

Returns true if the <regex> expression matches expression.

To use the capturing groups from the <regex> expression for further
matching, you can use the matchN() function. The capturing groups from
this function are automatically used as the parameter in the matchN()
function.

Finds all matches of the <some_regex> expression within the expression
string and returns an array of strings. Use this function when you need
demultiplexing.

Returns a capturing group from the last match() function call. You can

then use the capturing group value in other functions or assign the
capturing group value to a variable.
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Function name Description

splitChar Splits the expression using the pattern in <expression_split>= and returns an
(expression_split, array of strings. Use this function when you need demultiplexing. It
expression) creates multiple, structured data output records for a single log.

Use the following pattern:

foreach element in T_elementList {
//assign fields values.... ;
Insert;

}

splitRegex("some_  Similar to splitChar (), but with a Regex as the split condition.
regex", expression)

strequal Returns true if the expression strings are identical.
(expression_string1,

expression_string2)

strptime(time_ Convert the expression string into a timestamp of the specified time
format, expression) format.

For more information about how to specify the time format, see Time
format specifiers.

strstr(<source_ Returns true if the source expression string contains the search

expression>, search_  expression string.
expression)

upcase(expression)  Return uppercase string of the expression string.

Time format specifiers

Use the following letters to specify the time format parameter in the strptime() function.

Parameter Description

‘A", 'a’ The day of the week, using the locale's weekday names. Specify either the
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Parameter

lBl, lbl

'C" ICI

Description
abbreviated or full name.

The month, using the locale's month names. Specify either the abbreviated or
full name.

Not supported

The day of the month [1-31]. Leading zeros are permitted, but not required.
%D is the same as %m/%d/%y.

%e is the same as %d.

%h is the same as %b.

The hour (24-hour clock) [0-23]. Leading zeros are permitted; but not
required.

The hour (12-hour clock) [1-12]. Leading zeros are permitted; but not
required.

The day of the year [1366] Leading zeros are permitted; but not required.

%k is the same as %H.

%! is the same as %l.

The month number [1-12]. Leading zeros are permitted; but not required.
The minute [0-59]. Leading zeros are permitted; but not required.

Any white space.

The locale's equivalent of A.M. or P.M. It is an indicator for the 12-hour clock.

%r is the time as %I:%M:%S %p.
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Parameter

IRI

ISI

ltl

ITI

lYl

Description
%R is the time as %H:%M.

The seconds [0-61]. Leading zeros are permitted; but not required. You can
also specify milliseconds (optional).

%t is any white space.
%T is the time as %H:%M:%S.

The week number of the year as a decimal number [0-53]. Leading zeros are
permitted but not required. Sunday is considered as the first day of the week.

The weekday as a decimal number [0-6], with O representing Sunday. Leading
zeros are permitted; but not required.

The week number of the year as a decimal number [0-53]. Leading zeros are
permitted; but not required. Monday is considered the first day of the week.

Not supported.
The year including the century. For example, 1998.

%% is replaced by %.

Monitoring Console

The Hawk Console is available in LogLogic LMI as the Monitoring Console. It provides a
central view of all the distributed components interacting within the Hawk® environment.

It is easier to manage multiple domains from LogLogic LMI than configuring and controlling
the domains individually. From the Monitoring Console, you can:

e Configure and manage domains of TIBCO Operational Intelligence Hawk® 6.2.1 HF2 or

later

e Monitor and manage distributed applications and operating systems

e Manage alerts generated by Hawk agents
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e Take action in response to predefined conditions

By default, the Monitoring Console is disabled in LogLogic LMI. After a user with
administrator access enables it, you can access it from Monitoring > Console.

Domains

Monitoring Console provides a ready-to-use Hawk domain named 1mi_domain, to which
you can connect external Hawk agents. By default, lmi_domain is registered to the

Monitoring Console. You can unregister it by clicking the Unregister icon on the domain
card. To register it again, follow the procedure described in Configuring a Hawk domain.

You can also register other external domains and external Hawk agents can connect to the
domains.

Related Topics

For more information, see the following documentation:

Topic Reference
TIBCO Hawk Console TIBCO Hawk Console User's Guide
TIBCO Operational Intelligence Hawk® TIBCO Operational Intelligence Hawk®

documentation

Enabling the Monitoring Console Contact your Loglogic LMI
administrator.

Configuring a Hawk domain within LoglLogic LMI Contact your TIBCO Operational
Intelligence Hawk® administrator.

Securing the communication between the Monitoring  Contact your TIBCO Operational
Console and other Hawk components Intelligence Hawk®administrator.
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Configuring a Hawk domain

You can register and configure multiple Hawk domains within LoglLogic LMI. The Monitoring
Console connects to Hawk domains using TCP.

In addition to the default 1mi_domain, you can configure and register other external
domains in LoglLogic LMI and external Hawk agents can connect to the domains.

If you have deployed LogLogic EVA on a Docker host, you must use the proxy domain type
to connect to existing Hawk domains.

Domain Description

type

regular An external Hawk domain (created outside of LoglLogic LMI), to be connected
over TCP.

Provide a domain name and its TCP transport details.

proxy An external Hawk domain (created outside of the LoglLogic LMI), to be connected
using the proxy method.

Provide a domain name, URL, and login credentials.

LMI An internal domain, provided as a built-in, ready-to-use domain.

Domain
External agents can connect securely to this domain using the Self/Cluster

Manager Host:Port field.

New An internal domain, similar to the built-in LMI Domain

Domain
External agents can connect securely to this domain using the Self/Cluster

Manager Host:Port field.

Procedure
1. On the Monitoring Console, in the Domain section click the plus (+) icon.

2. In the Configure Domain dialog box, provide the following information:

For details about these parameters, see TIBCO Hawk® Console User's Guide.
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Field Description
Domain type Choose one of the following
domain types:
* proxy
e regular
e New Domain
e LMI Domain
Note: LMI Domain is the
default domain. If you select
LMI Domain, all other fields

are automatically set to their
default values.

LMI Domain is available in
the list only if it is currently
unregistered.

Domain Name Type a name for the domain

Transport The transport protocol

Note: Not applicable to a
proxy domain.

e Self Host: o Self Host: Port: Enter the
Port IP address and port of the
« Cluster LogLogic LMI appliance
Manager * Cluster Manager Host:
Host: Port Port: Enter the IP address
and port of the cluster
manager

Default Value

regular

Automatically set to Imi_domain
(if you select LMI Domain as the
domain type)

TCP

None
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Field Description Default Value

Note: These two fields are
available when you select the
domain type as regular.

Self/Cluster Enter the IP address and port of * If you select LMI Domain

Manager Host: the appliance. The port number as the domain type, the

Port must be unique and open for value is set to
bidirectional communication. <appliance_IP_

address>:9688 and the
field is not editable.

 If you select New domain
as the domain type, you
must enter the appliance
IP address and port.

If you select LMI Domain or New domain as the domain type, the two
fields Self Host: Port and Cluster Manager Host: Port are
combined as the Self/Cluster Manager Host: Port field.

3. To configure a domain that uses SSL-based TCP transport, select the Additional
transport options check box and provide the values for the following fields:

Field Description

Key store Absolute path of the key store that contains the Monitoring Console
certificate and key to be loaded while communicating with the Hawk
domain. You must provide a custom keystore that has a password-
protected key.

For example, the default keystore of LogLogic LMl is:

/loglogic/tomcat/conf/keystore

Key store Password to access the key store

TIBCO Loglogic® Log Management Intelligence User Guide



430 | Advanced Features

Field Description

password

Key Password to access the private key

password

Trust store Absolute path to the trust store to be used to validate the Hawk

component certificates while communicating with the Hawk domain.

For example, the default trust store of LogLogic LMl is:

/loglogic/tomcat/conf/truststore

Trust store Password to access the trust store
password

SSL protocol ~ TLSv1.3 and TLSv1.2 protocols are supported.
(optional)

SSL Enabled ~ Comma-separated list of algorithms.

Algorithms
. Default value: TLS_RSA_WITH_AES_128_CBC_SHA
(optional)
Security Choose one of the following:
Policy . None
e Trusted

Trusted with Domains (only for Windows domains)

e Custom

4. Click Configure.

Result
The domain is configured and displayed in the Domains section.
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o Note: Whenever the connection of the appliance with the domain is lost, the
appliance tries to reconnect. However, if the appliance is not able to reconnect,
a reconnect button appears on the Monitoring Console. You can click the button
to manually reconnect to the domain.

What to do next
After configuring a Hawk domain, you can connect Hawk agents to it.

Note: When configuring Hawk agents, ensure that you use the domain name, IP
address, and port number of the domain in LoglLogic LMI.

For information about how to connect Hawk agents to the Hawk domain, contact your
Hawk administrator or see TIBCO Operational Intelligence Hawk® documentation.

Groups

You can organize your data into groups. A collapsible pane on the left displays the
dashboard groups in a folder-like structure. Groups are available in the following Advanced
Features:

e Advanced aggregation

Advanced dashboards
Bloks

Data models

Enrichment lists

For more information about these features, see Advanced Features.

Shared and Nested Groups

To further organize artifacts, you can create nested groups. When you create a group, by
default the Shared option is enabled. Setting a group as shared makes it available in other
Advanced Features and you can store artifacts relevant to that functionality in the shared
group. A group with its Shared option disabled is not available in other Advanced Features.
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 If a parent group is shared, then that group, along with the nested groups that are
shared, are available in other Advanced Features. The nested groups with Shared
disabled are not available in other Advanced Features.

 If a parent group is not shared, then that parent group and all of its nested groups
are not shared.

» The Shared option of a group cannot be changed later.

e Shared groups are indicated by the icon ™ and groups that are not shared are

indicated by the icon a |

o Note: By enabling the Shared option, only the groups are available in other
Advanced Features; the artifacts stored in the groups are not available in other
features. For example, the User group in the Data Models feature stores data
models, but in the Bloks feature stores Bloks.

Built-in Groups

The following built-in groups are available:

o Note: User-created artifacts cannot be stored in built-in groups.

Group Name Contents of the group Shared? Yes/ No
System Artifacts created by the system Yes
User * New artifacts created by users (non- Yes

system users) in LogLogic LMI 6.4.0

 Artifacts created by users in previous
LogLogic LMI versions and that are not
associated with any group

LSP Artifacts related to LoglLogic LSP Yes

Distributed Distributed aggregation rules that are created Yes
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Group Name Contents of the group Shared? Yes/ No

on a Management Station. On a Remote
Appliance, you can see the aggregation rules
created on the Management Station in the
Distributed group.

Note: You cannot create a new rule or group
in the Distributed group.

ComplianceSuites Artifacts related to TIBCO LoglLogic® Compliance Yes
Suite

Rules All aggregation rules No

> Aggregation > All

Rules

Advanced All dashboards No

dashboards > All

Dashboards

Bloks > All Bloks All Bloks No

Data models > All All data models No

Data Models

Enrichment lists > All  All enrichment lists No

Enrichment Lists

After Upgrading to LogLogic LMI 6.4.0

In versions 6.3.x, groups were available only in the Advanced Dashboards. In other
Advanced Features (Bloks, Data Models, Aggregation Rules, and Enrichment Lists), the
corresponding artifacts were displayed on the main page of the feature.

After upgrading to LoglLogic LMI 6.4.0, the artifacts from versions 6.3.x are stored in
different groups, depending on whether the artifacts are built-in or how they are related to
LoglLogic LSP.
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For details about these changes, see the "Upgrade Considerations" section in TIBCO
LogLogic® Log Management Intelligence Configuration and Upgrade.

Managing Groups

You can create, delete, or rename a group from any of the Advanced Features where the
group is available.

Task Steps

View all groups The following types of views are available:

* In the left pane, as a folder-like structure. The left pane can be

collapsed by clicking or expanded by clicking =,

e On the main page, as a list view. The path of the group is also
mentioned in the list.

For dashboard groups, a grid view is also available. You can switch
to the grid view by clicking the grid icon &= or to the list view by

clicking the list icon

Create a group 1. To create a parent group: click Create Group.

To create a nested group: click Create Nested Group.

2. (Optional) By default, the group is shared across other Advanced
Features. If you do not want it to be shared, then disable the
Shared option.

3. Type a group name.
4. (Only for nested groups) Select the parent group from the list.

You can create a new group or select the User group, or select any
user-created group

Default parent group: When creating a nested group within any

'All" group (for example, All Rules, All Bloks, and so on), the User

group is the default group. Otherwise, the current parent group is
selected as the default group.
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Task

Delete

Rename

Move

Duplicate

Steps
5. Click Save.

o Delete: Select the group and click the delete icon ﬁ.ﬂ

« Rename: Select the group and click the rename icon T . Enter the

new group name.

Note: You cannot delete or rename built-in groups.

Note: You cannot move or duplicate groups.
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Universal Lossless Data Protocol Library

The Universal Lossless Data Protocol (ULDP) library provides a means for users to connect
to a LogLogic LMI appliance and send logs to it.

Overview

The ULDP protocol is designed to send log data in a reliable and secure manner from their
collection point to a LoglLogic LMI appliance. TIBCO LoglLogic® Universal Collector uses this
protocol to communicate with a LoglLogic LMI appliance.

Using the ULDP library, you can:
e Send data in raw mode.
e Send encrypted and compressed data.
» Tag files that are sent to LoglLogic LMI to allow properly identifying the log source.
» Send log files in such a way that the time stamps are parsed.

The ULDP library is provided in the ULDPClient directory of the LogLogic LMI supplemental
package. For more information, see the README. txt file in the same directory.

How Messages are Transmitted

When messages are sent, they are placed in a queue, waiting for their acknowledgements
to arrive. If at some point the size of the queue is more than the maximum value
(MaxQueueSize), a mandatory request for acknowledgment is sent and no further messages
are sent until the acknowledgement is received, thereby effectively blocking the
sendMessage call.

The sequence of calls is:

1. Create a UldpConnectionSettings object and set its properties. At minimum, the
destination host should be set.

2. Create a UldpSender object, passing the UldpConnectionSettings as a parameter.
3. Call the connect () method on the UldpSender object.

4. For each log message element to be sent, perform the following steps:
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a. Create a UldpLogMessage object.

b. Call the sendMessage() method of the UldpSender object, passing it the
UldpLogMessage Object.

c. Optionally, call the flush() method if nothing is ready to be sent.

5. Call the close() method of the UldpSender object when desired.

If the close() method raises the exception PendingAckMessageException, which
means some messages have not been acknowledged by the LoglLogic LMI appliance,
and are possibly not received properly. Upon the next call to connect, those events is
sent again, possibly ending up with duplicates, but avoiding any message loss.

Note: This library is not thread-safe. If multiple threads need to send messages
through sendMessage () calls, the calls should be synchronized, for example by
using:

synchronized(sender) {
sender.sendMessage(...)

}

Connection Parameters

The connection properties are hosted in the UldpConnectionSettings object. They follow
the typical get/set method naming of Java Beans.

Name Type Defaul Description
t
Value

Host String  localh  Part of the constructor
ost

Port Intege 5515if Part of the constructor
r secure;

5516 if
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Name

MaxQueueSize

UseCompression

UseTls

UseEncryption

KeystorePath

KeystorePassword

TIlsProtocolName

CipherName

Type

Intege

Boole
an

Boole
an

Boole

an

String

String

String

String

Defaul
t
Value

not
secure

51200
(50kB)

false

false

true

N/A

N/A

TLSv1.

N/A

Description

The size of the queue of non-acknowledged
message to retain.

The value 0 indicates not retaining messages
after they are sent.

If true, messages are compressed. Better
compression is achieved by sending event in
batches, by calling flush() after the end of the
batch.

If true, initiates a TLS connection.

Implies that UseAuthentication is true. A
ciphering algorithm should be used.

Sets the keystore to be used to find an anchor
of trust and a client certificate, if needed.

The password to be used to access the keystore
and the private keys within it.

The version of the TLS protocol to use.

Name of the stack of crypto protocols to be
used:

e TLS_RSA_WITH_AES_128_CBC_SHA: If
encryption is on

e SSL_RSA_WITH_NULL_SHA: If encryption
is off
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Name

NoServerAuthentication

DomainName
ignoreHostnameValidati

on

addAcceptedCertificateF
ingerprints

Type

Boole
an

String
Boole

an

String

Defaul
t
Value

false

N/A

true

N/A

Description

Note: Although encryption is off, a cipher
suite is used for authentication. This might
cause problems with Java 1.8.0_u201 or
later, because null cipher suites are disabled
by default.

Accept any server certificate. Recommended
only for testing purposes, such as when there is
no threat of a man-in-the-middle (MITM) attack.

Sets the domain name

When true, the certificate subject is not
validated against the host name or IP address
used for connection.

Lists the fingerprints of the accepted
certificates, separated by ','. An ASCII label
identifying the hash function followed by a
colon are concatenated at the beginning of the
fingerprint.

Important: Implementations must support
SHA-1 as the hash algorithm and use the
ASCII label "sha-1" to identify the SHA-1
algorithm.

The length of an SHA-1 hash is 20 bytes and
the length of the corresponding fingerprint
string is 65 characters. An example certificate
fingerprint is: sha-
1:E1:2D:53:2B:7C:6B:8A:29:A2:76:C8:64:36:
0B:08:4B:7A:F1:9E:9D
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ULDP Log Types

ULDP defines several log types, each suited for distinct collection technologies and
products.

Irrespective of its type, each log message contains at least:
e A timestamp

e A source address (InetAddress)
ULDP log types are:

Syslog Message
This is implemented by the UldpSyslogMessage class.
The only specific property is the log message itself.

For the products supported by LoglLogic LMI and collected through Syslog, the source
type is automatically identified, similar to when logs are transmitted using Syslog to the
LogLogic LMI appliance.

Realtime LogFile Message

This is implemented by the UldpFileTailMessage class. This type is used for sending
files line by line, as they are written into the file. Each line should have its own message.

Two properties must be defined: the content of the line itself and an appName
(application name). LogLogic LMI uses the appName field to identify the source type.
LoglLogic LMI recognizes the following values for this field:

Value of appName Description

AMXAdmin TIBCO ActiveMatrix” Administrator
Business Works TIBCO BusinessWorks™

HawkAgent TIBCO Operational Intelligence Hawk®
TIBCO TIBCO Generic

TIBCO ADMIN TIBCO Administrator™
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Value of appName Description
TIBCO AMX BPM TIBCO ActiveMatrix” BPM
TIBCO APIX TIBCO® AP Exchange

TIBCO ActiveSpaces TIBCO ActiveSpaces®
TIBCO BE TIBCO BusinessEvents’ Server
TIBCO EMS TIBCO Enterprise Message Service™ Server

TIBCO SILVER FABRIC  TIBCO Silver® Fabric

Even for unknown products, using this parameter enables easily retrieving different logs
belonging to the same application because this value is part of the message that
LogLogic LMI ingests.

FileChunk Message

A sequence of file chunk messages to send the content of a file in raw form. The eof
attribute of the last file chunk must be set to true. A file identifier must be provided,
which reflects both the location of the file and its content. If several overlapping chunks
with the same fileIdentifier are sent, the last ones are ignored. If a file at the same
location has different content than before, the file identifier should be changed. One
way to achieve this is to create a compound file identifier with <file
path>:<checksum>. Using this type of message is the only way to send logs in which the
dates are extracted from the log message and are not assumed to be the current date,
as is the case with other ULDP messages. This mechanism is similar to the file-pull
mechanism in LogLogic LMI. The maximum size of a file chunk is 50 KB.

The following table lists the file format of supported file devices, when files are to be
collected via LoglLogic Universal Collector or via the ULDP library when sent over ULDP.

File format of supported file devices

FormatType Name

0 Cisco ACS Failed Attempts
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FormatType Name

1 Cisco ACS Passed Authentication
2 Cisco ACS RADIUS Accounting

3 Cisco ACS TACACS+ Accounting
4 Cisco ACS Administration Audit
6 Microsoft IAS

7 Microsoft ISA Web (W3C)

9 Generic W3C

10 Others

11 W3C (NetCache)

12 W3C (BlueCoat)

13 Squid Native

14 MS Exchange 2003 Tracking Log
15 MS Exchange 2000 Tracking Log
16 MS Exchange 2003 SMTP (W3C)
17 MS Exchange 2000 SMTP (W3C)
18 Oracle Audit Log

19 Oracle DB Log

21 Oracle Listener Log
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Sample Tools

Some tools are provided with LogLogic LMI as examples of how to use the ULDP library.

The sample tools do not intend to be production-ready pieces of software, but they
demonstrate how to create the various message types and send them through a ULDP
connection.

The source files are located in the ULDPClient/examples directory in the supplemental
package of LoglLogic LMI. The only dependency to run the Java classes is the ULDP-client
library. For further information on how to use these commands and a list of options, see
the source code.

The following sample tools can be used to send log files via a ULDP connection:

SendSyslogFileUldp

This tool sends the content of log files, optionally parsing the lines to extract the date
and origin of the log, if they are formatted according to the syslog standard.

TailUldp

This tool sends the content of files line by line as they are appended at the end, similar
to a UNIX tail command.

SendFileUldp

This tool sends entire files in a mechanism compatible with the file pulling features of
LogLogic LMI.

Setting Up a Secure Connection With ULDP

To set up proper encryption with ULDP, you need to provide the APl with a keystore at
startup. The keystore contains the certificate and private key for authenticating with
LoglLogic LMI, and also an anchor of trust or certification authority (CA) to authenticate the
server, unless you have chosen the noServerAuthentication option.

You can use the PKI of your choice to generate the keystore and its certificate. For testing
purposes, the following procedure creates a minimal PKI. For actual implementation, refer
to the documentation of the certificates that you use.

Procedure
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1. Create a keystore that contains a new CA, for example: CA.ks.

keytool -genkeypair -alias CA -keyalg RSA -sigalg SHA256withRSA -
storetype JKS -keystore CA.ks

2. Export the root certificate into a file.

keytool -exportcert -alias CA -keystore CA.ks -rfc -file CA.cert

3. Create a keystore for the ULDP client API.

keytool -genkeypair -alias ULDP_client -keyalg RSA -sigalg
SHA256withRSA -storetype JKS -keystore client.ks -dname "CN=clientIP
address"

Note: The value of dname can be arbitrary and no validation is performed
in LogLogic LMI. It is best practice to use an IP address that identifies the
client.

4. Import the CA certificate into the client keystore.

keytool -importcert -alias CA -keystore client.ks -file CA.cert

5. Create a CSR from the client keystore.

keytool -certreq -rfc -alias ULDP_client -keystore client.ks -file
ULDP_client.csr

6. Sign the CSR with the CA.

keytool -gencert -infile ULDP_client.csr -alias CA -keystore CA.ks
-validity 365 -outfile ULDP_client.cert -rfc

You can choose the validity arbitrarily. Ensure that the date on the host system is
correct in order to produce a valid certificate.

~

Import the certificate in the client keystore.
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10.

11.

12.

13.

keytool -importcert -file ULDP_client.cert -keystore client.ks -
alias ULDP_client

The client keystore for the ULDP library is now ready. Repeat steps 3-7 to create
additional keystores for other clients, if needed.

Generate a CSR from the LoglLogic LMI certificate.

system secureuldp create csr

Then copy and paste the contents of the certificate signing request into a file on the
local machine, for example, lmi.csr.

Sign the Loglogic LMI CSR.

keytool -gencert -alias CA -infile lmi.csr -outfile lmi.cert -
validity 365 -keystore CA.ks -rfc

Import the CA root certificate into LoglLogic LMI.

system secureuldp install rootCA

Then copy and paste the contents of CA.cert into the terminal.

Import the Loglogic LMI certificate.

system secureuldp install certificate

When calling the ULDP API, use the following methods on the
UldpConnectionSettings object:

setUseAuthentication();
.setKeystorePath ("location of client.ks") ;
.setKeystorePassword ("keystore password") ;

On the LoglLogic LMI GUI, navigate to Home > Administration > System Settings,
and:

a. Select Enable Secure ULDP to enable secure ULDP on the appliance.

b. Click Update.
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Syslog Host Field Character Sets

A list of the acceptable characters in an ASCII syslog header.

Character Description Example

Alpha chars, upper or lower case  A-Z and a-z

Numbers 0-9

Punctuation at sign @
underscore _
period
backslash \
colon
asterisk *
brackets []
parentheses ()
plus sign +
minus -

space

tab
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Exceptions

Some exceptions occur for ASCII syslog headers.

The following exceptions are noted for ASCII syslog headers:

e Some Unix/Linux syslog messages have a path in the process name. That is taken
care of by looking for a leading backslash (/) and any number of the following

characters:

o Alpha characters, upper or lower case
B AZ
B a-z

° The numbers 0-9

° Punctuation including:
® ynderscore _
® period .
® dash -

» The use of space and tab depends on the log source. Some log sources have spaces
at the point right before the log source target string is found. Others have only a tab.

Specifically:

° Windows messages require a space before the target string

° Cisco VPN3000 requires a tab
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Supported Regular Expression Characters

Advanced Search and data models in LogLogic LMI support the following regular
expression meta characters, based on Java regular expressions:

Characters

\a

\d

\D

\e

\f

\n

\r

\s

\S

\t

\w

\W

\xHH

\Q

Description

Matches ASCII character code 0x07.

Matches character in the set "0123456789".

Matches any byte not in the set "0123456789".

The escape character. Matches ASCII character code 0x1b.

The form-feed character. Matches ASCII character code 0xOc.

The new line (line feed) character. Matches ASCII character code 0x0a.
The carriage return character. Matches ASCII character code 0x0d.
A white space. Matches white space - \t \n 0x0b \f or \r.

A non-white space. Matches any byte not in \s.

The tab character. Matches any byte not in 0x09.

A word character. Matches any ASCII character in the set underscore, digits,
or upper or lower case letter.

A non-word character. Matches any bytes not in \w.

Matches a byte specified by the hex code HH. There must be exactly two
characters after the \x.

Starts a quoted region. All meta characters lose their meaning until \E. A \\
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Characters

\anything else

\k<name>

{num} or
{num:num}

() (%)

(?<name>)

anything else

Description

can be used to put a backlash into the region.

Matches the next character.

Refers to previous named capture.

Specifies a character class - match anything inside the brackets. A leading *
negates the sense of the class - match anything not inside the brackets.
Negated character classes are computed from the set of code in the range 0-
127 - in other words no bytes with the high bit set. Within a character class
the following backslash characters mean the same thing as outside the

character class: \a, \d, \D, \e, \f, \n, \r, \s, \S, \t, \w, \W, and \xHH.

Specifies a repetition count for the previous regular expression. Num must be
less than 16. {num} is equivalent to {0:num}.

Matches any byte: 0x00 - OxFF.

Specifies that the previous regular expression is repeated 1 or more times.
Specifies that the previous regular expression is repeated zero or more times.
Specifies capturing or non-capturing groups.

Specifies capturing named groups.

Specifies alternation.

Specifies that the previous regular expression is repeated zero or one time.

Any other character matches itself.
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Supported Data Types

This section provides a list of data types used in LogLogic LMI data models.

Standard data typesThe following standard data types are used in LogLogic LMI data models.

Data type Description

Float Stores double-precision floating-point numbers with up to 17 significant
digits

String Stores text, spaces, and numbers

Int Stores integers

Long Stores large integers

Boolean Stores true or false

Timestamp Stores both date and time

Inet_addr Stores IP addresses in binary format

Data types created in LogLogic LMIThe following data types have been created for use in LoglLogic
LMI data models.

Data Type Description Examples

Duration Displays time in a human-readable format on e 1Y2M3W4D5h6m7s8ms
the GUI for time values that are stored in

e 1ly4d5m
milliseconds (ms) as a Long data type. y

0 values are omitted while
displaying time in the Duration
format.
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Search Syntax Reference

LoglLogic Advanced Search query language is intuitive and efficient, you can search large
data and view results in seconds.

The search query supports the following types of languages:
» Event Query Language (EQL)
e Structured Query Language (SQL) dialect.
» Event Correlation Language (ECL)

Both EQL and SQL are equally capable for searching, but the syntaxes are different in some
cases. For example, simply providing a string in EQL is understood as a full text search, but
it gives a syntax error in SQL. So the translation is not always literal. EQL is easy to use,
however, SQL is more familiar and it is to write SQL using existing SQL tools.

Using EQL, you can define filters, regular expressions, sources, time ranges. ECL can be
used to find patterns in a given set of data and for correlation purposes.

Event Query Language Reference

The search query supports the query languages: EQL and the LoglLogic LMI SQL dialect.

The EQL query is composed of different parts separated by pipe (| ) character. The pipe
delimiter is used to separate the expression and each subsequent expression. Each pipe-
delimited expression further processes search results from the preceding expression. For
more structured queries, a subset of SQL is supported that is mainly focused on the
SELECT statement. Both languages are supported in LoglLogic LMI, but you cannot use a
mix of both languages in the same query. All that is available in EQL can be achieved via
SQL and vice versa except the following differences:

» EQL supports the full text search statement, but SQL does not support this
statement. For details, see FILTER Statement.

e Multiple EQL filter expression statements, separated by a pipe, get automatically
combined using the AND operator into a single filter expression. SQL does not
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support this feature.

The EQL and SQL language rules are based on a Backus-Naur Form (BNF)-like notation as
follows:

<symbol> ::= <expression> ;

where:

Non-terminal symbols in syntax rules have angle brackets (< >). For example, in the

rule <expression> ::= <expression> "+" <integer>; the <expression> is a non-terminal

symbol and the rule specifies that as an expression is the addition of any number of
integers.

Terminal symbols are shown in double quotes (" "). For example, the "+" in the
previous example.

As an additional shortcut notation to BNF, optional symbols (that can occur zero or
one times) are followed by a question mark (?). For example, in the rule
<colNameForSort> ::= <colname> (ASC| DESC)?; a column name used for sort is a
column name optionally followed by the keywords ASC or DESC.

Optional symbols that can occur zero or any number of times are followed by an

asterisk (*). For example, in the rule <itemList> ::= <item> ("," <item>)*; an itemList
can contain one or more comma-separated items.

Multiple symbols are grouped together using parenthesis () when some common
operation is applied, for example, the selection of one member of the group, or to
indicate that the entire group can be repeated zero or more times. An example is
shown in the previous bullet item.

Words that are all capitalized represent keywords (special terminal symbols). For
example, the keywords ASC and DESC in the column name for sort described in the
previous example.

All parts of the query are optional, but overall the syntax is:

<EQL_statement> ::= <statement> ("|" <statement> )x* ;
<statement> ::= <useStatement> | <filterStatement> | <groupByStatement>

<columnsStatement> | <sortStatement> | <limitStatement>;
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String literals and identifiers (including keyspace, column family names, and data model
names) are case sensitive but all EQL keywords are not case sensitive. For example, 'USE
Windows' and 'use Windows' are treated in the same way.

String literal can be quoted with single (') or double (") quotation marks. The quotation
marks (single or double) inside the string literal has to be prefixed with backslash ()
character. The \ character change to be prefixed with another backslash (\\ ). For example,

"Mike's car" or 'Mike\'s car".

A special syntax for time range can be used. For details, see Time Range Expressions.

Note: In this syntax reference topic, EQL keywords are mentioned in upper case

letters for easy readability.

Examples

Expression

sys_sourceType = 65536 and sys_
eventTime in -5d | columns sys_
eventTime, sys_collectIP, 11_
eventStatus

USE Microsoft_Windows | 11_
eventAction ='A user account was
enabled.' | sys_eventTime IN -1h

Definition

Events from source type '65536' in last 5
days, display result as a table with columns
sys_eventTime, sys_collectIP, and ll_
eventStatus

Using the data model Microsoft Windows,
display results of all events where a user
account was enabled during the past hour.

Common Search Commands

The search commands that LoglLogic EQL uses.

command Definition

USE Defines the data models, which include the parsing
configuration. For details, see USE Statement.
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command Definition

COLUMNS Defines which columns should appear in search results.
For details, see COLUMNS Statement.

GROUP BY Groups search results based on specified columns. For
details, see GROUP BY Statement.

SORT BY Sorts search results based on the expression. For
details, see Time Range Expressions.

LIMIT Limits the size of search results to be displayed. For
details, see LIMIT Statement.

FILTER For detailed information about filters, see FILTER
Statement.

USE Statement

The USE statement defines which data models to query.

A data model is a way to view a set of events, including columns parsed off the event body.
The data model defines which events to parse, how to parse them, and what columns to
extract in order to execute this query.

The USE statement is an optional parameter, but it is a good practice to improve

performance by reducing the set of event sources and set of parsers used.
<useStatement> ::= "USE" <identifier> ( "," <identifier> )x* ;

The USE statement consists of the USE keyword followed by one or many data model
names separated by commas. An <identifier> is a letter followed by any sequence of
letters, digits, or an underscore (_).
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o Note: If you do not specify any data model in the Search field, the results are
retrieved in the following order:

1. All enabled built-in data model configurations

2. All enabled data models that are not LoglLogic LMI-specific but have source
filters defined

3. The system data model

The user-defined data models without the source filter are not included in the
search query. For the list of built-in data models, see the Supported Log Sources
list in the TIBCO LogLogic® Log Source Packagesinstallation and Upgrade, which
is available on the TIBCO eDelivery website or TIBCO Support website after
logging in. For more information about data models, see Data Models.

Certain data model expressions refer to a source of infrastructure data. This is defined by
the corresponding data model itself and is typically defined by the name. The currently
defined infrastructure data models are: LoglLogic_Config_Bloks and LoglLogic_Config_
Models that represents the set of currently-defined Bloks and Data Model records

respectively. For example, use LoglLogic_Config_Bloks | COLUMNS name, origin,
created, type, description, value

Do not use infrastructure queries within regular search queries. Infrastructure data model
expression and an event data model expression are not allowed in the same query. An
example of invalid mixed query is: use LoglLogic_Config_Bloks, system.

Examples

Data Model Definition
Expression

use Windows  The result displays all events from Windows sources.

use Windows, The result displays all events from Windows and Cisco
Cisco log sources.
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FILTER Statement

A filter is an expression that specifies the conditions that events must satisfy to be returned
by this query.

The filter criteria can be in form of free text search of the entire body or value of a
particular preparsed or parsed column.

Tip: The system (event metadata) columns are indexed so searching is faster on
the system columns.

The list of available columns is determined by list of event sources. In case the list of event
sources are not available, the system does the best to extract those columns using
heuristics algorithms. For queries, the filter should contain a time condition, otherwise the
default is used.

Note: When defining column names in a search query, follow the guidelines
described in the COLUMNS Statement section.

A filter statement is any expression that evaluates to a result of type Boolean. Any event
that does not satisfy this condition is eliminated from the results. An event that satisfies
the condition if it returns true when the actual event values are substituted for any variable
references.

The following table explains the types of filter statements that can be used.

Types of FILTER statements
Operator Description
AND Narrows your search results by only returning those events where each
one of the AND conditions evaluates to true.

For example, use AND to return results containing all specified keywords.
When AND is used, the results contain all specified keywords and do not
contain entries with just one of the specified keywords.

OR Expands your search results by returning events where either of the OR
conditions evaluates to true.

TIBCO Loglogic® Log Management Intelligence User Guide



457 | Search Syntax Reference

Operator

Full text search

Equals (=),

Not equals (<> ),

(1=),

Natural equal to

(==),

Natural not
equal to (I==)

Lower than (<),

Lower or equal

(<=),
Greater than (>),

Greater or equal

(>=)

Description

For example, use OR to return results containing any and all specified
keywords. OR is ideal when you have common synonyms for a keyword.
To narrow results as much as possible, combine OR statements with AND
statements.

Full text search on the body of each event can be performed by simply
providing the phrase that needs to be enclosed in double quotes. For
example, use system | "authentication failed" to retrieve all events that
contain the phrase.

The EQL full text search (specifically on sys_body) is exactly the same as
the CONTAINS statement on the sys_body (so "use system | '‘Bob' is
exactly the same as "select * from system where sys_body CONTAINS
lBoblﬂ)'

A comparison condition compares two expressions using the operator
specified in the comparison, which might be one of seven possible
comparison operators with well-known meanings, and two more with
special meanings. The comparison condition evaluates to true only if the
comparison condition is satisfied. This can be used to narrow search
results. These operators are case sensitive. For example, coll > col2/100.

Most of the operators behave as expected in SQL. If one or both values
being compared is NULL, the result is NULL, otherwise the comparison is
performed. However, the special operators == (natural equal to) and !==
(natural not equal to) always return either true or false. If either value
being compared is NULL, "natural equal to" returns false. If both values
being compared are NULL, "natural equal to" returns true. If neither value
being compared is NULL, the comparison is performed as expected.
"Natural not equal to" returns the negation of "natural equal to".

The operators == and !== can also be specified in functional form as
NaturalEqualTo(vall, val2) and NaturalNotEqualTo(vall, val2).

Note: If the field type is string, the comparison operators less than (<)
and greater than (>) compare the data lexicographically (as strings)
even if the data is numerical. For example, if the field type is string, 21’
is considered less than ’3’.
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Operator

Plus (+),
Minus (-),

Multiply (asterisk
(),

Divide (forward
slash (/),

String
concatenation

(11

Function

BETWEEN

Description

The arithmetic (+, -, *, /) and string concatenation (||) operators can be
used to create parts of other conditions.

For example, "columnl + column2 < 5" or "col3 x 4 - 1000 > col5"

The order of evaluation of the operators in an expression is according to
the following precedence rules, from highest to lowest, with the highest
precedence implying earlier evaluation:

e Functions

e Multiplication and division: both have equal priority and the
evaluation order is from left to right

Addition and subtraction: both have equal priority and the
evaluation order is also from left to right

String concatenation

Comparators (>, < and so on)

For example, if you have an expression of the form "coll > col2 +
col3*col4", then col3*col4 is evaluated first, and then the result is
added to col2. The coll is then compared against the final result to
see if it is greater.

You can use a floating point number with the divide operator (/), to
obtain a floating point number as the result. For example, <Number>
/ 1024.0.

A set of predefined functions. For details, see Predefined EQL Functions.
They can be used in filter, column expressions, or as part of Data Model
expressions.

Note: The parameters of the functions can be expressions themselves
and is evaluated before the function is called.

For example, "ToInt(coll + col2)" adds the contents of the columns of
the event named col1 and col2, and pass the result to the ToInt function

and the result of the function is used.

Narrows your search results by only selecting those events where the left
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Operator

IN, NOT IN

IS NULL, IS NOT
NULL

LIKE, NOT LIKE

Description

hand side expression evaluates to a value that is between the two right
hand side target expressions.

Supports Timestamps, Long, and Integers.

For time range syntax details, see Time Range Expressions.

Narrows your search results. This is case sensitive.
Checks whether the value matches any one of the values in a set or not.
For example:

e '"eventID IN ('did1', 'did2', 'did3')"

e 1ll_eventID NOT IN ("6279","4749")

Supports all data types. For time range syntax details, see Time Range
Expressions.

Narrows your search results by accepting or rejecting the event based on
whether the evaluated expression is null or not null. An expression most
frequently becomes null if a column named in the expression has no value
for the current event.

Supports all data types.

Expands your search results. Returns true if it matches the supplied
pattern. This is case sensitive. The following rules are used to interpret the
supplied string.

» The character percent (%) is the wildcard character (matches zero or
more characters).

» The character underscore (_) means that it matches exactly one
character.

» The backslash character (\) is used to escape itself and the two
characters mentioned earlier, if a literal search for any is desired.
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Operator

CONTAINS, NOT
CONTAINS

Description

Note: Since string literals in EQL and SQL require backslashes (\) to be
escaped, note that additionally escaping for the LIKE statement
doubles the escaping requirement. The simple rule to follow is to
construct the match string using the rules stated earlier, then simply
double up each backslash.

The following examples show the actual syntax (not the escaping needed
for Java):

coll LIKE "a_b" - produces a match for "acb", "adb" and so on

coll LIKE "a\\_b" - produces a match for "a_b" but not "acb".
Note the double backslashes.

coll LIKE "a\\\\_b" - produces a match for "a\cb" and "a\db"

coll LIKE "a%b" - produces a match for "ab", "ach", "accb" and so
on

coll LIKE "a\\%b" - produces a match for "a %b" but not "acbh"

Expands your search results. Returns true when at least a part of the string
matches the supplied pattern. This is not case sensitive. The sys_body
column is special, because the supplied pattern is used to do a full text
search on the event body. For all other columns, the following rules are
used to interpret the supplied string.

The character asterisk (*) is the wildcard character (matches zero or
more characters).

» The character question mark (?) means that it matches exactly one

character.

» The backslash character (\) is used to escape itself and the two

characters mentioned earlier, if a literal search for any is desired.

The CONTAINS statement for columns starting with sys_ uses a full text
search.
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Operator

REGEXP, NOT
REGEXP

DISTINCT

Description

Note: Since string literals in EQL and SQL require backslashes (\) to be
escaped, note that additionally escaping for the CONTAINS statement
doubles the escaping requirement. The simple rule to follow is to
construct the match string using the rules mentioned earlier, then
simply double up each backslash.

The following examples show the actual syntax (not the escaping needed
for Java):

e coll CONTAINS "a?b" - produces a match for "ccc acb jjj", "adb"
and so on

e coll CONTAINS "a\\?b" - produces a match for "a?b" but not
"ach". Note the double backslashes.

e coll CONTAINS "a\\\\?b" - produces a match for "a\cb" and
lla\dbll

e coll CONTAINS "axb" - produces a match for "ab", "acbh", "acch"
and so on

e coll CONTAINS "a\\xb" - produces a match for "a*b" but not "acb"

Narrows your search results. By default, this is case sensitive but can be
changed in the regular expression using the embedded flag (?i).

Returns true if it matches the supplied pattern. The pattern syntax uses
POSIX syntax. Since string literals in EQL/SQL require backslashes (\) to be
escaped, note that all the backslashes inside a regular expression pattern
must be doubled up, similar to the LIKE statement.

Examples:

e coll REGEXP "[a-z]b" - produces a match for "ab", "cb" but not
llAblI Or l|_b|l

e coll REGEXP "\\wx" - produces a match for a word, for example
"this" or "that", but not "this and that"

Fetches only the distinct values from data. The DISTINCT statement can be
used in all advanced search queries.
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Operator Description

If your search query includes a DISTINCT clause and the data includes
multiple records with NULL values, all NULL values are included as distinct
values in the search result. For example:

USE TIBCO_Hawk_Agent | COLUMNS DISTINCT 11_
collectHostName, 11_sensorName

In this example, 11_collectHostName and 11_sensorName can have NULL
values.

As a workaround, add the IS NOT NULL clause for all DISTINCT projections
in the query. However, all results with NULL values are excluded from the
search result.

USE TIBCO_Hawk_Agent | COLUMNS DISTINCT 11_
collectHostName, 1l1l_sensorName | 11_collectHostName IS NOT
NULL AND 11_sensorName IS NOT NULL

Examples
Filter Expression Definition
"Authentication" and sys_eventTime in -  The result displays all events that contain
ly Authentication from the last one year.

The result displays all events that contain
use sample | ‘ . .
1l_sourceUser = 'SiteSvrAdmin' | column 'll_sourceUser' and value is
sy;_event'ﬁme in '2014-02-02" 'SiteSvrAdmin' on the 2 February 2014.

Predefined EQL Functions

A list of functions that are available in the EQL.
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e Conversion functions

e String Functions

e Comparison Functions
e Math Functions

e Conditional Functions

e Time functions

e Miscellaneous Functions

The conversion functions are typically used when adding a new data model, or when you
need to define new columns, where the expressions for new columns can use conversion
functions to convert between data types and combine them using various operators. For
instructions on how to add a new data model, see Creating a Data Model in Graphical
Mode.

Conversion functions

Conversion functions

Function Name Arguments Returns
ToTimestamp e (expression, The expression, which should evaluate to a
formatString) string, is interpreted as a time according to

the supplied formatString. If the
conversion fails, null is returned, unless a
default string is provided, which is
interpreted as a time and returned.

* (expression,
formatString,
timezone)

» (expression,
formatString,
timezone,

Example: ToTimestamp(
logFileStringTimestampField, '"dd, MM,
yyyy HH:mm:ss", "America/ Los_
defaultvalue) Angeles", "01, 01, 1970 00:00:00")

Note: If timezone is omitted or is empty,
the system default timezone is used.

If formatString does not contain a year,
then when the function is being evaluated
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Function Name

TolP

ToTimestampString

Tolnt

TolLong

ToString

Arguments

(expression)

(expression,
defaultValue)

(expression,
formatString)

(expression,
formatString,
timezone)

(expression,
formatString,
timezone,
defaultValue)

(expression)

(expression,
defaultValue)

(expression)

(expression,
defaultValue)

(expression)

Returns

in the context of processing an event, the
year from the event time (sys_eventTime) is
used. If this results in a timestamp that is
later than the event time, the prior year is
used.

Converts the expression to an IP address
(Java InetAddress). If the conversion fails,
returns null; but if a default string is
provided, it is interpreted as an IP address
and returned.

Example: ToIP(ipAddressField,
"10.0.0.1")

Same as ToTimestamp, except that the
expression is converted to string to get a
printable timestamp.

Example: ToTimestampString(timestamp ,
"dd, MM, yyyy HH:mm:ss'", "Amerdica/Los_
Angeles", "01, 01, 1970 00:00:00")

Note: If timezone is omitted or is empty,
the system default timezone is used.

Returns the integer value of the expression;
or the default value if not convertible.

Example: ToInt("1348") or ToInt
(numberField, 0)

The obvious conversion to Long with
default value taken if not convertible.

Example: ToLong("1348") or Tolong
(numberField, 0)

Returns the string string value of the
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Function Name Arguments Returns

» (expression, expression; or the default value if not

defaultValue)

convertible.

Example: ToString(124.5) or ToString
(numberField, "null")

ToFloat (expression) Returns the Float value of the expression; or
. the default value if not convertible.
(expression,
defaultValue) Example: ToFloat("1348.2") or Tolong
(numberField, 0.0)
Note: LoglLogic LMI uses double precision
(that is 64 bits) when storing floating point
numbers.
ToBool (expression) Returns the Boolean value of the
. expression; or the default value if not
(expression, bl
defaultValue) convertible.
Example: ToBool ("FALSE") or ToBool
(coll, FALSE)
ExtractJson (expression, The expression, which is a JSON string is
extraction path) parsed. A field is extracted from the
. expression using the extraction path. If
(expression, . ) . .
. either the expression or the path are invalid,
extraction path, ) .
an optional default value is returned.
default value)
Example: ExtractJson("{"cat":
{"color":" blue"}}", "cat.color",
"burlesque") returns a string "blue" which
is a JSON value of color, which is a JSON
value of cat.
ExtractKvp (expression, The expression, which is a nested KVP string

extraction path)

(expression,
extraction path,

is parsed. A field is extracted from the
expression using the extraction path. If
either the expression or the path are invalid,
an optional default value is returned.
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Function Name Arguments Returns
nested KVP Example: ExtractKvp(" alert={ agent={
delimiters hostname=esbqa®l, dns=none}}" ,
/default "{}"/) "alert.agent.dns") returns a string
"none".

» (expression,
extraction path, or
nested KVP,
deliiter / default
""/)

e (expression,
extraction path,
nested KVP,
delimiter,
separator
/default "="/)

ExtractKvp(" (abc*rdef|asd?raaa)" ,
"an", ||()||’ |||||’ Il/\ll) returns "aaa".

e (expression,
extraction path,
nested KVP,
delimiter,
separator,
escape
character /
default "\\"/)

* (expression,
extraction path,
nested KVP,
delimiter,
separator,
escape
character,
default value)

String Functions

The smart list functions are usually used in filter expressions and data model.
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Function Name Arguments Returns

lookup (string 1, string 2, [string 3])  Returns the value associated with
string2 in the Enrichment list named
stringl.
Examples:

lookup ("listl", "keyl")
lookup ("listl", "keyl",
"default_return_value"
$listl("keyl")
$listl("keyl", "default_
return_value')

length (expression) Returns the length of the string value
of the evaluated expression. For
example, if an expression is an integer,
it is converted to a string first.

Example: length("abc") is 3, length
(3145) is 4 (after converting the
integer 3145 to the string "3145")

TransformString e (stringToTransform, The function tries to match the
regularExpression, stringToTransform string with the
template) regular expression, and then returns

the template with references to groups
in the regular expression substituted
with the actual values. To refer to
groups, use $1, $2, so on, to refer to
numbered groups, and $<name> to
refer to named groups. If the string
does not match, or is there any other
error, the default value is returned (or
NULL if not specified).

e (stringToTransform,
regularExpression,
template,
defaultValue)

Example:
TransformString("myName=Tloglogic"
, ""myName=(\\S*)", "the name is

$1")
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Function Name

lower

upper

trim

substitute

left
right

e mid
e substr

e substring

position

concatenate

find

Arguments

(string)
(string)

(string)

(stringl, string2, string3)

(string, Int) <int>
(string, Int) <int>

(string, Int 1, Int 2)

(string 1, string 2)

(string 1, string 2, ...)

(stringl, string2, index )

Returns

returns: "the name is loglogic".
Returns the lower case of the string
Returns the upper case of the string

Returns the trimmed string (without
leading and trailing spaces).

Substitutes string2 by string3 in
stringl.

Returns the left characters of string.
Returns the right characters of string.

Returns the characters from string
starting at offset int1 for a length of
int2.

Returns the index of the first
occurrence of string2 within stringi;
-1 if no occurrence is found.

Returns the concatenation of all strings
passed as arguments.

Returns the position (from the
beginning of stringl) of the first
occurrence of string2 within stringi;
and -1 if no occurrence is found.

Searching starts beyond the position
specified by index.

Example:
find("Here Here", "e", 3 )
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Function Name Arguments Returns
returns 6
findlast (stringl, string2, index ) Returns the position (from the

beginning of stringl) of the last
occurrence of string2 within stringi;
and -1 if no occurrence is found.

Searching starts beyond the position
specified by index.

Example:
findlast("Here Here", "e" )

returns 8

findnth (stringl, string2, n, index ) Returns the position (from the
beginning of stringl) of the 'n'th
occurrence of string2 within stringi;
and -1 if no occurrence is found.

Searching starts beyond the position
specified by index.

Example:
findnth("Here Here", "r", 3, 2 )

returns -1
¢ substituteall (source, regex_pattern, e Returns the new string after
replacement_string) replacing the pattern in the

e substitutefirst ) ;
source string with the

replacement string.

e Returns the original string if the
pattern is invalid or not found.

Examples:

o substituteall(' (4)john
(3)hot(6)doggie(3)com',
T(\dH)T, )
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Function Name Arguments Returns

returns
"!john!hot!doggie!com'
o substitutefirst( '

(4)john(3)hot(6)doggie
(3)com', '(\d+)', "!' )

returns '!john(3)hot
(6)doggie(3)com'

split (input_string, 'separator’, Returns the string at the specified
position_num) position, extracted from the original
string specified in input_string; and
an empty string if no occurrence is
found.

e separator can be any regex
pattern

e position_num starts at 0

e The function can be used within
EQL, SQL, and ECL queries for
advanced search queries,
aggregation rule queries,
correlation Blok definitions, and
column parsing rules of a data
model. However, the function
cannot be used in a GROUP BY
clause of aggregation rules.

For examples of these functions in SQL and EQL queries, see Search Examples.

Comparison Functions

Function Name Arguments Returns

NaturalEqualTo (argl, arg2) e True if argl equals arg2
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Function Name Arguments Returns

 False if argl is not equal to arg2

 False if only one of the arguments is
NULL

e True if both arguments are NULL

NaturalNotEqualTo (argl, arg2) e True if argl is not equal to arg2
e False if argl equals arg2

e True if only one of the arguments is
NULL

* False if both arguments are NULL

Math Functions

Function Arguments Returns
Name
Power base, exponent Returns the value of base raised to the power of

exponent. Any null argument returns null.

Round ¢ (numeric) Returns a FLOAT value of the numeric argument
rounded to the number of decimal places specified
by integer. The argument integer is optional, and
the default value is zero if not provided.

* (numeric, [integer])

The numeric value is rounded mid-way and away
from zero. A null argument returns null. If the
second argument is positive, it represents the
number of decimal places to the right of the
decimal point, whereas if it is negative, it
represents the number of places to the left of the
decimal point which become a zero.
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Function Arguments Returns
Name
For example:
Function Returns
ROUND( 12.345) 12.0
ROUND( 12.345, 2) 12.35
ROUND( 123.45,-1) 120.0
ROUND( 34567, -2 ) 34600
ROUND( -3456.5) -3457.0
Sqrt numeric Returns the square root of the argument or null if

the argument is null.

sum ¢ (<columnName>) Returns the sum of all values in the column
specified by <columnName>. If distinct is
specified, returns the sum of the distinct values in
the column.

e (distinct
<columnName>)

For example, if the column 'contentLength’
contains the values 2,3,4,5,5,6:

Function Returns
sum (contentLength) 25
sum (distinct contentLength) 20
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Conditional Functions

Function Arguments Returns

Name

IIF Condition, Returns the value of the 'then' clause if the condition is true,
then, else otherwise the value of the 'else' clause.

[{P ]

Example: IIF(true, “a”, “b”) returns “a” if true and “b” if
false

Time functions

The following time functions are available:

e seconds (timestamp, [multiplier])

e minutes (timestamp, [multiplier])

e hours (timestamp, [multiplier])

e days (timestamp, [multiplier])

e weeks (timestamp, [multiplier])

e months (timestamp, [multiplier])
 years (timestamp, [multiplier])

Each function returns the value of the specified timestamp parameter truncated to the
corresponding time unit (seconds, minutes, hours, and so on).

If the optional parameter multiplier is specified, then the function creates a time bucket
of the specified units and with the precision of the multiplier, and returns the truncated
timestamp at the start of the time interval specified by multiplier.

Example

Consider the following example:

seconds(sys_eventTime, 10)

This function creates a time bucket of 10 seconds, and returns the truncated timestamp
out of the specified sys_eventTime at the start of the 10-second interval. That is, if the
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value of sys_eventTime is "2020-06-26 10:57:24", then it truncates the value to "2020-06-26

10:57:20".

Miscellaneous Functions

Function Name

geoiplookup

By using this function within
SQL and EQL queries, you can
search logs that originated
from a particular geographical
area such as location,
country, city, postal code, and
so on. You can use the
function in Advanced Search
and Advanced Dashboards.

matchcidr

You can use the function
within SQL, EQL, and ECL

Arguments

e (IPaddress)

e (IPaddress, field_
option)

In the IPaddress
parameter, you can
specify an IP address or a
column that stores an IP
address such as Inet_
Address.

The field_option
parameter can be one of
the following values:

 location

e continent

e country

e city

e postal

e subdivision

e domain

e connectiontype
e asn

e (IP_string_format,

IP_address_to_
Match)
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Returns

Returns the geographical
information of a specified IPv4
or IPv6 address. Returns the
country name if the field_
option parameter is not
specified.

Note: To use this function,
the MaxMind database must
be available on your
appliance. If any errors are
displayed, contact your
administrator.

e Returns those IP

addresses from the IP_
address_to_Match

parameter, which belong
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Function Name

queries, and in turn, in other
functionality that make use of
these queries.

Arguments

e (IP_string_format,
IP_address_to_
Match, key)

e ( CIDR_expression,
extractIP(input_
column_name or
custom_input_
value) )

In the IP_string_format
parameter, you can
specify a CIDR address,
single IPv4 or IPv6
address, a comma-
separated list of CIDR IP
addresses or a range, a
hyphen-separated range
of IP addresses, or an
enrichment list.

In the IP_address_to_
Match parameter, specify
the column name from
the logs, which are to be
matched against the IP_
string_format
parameter. The data type
of the column must be
INET_ADDR.

The key parameter
specifies a key name in
the enrichment list. The
key parameter is
mandatory when using
this function in
correlation Bloks. You

must provide either a key

Returns

to the IP addresses
specified in the IP_
string_format list.

If you use extractIPs
within matchcidr, then
extractIPs extracts all

IP addresses from either a
column containing a list
of IP addresses or a list of
IP addresses. If any of the
IP addresses matches with
the CIDR_expression,
then matchcidr returns
true; otherwise false.
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Function Name

extractIPs

You can use the function
within SQL, EQL, and ECL
queries, and in turn, in the
matchcidr function.

Arguments

name or an empty string

("),

o for extractlPs: (list_

of_IP_addresses)

e within matchcidr:
(input_column) or
(custom_input_
value)

The input list of IP
addresses can contain
IPv4, IPv6, or IPv6
compressed addresses.

Returns

Returns a list of IP addresses as
a comma-separated string; or an
empty string if no IP addresses
are found within the input
string.

For examples of geoiplookup and matchcidr functions in SQL and EQL queries, see Search

Examples.

Time Range Expressions

The time range for IN operator understands both relative time and absolute time. Absolute
time is the same as in BETWEEN operator.

Relative time is defined as: <sign><number><unit>, for example: -5d means 5 days ago.

Note: All dates and times are defined in the local time zone of the machine
where the system is installed and it is not based on the browser time zone.

The following time units are available:

e s-second
e m - minute
e h-hour

e d-day
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w - week
M - month

g - quarter (3 months)

Yy - year

The supported timestamp formats are:

Any day of the week; for example, MON, TUE, WED, THU, FRI, SAT, SUN
NOW specifies up to the current time
Today specifies as the end of the day (23:59:59)

yyyy-MM-dd HH:mm:ss, {d yyyy-MM-dd HH:mm:ss}, {t yyyy-MM-dd HH:mm:ss}, or {ts
yyyy-

MM-dd HH:mm:ss}
MM/dd/yyyy HH:mm:ss

BETWEEN and IN support dates (yyyy-MM-dd or MM/dd/yyyy). The interpretation
depends on whether it is used as beginning or end of time period. When used in
beginning it is equivalent to yyyy-MM-dd 00:00:00; when used at the end - yyyy-MM-
dd 23:59:59.

Examples
Time Range Definition
Expression
-23h Last 23 hours.
For example, if the current time is 2014-10-20 08:00:00, -23h is the
period from 2014-10-19 09:00:00, which is exactly the last 23 hours.
-1d Last 1 day including today.

Note: Starts from the midnight of the previous date till the
current time. Therefore, the period is always more than 24 hours.

For example, if the current time is 2014-10-20 08:00:00, -1d is the
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Time Range
Expression

-1M
"2014-10-20"

"2014-10-20":"2014-
10-25"

"2014-10-20
14:00:00":"2014-10-25
20:00:10"

"2014-10-20
14:00:00":NOW

MON:NOW

Definition

period from 2014-10-19 00:00:00, which is 32 hours.
Last month.
From 2014-10-20 00:00:00 and 2014-10-20 23:59:59.

From 2014-10-20 00:00:00 until 2014-10-25 23:59:59.

From 2014-10-20 14:00:00 until 2014-10-25 20:00:10.

From 2014-10-20 14:00:00 until now (the time the query was issued).

From beginning of last Monday till the current time.

COLUMNS Statement

COLUMNS is used to define which columns should appear in the results and how they

should be computed.

<columnsStatement>

<columnList> ::=

::= "COLUMNS" <columnsList> | <aggregationList> ;

<columnExpression> ( "," <columnExpression> )x* ;
<aggregationList> :

:= <aggregationExpression> ( ","

<aggregationExpression> )*x ;

A COLUMNS statement can be a column based expression or an aggregate expression. A

column based expression is any expression supporting mathematical and logical operators,
functions, and other operators. For details, see FILTER Statement. An aggregate expression
is a similar expression that contains an aggregationFunction. If all columns use aggregation
functions, the result contains only one row with results of the aggregation. For details, see

GROUP BY Statement.
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When defining a column name in a search query, it must be enclosed in square brackets ([])
in the following scenarios:

e If a column name is also an EQL or SQL keyword, for example, "use
MyEventSourceConfiguration |[IN] >5".

e If a column name has a space, for example, "use Hawk_getProcess | COLUMNS
Status, [Virtual KBytes] | sys_eventTime in -10y".

 If a column name contains non-alphabetic or non-digit characters such as dash (-),
for example, "[ab]", to distinguish it from the subtraction expression "a-b".

The following data types for columns are supported:

e String

e Integer

e Long

e Double

e Boolean

e Timestamp

e |P address

Examples

Columns Expression Definition

columns sys_ The result is a table with three columns:

eventTime, sys_

collectIP, sys_ sys_eventTime, sys_collectIP, sys_body. The columns could be
body one of the pre-parsed columns such as sys_eventTime, sys_body, or

columns from configured parsers. See USE Statement.

columns count(11_ The result has one column with one row with count of all events that
sourceUser) has ll_sourceUser column with no empty value.

columns ToInt(1ll_ The result is a table with two columns, the first column called 'action’
eventActionID)+2 with the value of converting ll_eventActionID to int and adding 2 to it,

ti ‘
Ezdjc oM S5 and the second column is sys_body.
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Columns Expression Definition

columns max(length  The result is a table with a column containing the difference in length
(sys_body)) - between the longest and shortest events.

min(length(sys_
body))

GROUP BY Statement

Grouping can be used to group values by one or more expressions involving columns.

Grouping requires a list of grouping expressions and the list of aggregation columns.

A group by expression can be a column name or an expression involving multiple columns,
and an optional list of aggregation functions after the COLUMNS keyword. All the group by
expressions and the aggregates listed after the COLUMNS keyword are displayed by the

query.

<groupByStatment> ::= "GROUP BY" <columnExpression> ( ","

<columnExpression> )* )?

(COLUMNS <aggregationFunction> ("," <aggregationFunction> )x )?;
The following aggregation functions are supported:

¢ COUNT(*): Count all the rows.

¢ COUNT(columnName): Count all the rows in which the value of the column is not
null.

e COUNT(DISTINCT columnName): Count all distinct values from the column.

e SUM(column): Sum of all values from the column. Supports numerical types (Integer,
Long, Double).

e AVG(column): Provide average value for the column. Supports numerical types
(Integer, Long, Double).

e MIN(column): Smallest value of the column. Supports all data types that can be
ordered (Integer, Long, Double, Timestamp, String).

e MAX(column): Largest value of the column. Supports all data types that can be
ordered (Integer, Long, Double, Timestamp, String).
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» DURATION(timestamp): Returns the difference (in milliseconds) between the latest
and the earliest time. Supports Timestamp only.

e Time functions: Groups events by time. Supports time functions (Seconds, Minutes,
Hours, Days, Weeks, Months, Years).

Examples

Grouping
Expression

group by 11_
sourceUser
columns count(x)

group by 11_
sourceUser
columns

count(11_
sourceUser),

min(sys_
eventTime), max
(sys_eventTime)

group by 11_
sourceUser
columns

Duration(sys_
eventTime)

group by Tolong
(sys_
eventTime) /1000
COLUMN TolLong
(sys_e
ventTime) /1000,

AVG (LENGTH (sys_
body)), COUNT (%)

Definition

The result has two columns, the ll_sourceUser and count of users per
distinct value.

The result has 4 columns ll_sourceUser, number of users for each
distinct value of source user, minimum value of sys_eventTime and
maximum value of sys_eventTime.

The result has 2 columns, the source user and the duration.

The result has three columns, ToLong(sys_eventTime)/1000, AVG
(LENGTH(sys_body)), and COUNT(*). Grouping is done using the value
of the expression in the first column, which results in events being
grouped by the second at which they occurred. The next column shows
the average length of the events every second. The last column shows
the number of events that occurred every second.
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SORT BY Statement

SORT BY causes the result rows to be sorted according to the specified expressions.

By default, results are sorted in ascending order.
<sortByStatement> ::= "SORT BY" <expression> ( "," <expression> )x*x ;

A SORT BY expression can be the name of a column.

If two rows are equal according to the leftmost expression, they are compared according to
the next expression and so on. If they are equal according to all specified expressions, they
are returned in an implementation-dependent order.

Note: Sorting by an expression is not supported directly, but you can do it if you
put the expression in the projection (COLUMNS statement) and assign it a
column name with the AS statement

The following functions are supported:
e ASC: Sort results in ascending order. This is the default order.

e DESC: Sort results in descending order.

Examples
Sorting Expression Definition
sort by sys_ The result is sorted by time in ascending order.

eventTime ASC

sort by 11_ The result is sorted by ll_sourceUser in ascending order (default), in

sourceUser, sys_ case ll_sourceUser is the same, sort by sys_eventTime in descending

eventTime DESC
order.

LIMIT Statement

LIMIT indicates the maximum number of results that should be returned by the query.
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<limitStatement> ::= "LIMIT" <number> ;

If you do not specify a LIMIT clause in the query, the default limit of 100,000 is used.

Example

USE system | LIMIT 100

Expression Definition

limit 100 Limits the result set to top 100 rows.

Query Optimization for Better Performance

Besides narrowing the time span for the query, the best way to improve performance is to
leverage the index, using the CONTAINS operator.

For example:

sys_body CONTAINS 'string'
quickly finds all the events that contain the token 'string' by using the index.

o Note: The index only stores full words called tokens, and ignores characters
such as punctuation signs, spaces, and so on.

Even if your query is based on other columns or operators, you can accelerate it if you
know some tokens that appear verbatim in the events you are looking for, and add them to
your query with the CONTAINS operator.

For example, the following query works as is:
USE Microsoft_Windows | 1l_actionID = 4291

However, since we know that the token 4291 appears in the events we are looking for, we

can get faster results by typing:
USE Microsoft_Windows | 1l_actionID = 4291 AND sys_body CONTAINS '4291'
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Text Search

Searching by text is an important feature when dealing with logs.

The Loglogic Query Language offers several operators to perform text matches:

LIKE REGEXP CONTAINS
Matching level Character Character Token
Syntax Wildcards: _ %  Java Regular Expressions  Wildcards: ? *
Expression matches  Full string Part of the string Part of the string
Indexed No No Yes
Case-sensitive Yes Per syntax No

LIKE is the classical SQL operator. It matches the full string (so leading and trailing
wildcards should be added if trying to match only a fragment). It has a granularity of
character, that is, we can match character by character. The supported wildcards are _ for
one character and % for many characters. It is not indexed, so it is not particularly fast.

REGEXP allows matching regular expressions. It searches a match within the string. It has
character granularity. The syntax for the regular expression language is the same that
provided by the Java language. It is not indexed.

CONTAINS searches within the index, with a token granularity. The index stores tokens, or
full words, so we must search for the full words, or add wildcards. The wildcards allowed
are ? for one character and * for multiple characters, and matching part of the string is
enough. This operator takes advantage of the index, and hence CONTAINS speeds up
queries.

See Types of FILTER statements for details on the syntax of this operators and available
string functions that can be useful to manipulate text.

Search Examples

Some search examples for reference.
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SQL Expression

select sys_
eventTime,sys_body from
LoglLogic_Appliance where
sys_eventTime between
'2016-02-02"' and '2016-
02-03"

select x from LoglLogic_
Appliance where sys_body
like '%Authentication%'
and sys_eventTime
between '2016-02-02' and
'2016-02-03"

select x from LoglLogic_

Appliance where sys_body
like '%logon%' and sys_

eventTime between '2016-
02-02' and '2016-02-03'

limit 10

select x from LoglLogic_
Appliance where sys_
eventKey REGEXP '[az0O-
9|1*' and sys_eventTime
in -10y limit 10

select x from LoglLogic_
Appliance where sys_
eventTime between '2016-
02-02' and '2016-02-03'
order by sys_eventTime
DESC

select * from LoglLogic_
Appliance where sys_
eventTime between

'2016-02-02' and '2016-
02-03"' order by sys_
eventTime DESC limit 100

EQL Expression

use Loglogic_Appliance
|columns sys_eventTime,
sys_body | sys_eventTime
between '2016-02-02' and
'2016-02-03"

use Loglogic_Appliance |
sys_body contains
"Authentication" | sys_
eventTime between '2016-
02-02' and '2016-02-03'

use Loglogic_Appliance |

sys_body like '%logon%' |
limit 10 | sys_eventTime
between '2016-02-02' and

'2016-02-03"

use Loglogic_Appliance |
sys_eventKey REGEXP '[a-
z0-9|]x' | sys_eventTime
in -10y | limit 10

use Loglogic_Appliance |
sys_eventTime between
'2016-02-02"' and '2016-
02-03' | sort by sys_
eventTime DESC

use Loglogic_Appliance |
sys_eventTime between
'2016-02-02"' and '2016-
02-03' | sort by sys_
eventTime DESC | limit
100

Definition

Displays results from the
LogLogic_Appliance data
model where the records
have the timestamp
between '2014-02-02' and
'2014-02-03'.

Displays results from the
LoglLogic_Appliance data
model with
"Authentication" in the
event body.

Demonstrates an example
of a 'like' statement to
display a limit of 10
results.

Demonstrates an example
of the REGEXP expression
matching.

Displays events sorted by
time for records having
timestamp for the
specified dates in
descending order.

Displays top 100 results for
records sorted by time in
descending order.
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SQL Expression

select sys_eventTime,
sys_body from Loglogic_
Appliance where sys_
eventTime between '2016-
02-02 14:34:34' and
'2016-02-03 12:00:00'
ORDER BY sys_eventTime
DESC LIMIT 100

select 11l_sourceUser,
count(*) from Loglogic_
Appliance where sys_
eventTime between '2016-
02-02' and '2016-02-03'
group by 11_sourceUser

select 11l_sourceUser,
max (sys_eventTime), min
(sys_eventTime), count
(x) from LoglLogic_
Appliance where sys_
eventTime between '2016-
02-02' and '2016-02-03'
group by 11_sourceUser

select 1l_sourceUser,
(max(ToLong(sys_
eventTime ))- min(ToLong
(sys_eventTime) )) /1000
as seconds from
LoglLogic_Appliance where
sys_eventTime IN -10y
group by 11_sourceUser

EQL Expression

use Loglogic_Appliance |
sys_eventTime between
'2016-02-02 14:34:34' and
'2016-02-03 12:00:00" |
sort by sys_eventTime
DESC | LIMIT 100

use Loglogic_Appliance |
group by 11_sourceUser
columns 11_sourceUser,
count(*) | sys_eventTime
between '2016-02-02' and
'2016-02-03"

use Loglogic_Appliance |
group by 11_sourceUser
columns max(sys_
eventTime), min(sys_
eventTime), count(x) |
sys_eventTime between
'2016-02-02"' and '2016-
02-03"

use Loglogic_Appliance |
sys_eventTime in -10y |
group by 11_sourceUser
COLUMNS 11_sourceUser,
(max (ToLong(sys_
eventTime) )- min(ToLong
(sys_eventTime)) )/1000
as seconds
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Definition

Display sorted first page of
results for events ordered
by time in descending
order.

Displays grouped results
based on the source users.

Displays the count of rows
for distinct source users
and its corresponding
maximum timestamp and
minimum timestamp.

Demonstrates the use of a
complex expression in the
COLUMNS statement. For
each user, calculate the
difference in time between
the earliest and latest
events. The time values
are first converted to
LONG (milliseconds), then
subtracted, and finally
divided by 1000 to convert
the milliseconds to
seconds.
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Examples for geoiplookup()

SQL Expression

select geoiplookup(sys_
collectIP,"location"),
sys_collectIP from
Microsoft_Windows where
sys_collectIP like
'128%'

select geoiplookup(sys_
collectIP,"country"),
sys_collectIP from
Microsoft_Windows where
sys_collectIP like
'128%'

select geoiplookup(sys_
collectIP,"country"),
sys_collectIP from
Microsoft_Windows where
sys_collectIP like
'2001%"'

EQL Expression

use Microsoft_Windows_
Windows | sys_collectIP
like '128%' |COLUMNS sys
collectIP, geoiplookup
(sys_
collectIP,"location")

use Microsoft_Windows |
sys_collectIP like '128%'
| COLUMNS sys_collectIP,
geoiplookup(sys_
collectIP,"country")

use Microsoft_Windows |
sys_collectIP like
'2001%"' | COLUMNS sys_
collectIP, geoiplookup
(sys_collectIP,"country")

Definition

Returns location information
such as latitude, longitude,
time zone corresponding to
the IPv4 address specified in
the sys_collectIP parameter.

Returns the country
corresponding to the IPv4
address specified in the sys_
collectIP parameter.

Returns the country
corresponding to the IPv6
address specified in the sys_
collectIP parameter.

Examples for matchcidr() and extractIPs()

SQL Expression

select x from
system where

EQL Expression

If sys_collectIP="198.51.100.101", 203.0.113.101",

Definition

Returns the

then: data that
matchcidr .
("198.51.100.101/  use system | matchcidr("198.51.100.101/32", includes sys_
32", sys_ sys_collectIP) collectIP as
collectIP) 198.51.100.101,

because the IP
address is
within the CIDR
range of
"198.51.100.10
1/32".

TIBCO Loglogic® Log Management Intelligence User Guide



488 | Search Syntax Reference

SQL Expression

select * from
system where
matchcidr
("198.168.0.0-
198.168.255.255",
sys_collectIP)

o select «*
from system
where
matchcidr
("IPList",sy
s_collectIP)

o select «*
from system
where
matchcidr
("IPList",sy
s_collectIP,
IlIPlll)

select minutes
(sys_eventTime),
count(*) from
system where sys_
collectIP="198.51
.100.0"™ AND
extractIPs(sys_
body) !="" AND
matchCidr(
"192.0.2.0/24"
extractIPs(sys_
body) ) GROUP BY
minutes(sys_
eventTime)

EQL Expression

If sys_collectlP="198.51.100.101",203.0.113.101",
then:

use system | matchcidr("203.0.0.0-
203.0.255.255",sys_collectIP)

For an enrichment list named IPList:

{"198.51.100.101/32":"IP1","192.0.2.101/32":"
IP2","203.0.113.0-
203.0.113.255":"IP3","2001:DB8:4860: : 8888/32"
:"IP4"}

and if sys_
collectTP="198.51.100.101",203.0.113.101", then:

e use system | matchcidr("IPList",sys_
collectIP)

e use system | matchcidr("IPList",sys_
collectIP,"IP1")

USE system | sys_collectIP="198.51.100.0" AND
extractIPs(sys_body) !="" AND matchCidr(
"192.0.2.0/24" , extractIPs(sys_body) ) |

GROUP BY minutes(sys_eventTime)

Definition

Returns the
data that
includes sys_
collectIP as
203.0.113.101,
because the IP
address is
within the
range of
"203.0.0.0-
203.0.255.255".

Returns the
data that
includes sys_
collectIP as
198.51.100.101,
because this IP
address is
within the
range
198.51.100.101/
32 and
matches the
key IP1.

Returns the
output of the
query
aggregated per
minute
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Examples for split() and extractlPs()

SQL Expression

select split(sys_body,' ',
2) from system

select * from system where
sys_collectIP="192.0.2.0"
and extractIPs(sys_body)
1="" and split(extractIPs
(sys_body),',',1) group by
minutes(sys_eventTime)

select split(sys_
collectIP, '\\.',3) from
system

e select split(sys_body,
"', 4) from system

o select extractIPs(sys_

body) from system
where extractIPs(sys_
body) !="" and split
(extractIPs(sys_
body), ', ",1) 1=""

EQL Expression

USE system | COLUMNS
split(sys_body, ' ', 2)

USE system | sys_

collectIP="192.0.2.0" AND
extractIPs(sys_body) !=""
AND split(extractIPs(sys_
body),',',1)!="" | GROUP
BY minutes(sys_eventTime)

USE system | COLUMNS
split(sys_collectIP,
"\\.',03)

e USE system |
COLUMNS split(sys_
body, ' ', 4)

e USE system |
extractIPs(sys_body)
I= """ AND split
(extractIPs(sys_
body),",",1)="" |
COLUMNS extractIPs
(sys_body)

Definition

Parsing rule in a data
model:

Returns the third element
in the list, after splitting
sys_body column using
space as the separator.

Aggregation rule query:

Returns the output of the
query aggregated per
minute for results where
extractIPs returns the list
with more than one values.
Otherwise split returns
false.

Returns the last numbers of
the IP address provided in
sys_collectIP and
separated by dot (the regex
"\\."is for the dot
character)

Advanced search queries:

e Using space as a
separator, returns the
fifth element from
the value of sys_body
column.

e Returns a list of
extracted IPs from
sys_body with more
than one IP
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SQL Expression

select x from system where
sys_collectIP="192.0.2.0"
and extarctIPs(sys_

body) !="" and split
(extractIPs(sys_
body),',',1)!="" group by

minutes(sys_eventTime)

EQL Expression

USE system | sys_

collectIP="192.0.2.0" AND
extractIPs(sys_body) !=""
AND split(extractIPs(sys_
body),',',1)!="" | GROUP
BY minutes(sys_eventTime)

OPTIONS Statement

You can use the training model classification in advanced search queries, correlation,
aggregation rules, and Bloks, by adding the following syntax in the query:

OPTIONS useClassifier=<modelName>

The search result displays the following additional columns:

e 11_tax_action: Action performed by the logged-in user.

Definition
addresses.

Aggregation rule query:

Returns the output of the
query aggregated per
minute for results where
extractIPs() returns a list
with more than one values.
Otherwise split() returns
false.

* 11_tax_event_type: Type of event, such as config activity or standard activity.

e 11_tax_intent: Intention of the action, such as authentication or common use.

e 11_tax_outcome: Outcome of the user's action, such as successful or failed.

e 11_tax_target: The parameter affected by the user's action, such as Application

context or Auth policy.

The triplet 11_tax_action, 11_tax_event_type, and 11_tax_intent together indicate the

user's action.
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Event Correlation Language Reference

LoglLogic Event Correlation Language (ECL) is effective in finding patterns in a given set of
logs.

ECL is able to describe searches that are a bit complex for the regular EQL, especially when
there is a need to join several types of events. Rules described in ECL can be used for
advanced forensics searches and also for real-time alerting.

Rule Structure

A rule describes a pattern to look for within a given time window.

It contains a list of event group definitions (at least one), and the correlation criteria that
are used to join those event groups (if there is more than one event group). A rule can also
be valid for only a given period of time.

All mandatory parameters are explained here. The optional parameters are in square
brackets [ ].

Valid From yyyy-MM-dd hh:mm:ss To yyyy-MM-dd hh:mm:ss ) ]
[ <identifier environment> ]

USE <source identifier> (, <source tidentifier>)x

Within <integer> [ d |h | m | s J[Fixed | Sliding ]
<event group 1>

<event group 2>

[Correlation

<correlation criteria 1>

<correlation criteria 2>

]

[Autofill]

(Set <expression> AS <identifier>)x
[Inject Correlation Event]

[ LIMIT <integer> CORRELATION EVENTS ]

Note: Each ruleset can have multiple rules. Each rule name must be unique in a
defined ruleset.
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Parameter

Rule <identifier
environment>

USE

Within

Event Group

Correlation
<correlation
criteria>

LIMIT

Description

The rule name defined using an identifier and the environment. For
details, see Identifier Environment.

The list of log sources used by the rule. Multiple log sources must be
separated by comma (,).

The time period is defined as an integer in days, hours, minutes, or
seconds.

Each event group describes the criteria that must combine events to be
group together as part of the rule. This is equivalent to a single search in
EQL. For details, see Event Group Structure.

The correlation criteria describes the joins and other constraints that
various event groups must meet to trigger a rule. For details, see
Correlation Criteria.

Limit on number of correlation events is only effective for "replay"
instances when INJECT CORRELATION EVENT is not set. The default limit is
10,000.

Identifier Environment

An identifier environment is used to specify the data models, when those parts are not
present in a key identifier.

The identifier environment is composed of:

o [Default data model <identifier>]

The identifier environment follows a hierarchical structure when resolving a missing part in
an identifier. The order is as follows:

e Event Group Environment

e Correlation Rule Environment

¢ Ruleset Environment

¢ Root Environment (defined outside ECL itself)
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° For Correlation REST API: this is the environment parameter.

° For Web application: this is related to the currently logged in user.

Limitations

e The only possible value for tenant is: tenantl
e The only possible value for domain is: shared

* The only possible value for source is: correlation

Simple Identifier

The simple identifier must be defined using letters, numbers, underscore (_), and dollar
sign ($) with or without single quotes (' '). If single quotes (' ') are not used, use square
brackets ([ ]), or back quotes (* ).

Forexample: (lal..lzlllAl..lZI) (lal'.lzlllAl..lzlllel..lglll_l||$l)*

Key Identifier

An identifier is composed of four parts separated by dots. An identifier part follows the
syntax of the simple identifier. The identifier parts are:

¢ Tenant name

e Domain name

» Source configuration name

e Field name (or column name)

The key identifier can be defined as follows:

[[[<tenant identifier>.]<domain identifier>.]<source config
identifier>.]<field
identifier>

The <field -identifier> is mandatory part. If the other identifier parts are not defined,
they are automatically extracted from the identifier environment.
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Limitations:

e The only possible value for tenant is: tenantl

e The only possible value for domain is: shared

* The only possible value for source is: correlation

Event Group

An event group describes the criteria events should meet to be part of a rule. Event groups
can be of the following types:

Type Description

Required The rule cannot be triggered if no event matches this event group. This is the

default type.

Excluded The rule is NOT triggered if an event matches this event group.

Optional If any events match this event group and if other criteria are met, they are part

of the triggering rule.

An event group can have the following parts:

Conditions on the number of events
A filtering clause

A grouping clause

A set of having clause

Upper limits on the number of groups and events that can be created while this rule
is run. This is a safeguard against a memory overflow.

An event group is defined as follows:

Event Group <identifier> [ Is ( Required | Optional | Excluded ) ] [
With Delayed Evaluation ]

[ At Least <integer> Events ]

[ At Most <integer> Events ]

[ <identifier environment> ]
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[ Where <expression> ]
[ With The Same <expression> [ As <identifier> ]
( , <expression> [ As <identifier> ] )x ]

( Having <having clause> )x*
[ Limits <integer> Groups And <integer> Events ]

When the At Least parameter is defined, it requires at least an integer more than 0. If it is
omitted, this implies at least 1.

If the where clause is defined, it must match the expressions. It is evaluated as a Boolean.
For details, see Expressions.

Default Limits are 10000 groups and 100000 events.

Expressions

Expressions can be used to express how to compute a value in situations such as:

e in a condition

e in a grouping definition

¢ in field assignment

[ C+ |
[ C+ |

"<String>"

=) ]
=) ]

<double>
<long>

{ (d ] t ] ts ) yyyy-MM-dd hh:mm:ss }

True
False
Null

<IPv4 address>
<IPv6 address>
<key didentifier>

$<identifier>(<expression>)
( <expression>

<expression>
<expression>
<expression>
<expression>
<expression>
<expression>

*

/

/
%

+

Is [ Not ] Null

)

<expression>
<expression>
<expression>
<expression>
<expression>

Exists <expression>
<expression> [ Not ] Like <expression>
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<expression>
<expression>
<expression>
<expression>
<expression>
<expression>
<expression>
<expression>
<expression>
<expression>
<expression>

[ Else <expression> ]

Not
Not
Any
Any
Any
Any
Any
Any
Any
[ Any

| A e I s Y s I s O I s A e N |

| ALl ] Contains <expression>
| A1l ] Regexp <expression>

<expression>
I= <expression>
> <expression>
>= <expression>
<= <expression>
< <expression>
<> <expression>
In ( <expression>, expression, .. )

In <expression>/<expression>

<expression> [ Any | All ] Between <expression> And <expression>
Case <expression>
( When <expression> Then <expression ) +

<function name> ( [ <expression> ] , [ <expression> ] , .. )
<aggregation function>

The following operators are supported:

Equals (=)

Not equals (!=), (<>)

Lower than (<)

Lower or equal (<=)

Greater than (>)

Greater or equal (>=)

In:

o <list of expressions>: Checks if value matches any one of the values in a set.
Supports all data types.

o <network>/<net length>: Checks whether an IP address matches a network,
defined as a network IP address and a network bitmask length.

Between <expression> And <expression>: Supports Timestamps, Long, Integers and

Float

AND, OR

Examples:
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( sys_eventType = “1234”) and ( sys_body like “%login failed%”)
( sys_bodySize > 30) and (sys_bodySize < 20)
( 1l_eventID is not null) and ( ll_eventID > -1 )

e Predefined ECL Functions

e Aggregation Functions

¢ |dentifier Environment

Predefined ECL Functions

Functions are used to compute a value as output from parameters as input. Some
functions are predefined in the language. You can also call a static Java function provided
by the user. The predefined functions that are available in ECL are listed in the following
tables.

e String functions

List functions

Conditional functions

Smart List functions

Conversion functions

Miscellaneous functions

String Functions

Function Name Arguments Returns

e len (String) Length of string 1.
e char_length

e character_
length

e length
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Function Name
lower

upper

trim

substitute

left
right

e mid
e substr

e substring

o find

e position

concatenate

TransformString

Arguments

(String)

(String)

(String)

(String 1, String 2,
String 3)

(String, Int)
(String, Int)

(String, Int 1, Int 2)

(String 1, String 2)

(String 1, String 2, ...)

(stringToTransform,
regularExpression,
template) or
(stringToTransform,
regularExpression,
template,
defaultValue)

Returns
Lower case of string 1.
Upper case of string 1.

Trimmed string 1 (without leading and trailing
spaces).

Substitute string 2 by string 3 in string 1.

<int> left characters of string 1.
<int> right characters of string 1 .

Characters from stringl starting at offset
<intl> for a length of <int2>.

Index of the first occurrence of string2 within
stringl, -1 if no occurrence is found.

Concatenation of all strings passed as
arguments.

It tries to match the stringToTransform with
the regular expression, and then returns the
template with references to groups in the
regular expression substituted with the actual
values. To refer to groups, use $1, $2, etc to
refer to numbered groups, and $<name> to
refer to named groups. If the string does not
match, or is there any other error, the default
value is returned (or NULL if not specified).
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List Functions

Function Name Arguments Returns

size List Size of the list

Conditional Functions

Function Arguments Returns

Name

IIF Condition, Returns the 'Then' value if condition is true, otherwise it
then, else should return the 'Else' value.

For example: IIF(true, “a”, “b”) returns “a” IIF
(false, ”a”,”b”) returns “b”

Smart List Functions

Smart List functions

Function Arguments Returns

Name

lookup (String 1, String  The value associated with String2 in the smart list named
2) Stringl.

isInList (String 1, String  True if the value String2 is defined in smart list named
2) Stringl.
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Conversion Functions

Function Name

ToTimestamp

TolP

ToTimestampString

Arguments

(expression, formatString) or (expression,
formatString, timezone) or (expression,
formatString, timezone, defaultValue)

(expression_ or (expression, defaultValue)

(expression, formatString) or (expression,
formatString, timezone) or (expression,
formatString, timezone, defaultValue)

Returns

The expression, which
should evaluate to a
string, is interpreted
as a time according to
the supplied
formatString. If the
conversion fails, null
is returned, unless a
default string is
provided, which is
interpreted as a time
and returned.

Note: If timezone
is omitted or is
empty, the system
default timezone is
used.

Convert the
expression to an IP
address (Java
InetAddress). If the
conversion fails, null
is returned, unless a
default string is
provided, which is
interpreted as an IP
address and returned.

Same as
ToTimestamp, except
the conversion is in
the opposite direction
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Function Name Arguments Returns

to get a printable
timestamp.

Note: If timezone
is omitted or is
empty, the system
default time zone
is used.

Tolnt (expression) or (expression, defaultValue) The obvious
conversion to integer
with default value
taken if not
convertible.

TolLong (expression) or (expression, defaultValue) The obvious
conversion to Long
with default value
taken if not
convertible.

ToString (expression) or (expression, defaultValue) The obvious
conversion to String
with default value
taken if not
convertible.

Note: Using the
ToString() function
in a correlation
Blok might result
in inconsistent
time format.
Therefore, use the
ToTimestamp()
function instead.
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Function Name Arguments Returns

ToFloat (expression) or (expression, defaultValue) The obvious
conversion to Float
with default value
taken if not
convertible.

Note: LogLogic
uses double
precision (that is
64 bits) when
storing floating
point numbers.

ToBool (expression) or (expression, defaultValue) The obvious
conversion to Boolean
with default value
taken if not
convertible.

ToDouble (expression) or (expression, defaultValue) The obvious
conversion to Double
with default value

taken if not
convertible.
ExtractJson (expression, extraction path) or (expression, The expression, which
extraction path, default value) is a JSON string is

parsed. A field is
extracted from the
expression using the
extraction path. If
either the extpression
or the path are
invalid, an optional
default value is
returned.
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Function Name

ExtractKvp

Arguments

(expression, extraction path) or (expression,

extraction path, nested KVP delimiters
/default "{}"/) or (expression, extraction

path, nested KVP, delimiter / default ","/) or

(expression, extraction path, nested KVP,
delimiter, separator /default "="/) or
(expression, extraction path, nested KVP,
delimiter, separator, escape character /
default "\\"/) or (expression, extraction
path, nested KVP, delimiter, separator,
escape character, default value)

Miscellaneous Functions

Function Name

matchcidr

You can use the
function within SQL,
EQL, and ECL queries,
and in turn, in other
functionality that
make use of these
queries.

Arguments

(IP_string_format, IP_address_to_
Match, key)

In the IP_string_format parameter,
you can specify a CIDR address, single
IPv4 or IPv6 address, a comma-
separated list of CIDR IP addresses or a
range, a hyphen-separated range of IP
addresses, or an enrichment list.

In the IP_address_to_Match field,
specify the column name from the logs,
which are to be matched against the
IP_string_format parameter. The data
type of the column must be INET_ADDR.

The key parameter specifies a key name
in the enrichment list. The key
parameter is mandatory when using this
function in correlation bloks. You must
provide a either key name or an empty
string ("").

Returns

The expression, which
is a nested KVP string
is parsed. A field is
extracted from the
expression using the
extraction path. If
either the expression
or the path are
invalid, an optional
default value is
returned.

Returns

Returns those IP
addresses from the IP_
address_to_Match
parameter, which belong
to the IP addresses
specified in the IP_
string_format list.
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Having Clause

The Having clause adds additional constraints on the events that have passed the filter and
are grouped by the rule.

At (Least | Most) <integer>

Distinct <expression>

As <didentifier>

Limit <integer>

Count Of <expression> Being <expression> (Greater | Less) Than <integer>
Percentage Of <expression> Being <expression> (Greater | Less) Than
<integer> %<condition>

Note: The Having clause expression must contain at least one aggregation
function.

The supported parameters are:

Parameter Description

Count Of Counts the number of time two expressions are equals and check that this
value is greater or less than a boundary.

Percentage Counts the number of time two expressions are equals and make a ratio of
of this count versus the number of events in the group, then check whether the
value is less or more than a value expressed as percent.

The Having clause can also be an expression using aggregation functions and resolving to a
Boolean.

Aggregation Functions

Expressions used in the Having clause must contain at least one aggregation function. The
(x) option applies the function to any event with no additional constraints. The A11 option
applies the function to all values that are not null. The Distinct option applies the
function only once per distinct values.
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Count ( * )

Count ( [ Distinct | ALl ] <expression> Limit <integer> )
Sum ( [ Distinct | ALl ] <expression> Limit <integer> )
Avg ( [ Distinct | ALl ] <expression> Limit <integer> )
Max ( [ Distinct | All ] <expression> Limit <integer> )
Min ( [ Distinct | All ] <expression> Limit <integer> )
Var ( [ Distinct | All ] <expression> Limit <integer> )
Stdev ( [ Distinct | All ] <expression> Limit <integer> )
Function Definition

Count() Count of values

Sum The total value

Avg The average value

Max The maximum value

Min The minimum value

Var The variance

Stdev The standard deviation function

Having Clause

The Having clause adds additional constraints on the events that have passed the filter and
are grouped by the rule.

At (Least | Most) <integer>

Distinct <expression>

As <identifier>

Limit <integer>

Count Of <expression> Being <expression> (Greater | Less) Than <integer>
Percentage Of <expression> Being <expression> (Greater | Less) Than
<integer> %<condition>
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Note: The Having clause expression must contain at least one aggregation
function.

The supported parameters are:

Parameter Description

Count Of Counts the number of time two expressions are equals and check that this
value is greater or less than a boundary.

Percentage Counts the number of time two expressions are equals and make a ratio of
of this count versus the number of events in the group, then check whether the
value is less or more than a value expressed as percent.

The Having clause can also be an expression using aggregation functions and resolving to a
Boolean.

Correlation Criteria

Correlation criteria can be of the following types:
» A join condition describing which fields should be equals in two event groups

» A sequencing constraint that describes the relative order in which two event groups
should occurs

» An expression criteria that describes a condition among fields of different event
groups

<event_group_identifierl> -> <field_identifierl> == <event_group_
identifier2> -> <field_identifier2> <event_group_identifierl>
(Begins | Ends) [At Least <integer> [ d | h | m | s 1] [Up To
<integer> [ d |h | m | s ]] (Before | After) <event_group_
identifier2> (Begins]|Ends)

This is an expression criteria that is used to describe a condition between fields that
belongs to different event groups.
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<expression which uses syntax eventGroupIdentifier -> fieldIdentifier
for keys>

For example, groupl->sum_bytes >= group2->sum_bytes

o Note: The fields referenced in a join must be grouping fields for their respective
event groups.

Correlation Blok (ECL) Examples

A correlation Blok can be used in Advanced Search on historic data for forensic analysis. It
can also be used in a rule, which triggers in real time to generate alerts and notifications.
Notifications can be in the form of email, syslog, or SNMP.

Blok Definition

. Example 1:
USE Loglogic_

Appliance This Blok triggers a new alert at the first event and accumulate

WITHIN 30m all events during 30 minutes time period.
EVENT GROUP [My

EVENTS]

. Example 2:
USE Loglogic_

Appliance WITHIN This Blok does the same as Blok Example 1, but the alerts

3om generated then give information about the number of distinct
EVENT GROUP [My ) } .
EVENTS] 11_sourceDomain or 11_deviceTypeID and their values.

HAVING AT LEAST 1
DISTINCT [11_
sourceDomain]
HAVING AT LEAST 1
DISTINCT [11_
deviceTypelD]
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Blok

USE Loglogic_
Appliance WITHIN
30m

EVENT GROUP [My
EVENTS]

WHERE [11_
deviceTypelD]
:"17"

HAVING AT LEAST 2
DISTINCT [11_
sourcelIP]

USE Loglogic_
Appliance WITHIN
30m

EVENT GROUP
[suspiciousSource
s] AT LEAST 100
EVENTS

WHERE [11_
deviceTypelD]
=mi7"

WITH THE SAME [11_
sourcelP]

HAVING AT LEAST 1
DISTINCT [11l_
eventStatus]

USE Loglogic_
Appliance WITHIN
30m

EVENT GROUP
[suspiciousUsers]
AT LEAST 100
EVENTS

WHERE [11_
deviceTypelD]
=mi7"

Definition

Example 3:

This Blok filters events that have 11_deviceTypeID equal to
"17", and at least 2 distinct values of 11_sourceIP

Example 4:

This Blok looks for at least 100 events with the same criteria as
the previous one, coming from the same 11_sourceIP and
giving information about the number of distinct 11_
eventStatus and their value.

Example 5:

This Blok filters the event the same way as the previous one,
and is looking for 100 events from the same 11_sourceUser that
have at least 10 distinct values of 11_sourceIP and at most 1
distinct value of 11_eventStatus.
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Blok Definition

WITH THE SAME [11_
sourceUser]

HAVING AT MOST 1
DISTINCT [11_
eventStatus]
HAVING AT LEAST 10
DISTINCT [11_
sourcelP]

. Example 6:
USE Loglogic_

Appliance WITHIN This Blok looks at two groups of events happening within 30
30m . . . .
minutes. The first event group is success audit from the same

EVENT GROUP e
[success] AT LEAST 11_sourceIP/11_sourceUser and the second group is failed

1 EVENTS status grouped the same way. The Blok is triggered if the fields
WHERE [11_ grouped on both event groups are same.
deviceTypelD]
="17" AND [11_
eventStatus] =
"success"

WITH THE SAME [11_
sourceUser],[11_
sourcelP]

EVENT GROUP
[failed] AT LEAST
1 EVENTS

WHERE [11_
deviceTypelD]
="17" AND [11_
eventStatus]
="failure"

WITH THE SAME [11_
sourceUser], [11_
sourcelP]
CORRELATION
success->[11_
sourcelIP]==
failed->[11_
sourcelP]
success->[11_
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Blok Definition

sourceUser]==
failed->[11_
sourceUser]

. Example 7:
USE Loglogic_

Appliance WITHIN Same as the previous Blok, but this time the Blok is triggered if
30m there are only failed events within 30m for the same 11_

EVENT GROUP
[success] is sourceIP / 11_sourceUser.

excluded AT LEAST
1 EVENTS

WHERE [11_
deviceTypelD]
="17" AND [11_
eventStatus]
="success"

WITH THE SAME [11_
sourceUser], [11_
sourcelP]

EVENT GROUP
[failed] AT LEAST
1 EVENTS

WHERE [11_
deviceTypelD]
="17" AND [11_
eventStatus] =
"failure"

WITH THE SAME [11_
sourceUser],[11_
sourcelIP]
CORRELATION
success->[11_
sourcelIP]==
failed->[11_
sourcelIP]
success->[11_
sourceUser]==
failed->[11_
sourceUser]
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Blok Definition

. Example 8:
USE Loglogic_

Appliance WITHIN This Blok looks for users that have events with 11_eventStatus

30m equal to either failed or success.
EVENT GROUP

[users]

WHERE [11_
eventStatus]
="failure" OR [11_
eventStatus]="succ
ess"

WITH THE SAME [11_
sourceUser]

HAVING AT LEAST 2
DISTINCT [11_
eventStatus]

. Example 9:
USE Loglogic_

Appliance WITHIN Same as the previous Blok with an additional constraint that

30m there are twice as many failed than success events.
EVENT GROUP

[success] 1s
excluded AT LEAST
1 EVENTS

WHERE [11_
deviceTypelD]
="17" AND [11_
eventStatus]
="Success"

WITH THE SAME [1l1_
sourceUser],[11_
sourcelP]

EVENT GROUP
[failed] AT LEAST
1 EVENTS

WHERE [11_
deviceTypelD]
="17" AND [11_
eventStatus] =
"Failure"

WITH THE SAME [11_
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Blok Definition

sourceUser], [11_
sourcelIP]
CORRELATION
success->[11_
sourcelIP]==
failed->[11_
sourceIP] success-
>[11l_sourceUser]==
failed->[11_
sourceUser]

Example 10:
use system WITHIN

20m For an enrichment list named IPList:
EVENT GROUP egl
WHERE matchcidr
("IPList",sys_ {"192.168.56.101/32":"IP1","191.163.56.101/32":"IP2", "1
collectIP,"IP1") 98.168.0.0-
198.168.255.255": "IP3","2001:4860:4860: : 8888/32": "IP4"}

and for sys_collectIP="192.168.56.101",198.168.56.101", then:
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REST API Reference

You can use the Representational State Transfer (REST) API to develop your own client
application.

LogLogic LMI provides REST API that a client application can use to invoke services using
simple HTTP methods. Starting from LoglLogic LMI 6.1.1, queries via REST API are
encrypted.

You can access Loglogic LMI API online documentation using the following URLs:

Category of Services provided URL for the REST API
services
Query API e Queries https://<hostName>:9681/docs
* Sub queries For more information, see REST API for Advanced
Search.

e Quick queries

Aggregation Aggregation rules https://<hostName>:9685/docs
node API
Correlation API  Correlation https://<hostName>:9682/docs
instances

e Alerts

o Triggers

* Metrics
Monitoring e Default https://<hostName>:9687/HawkConsole/v1/docs
console API e Authentication For more information, see TIBCO Operational

. Intelligence Hawk® Concepts Guide.

e Domain

o Alert

e Agent
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Category of Services provided URL for the REST API
services
e |nvoke and
Subscribe
e Rulebase
e Schedule

e Microagent

Note: The URLs include the default ports. If you change the default ports,
update the URL accordingly.

To demonstrate the usage of REST API, some sample scripts are provided in the
REST/Samples/ directory in the supplemental package. For more information, see the
samples.txt file in the supplemental package.

Authentication and Access

LoglLogic LMI users who have Admin or Search Archived Data permissions can access REST
API. If a user without these permissions tries to access REST API, authentication fails.

REST Request Format

REST API requests must be submitted in a specific format.

The format of a LoglLogic REST API request is:
<METHOD> <baseurl>/<basePath>?<query_parameters>

where:

e <METHOD> is the HTTP method to be used on the resource (GET, POST, PUT, or
DELETE)

e <baseurl> is the REST API Endpoint ( baseurl ).
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» <basePath> is the part of the path that identifies the required LoglLogic resource. It
consists of:

° a fixed part - for example, /api/v2/query when starting a query.

° followed by (if required) path parameters - for example, id when starting a
query

e <query_parameters> identifies any parameters to be passed as part of the request.
Unless otherwise specified for a specific parameter, all query parameters are always
optional. Multiple query parameters should be separated by ampersand (&)
characters.

For example, the GET query request shows how to start a business service called GET
query:

GET https://<hostName>:9681/api/v2/query/{id}

where:
* https://<hostName>:9681/ is the LoglLogic REST APl endpoint.
e api/v2 is the fixed part of the <basePath>.
e query is the path parameter in the <basePath>.

e {4id} is the parameter of the path in the <basePath>.

REST API Endpoint (baseurl)

A specific endpoint must be used when submitting REST API requests.
The endpoint on which all LogLogic REST resources are exposed is:
<protocol>://<host>:<port>/api/<API_version_number>
where:
e <protocol> is the protocol used to communicate with the LoglLogic runtime HTTP.

e <host> is the network name or IP address of the LoglLogic runtime.

e <port> is the port used by the LoglLogic runtime for incoming HTTP connections,
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exposed by the HTTP connector shared resource.
e api is the context root used by the LoglLogic REST API resource hierarchy.

e <API_version_number> is the APl version number.

o Note: The Loglogic REST API endpoint is referenced throughout this
document as <baseur1>.

Response Status Codes

All REST API requests return a response status code.

The main HTTP status codes that might be returned by LoglLogic are:

HTTP status code Description

200 Request completed successfully.

204 Request completed successfully but no content available to return.
400 Bad request/ Invalid query.

401 Authentication failure, invalid access credentials.

403 Insufficient permission.

404 <Component> id not found.

406 Not acceptable.

500 Unspecified internal server error.

REST API for Advanced Search

You can use REST API to run an Advanced Search query.
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Querying LoglLogic LMI using the REST API includes the following steps:

1. Create a query and obtain its ID.
2. Get status, results, or details from the query (in multiple invocations).
3. Delete the query after all the data has been obtained.

You can omit deleting the query if you create the query with a timeToLive parameter, in
which case the query is automatically deleted after some time of inactivity.

o Note: TLSv1.2 and TLS v1.3 are supported for REST API.

Query Creation

This is a single synchronous call where the results are returned immediately after
specifying the query:

POST <baseurl>/api/v2/query

The result can be any of the following items:

e Success: The query returns information about the query, including the ID number of
the query and the schema of the results. When the query creation succeeds, although
the call returns immediately, LoglLogic starts the process of generating results in the
background.

e Failure: The result is a failure if the query is invalid, for example, if there are syntax
errors. In such case, the error details are returned.

Two more parameters can be specified in addition to the query itself:

e cached: Using this parameter, the results are cached temporarily. This allows you to
retrieve any window of results from the total results, effectively allowing you to scroll
the results up and down. It also allows you to run sub-queries, which is allowed only
if the query is cached.

Note: Cached queries have a performance penalty and should be only
used if needed.

e timeToLive: The time of inactivity in seconds, after which the query is automatically
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deleted. The default is 0, which indicates never auto-deleting the query.
The query returns:
e The query ID

e The schema: An array of column descriptors, where each column descriptor contains
the name and the type of the column. Similar to a header in a table, the column
descriptor allows you to identify the values in each column. You use the column
descriptor to interpret the results, as each row in the results is represented by a raw
array.

API to Retrieve the Results

After creating the query and obtaining its ID, you can check its status, obtain details about
the query, and retrieve results:

e GET <baseurl>/api/v2/query/{id}/status
e GET <baseurl>/api/v2/query/{id}/details

e GET <baseurl>/api/v2/query/{id}/results

The API to retrieve results takes the following parameters:
 id: The id of the query to get results from

» offset (optional): The offset of the results to be retrieved. Only available for cached
queries. For non-cached queries, you cannot choose the offset; the results must be
retrieved sequentially using multiple calls to this API.

* size (optional): The number of rows to return in this call. The APl might return fewer
or no rows, depending on the number of rows available.

 longPollTimeout (optional): The time in milliseconds to wait before returning results,
if the result rows are not available. Only available for non-cached queries.

This API returns:

e rows: The array of rows. In most cases, it is a subset of the result rows. However, it
could be all the results if there are only a few. Whether you need to fetch more
results or not is indicated by the hasMore parameter. To fetch more rows, you must
call this method again.

o offset: The offset of the subset of the rows returned.
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e errorsOrWarnings: The details of error or warnings, if any.

* hasMore: A Boolean value. It is true if more rows are available to fetch, and false if
there are no more rows to fetch.

Typically this APl is repeatedly invoked to fetch the rows, until hasMore is false. After all
the results have been fetched, you can delete the query.

API to Delete a Query

After using a query, you must delete it from the system; otherwise it continues using
valuable resources. Deleting a query requires only the ID of the query:

DELETE <baseurl>/api/v2/query/{id}

Alternatively, you can set the timeTolLive parameter while creating the query, so that the
query is deleted automatically after the specified time of inactivity.

Sub-Queries

If a query returns too many rows, you can further refine the results by creating a sub-query.
Similar to a filter, a sub-query adds modification to the original query, for example, sorting
or grouping.

POST <baseurl>/api/v2/query/{id}/subquery/

This is especially useful for user interfaces that allow exploratory querying, where the user
is not sure of what exactly to search.

o Note: Use sub-queries only when needed, as they are supported only for cached
queries and have a performance penalty compared to regular queries.

Creating a sub-query requires only the modification parameter. This parameter is an EQL
fragment including the operations that must be applied. EQL and SQL both are supported.

After a sub-query is created, the APIs to retrieve results or status, delete, are equivalent to
the APIs for the regular queries. The parameters and results are identical.
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Examples of modifications:

Query

SORT BY 11l_sourceUser

GROUP BY 11_eventAction | COLUMNS 11_
eventAction, COUNT(*)

11l_device = '"MyDevice’

Description
Sort by the column ll_sourceUser

Get the count of events per Il_
eventAction

Get only the events for device
MyDevice

REST API for Aggregation Rules

The following table lists the REST API to perform the functions related to aggregation rules:

Resource API

PUT /configuration/aggregationRule

GET /configuration/aggregationRule

POST /configuration/aggregationRule {ruleld}
DELETE /configuration/aggregationRule {ruleld}
GET /configuration/aggregationRule {ruleld}

PUT
/configuration/aggregationRule/validate/query

Description

Create an aggregation rule.
Retrieve all aggregation rules
Update an aggregation rule.
Delete an aggregation rule.

Retrieve an aggregation rule having the
specified rule ID.

Validate an aggregation rule query.

REST API for Triggers and Trigger Groups

Using the correlation APIs, you can create a new trigger and test it on incoming data.
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You can perform the following operations using REST API:

e Create a trigger and trigger group after creating a correlation Blok using ECL:

PUT https://<host>:9682/api/vl/trigger-groups

To create a trigger, use the following URL:

PUT https://<host>:9682/api/vl/triggers

e Deploy or synchronize the trigger group:

POST https://<host>:9682/api/vl/triggers/deploy

» Check the status of the deployed trigger group:

GET https://<host>:9682/api/vl/trigger-groups

List of REST API services

REST API services to manage triggers

Resource API Description
GET triggers Get a list of triggers.
PUT triggers Create a new trigger.

DELETE trigger/{id}  Delete a trigger from the node.
POST trigger/{id} Update a trigger.

GET trigger/{id} Get a trigger.
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REST API services to manage trigger groups

Resource API Description

GET trigger-groups Get a list of trigger groups.
PUT trigger-groups Create a new trigger group.
GET trigger-group/{id} Get a trigger group.

POST trigger-group/{id} Update a trigger group.
DELETE trigger-group/{id}  Delete a trigger group.

POST triggers/deploy Deploy triggers.

Related topics

For information about how to manage triggers by using the GUI, see Managing Triggers.

REST API for Correlation Rules

Correlation instances are required to run correlation rules. A correlation instance includes
an ECL ruleset, which is effective as soon as the correlation instance is active.

There are two types of instances, replay and real-time.

Replay Instances

Replay instances work on historical data. When you run an Advanced Search with a
correlation Blok from the GUI, a corresponding replay instance is automatically created and
executed.

You can perform the following operations on replay instances using REST API:

e Create a replay instance using ECL:
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POST http://<host>:9682/api/vl/instances

Ensure that you specify "instanceType": "replay". Note down the instance ID
returned in the response body.

e Check the status of the instance to ensure it has finished processing the historical

data:

GET https://<host>:9682/api/vl/instance/<instancelD>

"status": "completed" indicates that the instance has processed all the historical
data in the system.

e Retrieve the correlation events to ensure the rule is operating as expected.

GET
https://<host>:9682/api/vl/instance/<instancelID>/correlationevents?
type=MESSAGES

 If the output is not as expected, update the instance with new ECL and view the new
results.

POST https://<host>:9682/api/vl/instance/<instanceID>

After updating the instance, the modified rule is applied to the data and a new set of
correlation events is generated.

» Delete the instance to free all the resources being used by the instance:

DELETE https://<host>:9682/api/vl/instance/<instanceID>

Real-Time Instances

Real-time instances work on real time events. When you create triggers and trigger groups
from the GUI and synchronize trigger groups, a real-time instance is automatically created
for each trigger group. The real-time instance includes all information associated with that
trigger, such as correlation Blok and notification settings.

Real-time instances process only the new data ingested in the appliance. Therefore, after
creating a real-time instance, you must wait until new data arrives before any alerts can be
generated.
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To create a real-time instance using REST API, use the same resource URL as that for
creating replay instances; but specify "instanceType": "realtime". REST API services for
other operations are the same as those for replay instances.

Real-time instances generate alerts. To retrieve and acknowledge alerts using the REST API,

see REST API for Advanced Alerts.

List of REST API services

Resource API

GET activelnstances

GET instances

POST instances

GET instance/{id}

POST instance/{id}

DELETE instance/{id}

GET instance/{id}/correlationevents
GET instance/{id}/correlationevent/
{eventld}/group/{name}/eventKeys

GET instance/{id}/result/
{resultSetld}/columns

PUT validate/correlation/rule

Description

Get a list of active instance states that currently
exist in the node.

Get a list of instances that currently exist in the
node.

Create a new instance and run it on the specified
data.

Get the summary of an instance.
Update the state of an instance.
Delete an instance from the node.

Get correlation events for an instance. This
supports only replay instances.

Get a list of event references and sources. This
supports only replay instances.

Get lists of correlation result set columns. This
supports only for replay instances.

Validate a correlation rule.
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Limitations

You can use correlation instances from the REST API, but not from the GUI, because of the

following reasons:

e A correlation instance created by using the REST API service cannot be viewed or
edited from the GUI.

» A real-time correlation instance updated by using the REST API service is not
synchronized with its corresponding triggers and trigger group created from the GUI.
Similarly, a replay instance updated by using the REST API service is not
synchronized with its corresponding search query created from the GUI.

REST API for Advanced Alerts

Using the correlation APIs, you can retrieve and acknowledge alerts. Real-time instances
generate alerts; replay instances do not.

You can perform the following operations on alerts using REST API:

e Retrieve and view alerts:

GET
https://<host>:9682/api/vl/instance/<instancelID>/alerts?alertNameFi

lter=LoginFailureAttempt

e Retrieve alert details:

GET
https://<host>:9682/api/vl/instance/<instanceID>/alert/<alertID>

* Acknowledge alerts:

POST https://<host>:9682/api/vl/alerts
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List of REST API services

Resource API Description

GET instance/{id}/alerts Get a list of alerts from an instance.
POST alerts Acknowledge alerts.

GET instance/{id}/alert/ Get the detailed summary of an alert.
{alertID}

GET Get a list of alert severities.

instances/alert/severities

GET Get a list of alert categories.
instances/alert/categories

POST instances/alert/fields Get a list of alert fields for the rule and source environment.
The alert fields are different depending on the rule and source
environment.

GET instance/{id}/alert/ Get a list of event references and sources. This supports only

{alertID}/group/ realtime instances.
{groupName}/ eventKeys

Related topics

For information about how to work with Advanced Alerts by using the GUI, see Advanced
Alerts.

TIBCO Loglogic® Log Management Intelligence User Guide



527 | Reserved Keywords

Reserved Keywords

A list of reserved keywords that cannot be used in user-defined fields.

The following keywords cannot be used as column names of data models.

Reserved keywords

MONTH DAY YEAR HOUR
MIN SEC LENGTH SUBSTR
SUM AVG USE SUBSTRING
MID LOWER UPPER TRIM
SUBSTITUTE LEFT RIGHT FIND
CONCATENATE POSITION SECONDS MINUTES
HOURS DAYS WEEKS MONTHS
YEARS IIF TOTIMESTAMP TOIP
TOSTRING TOINT TOLONG TOFLOAT
TOBOOL EXTRACTJSON EXTRACTKVP TOTIMESTAMPSTRING
INT LONG BOOLEAN DATE
TIME STRING HEX CASE
EXPRESSION

Reserved keywords from the H2 database
ALL CHECK CONSTRAINT CROSS
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CURRENT_DATE CURRENT_TIME  CURRENT_TIMESTAMP  DISTINCT

EXCEPT EXISTS FALSE FETCH
FOR FOREIGN FROM FULL
GROUP HAVING INNER INTERSECT
IS JOIN LIKE NULL
LIMIT MINUS NATURAL NOT
OFFSET ON ORDER PRIMARY
ROWNUM SELECT SYSDATE SYSTIME
SYSTIMESTAMP TODAY TRUE UNION
UNIQUE WHERE WITH
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TIBCO Documentation and Support Services

For information about this product, you can read the documentation, contact TIBCO
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation
website, mainly in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than
any other documentation included with the product.

Product-Specific Documentation

The following documentation for this product is available on the TIBCO Loglogic® Log
Management Intelligence Product Documentation page.

e TIBCO LoglLogic® Log Management Intelligence Release Notes

TIBCO LoglLogic® Log Management Intelligence Administration

e TIBCO Loglogic® Log Management Intelligence Configuration and Upgrade

e TIBCO LogLogic® Log Management Intelligence Hardware Installation Guide

e TIBCO LogLogic® Log Management Intelligence Log Source Report Mapping

e TIBCO Loglogic® Log Management Intelligence Security Guidelines

e TIBCO LogLogic® Log Management Intelligence SSD Hardware Field Installation

e TIBCO LogLogic® Log Management Intelligence Syslog Alert Message Format Quick
Reference

e TIBCO Loglogic® Log Management Intelligence User Guide
e TIBCO LogLogic® Log Management Intelligence XML Import/Export Entities Reference

e TIBCO Loglogic® Enterprise Virtual Appliance Quick Start
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Other TIBCO Product Documentation

The following documents for TIBCO LoglLogic® Log Source Packages are available on the
TIBCO eDelivery website or TIBCO Support website after logging in.

e TIBCO Loglogic® Log Source Packages Release Notes

e TIBCO LogLogic® Log Source Packages Installation and Upgrade
e TIBCO Loglogic® Log Source Packages Log Configuration Guides
e TIBCO Loglogic® Log Source Packages Log Collector Guides

How to Contact TIBCO Support
Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

» For accessing the Support Knowledge Base and getting personalized content about
products you are interested in, visit the TIBCO Support website.

» For creating a Support case, you must have a valid maintenance or support contract
with TIBCO. You also need a user name and password to log in to TIBCO Support
website. If you do not have a user name, you can request one by clicking Register on
the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to

TIBCO Community.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED
OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED
ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED
SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR
ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE AGREEMENT,
OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER LICENSE AGREEMENT
WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE SOFTWARE (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR
CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF
THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE
SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, and LogLogic are either registered trademarks or
trademarks of TIBCO Software Inc. in the United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme file for the
availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR
CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY
TIME.
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THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2002-2022. TIBCO Software Inc. All Rights Reserved.
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